Copyright and Trademark Information

© 2013 SAS IP, Inc. All rights reserved. Unauthorized use, distribution or duplication is prohibited.

ANSYS, ANSYS Workbench, Ansoft, AUTODYN, EKM, Engineering Knowledge Manager, CFX, FLUENT, HFSS and any and all ANSYS, Inc. brand, product, service and feature names, logos and slogans are registered trademarks or trademarks of ANSYS, Inc. or its subsidiaries in the United States or other countries. ICEM CFD is a trademark used by ANSYS, Inc. under license. CFX is a trademark of Sony Corporation in Japan. All other brand, product, service and feature names or trademarks are the property of their respective owners.

Disclaimer Notice

THIS ANSYS SOFTWARE PRODUCT AND PROGRAM DOCUMENTATION INCLUDE TRADE SECRETS AND ARE CONFIDENTIAL AND PROPRIETARY PRODUCTS OF ANSYS, INC., ITS SUBSIDIARIES, OR LICENSORS. The software products and documentation are furnished by ANSYS, Inc., its subsidiaries, or affiliates under a software license agreement that contains provisions concerning non-disclosure, copying, length and nature of use, compliance with exporting laws, warranties, disclaimers, limitations of liability, and remedies, and other provisions. The software products and documentation may be used, disclosed, transferred, or copied only in accordance with the terms and conditions of that software license agreement.

ANSYS, Inc. is certified to ISO 9001:2008.

U.S. Government Rights

For U.S. Government users, except as specifically granted by the ANSYS, Inc. software license agreement, the use, duplication, or disclosure by the United States Government is subject to restrictions stated in the ANSYS, Inc. software license agreement and FAR 12.212 (for non-DOD licenses).

Third-Party Software

See the legal information in the product help files for the complete Legal Notice for ANSYS proprietary software and third-party software. If you are unable to access the Legal Notice, please contact ANSYS, Inc.

Published in the U.S.A.
Table of Contents

Using This Manual ................................................................................................................. xiii
1. What's In This Manual ........................................................................................................... xiii
2. The Contents of the Fluent Manuals ..................................................................................... xiii
3. Where to Find the Files Used in the Tutorials ....................................................................... xv
4. How To Use This Manual ....................................................................................................... xv
  4.1. For the Beginner .................................................................................................................. xv
  4.2. For the Experienced User .................................................................................................... xv
5. Typographical Conventions Used In This Manual ................................................................. xv

1. Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow ................................................................. 1
  1.1. Introduction ..................................................................................................................... 1
  1.2. Prerequisites ................................................................................................................... 2
  1.3. Problem Description ....................................................................................................... 2
  1.4. Setup and Solution ......................................................................................................... 3
    1.4.1. Preparation ............................................................................................................... 4
    1.4.2. Creating a Fluent Fluid Flow Analysis System in ANSYS Workbench .................... 4
    1.4.3. Creating the Geometry in ANSYS DesignModeler .............................................. 9
    1.4.4. Meshing the Geometry in the ANSYS Meshing Application .................................. 20
    1.4.5. Setting Up the CFD Simulation in ANSYS Fluent ................................................ 27
    1.4.6. Displaying Results in ANSYS Fluent and CFD-Post ............................................. 51
    1.4.7. Duplicating the Fluent-Based Fluid Flow Analysis System .................................. 60
    1.4.8. Changing the Geometry in ANSYS DesignModeler ........................................... 61
    1.4.9. Updating the Mesh in the ANSYS Meshing Application ....................................... 63
    1.4.10. Calculating a New Solution in ANSYS Fluent ................................................... 65
    1.4.11. Comparing the Results of Both Systems in CFD-Post ........................................ 67
  1.5. Summary ....................................................................................................................... 72

2. Parametric Analysis in ANSYS Workbench Using ANSYS Fluent ........................................ 73
  2.1. Introduction .................................................................................................................... 73
  2.2. Prerequisites .................................................................................................................. 74
  2.3. Problem Description ...................................................................................................... 74
  2.4. Setup and Solution ........................................................................................................ 77
    2.4.1. Preparation ............................................................................................................... 78
    2.4.2. Adding Constraints to ANSYS DesignModeler Parameters in ANSYS Workbench ...... 78
    2.4.3. Setting Up the CFD Simulation in ANSYS Fluent ................................................ 87
    2.4.4. Defining Input Parameters in ANSYS Fluent and Running the Simulation ............ 91
    2.4.5. Postprocessing and Setting the Output Parameters in ANSYS CFD-Post .......... 100
    2.4.6. Creating Additional Design Points in ANSYS Workbench .................................. 112
    2.4.7. Postprocessing the New Design Points in CFD-Post ............................................. 115
    2.4.8. Summary ................................................................................................................ 121

3. Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow ........ 123
  3.1. Introduction .................................................................................................................... 123
  3.2. Prerequisites .................................................................................................................. 123
  3.3. Problem Description ...................................................................................................... 123
  3.4. Setup and Solution ........................................................................................................ 124
    3.4.1. Preparation ............................................................................................................... 125
    3.4.2. Launching ANSYS Fluent ...................................................................................... 125
    3.4.3. Reading the Mesh .................................................................................................... 128
    3.4.4. General Settings ..................................................................................................... 133
    3.4.5. Models ..................................................................................................................... 135
    3.4.6. Materials .................................................................................................................. 138
### 3.4. Summary

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.7. Cell Zone Conditions</td>
<td>141</td>
</tr>
<tr>
<td>3.4.8. Boundary Conditions</td>
<td>143</td>
</tr>
<tr>
<td>3.4.9. Solution</td>
<td>147</td>
</tr>
<tr>
<td>3.4.10. Displaying the Preliminary Solution</td>
<td>157</td>
</tr>
<tr>
<td>3.4.11. Using the Coupled Solver</td>
<td>172</td>
</tr>
<tr>
<td>3.4.12. Adapting the Mesh</td>
<td>175</td>
</tr>
</tbody>
</table>

### 4. Modeling Periodic Flow and Heat Transfer

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1. Introduction</td>
<td>193</td>
</tr>
<tr>
<td>4.2. Prerequisites</td>
<td>193</td>
</tr>
<tr>
<td>4.3. Problem Description</td>
<td>194</td>
</tr>
<tr>
<td>4.4. Setup and Solution</td>
<td>194</td>
</tr>
<tr>
<td>4.4.1. Preparation</td>
<td>195</td>
</tr>
<tr>
<td>4.4.2. Mesh</td>
<td>195</td>
</tr>
<tr>
<td>4.4.3. General Settings</td>
<td>198</td>
</tr>
<tr>
<td>4.4.4. Models</td>
<td>198</td>
</tr>
<tr>
<td>4.4.5. Materials</td>
<td>199</td>
</tr>
<tr>
<td>4.4.6. Cell Zone Conditions</td>
<td>201</td>
</tr>
<tr>
<td>4.4.7. Periodic Conditions</td>
<td>202</td>
</tr>
<tr>
<td>4.4.8. Boundary Conditions</td>
<td>203</td>
</tr>
<tr>
<td>4.4.9. Solution</td>
<td>204</td>
</tr>
<tr>
<td>4.4.10. Postprocessing</td>
<td>209</td>
</tr>
<tr>
<td>4.5. Summary</td>
<td>219</td>
</tr>
<tr>
<td>4.6. Further Improvements</td>
<td>220</td>
</tr>
</tbody>
</table>

### 5. Modeling External Compressible Flow

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1. Introduction</td>
<td>221</td>
</tr>
<tr>
<td>5.2. Prerequisites</td>
<td>221</td>
</tr>
<tr>
<td>5.3. Problem Description</td>
<td>222</td>
</tr>
<tr>
<td>5.4. Setup and Solution</td>
<td>222</td>
</tr>
<tr>
<td>5.4.1. Preparation</td>
<td>222</td>
</tr>
<tr>
<td>5.4.2. Mesh</td>
<td>223</td>
</tr>
<tr>
<td>5.4.3. General Settings</td>
<td>226</td>
</tr>
<tr>
<td>5.4.4. Models</td>
<td>226</td>
</tr>
<tr>
<td>5.4.5. Materials</td>
<td>227</td>
</tr>
<tr>
<td>5.4.6. Boundary Conditions</td>
<td>229</td>
</tr>
<tr>
<td>5.4.7. Operating Conditions</td>
<td>231</td>
</tr>
<tr>
<td>5.4.8. Solution</td>
<td>232</td>
</tr>
<tr>
<td>5.4.9. Postprocessing</td>
<td>249</td>
</tr>
<tr>
<td>5.5. Summary</td>
<td>255</td>
</tr>
<tr>
<td>5.6. Further Improvements</td>
<td>255</td>
</tr>
</tbody>
</table>

### 6. Modeling Transient Compressible Flow

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1. Introduction</td>
<td>257</td>
</tr>
<tr>
<td>6.2. Prerequisites</td>
<td>257</td>
</tr>
<tr>
<td>6.3. Problem Description</td>
<td>258</td>
</tr>
<tr>
<td>6.4. Setup and Solution</td>
<td>258</td>
</tr>
<tr>
<td>6.4.1. Preparation</td>
<td>258</td>
</tr>
<tr>
<td>6.4.2. Reading and Checking the Mesh</td>
<td>259</td>
</tr>
<tr>
<td>6.4.3. Specifying Solver and Analysis Type</td>
<td>261</td>
</tr>
<tr>
<td>6.4.4. Specifying the Models</td>
<td>263</td>
</tr>
<tr>
<td>6.4.5. Editing the Material Properties</td>
<td>264</td>
</tr>
<tr>
<td>6.4.6. Setting the Operating Conditions</td>
<td>265</td>
</tr>
<tr>
<td>6.4.7. Creating the Boundary Conditions</td>
<td>266</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>18.4.3. Specifying Solver and Analysis Type</td>
<td>764</td>
</tr>
<tr>
<td>18.4.4. Specifying the Models</td>
<td>765</td>
</tr>
<tr>
<td>18.4.5. Defining Materials and Properties</td>
<td>767</td>
</tr>
<tr>
<td>18.4.6. Specifying Boundary Conditions</td>
<td>776</td>
</tr>
<tr>
<td>18.4.7. Setting the Operating Conditions</td>
<td>782</td>
</tr>
<tr>
<td>18.4.8. Simulating Non-Reacting Flow</td>
<td>783</td>
</tr>
<tr>
<td>18.4.9. Simulating Reacting Flow</td>
<td>786</td>
</tr>
<tr>
<td>18.4.10. Postprocessing the Solution Results</td>
<td>793</td>
</tr>
<tr>
<td>18.5. Summary</td>
<td>801</td>
</tr>
<tr>
<td>18.6. Further Improvements</td>
<td>801</td>
</tr>
<tr>
<td><strong>19. Modeling Evaporating Liquid Spray</strong></td>
<td>803</td>
</tr>
<tr>
<td>19.1. Introduction</td>
<td>803</td>
</tr>
<tr>
<td>19.2. Prerequisites</td>
<td>803</td>
</tr>
<tr>
<td>19.3. Problem Description</td>
<td>803</td>
</tr>
<tr>
<td>19.4. Setup and Solution</td>
<td>804</td>
</tr>
<tr>
<td>19.4.1. Preparation</td>
<td>804</td>
</tr>
<tr>
<td>19.4.2. Reading the Mesh</td>
<td>805</td>
</tr>
<tr>
<td>19.4.3. General Settings</td>
<td>806</td>
</tr>
<tr>
<td>19.4.4. Specifying the Models</td>
<td>809</td>
</tr>
<tr>
<td>19.4.5. Materials</td>
<td>812</td>
</tr>
<tr>
<td>19.4.6. Boundary Conditions</td>
<td>814</td>
</tr>
<tr>
<td>19.4.7. Initial Solution Without Droplets</td>
<td>819</td>
</tr>
<tr>
<td>19.4.8. Create a Spray Injection</td>
<td>829</td>
</tr>
<tr>
<td>19.4.9. Solution</td>
<td>837</td>
</tr>
<tr>
<td>19.4.10. Postprocessing</td>
<td>842</td>
</tr>
<tr>
<td>19.5. Summary</td>
<td>853</td>
</tr>
<tr>
<td>19.6. Further Improvements</td>
<td>853</td>
</tr>
<tr>
<td><strong>20. Using the VOF Model</strong></td>
<td>855</td>
</tr>
<tr>
<td>20.1. Introduction</td>
<td>855</td>
</tr>
<tr>
<td>20.2. Prerequisites</td>
<td>855</td>
</tr>
<tr>
<td>20.3. Problem Description</td>
<td>856</td>
</tr>
<tr>
<td>20.4. Setup and Solution</td>
<td>857</td>
</tr>
<tr>
<td>20.4.1. Preparation</td>
<td>857</td>
</tr>
<tr>
<td>20.4.2. Reading and Manipulating the Mesh</td>
<td>858</td>
</tr>
<tr>
<td>20.4.3. General Settings</td>
<td>863</td>
</tr>
<tr>
<td>20.4.4. Models</td>
<td>866</td>
</tr>
<tr>
<td>20.4.5. Materials</td>
<td>866</td>
</tr>
<tr>
<td>20.4.6. Phases</td>
<td>868</td>
</tr>
<tr>
<td>20.4.7. Operating Conditions</td>
<td>870</td>
</tr>
<tr>
<td>20.4.8. User-Defined Function (UDF)</td>
<td>871</td>
</tr>
<tr>
<td>20.4.9. Boundary Conditions</td>
<td>872</td>
</tr>
<tr>
<td>20.4.10. Solution</td>
<td>875</td>
</tr>
<tr>
<td>20.4.11. Postprocessing</td>
<td>882</td>
</tr>
<tr>
<td>20.5. Summary</td>
<td>888</td>
</tr>
<tr>
<td>20.6. Further Improvements</td>
<td>888</td>
</tr>
<tr>
<td><strong>21. Modeling Cavitation</strong></td>
<td>891</td>
</tr>
<tr>
<td>21.1. Introduction</td>
<td>891</td>
</tr>
<tr>
<td>21.2. Prerequisites</td>
<td>891</td>
</tr>
<tr>
<td>21.3. Problem Description</td>
<td>891</td>
</tr>
<tr>
<td>21.4. Setup and Solution</td>
<td>892</td>
</tr>
<tr>
<td>21.4.1. Preparation</td>
<td>892</td>
</tr>
<tr>
<td>21.4.2. Reading and Checking the Mesh</td>
<td>893</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>24.4.1</td>
<td>Preparation</td>
</tr>
<tr>
<td>24.4.2</td>
<td>Reading and Checking the Mesh</td>
</tr>
<tr>
<td>24.4.3</td>
<td>Specifying Solver and Analysis Type</td>
</tr>
<tr>
<td>24.4.4</td>
<td>Specifying the Models</td>
</tr>
<tr>
<td>24.4.5</td>
<td>Defining Materials</td>
</tr>
<tr>
<td>24.4.6</td>
<td>Setting the Cell Zone Conditions</td>
</tr>
<tr>
<td>24.4.7</td>
<td>Setting the Boundary Conditions</td>
</tr>
<tr>
<td>24.4.8</td>
<td>Solution: Steady Conduction</td>
</tr>
<tr>
<td>24.4.9</td>
<td>Solution: Transient Flow and Heat Transfer</td>
</tr>
<tr>
<td>24.5</td>
<td>Summary</td>
</tr>
<tr>
<td>24.6</td>
<td>Further Improvements</td>
</tr>
<tr>
<td>25.1</td>
<td>Introduction</td>
</tr>
<tr>
<td>25.2</td>
<td>Prerequisites</td>
</tr>
<tr>
<td>25.3</td>
<td>Problem Description</td>
</tr>
<tr>
<td>25.4</td>
<td>Setup and Solution</td>
</tr>
<tr>
<td>25.4.1</td>
<td>Preparation</td>
</tr>
<tr>
<td>25.4.2</td>
<td>Mesh</td>
</tr>
<tr>
<td>25.4.3</td>
<td>General Settings</td>
</tr>
<tr>
<td>25.4.4</td>
<td>Models</td>
</tr>
<tr>
<td>25.4.5</td>
<td>UDF</td>
</tr>
<tr>
<td>25.4.6</td>
<td>Materials</td>
</tr>
<tr>
<td>25.4.7</td>
<td>Phases</td>
</tr>
<tr>
<td>25.4.8</td>
<td>Boundary Conditions</td>
</tr>
<tr>
<td>25.4.9</td>
<td>Solution</td>
</tr>
<tr>
<td>25.4.10</td>
<td>Postprocessing</td>
</tr>
<tr>
<td>25.5</td>
<td>Summary</td>
</tr>
<tr>
<td>25.6</td>
<td>Further Improvements</td>
</tr>
<tr>
<td>25.7</td>
<td>References</td>
</tr>
<tr>
<td>26.1</td>
<td>Introduction</td>
</tr>
<tr>
<td>26.2</td>
<td>Prerequisites</td>
</tr>
<tr>
<td>26.3</td>
<td>Problem Description</td>
</tr>
<tr>
<td>26.4</td>
<td>Setup and Solution</td>
</tr>
<tr>
<td>26.4.1</td>
<td>Preparation</td>
</tr>
<tr>
<td>26.4.2</td>
<td>Reading the Mesh</td>
</tr>
<tr>
<td>26.4.3</td>
<td>Manipulating the Mesh in the Viewer</td>
</tr>
<tr>
<td>26.4.4</td>
<td>Adding Lights</td>
</tr>
<tr>
<td>26.4.5</td>
<td>Creating Isosurfaces</td>
</tr>
<tr>
<td>26.4.6</td>
<td>Generating Contours</td>
</tr>
<tr>
<td>26.4.7</td>
<td>Generating Velocity Vectors</td>
</tr>
<tr>
<td>26.4.8</td>
<td>Creating Animation</td>
</tr>
<tr>
<td>26.4.9</td>
<td>Displaying Pathlines</td>
</tr>
<tr>
<td>26.4.10</td>
<td>Overlaying Velocity Vectors on the Pathline Display</td>
</tr>
<tr>
<td>26.4.11</td>
<td>Creating Exploded Views</td>
</tr>
<tr>
<td>26.4.12</td>
<td>Animating the Display of Results in Successive Streamwise Planes</td>
</tr>
<tr>
<td>26.4.13</td>
<td>Generating XY Plots</td>
</tr>
<tr>
<td>26.4.14</td>
<td>Creating Annotation</td>
</tr>
<tr>
<td>26.4.15</td>
<td>Saving Hardcopy Files</td>
</tr>
<tr>
<td>26.4.16</td>
<td>Generating Volume Integral Reports</td>
</tr>
<tr>
<td>26.5</td>
<td>Summary</td>
</tr>
<tr>
<td>27.</td>
<td>Parallel Processing</td>
</tr>
</tbody>
</table>

**25. Using the Eulerian Granular Multiphase Model with Heat Transfer**

25.1 Introduction .................................................. 1037
25.2 Prerequisites ............................................... 1037
25.3 Problem Description ........................................ 1038
25.4 Setup and Solution .......................................... 1038
25.4.1 Preparation ............................................... 1039
25.4.2 Mesh .................................................. 1040
25.4.3 General Settings .......................................... 1040
25.4.4 Models ................................................. 1042
25.4.5 UDF ................................................... 1044
25.4.6 Materials ................................................ 1045
25.4.7 Phases .................................................. 1047
25.4.8 Boundary Conditions ..................................... 1049
25.4.9 Solution ................................................ 1056
25.4.10 Postprocessing .......................................... 1069
25.5 Summary .................................................. 1072
25.6 Further Improvements ....................................... 1072
25.7 References ................................................ 1073
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>27.1</td>
<td>Introduction</td>
<td>1129</td>
</tr>
<tr>
<td>27.2</td>
<td>Prerequisites</td>
<td>1129</td>
</tr>
<tr>
<td>27.3</td>
<td>Problem Description</td>
<td>1130</td>
</tr>
<tr>
<td>27.4</td>
<td>Setup and Solution</td>
<td>1130</td>
</tr>
<tr>
<td>27.4.1</td>
<td>Preparation</td>
<td>1130</td>
</tr>
<tr>
<td>27.4.2</td>
<td>Starting the Parallel Version of ANSYS Fluent</td>
<td>1131</td>
</tr>
<tr>
<td>27.4.2.1</td>
<td>Multiprocessor Machine</td>
<td>1131</td>
</tr>
<tr>
<td>27.4.2.2</td>
<td>Network of Computers</td>
<td>1132</td>
</tr>
<tr>
<td>27.4.3</td>
<td>Reading and Partitioning the Mesh</td>
<td>1135</td>
</tr>
<tr>
<td>27.4.4</td>
<td>Solution</td>
<td>1142</td>
</tr>
<tr>
<td>27.4.5</td>
<td>Checking Parallel Performance</td>
<td>1142</td>
</tr>
<tr>
<td>27.4.6</td>
<td>Postprocessing</td>
<td>1143</td>
</tr>
<tr>
<td>27.5</td>
<td>Summary</td>
<td>1146</td>
</tr>
</tbody>
</table>
Using This Manual

This preface is divided into the following sections:
1. What's In This Manual
2. The Contents of the Fluent Manuals
3. Where to Find the Files Used in the Tutorials
4. How To Use This Manual
5. Typographical Conventions Used In This Manual

1. What's In This Manual

The ANSYS Fluent Tutorial Guide contains a number of tutorials that teach you how to use ANSYS Fluent to solve different types of problems. In each tutorial, features related to problem setup and postprocessing are demonstrated.

The tutorials are written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.

Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

All of the tutorials include some postprocessing instructions, but Postprocessing (p. 1075) is devoted entirely to postprocessing.

2. The Contents of the Fluent Manuals

The manuals listed below form the Fluent product documentation set. They include descriptions of the procedures, commands, and theoretical details needed to use Fluent products.

• Fluent Getting Started Guide contains general information about getting started with using Fluent and provides details about starting, running, and exiting the program.

• Fluent Migration Manual contains information about transitioning from the previous release of Fluent, including details about new features, solution changes, and text command list changes.

• Fluent User's Guide contains detailed information about running a simulation using the solution mode of Fluent, including information about the user interface, reading and writing files, defining boundary conditions, setting up physical models, calculating a solution, and analyzing your results.

• ANSYS Fluent Meshing User’s Guide contains detailed information about creating 3D meshes using the meshing mode of Fluent.

• Fluent in Workbench User's Guide contains information about getting started with and using Fluent within the Workbench environment.
• **Fluent Theory Guide** contains reference information for how the physical models are implemented in Fluent.

• **Fluent UDF Manual** contains information about writing and using user-defined functions (UDFs).

• **Fluent Tutorial Guide** contains a number of examples of various flow problems with detailed instructions, commentary, and postprocessing of results.

• **ANSYS Fluent Meshing Tutorials** contains a number of examples of general mesh-generation techniques used in ANSYS Fluent Meshing.

  Tutorials for release 15.0 are available on the ANSYS Customer Portal. To access tutorials and their input files on the ANSYS Customer Portal, go to [http://support.ansys.com/training](http://support.ansys.com/training).

• **Fluent Text Command List** contains a brief description of each of the commands in Fluent’s solution mode text interface.

• **ANSYS Fluent Meshing Text Command List** contains a brief description of each of the commands in Fluent’s meshing mode text interface.

• **Fluent Adjoint Solver Module Manual** contains information about the background and usage of Fluent’s Adjoint Solver Module that allows you to obtain detailed sensitivity data for the performance of a fluid system.

• **Fluent Battery Module Manual** contains information about the background and usage of Fluent’s Battery Module that allows you to analyze the behavior of electric batteries.

• **Fluent Continuous Fiber Module Manual** contains information about the background and usage of Fluent’s Continuous Fiber Module that allows you to analyze the behavior of fiber flow, fiber properties, and coupling between fibers and the surrounding fluid due to the strong interaction that exists between the fibers and the surrounding gas.

• **Fluent Fuel Cell Modules Manual** contains information about the background and the usage of two separate add-on fuel cell models for Fluent that allow you to model polymer electrolyte membrane fuel cells (PEMFC), solid oxide fuel cells (SOFC), and electrolysis with Fluent.

• **Fluent Magnetohydrodynamics (MHD) Module Manual** contains information about the background and usage of Fluent’s Magnetohydrodynamics (MHD) Module that allows you to analyze the behavior of electrically conducting fluid flow under the influence of constant (DC) or oscillating (AC) electromagnetic fields.

• **Fluent Population Balance Module Manual** contains information about the background and usage of Fluent’s Population Balance Module that allows you to analyze multiphase flows involving size distributions where particle population (as well as momentum, mass, and energy) require a balance equation.

• **Fluent as a Server User's Guide** contains information about the usage of Fluent as a Server which allows you to connect to a Fluent session and issue commands from a remote client application.

• **Running Fluent Under LSF** contains information about using Fluent with Platform Computing’s LSF software, a distributed computing resource management tool.

• **Running Fluent Under PBS Professional** contains information about using Fluent with Altair PBS Professional, an open workload management tool for local and distributed environments.
**3. Where to Find the Files Used in the Tutorials**

Each of the tutorials uses an existing mesh file. (Tutorials for mesh generation are provided with the mesh generator documentation.) You will find the appropriate mesh file (and any other relevant files used in the tutorial) on the ANSYS Customer Portal. The “Preparation” step of each tutorial will tell you where to find the necessary files. (Note that Tutorials Postprocessing (p. 1075) and Parallel Processing (p. 1129) use existing case and data files.)

Some of the more complex tutorials may require a significant amount of computational time. If you want to look at the results immediately, without waiting for the calculation to finish, final solution files are provided in a solution_files folder that you can access after extracting the tutorial input archive.

**4. How To Use This Manual**

Depending on your familiarity with computational fluid dynamics and the ANSYS Fluent software, you can use this tutorial guide in a variety of ways.

**4.1. For the Beginner**

If you are a beginning user of ANSYS Fluent you should first read and solve Tutorial 1, in order to familiarize yourself with the interface and with basic setup and solution procedures. You may then want to try a tutorial that demonstrates features that you are going to use in your application. For example, if you are planning to solve a problem using the non-premixed combustion model, you should look at Using the Non-Premixed Combustion Model (p. 723).

You may want to refer to other tutorials for instructions on using specific features, such as custom field functions, mesh scaling, and so on, even if the problem solved in the tutorial is not of particular interest to you. To learn about postprocessing, you can look at Postprocessing (p. 1075), which is devoted entirely to postprocessing (although the other tutorials all contain some postprocessing as well).

**4.2. For the Experienced User**

If you are an experienced ANSYS Fluent user, you can read and/or solve the tutorial(s) that demonstrate features that you are going to use in your application. For example, if you are planning to solve a problem using the non-premixed combustion model, you should look at Using the Non-Premixed Combustion Model (p. 723).

You may want to refer to other tutorials for instructions on using specific features, such as custom field functions, mesh scaling, and so on, even if the problem solved in the tutorial is not of particular interest to you. To learn about postprocessing, you can look at Postprocessing (p. 1075), which is devoted entirely to postprocessing (although the other tutorials all contain some postprocessing as well).

**5. Typographical Conventions Used In This Manual**

Several typographical conventions are used in the text of the tutorials to facilitate your learning process.

- Different type styles are used to indicate graphical user interface menu items and text interface menu items (e.g., Zone Surface dialog box, surface(zone-surface command).
• The text interface type style is also used when illustrating exactly what appears on the screen or exactly what you must type in the text window or in a dialog box.

• Instructions for performing each step in a tutorial will appear in standard type. Additional information about a step in a tutorial appears in italicized type.

• A mini flow chart is used to guide you through the navigation pane, which leads you to a specific task page or dialog box. For example,

\[\text{Models} \rightarrow \text{Multiphase} \rightarrow \text{Edit...}\]

indicates that Models is selected in the navigation pane, which then opens the corresponding task page. In the Models task page, Multiphase is selected from the list. Clicking the Edit... button opens the Multiphase dialog box.

Also, a mini flow chart is used to indicate the menu selections that lead you to a specific command or dialog box. For example,

\[\text{Define} \rightarrow \text{Injections...}\]

indicates that the Injections... menu item can be selected from the Define pull-down menu.

The words surrounded by boxes invoke menus (or submenus) and the arrows point from a specific menu toward the item you should select from that menu.
Chapter 1: Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow

This tutorial is divided into the following sections:

1.1. Introduction
1.2. Prerequisites
1.3. Problem Description
1.4. Setup and Solution
1.5. Summary

1.1. Introduction

This tutorial illustrates using ANSYS Fluent fluid flow systems in ANSYS Workbench to set up and solve a three-dimensional turbulent fluid-flow and heat-transfer problem in a mixing elbow. It is designed to introduce you to the ANSYS Workbench tool set using a simple geometry. Guided by the steps that follow, you will create the elbow geometry and the corresponding computational mesh using the geometry and meshing tools within ANSYS Workbench. You will use ANSYS Fluent to set up and solve the CFD problem, then visualize the results in both ANSYS Fluent and in the CFD-Post postprocessing tool. Some capabilities of ANSYS Workbench (for example, duplicating fluid flow systems, connecting systems, and comparing multiple data sets) are also examined in this tutorial.

This tutorial demonstrates how to do the following:

• Launch ANSYS Workbench.

• Create a Fluent fluid flow analysis system in ANSYS Workbench.

• Create the elbow geometry using ANSYS DesignModeler.

• Create the computational mesh for the geometry using ANSYS Meshing.

• Set up the CFD simulation in ANSYS Fluent, which includes:
  – Setting material properties and boundary conditions for a turbulent forced-convection problem.
  – Initiating the calculation with residual plotting.
  – Calculating a solution using the pressure-based solver.
  – Examining the flow and temperature fields using ANSYS Fluent and CFD-Post.

• Create a copy of the original Fluent fluid flow analysis system in ANSYS Workbench.

• Change the geometry in ANSYS DesignModeler, using the duplicated system.

• Regenerate the computational mesh.

• Recalculate a solution in ANSYS Fluent.
• Compare the results of the two calculations in CFD-Post.

1.2. Prerequisites

This tutorial assumes that you have little to no experience with ANSYS Workbench, ANSYS DesignModeler, ANSYS Meshing, ANSYS Fluent, or CFD-Post, and so each step will be explicitly described.

1.3. Problem Description

The problem to be considered is shown schematically in Figure 1.1: Problem Specification (p. 3). A cold fluid at 293.15 K flows into the pipe through a large inlet and mixes with a warmer fluid at 313.15 K that enters through a smaller inlet located at the elbow. The mixing elbow configuration is encountered in piping systems in power plants and process industries. It is often important to predict the flow field and temperature field in the area of the mixing region in order to properly design the junction.

Note

Because the geometry of the mixing elbow is symmetric, only half of the elbow must be modeled.
Note

The functionality to create named selections exists in both ANSYS DesignModeler and ANSYS Meshing. For the purposes of this tutorial, named selections are created in ANSYS Meshing since the meshing application provides more comprehensive and extensive named selection functionality.

1.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

1.4.1. Preparation
1.4.2. Creating a Fluent Fluid Flow Analysis System in ANSYS Workbench
1.4.3. Creating the Geometry in ANSYS DesignModeler
1.4.4. Meshing the Geometry in the ANSYS Meshing Application
1.4.5. Setting Up the CFD Simulation in ANSYS Fluent
1.4.6. Displaying Results in ANSYS Fluent and CFD-Post
1.4.7. Duplicating the Fluent-Based Fluid Flow Analysis System
1.4.8. Changing the Geometry in ANSYS DesignModeler
1.4.9. Updating the Mesh in the ANSYS Meshing Application
1.4.10. Calculating a New Solution in ANSYS Fluent
1.4.11. Comparing the Results of Both Systems in CFD-Post
1.4.1. Preparation

1. Set up a working folder on the computer you will be using.


**Note**

If you do not have a login, you can request one by clicking **Customer Registration** on the login page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   a. Click **ANSYS Fluent** under **Product**.
   b. Click **15.0** under **Version**.

5. Select this tutorial from the list.

6. Click **Files** to download the input and solution files.

7. Unzip **elbow-workbench_R150.zip** to your working folder. This file contains a folder, **elbow-workbench**, that holds the following items:
   
   • two geometry files, **elbow_geometry.agdb** and **elbow_geometry.stp**
   
   • an ANSYS Workbench project archive, **elbow-workbench.wbpz**

**Tip**

The Workbench project archive contains the project as it will be once you have completed all of the steps of the tutorial and is included for reference. If you want to extract the project archive, start Workbench and select the **File → Restore Archive...** menu item. You will be prompted with a dialog box to specify a location in which to extract the project and its supporting files. You may choose any convenient location.

**Note**

ANSYS Fluent tutorials are prepared using ANSYS Fluent on a Windows system. The screen shots and graphic images in the tutorials may be slightly different than the appearance on your system, depending on the operating system or graphics card.

1.4.2. Creating a Fluent Fluid Flow Analysis System in ANSYS Workbench

In this step, you will start ANSYS Workbench, create a new Fluent fluid flow analysis system, then review the list of files generated by ANSYS Workbench.
1. Start ANSYS Workbench by clicking the Windows **Start** menu, then selecting the **Workbench 15.0** option in the **ANSYS 15.0** program group.

   **Start** → **All Programs** → **ANSYS 15.0** → **Workbench 15.0**

This displays the ANSYS Workbench application window, which has the **Toolbox** on the left and the **Project Schematic** to its right. Various supported applications are listed in the **Toolbox** and the components of the analysis system will be displayed in the **Project Schematic**.

**Note**

Depending on which other products you have installed, the analysis systems that appear may differ from those in the figures that follow in this tutorial.

**Note**

When you first start ANSYS Workbench, the **Getting Started** pop-up window is displayed, offering assistance through the online help for using the application. You can keep the window open, or close it by clicking the ‘X’ icon in the upper right-hand corner. If you need to access the online help at any time, use the **Help** menu, or press the **F1** key.

2. Create a new Fluent fluid flow analysis system by double-clicking the **Fluid Flow (Fluent)** option under **Analysis Systems** in the **Toolbox**.

**Tip**

You can also drag-and-drop the analysis system into the **Project Schematic**. A green dotted outline indicating a potential location for the new system initially appears in the **Project Schematic**. When you drag the system to one of the outlines, it turns into a red box to indicate the chosen location of the new system.
Figure 1.2: Selecting the Fluid Flow (Fluent) Analysis System in ANSYS Workbench
3. Name the analysis.
   a. Double-click the Fluid Flow (Fluent) label underneath the analysis system (if it is not already highlighted).
   b. Enter elbow for the name of the analysis system.

4. Save the project.
   a. Select the Save option under the File menu in ANSYS Workbench.

      **File → Save**

      This displays the Save As dialog box, where you can browse to your working folder and enter a specific name for the ANSYS Workbench project.
   b. In your working directory, enter elbow-workbench as the project File name and click the Save button to save the project. ANSYS Workbench saves the project with a .wbpj extension and also saves supporting files for the project.

Note that the fluid flow analysis system is composed of various cells (Geometry, Mesh, etc.) that represent the workflow for performing the analysis. ANSYS Workbench is composed of multiple data-integrated and native applications in a single, seamless project flow, where individual cells can obtain data from other cells and provide data to other cells. As a result of this constant flow of data, a cell's state can quickly change. ANSYS Workbench provides a visual indication of a cell's state at any given time via icons on the right side of each cell. Brief descriptions of the various states are provided below:
Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow

- **Unfulfilled** ( _) indicates that required upstream data does not exist. For example, when you first create a new Fluid Flow (Fluent) analysis system, all cells downstream of the Geometry cell appear as Unfulfilled because you have not yet specified a geometry for the system.

- **Refresh Required** ( _) indicates that upstream data has changed since the last refresh or update. For example, after you assign a geometry to the geometry cell in your new Fluid Flow (Fluent) analysis system, the Mesh cell appears as Refresh Required since the geometry data has not yet been passed from the Geometry cell to the Mesh cell.

- **Attention Required** ( _) indicates that the current upstream data has been passed to the cell, however, you must take some action to proceed. For example, after you launch ANSYS Fluent from the Setup cell in a Fluid Flow (Fluent) analysis system that has a valid mesh, the Setup cell appears as Attention Required because additional data must be entered in ANSYS Fluent before you can calculate a solution.

- **Update Required** ( _) indicates that local data has changed and the output of the cell must be regenerated. For example, after you launch ANSYS Meshing from the Mesh cell in a Fluid Flow (Fluent) analysis system that has a valid geometry, the Mesh cell appears as Update Required because the Mesh cell has all the data it must generate an ANSYS Fluent mesh file, but the ANSYS Fluent mesh file has not yet been generated.

- **Up To Date** ( ✔ ) indicates that an update has been performed on the cell and no failures have occurred or that an interactive calculation has been completed successfully. For example, after ANSYS Fluent finishes performing the number of iterations that you request, the Solution cell appears as Up-to-Date.

- **Interrupted** ( ✔ ) indicates that you have interrupted an update (or canceled an interactive calculation that is in progress). For example, if you select the Cancel button in ANSYS Fluent while it is iterating, ANSYS Fluent completes the current iteration and then the Solution cell appears as Interrupted.

- **Input Changes Pending** ( ✔ ) indicates that the cell is locally up-to-date, but may change when next updated as a result of changes made to upstream cells. For example, if you change the Mesh in an Up-to-Date Fluid Flow (Fluent) analysis system, the Setup cell appears as Refresh Required, and the Solution and Results cells appear as Input Changes Pending.

- **Pending** ( ✔ ) indicates that a batch or asynchronous solution is in progress. When a cell enters the Pending state, you can interact with the project to exit Workbench or work with other parts of the project. If you make changes to the project that are upstream of the updating cell, then the cell will not be in an up-to-date state when the solution completes.

For more information about cell states, see Understanding Cell States.

5. View the list of files generated by ANSYS Workbench.

   ANSYS Workbench allows you to easily view the files associated with your project using the Files view. To open the Files view, select the Files option under the View menu at the top of the ANSYS Workbench window.

   View → Files
In the Files view, you will be able to see the name and type of file, the ID of the cell that the file is associated with, the size of the file, the location of the file, and other information. For more information about the Files view, see Files View.

Note

The sizes of the files listed may differ slightly from those portrayed in Figure 1.4: ANSYS Workbench Files View for the Project After Adding a Fluent-Based Fluid Flow Analysis System (p. 9).

From here, you will create the geometry described in Figure 1.1: Problem Specification (p. 3), and later create a mesh and set up a fluid flow analysis for the geometry.

1.4.3. Creating the Geometry in ANSYS DesignModeler

For the geometry of your fluid flow analysis, you can create a geometry in ANSYS DesignModeler, or import the appropriate geometry file. In this step, you will create the geometry in ANSYS DesignModeler, then review the list of files generated by ANSYS Workbench.

Important

Note the Attention Required icon ( BOOLEAN ) within the Geometry cell for the system. This indicates that the cell requires data (for example, a geometry). Once the geometry is defined, the state of the cell will change accordingly. Likewise, the state of some of the remaining cells in the system will change.

Note

If you would rather not create the geometry in ANSYS DesignModeler, you can import a pre-existing geometry by right-clicking the Geometry cell and selecting the Import Geometry option from the context menu. From there, you can browse your file system to locate the elbow_geometry.agdb geometry file that is provided for this tutorial. If you do not have access to ANSYS DesignModeler, you can use the elbow_geometry.stp file instead.

To learn how to create a mesh from the geometry you imported, go to Meshing the Geometry in the ANSYS Meshing Application (p. 20).

1. Start ANSYS DesignModeler.
In the ANSYS Workbench **Project Schematic**, double-click the **Geometry** cell in the **elbow fluid flow analysis system**. This displays the ANSYS DesignModeler application.

**Tip**

You can also right-click the **Geometry** cell to display the context menu, then select **New Geometry...**

2. Set the units in ANSYS DesignModeler.

When ANSYS DesignModeler first appears, you should select desired system of length units to work from. For the purposes of this tutorial (where you will create the geometry in millimeters and perform the CFD analysis using SI units) set the units to **Millimeter**.

**Units → Millimeter**

3. Create the geometry.

The geometry for this tutorial (Figure 1.1: Problem Specification (p. 3)) consists of a large curved pipe accompanied by a smaller side pipe. ANSYS DesignModeler provides various geometry primitives that can be combined to rapidly create geometries such as this one. You will perform the following tasks to create the geometry:

- Create the bend in the main pipe by defining a segment of a torus.
- Extrude the faces of the torus segment to form the straight inlet and outlet lengths.
- Create the side pipe by adding a cylinder primitive.
- Use the symmetry tool to reduce the model to half of the pipe assembly, thus reducing computational cost.

a. Create the main pipe:

i. Create a new torus for the pipe bend by choosing the **Create → Primitives → Torus** menu item from the menubar.

A preview of the torus geometry will appear in the graphics window. Note that this is a preview and the geometry has not been created yet. First you must specify the parameters of the torus primitive in the next step.

ii. In the **Details View** for the new torus (**Torus1**), set **Base Y Component** to −1 by clicking the 1 to the right of **FD10, Base Y Component**, entering −1, and pressing **Enter**. This specifies the direction vector from the origin to the center of the circular cross-section at the start of the torus. In the same manner, specify **Angle; Inner Radius**; and **Outer Radius** as shown below.

**Note**

Enter only the value without the units of mm. They will be appended automatically because you specified the units previously.
iii. To create the torus segment, click the **Generate** button that is located in the ANSYS DesignModeler toolbar.
iv. Ensure that the selection filter is set to **Faces**. This is indicated by the **Faces** button appearing depressed in the toolbar and the appearance of the Face selection cursor, when you mouse over the geometry.

v. Select the top face (in the positive Y direction) of the elbow and click the **Extrude** button from the **3D Features** toolbar.

vi. In the **Details View** for the new extrusion (**Extrude1**), click **Apply** to the right of **Geometry**. This accepts the face you selected as the base geometry of the extrusion.

vii. Click **None (Normal)** to the right of **Direction Vector**. Again, ensure that the selection filter is set to **Faces**, select the same face on the elbow to specify that the extrusion will be normal to the face and click **Apply**.
viii. Enter 200 for **FD1, Depth (>0)** and click **Generate**.
ix. In a similar manner, create an extrusion of the other face of the torus segment to create the 200 mm inlet extension. You will probably find it helpful to rotate the view so that you can easily select the other face of the bend.

You can use the mouse buttons to change your view of the 3D image. The following table describes mouse actions that are available:

Table 1.1: DesignModeler View Manipulation Instructions

<table>
<thead>
<tr>
<th>Action</th>
<th>Using Graphics Toolbar Buttons and the Mouse</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate view (vertical, horizontal)</td>
<td>After clicking the <strong>Rotate</strong> icon,  rotate, press and hold the left mouse button and drag the mouse. Dragging side to side rotates the view about the vertical axis, and dragging up and down rotates the view about the horizontal axis.</td>
</tr>
<tr>
<td>Translate or pan view</td>
<td>After clicking the <strong>Pan</strong> icon,  drag, press and hold the left mouse button and drag the object with the mouse until the view is satisfactory.</td>
</tr>
<tr>
<td>Zoom in and out of view</td>
<td>After clicking the <strong>Zoom</strong> icon,  zoom, press and hold the left mouse button and drag the mouse up and down to zoom in and out of the view.</td>
</tr>
</tbody>
</table>
**Action** | **Using Graphics Toolbar Buttons and the Mouse**
--- | ---
Box zoom | After clicking the **Box Zoom** icon, press and hold the left mouse button and drag the mouse diagonally across the screen. This action will cause a rectangle to appear in the display. When you release the mouse button, a new view will be displayed that consists entirely of the contents of the rectangle.

Clicking the **Zoom to Fit** icon, will cause the object to fit exactly and be centered in the window.

After entering the extrusion parameters and clicking **Generate**, the geometry should appear as in **Figure 1.5: Elbow Main Pipe Geometry** (p. 15).

**Figure 1.5: Elbow Main Pipe Geometry**

b. Next you will use a cylinder primitive to create the side pipe.
i. Choose **Create → Primitives → Cylinder** from the menubar.

ii. In the **Details View**, set the parameters for the cylinder as follows and click **Generate**:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details of Cylinder1</td>
<td>BasePlane</td>
<td>XYPlane</td>
</tr>
<tr>
<td></td>
<td>FD3, Origin X Coordinate</td>
<td>137.5</td>
</tr>
<tr>
<td></td>
<td>FD4, Origin Y Coordinate</td>
<td>-225</td>
</tr>
<tr>
<td></td>
<td>FD5, Origin Z Coordinate</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>FD6, Axis X Component</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>FD7, Axis Y Component</td>
<td>125</td>
</tr>
<tr>
<td></td>
<td>FD8, Axis Z Component</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>FD10, Radius (&gt;0)</td>
<td>12.5</td>
</tr>
</tbody>
</table>

The Origin Coordinates determine the starting point for the cylinder and the Axis Components determine the length and orientation of the cylinder body.
c. The final step in creating the geometry is to split the body on its symmetry plane which will halve the computational domain.

i. Choose \textbf{Tools} \rightarrow \textbf{Symmetry} from the menu bar.

ii. Select the \textit{XYPlane} in the \textbf{Tree Outline}.

iii. Click \textbf{Apply} next to \textbf{Symmetry Plane 1} in the \textbf{Details} view.

iv. Click \textbf{Generate}. 
The new surface created with this operation will be assigned a symmetry boundary condition in Fluent so that the model will accurately reflect the physics of the complete elbow geometry even though only half of it is meshed.

d. Specify the geometry as a fluid body.
   
i. In the **Tree Outline**, open the **1 Part, 1 Body** branch and select **Solid**.

   ii. In the **Details View** of the body, change the name of the **Body** from **Solid** to **Fluid**.

   iii. In the **Fluid/Solid** section, select **Fluid**.
iv. Click **Generate**.

**Tip**

In addition to the primitives you used in this tutorial, ANSYS DesignModeler offers a full suite of 2D sketching and 3D solid modeling tools for creating arbitrary geometry. Refer to **DesignModeler User's Guide** for more information.

4. Close ANSYS DesignModeler by selecting **File** → **Close DesignModeler** or by clicking the ‘X’ icon in the upper right-hand corner. ANSYS Workbench automatically saves the geometry and updates the **Project Schematic** accordingly. The question mark in the **Geometry** cell is replaced by a check mark, indicating that there is a geometry now associated with the fluid flow analysis system.

5. View the list of files generated by ANSYS Workbench by selecting **View** → **Files**.

**Figure 1.6: ANSYS Workbench Files View for the Project After Creating the Geometry**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Cell ID</td>
<td>Size</td>
<td>Type</td>
<td>Date Modified</td>
<td>Location</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>elbow-workbench.wbpj</td>
<td>124 KB</td>
<td>ANSYS Project File</td>
<td>08/xx/20xx 00:00:00 AM</td>
<td>C:\Tutorial_01</td>
</tr>
<tr>
<td>3</td>
<td>FFF.agdb</td>
<td>A2</td>
<td>Geometry File</td>
<td>08/xx/20xx 00:00:00 AM</td>
<td>C:\Tutorial_01\elbow-workbench.wbpj</td>
</tr>
<tr>
<td>4</td>
<td>designPoint.wbdp</td>
<td>26 KB</td>
<td>Design Point File</td>
<td>08/xx/20xx 00:00:00 AM</td>
<td>C:\Tutorial_01\elbow-workbench.wbpj</td>
</tr>
</tbody>
</table>

Note the addition of the geometry file (**FFF.agdb**, where **FFF** indicates a Fluent-based fluid flow system) to the list of files. If you had imported the geometry file provided for this tutorial rather than creating the geometry yourself, the **elbow_geometry.agdb** (or the **elbow_geometry.stp**) file would be listed instead.
1.4.4. Meshing the Geometry in the ANSYS Meshing Application

Now that you have created the mixing elbow geometry, you must generate a computational mesh throughout the flow volume. For this section of the tutorial, you will use the ANSYS Meshing application to create a mesh for your CFD analysis, then review the list of files generated by ANSYS Workbench.

**Important**

Note the Refresh Required icon ( sluggishly ) within the **Mesh** cell for the system. This indicates that the state of the cell requires a refresh and that upstream data has changed since the last refresh or update (such as an update to the geometry). Once the mesh is defined, the state of the **Mesh** cell will change accordingly, as will the state of the next cell in the system, in this case the **Setup** cell.

1. Open the ANSYS Meshing application.

   In the ANSYS Workbench **Project Schematic**, double-click the **Mesh** cell in the **elbow fluid flow analysis system** (cell A3). This displays the ANSYS Meshing application with the elbow geometry already loaded. You can also right-click the **Mesh** cell to display the context menu where you can select the **Edit...** option.
2. Create named selections for the geometry boundaries.

In order to simplify your work later on in ANSYS Fluent, you should label each boundary in the geometry by creating named selections for the pipe inlets, the outlet, and the symmetry surface (the outer wall boundaries are automatically detected by ANSYS Fluent).

a. Select the large inlet in the geometry that is displayed in the ANSYS Meshing application.

**Tip**

Use the Graphics Toolbar buttons and the mouse to manipulate the image until you can easily see the pipe openings and surfaces.

**Tip**

To select the inlet, the *Single select* mode must be active.
b. Right-click and select the **Create Named Selection** option.

**Figure 1.8: Selecting a Face to Name**

This displays the **Selection Name** dialog box.
c. In the **Selection Name** dialog box, enter `velocity-inlet-large` for the name and click **OK**.

d. Perform the same operations for:
   - The small inlet (**velocity-inlet-small**)
   - The large outlet (**pressure-outlet**)
   - The symmetry plane (**symmetry**).

**Important**

It is important to note that by using the strings “velocity inlet” and “pressure outlet” in the named selections (with or without hyphens or underscore characters), ANSYS Fluent automatically detects and assigns the corresponding boundary types accordingly.

3. Create a named selection for the fluid body.

   a. Change the selection filter to **Body** in the **Graphics Toolbar**

   b. Click the elbow in the graphics display to select it.

   c. Right-click, select the **Create Named Selection** option and name the body **Fluid**.

   *By creating a named selection called **Fluid** for the fluid body you will ensure that ANSYS Fluent automatically detects that the volume is a fluid zone and treats it accordingly.*

4. Set basic meshing parameters for the ANSYS Meshing application.

   *For this analysis, you will adjust several meshing parameters to obtain a finer mesh.*
In the **Outline** view, select **Mesh** under **Project/Model** to display the **Details of “Mesh”** view below the **Outline** view.

**Important**

Note that because the ANSYS Meshing application automatically detects that you are going to perform a CFD fluid flow analysis using ANSYS Fluent, the **Physics Preference** is already set to **CFD** and the **Solver Preference** is already set to **Fluent**.

b. Expand the **Sizing** node by clicking the “+” sign to the left of the word **Sizing** to reveal additional sizing parameters.

i. Change **Relevance Center** to **Fine** by clicking on the default value, **Coarse**, and selecting **Fine** from the drop-down list.

ii. Change **Smoothing** to **High**

c. Add a **Body Sizing** control.

i. With **Mesh** still selected in the **Outline** tree.

ii. Click the elbow in the graphics display to select it.

iii. Right click in the graphics area and select **Insert → Sizing** from the context menu.
A new **Body Sizing** entry appears under **Mesh** in the project **Outline** tree.

iv. Click the new **Body Sizing** control in the **Outline** tree.

v. Enter $6e^{-3}$ for **Element Size** and press **Enter**.

d. Click again on **Mesh** in the **Outline** view and expand the **Inflation** node in the Details of “Mesh” view to reveal additional inflation parameters. Change **Use Automatic Inflation** to **Program Controlled**.

5. Generate the mesh.

   Right-click **Mesh** in the project **Outline** tree, and select **Update** in the context menu.
**Important**

Using the **Generate Mesh** option creates the mesh, but does not actually create the relevant mesh files for the project and is optional if you already know that the mesh is acceptable. Using the **Update** option automatically generates the mesh, creates the relevant mesh files for your project, and updates the ANSYS Workbench cell that references this mesh.

**Note**

Once the mesh is generated, you can view the mesh statistics by opening the **Statistics** node in the **Details of “Mesh”** view. This will display information such as the number of nodes and the number of elements.
6. Close the ANSYS Meshing application.

You can close the ANSYS Meshing application without saving it because ANSYS Workbench automatically saves the mesh and updates the Project Schematic accordingly. The Refresh Required icon in the Mesh cell has been replaced by a check mark, indicating that there is a mesh now associated with the fluid flow analysis system.

7. View the list of files generated by ANSYS Workbench.

View → Files

Figure 1.11: ANSYS Workbench Files View for the Project After Mesh Creation

<table>
<thead>
<tr>
<th>Files</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>Cell ID</td>
<td>Size</td>
<td>Type</td>
<td>Date Modified</td>
</tr>
<tr>
<td>2</td>
<td>elbow-workbench.wbpj</td>
<td></td>
<td>122 KB</td>
<td>ANSYS Project File</td>
<td>XX/XX/20XX 00:00:30 AM</td>
</tr>
<tr>
<td>3</td>
<td>FFF.agdb</td>
<td>A2</td>
<td>1 MB</td>
<td>Geometry File</td>
<td>XX/XX/20XX 00:00:30 AM</td>
</tr>
<tr>
<td>4</td>
<td>FFF.msh</td>
<td>A3</td>
<td>8 MB</td>
<td>Fluent Mesh File</td>
<td>XX/XX/20XX 00:00:30 AM</td>
</tr>
<tr>
<td>5</td>
<td>FFF.mshdb</td>
<td>A3</td>
<td>2 MB</td>
<td>Mesh Database Files</td>
<td>XX/XX/20XX 00:00:30 AM</td>
</tr>
<tr>
<td>6</td>
<td>designPoint.wbdp</td>
<td></td>
<td>25 KB</td>
<td>Design Point File</td>
<td>XX/XX/20XX 00:00:30 AM</td>
</tr>
</tbody>
</table>

Note the addition of the mesh files (FFF.msh and FFF.mshdb) to the list of files. The FFF.msh file is created when you update the mesh, and the FFF.mshdb file is generated when you close the ANSYS Meshing application.

1.4.5. Setting Up the CFD Simulation in ANSYS Fluent

Now that you have created a computational mesh for the elbow geometry, in this step you will set up a CFD analysis using ANSYS Fluent, then review the list of files generated by ANSYS Workbench.

1. Start ANSYS Fluent.

In the ANSYS Workbench Project Schematic, double-click the Setup cell in the elbow fluid flow analysis system. You can also right-click the Setup cell to display the context menu where you can select the Edit... option.

When ANSYS Fluent is first started, the Fluent Launcher is displayed, enabling you to view and/or set certain ANSYS Fluent start-up options.

Note

The Fluent Launcher allows you to decide which version of ANSYS Fluent you will use, based on your geometry and on your processing capabilities.
a. Ensure that the proper options are enabled.

**Important**

Note that the **Dimension** setting is already filled in and cannot be changed, since ANSYS Fluent automatically sets it based on the mesh or geometry for the current system.

i. Ensure that **Serial** from the **Processing Options** list is enabled.

ii. Select **Double Precision** under **Options**.

iii. Enable the **Display Mesh After Reading**, **Embed Graphics Windows**, and **Workbench Color Scheme** options.

**Note**

An option is enabled when there is a check mark in the check box, and disabled when the check box is empty. To change an option from disabled to enabled (or vice versa), click the check box or the text.

**Note**

Fluent will retain your preferences for future sessions.
b. Click **OK** to launch ANSYS Fluent.

**Note**

The ANSYS Fluent settings file (**FFF.set**) is written as soon as ANSYS Fluent opens.

---

**Figure 1.13: The ANSYS Fluent Application**

---

2. Set general settings for the CFD analysis.

**Note**

Select **General** in the navigation pane to perform the mesh-related activities and to choose a solver.

**General**
a. Change the units for length.

Because you want to specify and view values based on a unit of length in millimeters from within ANSYS Fluent, change the units of length within ANSYS Fluent from meters (the default) to millimeters.

**Important**

Note that the ANSYS Meshing application automatically converts and exports meshes for ANSYS Fluent using meters (m) as the unit of length regardless of what units were used to create them. This is so you do not have to scale the mesh in ANSYS Fluent under ANSYS Workbench.

**General → Units...**

This displays the **Set Units** dialog box.
i. Select **length** in the **Quantities** list.

ii. Select **mm** in the **Units** list.

iii. Close the dialog box.

**Note**

Now, all subsequent inputs that require a value based on a unit of length can be specified in millimeters rather than meters.

---

b. Check the mesh.

**General → Check**

**Note**

ANSYS Fluent will report the results of the mesh check in the console.

---

Domain Extents:
- x-coordinate: min (m) = \(-2.000000e-01\), max (m) = \(2.000000e-01\)
- y-coordinate: min (m) = \(-2.250000e-01\), max (m) = \(2.000000e-01\)
- z-coordinate: min (m) = \(0.000000e+00\), max (m) = \(5.000000e-02\)

Volume statistics:
- minimum volume (m³): \(1.144763e-10\)
- maximum volume (m³): \(5.871098e-08\)
- total volume (m³): \(2.511309e-03\)

Face area statistics:
- minimum face area (m²): \(2.051494e-07\)
- maximum face area (m²): \(3.429518e-05\)

Checking mesh....................
Done.

**Note**

The minimum and maximum values may vary slightly when running on different platforms. The mesh check will list the minimum and maximum x and y values from
the mesh in the default SI unit of meters. It will also report a number of other mesh features that are checked. Any errors in the mesh will be reported at this time. Ensure that the minimum volume is not negative as ANSYS Fluent cannot begin a calculation when this is the case.

c. Review the mesh quality.

General → Report Quality

Note

ANSYS Fluent will report the results of the mesh quality below the results of the mesh check in the console.

Mesh Quality:
Orthogonal Quality ranges from 0 to 1, where values close to 0 correspond to low quality.
Minimum Orthogonal Quality = 2.54267e-01
Maximum Aspect Ratio = 2.18098e+01

Note

The quality of the mesh plays a significant role in the accuracy and stability of the numerical computation. Checking the quality of your mesh is, therefore, an important step in performing a robust simulation. Minimum cell orthogonality is an important indicator of mesh quality. Values for orthogonality can vary between 0 and 1 with lower values indicating poorer quality cells. In general, the minimum orthogonality should not be below 0.01 with the average value significantly larger. The high aspect ratio cells in this mesh are near the walls and are a result of the boundary layer inflation applied in the meshing step. For more information about the importance of mesh quality refer to Mesh Quality in the User’s Guide.

3. Set up your models for the CFD simulation.

Models
a. Enable heat transfer by activating the energy equation.

Models → Energy → Edit...

Note

You can also double-click a list item in order to open the corresponding dialog box.

i. Enable the **Energy Equation** option.

ii. Click **OK** to close the **Energy** dialog box.

b. Enable the $k-\varepsilon$ turbulence model.

Models → Viscous → Edit...
i. Select k-epsilon from the Model list.

**Note**

The Viscous Model dialog box will expand.

ii. Use the default Standard from the k-epsilon Model list.

iii. Select Enhanced Wall Treatment for the Near-Wall Treatment.

**Note**

The default Standard Wall Functions are generally applicable if the first cell center adjacent to the wall has a y+ larger than 30. In contrast, the Enhanced Wall Treatment option provides consistent solutions for all y+ values. Enhanced Wall
Treatment is recommended when using the k-epsilon model for general single-phase fluid flow problems. For more information about Near Wall Treatments in the k-epsilon model refer to Setting Up the k-ε Model in the User’s Guide.

iv. Click OK to accept the model and close the Viscous Model dialog box.

4. Set up your materials for the CFD simulation.

a. Create a new material called water using the Create/Edit Materials dialog box (Figure 1.14: The Create/Edit Materials Dialog Box (p. 36)).

i. Type water for Name.

ii. Enter the following values in the Properties group box:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Density</td>
<td>1000 kg/m³</td>
</tr>
<tr>
<td>(c_p) (Specific Heat)</td>
<td>4216 J/kg·K</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermal Conductivity</td>
<td>$0.677 , W/m-K$</td>
</tr>
<tr>
<td>Viscosity</td>
<td>$8 \times 10^{-4} , kg/m-s$</td>
</tr>
</tbody>
</table>

**Figure 1.14: The Create/Edit Materials Dialog Box**

iii. Click **Change/Create**.

**Note**

A **Question** dialog box will open, asking if you want to overwrite air. Click **No** so that the new material **water** is added to the **Fluent Fluid Materials** list of materials that originally contained only **air**.
Extra

You could have copied the material water-liquid \((\text{h}2\text{o} < \text{l}>)\) from the materials database (accessed by clicking the ANSYS Fluent Database... button). If the properties in the database are different from those you want to use, you can edit the values in the Properties group box in the Create/Edit Materials dialog box and click Change/Create to update your local copy. The original copy will not be affected.

iv. Ensure that there are now two materials (water and air) defined locally by examining the Fluent Fluid Materials drop-down list.

Note

Both the materials will also be listed under Fluid in the Materials task page.

v. Close the Create/Edit Materials dialog box.

5. Set up the cell zone conditions for the CFD simulation.

❖ Cell Zone Conditions
Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow

Set the cell zone conditions for the fluid zone.

i. Select fluid in the Zone list in the Cell Zone Conditions task page, then click Edit... to open the Fluid dialog box.

Note

You can also double-click a list item in order to open the corresponding dialog box.
ii. In the Fluid dialog box, select water from the Material Name drop-down list.

iii. Click OK to close the Fluid dialog box.

6. Set up the boundary conditions for the CFD analysis.

Boundary Conditions
a. Set the boundary conditions at the cold inlet (velocity-inlet-large).

Boundary Conditions → velocity-inlet-large → Edit...

This opens the Velocity Inlet dialog box.

Tip

If you are unsure of which inlet zone corresponds to the cold inlet, you can use the mouse to probe for mesh information in the graphics window. If you click the right mouse button with the pointer on any node in the mesh, information about the associated zone will be displayed in the ANSYS Fluent console, including the name of the zone. The zone you probed will be automatically selected from the Zone selection list in the Boundary Conditions task page.

Alternatively, you can click the probe button (probe) in the graphics toolbar and click the left mouse button on any node. This feature is especially useful when you have several zones of the same type and you want to distinguish between them quickly. The information will be displayed in the console.
i. Select **Components** from the **Velocity Specification Method** drop-down list.

**Note**

The **Velocity Inlet** dialog box will expand.

ii. Enter **0.4 m/s** for **X-Velocity**.

iii. Retain the default value of **0 m/s** for both **Y-Velocity** and **Z-Velocity**.

iv. Select **Intensity and Hydraulic Diameter** from the **Specification Method** drop-down list in the **Turbulence** group box.

v. Retain the default of **5 %** for **Turbulent Intensity**.

vi. Enter **100 mm** for **Hydraulic Diameter**.

**Note**

The hydraulic diameter $D_h$ is defined as:
where \( A \) is the cross-sectional area and \( P_w \) is the wetted perimeter.

vii. Click the **Thermal** tab.

![Velocity Inlet dialog box](image)

viii. Enter 293.15 \( K \) for **Temperature**.

ix. Click **OK** to close the **Velocity Inlet** dialog box.

b. In a similar manner, set the boundary conditions at the hot inlet (**velocity-inlet-small**), using the values in the following table:

<table>
<thead>
<tr>
<th>Velocity Specification Method</th>
<th>Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>X-Velocity</td>
<td>0 ( m/s )</td>
</tr>
<tr>
<td>Y-Velocity</td>
<td>1.2 ( m/s )</td>
</tr>
<tr>
<td>Z-Velocity</td>
<td>0 ( m/s )</td>
</tr>
<tr>
<td>Specification Method</td>
<td>Intensity &amp; Hydraulic Diameter</td>
</tr>
<tr>
<td><strong>Velocity Specification Method</strong></td>
<td><strong>Components</strong></td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Turbulent Intensity</td>
<td>5%</td>
</tr>
<tr>
<td>Hydraulic Diameter</td>
<td>25 mm</td>
</tr>
<tr>
<td>Temperature</td>
<td>313.15 K</td>
</tr>
</tbody>
</table>

c. Set the boundary conditions at the outlet (pressure-outlet), as shown in the **Pressure Outlet** dialog box.

![Boundary Conditions → pressure-outlet → Edit...](image)

**Note**

ANSYS Fluent will use the backflow conditions only if the fluid is flowing into the computational domain through the outlet. Since backflow might occur at some point during the solution procedure, you should set reasonable backflow conditions to prevent convergence from being adversely affected.

7. Set up solution parameters for the CFD simulation.

**Note**

In the steps that follow, you will set up and run the calculation using the task pages listed under the **Solution** heading in the navigation pane.
a. Change the Gradient method.

In the Spatial Discretization section of the Solution Methods pane, change the Gradient to Green-Gauss Node Based. This gradient method is suggested for tetrahedral meshes.

b. Examine the convergence criteria for the equation residuals.

Monitors → Residuals → Edit...
i. Ensure that Plot is enabled in the Options group box.

ii. Keep the default values for the Absolute Criteria of the Residuals, as shown in the Residual Monitors dialog box.

iii. Click OK to close the Residual Monitors dialog box.

**Note**

By default, all variables will be monitored and checked by ANSYS Fluent as a means to determine the convergence of the solution.

c. Create a surface monitor at the outlet (pressure-outlet)

*It is good practice to monitor physical solution quantities in addition to equation residuals when assessing convergence.*

![Monitors (Surface Monitors) → Create...](Monitors.png)
i. Retain the default entry of **surf-mon-1** for the **Name** of the surface monitor.

ii. Enable the **Plot** option for **surf-mon-1**.

iii. Set **Get Data Every** to 3 by clicking the up-arrow button.

   *This setting instructs ANSYS Fluent to update the plot of the surface monitor and write data to a file after every 3 iterations during the solution.*

iv. Select **Facet Maximum** from the **Report Type** drop-down list.

v. Select **Temperature...** and **Static Temperature** from the **Field Variable** drop-down lists.

vi. Select **pressure-outlet** from the **Surfaces** selection list.

vii. Click **OK** to save the surface monitor settings and close the **Surface Monitor** dialog box.

*The name and report type of the surface monitor you created will be displayed in the **Surface Monitors** selection list in the **Monitors** task page.*

d. Initialize the flow field.

[Solution Initialization]
i. Keep the default of **Hybrid Initialization** from the **Initialization Methods** group box.

ii. Click **Initialize**.

e. Check to see if the case conforms to best practices.

*Run Calculation → Check Case*

i. Click the **Models** and **Solver** tabs and examine the **Recommendation** in each. These recommendations can be ignored for this tutorial. The issues they raise will be addressed in later tutorials.

ii. Close the **Case Check** dialog box.

8. Calculate a solution.

   a. Start the calculation by requesting 300 iterations.

   *Run Calculation*
i. Enter 300 for **Number of Iterations**.

ii. Click **Calculate**.

---

**Important**

Note that the ANSYS Fluent settings file (`FFF.set`) is updated before the calculation begins.

---

**Important**

Note that while the program is calculating the solution, the states of the **Setup** and **Solution** cells in the fluid flow ANSYS Fluent analysis system in ANSYS Workbench are changing. For example:

- The state of the **Setup** cell becomes **Up-to-Date** and the state of the **Solution** cell becomes **Refresh Required** after the **Run Calculation** task page is visited and the number of iterations is specified.

- The state of the **Solution** cell is **Update Required** while iterations are taking place.
• The state of the Solution cell is **Up-to-Date** when the specified number of iterations are complete (or if convergence is reached).

---

**Note**

As the calculation progresses, the surface monitor history will be plotted in the graphics window (Figure 1.15: Convergence History of the Maximum Temperature at Pressure Outlet (p. 49)).

---

**Note**

The solution will be stopped by ANSYS Fluent when the residuals reach their specified values or after 300 iterations. The exact number of iterations will vary depending on the platform being used. An **Information** dialog box will open to alert you that the calculation is complete. Click **OK** in the **Information** dialog box to proceed.

Because the residual values vary slightly by platform, the plot that appears on your screen may not be exactly the same as the one shown here.

---

**Figure 1.15: Convergence History of the Maximum Temperature at Pressure Outlet**

You can display the residuals history (**Figure 1.16: Residuals for the Converged Solution (p. 50)**), by selecting it from the graphics window drop-down list.
b. Examine the plots for convergence (Figure 1.16: Residuals for the Converged Solution (p. 50) and Figure 1.15: Convergence History of the Maximum Temperature at Pressure Outlet (p. 49)).

Note

There are no universal metrics for judging convergence. Residual definitions that are useful for one class of problem are sometimes misleading for other classes of problems. Therefore it is a good idea to judge convergence not only by examining residual levels, but also by monitoring relevant integrated quantities and checking for mass and energy balances.

There are three indicators that convergence has been reached:

- The residuals have decreased to a sufficient degree.
  The solution has converged when the Convergence Criterion for each variable has been reached. The default criterion is that each residual will be reduced to a value of less than $10^{-3}$, except the energy residual, for which the default criterion is $10^{-6}$.

- The solution no longer changes with more iterations.
  Sometimes the residuals may not fall below the convergence criterion set in the case setup. However, monitoring the representative flow variables through iterations
may show that the residuals have stagnated and do not change with further iterations. This could also be considered as convergence.

- The overall mass, momentum, energy, and scalar balances are obtained.

You can examine the overall mass, momentum, energy and scalar balances in the Flux Reports dialog box. The net imbalance should be less than 0.2 % of the net flux through the domain when the solution has converged. In the next step you will check to see if the mass balance indicates convergence.

9. View the list of files generated by ANSYS Workbench.

View → Files

Note that the status of the Solution cell is now up-to-date.

1.4.6. Displaying Results in ANSYS Fluent and CFD-Post

In this step, you will display the results of the simulation in ANSYS Fluent, display the results in CFD-Post, then review the list of files generated by ANSYS Workbench.

1. Display results in ANSYS Fluent.

With ANSYS Fluent still running, you can perform a simple evaluation of the velocity and temperature contours on the symmetry plane. Later, you will use CFD-Post (from within ANSYS Workbench) to perform the same evaluation.

a. Display filled contours of velocity magnitude on the symmetry plane (Figure 1.17: Velocity Distribution Along Symmetry Plane (p. 53)).

Note

You can also double-click a list item in order to open the corresponding dialog box.
i. In the **Contours** dialog box, enable **Filled** in the **Options** group box.

ii. Ensure that **Node Values** is enabled in the **Options** group box.

iii. Select **Velocity...** and **Velocity Magnitude** from the **Contours of** drop-down lists.

iv. Select **symmetry** from the **Surfaces** selection list.

v. Click **Display** to display the contours in the active graphics window.
b. Display filled contours of temperature on the symmetry plane (Figure 1.18: Temperature Distribution Along Symmetry Plane (p. 55)).

Graphics and Animations → Contours → Set Up...
i. Select **Temperature...** and **Static Temperature** from the **Contours of** drop-down lists.

ii. Click **Display** and close the **Contours** dialog box.
c. Close the ANSYS Fluent application.

File → Close Fluent

**Important**

Note that the ANSYS Fluent case and data files are automatically saved when you exit ANSYS Fluent and return to ANSYS Workbench.

d. View the list of files generated by ANSYS Workbench.

View → Files
Note the addition of the compressed ANSYS Fluent case and data files to the list of files. These will have names like FFF-1.cas.gz and FFF-1-00222.dat.gz. Note that the digit(s) following FFF may be different if you have had to restart the meshing or calculation steps for any reason and that the name of the data file is based on the number of iterations. Thus your file names may be slightly different than those shown here.

2. Display results in CFD-Post.

   a. Start CFD-Post.

      In the ANSYS Workbench Project Schematic, double-click the Results cell in the elbow fluid flow analysis system (cell A6). This displays the CFD-Post application. You can also right-click the Results cell to display the context menu where you can select the Edit... option.

      **Note**

      The elbow geometry is already loaded and is displayed in outline mode. ANSYS Fluent case and data files are also automatically loaded into CFD-Post.

**Figure 1.19: The Elbow Geometry Loaded into CFD-Post**

b. Reorient the display.

   Click the blue Z axis on the axis triad in the bottom right hand corner of the graphics display to orient the display so that the view is of the front of the elbow geometry.
c. Ensure that Highlighting is disabled.

d. Display filled contours of velocity magnitude on the symmetry plane (Figure 1.20: Velocity Distribution Along Symmetry Plane (p. 58)).

i. Insert a contour object using the Insert menu item at the top of the CFD-Post window.

   **Insert → Contour**

   This displays the Insert Contour dialog box.

ii. Keep the default name of the contour (Contour 1) and click **OK** to close the dialog box. This displays the Details of Contour 1 view below the Outline view in CFD-Post. This view contains all of the settings for a contour object.

iii. In the Geometry tab, select fluid in the Domains list.

iv. Select symmetry in the Locations list.

v. Select Velocity in the Variable list.

vi. Click **Apply**.
Figure 1.20: Velocity Distribution Along Symmetry Plane

Figure 1.21: Temperature Distribution Along Symmetry Plane (p. 59).

e. Display filled contours of temperature on the symmetry plane.

i. Click the check-marked box beside the Contour 1 object under User Locations and Plots to disable the Contour 1 object and hide the first contour display.

ii. Insert a contour object.

   **Insert → Contour**

   This displays the Insert Contour dialog box.

iii. Keep the default name of the contour (Contour 2) and click OK to close the dialog box. This displays the Details of Contour 2 view below the Outline view.

iv. In the Geometry tab, select fluid from the Domains list.
v. Select **symmetry** in the **Locations** list.

vi. Select **Temperature** in the **Variable** list.

vii. Click **Apply**.

**Figure 1.21: Temperature Distribution Along Symmetry Plane**

---

3. Close the CFD-Post application by selecting **File → Close ANSYS CFD-Post** or by clicking the ‘X’ in the top right corner of the window.

---

**Important**

Note that the CFD-Post state files are automatically saved when you exit CFD-Post and return to ANSYS Workbench.
4. Save the elbow-workbench project in ANSYS Workbench.

5. View the list of files generated by ANSYS Workbench.

   View ➔ Files

   Note the addition of the CFD-Post state file (elbow.cst) to the list of files. For more information about CFD-Post (and the files associated with it), see the CFD-Post documentation.

### 1.4.7. Duplicating the Fluent-Based Fluid Flow Analysis System

At this point, you have a completely defined fluid flow system that is comprised of a geometry, a computational mesh, a CFD setup and solution, and corresponding results. In order to study the effects upon the flow field that may occur if you were to alter the geometry, another fluid flow analysis is required. One approach would be to use the current system and change the geometry, however you would overwrite the data from your previous simulation. A more suitable and effective approach would be to create a copy, or duplicate, of the current system, and then make the appropriate changes to the duplicate system.

In this step, you will create a duplicate of the original Fluent-based fluid flow system, then review the list of files generated by ANSYS Workbench.

1. In the **Project Schematic**, right-click the title cell of the **Fluid Flow (Fluent)** system and select **Duplicate** from the context menu.

   **Figure 1.22: Duplicating the Fluid Flow System**
Note

Notice that in the duplicated system, the state of the Solution cell indicates that the cell requires an update while the state of the Results cell indicates that the cell requires attention. This is because when a system is duplicated, the case and data files are not copied to the new system, therefore, the new system does not yet have solution data associated with it.

2. Rename the duplicated system to new-elbow.

3. Save the elbow-workbench project in ANSYS Workbench.

1.4.8. Changing the Geometry in ANSYS DesignModeler

Now that you have two separate, but equivalent, Fluent-based fluid flow systems to work from, you can make changes to the second system without impacting the original system. In this step, you will make a slight alteration to the elbow geometry in ANSYS DesignModeler by changing the diameter of the smaller inlet, then review the list of files generated by ANSYS Workbench.

1. Open ANSYS DesignModeler.

   Double-click the Geometry cell of the new-elbow system (cell B2) to display the geometry in ANSYS DesignModeler.

2. Change the diameter of the small inlet (velocity-inlet-small).

   a. Select Cylinder1 to open the Details View of the small inlet pipe.

   b. In the Details View, change the FD10, Radius (>0) value from 12.5 millimeters to 19 millimeters.
c. Click the **Generate** button to generate the geometry with your new values.
3. Close ANSYS DesignModeler.

4. View the list of files generated by ANSYS Workbench.

   **View → Files**

   Note the addition of the geometry, mesh, and ANSYS Fluent settings files now associated with the new, duplicated system.

### 1.4.9. Updating the Mesh in the ANSYS Meshing Application

The modified geometry now requires a new computational mesh. The mesh settings for the duplicated system are retained in the duplicated system. In this step, you will update the mesh based on the mesh settings from the original system, then review the list of files generated by ANSYS Workbench.
In the **Project Schematic**, right-click the **Mesh** cell of the *new-elbow* system (cell B3) and select **Update** from the context menu. This will update the mesh for the new geometry based on the mesh settings you specified earlier in the ANSYS Meshing application without having to open the editor to regenerate the mesh.

**Figure 1.25: Updating the Mesh for the Changed Geometry**

It will take a few moments to update the mesh. Once the update is complete, the state of the **Mesh** cell is changed to up-to-date, symbolized by a green check mark.

For illustrative purposes of the tutorial, the new geometry and the new mesh are displayed below.
Inspecting the files generated by ANSYS Workbench reveals the updated mesh file for the duplicated system.

**View → Files**

### 1.4.10. Calculating a New Solution in ANSYS Fluent

Now that there is an updated computational mesh for the modified geometry in the duplicated system, a new solution must be generated using ANSYS Fluent. In this step, you will revisit the settings within ANSYS Fluent, calculate another solution, view the new results, then review the list of files generated by ANSYS Workbench.

1. Open ANSYS Fluent.

   In the **Project Schematic**, right-click the **Setup** cell of the new-elbow system (cell B4) and select **Edit...** from the context menu. Since the mesh has been changed, you are prompted as to whether
you want to load the new mesh into ANSYS Fluent or not. Click **Yes** to continue, and click **OK** when Fluent Launcher is displayed in order to open ANSYS Fluent.

**Figure 1.27: ANSYS Workbench Prompt When the Upstream Mesh Has Changed**

2. Ensure that the unit of length is set to millimeters.

   ![General → Units...](image)

3. Check the mesh (optional).

   ![General → Check](image)

4. Revisit the boundary conditions for the small inlet.

   ![Boundary Conditions → velocity-inlet-small → Edit...](image)
   
   Here, you must set the hydraulic diameter to 38 mm based on the new dimensions of the small inlet.

5. Re-initialize the solution.

   ![Solution Initialization](image)
   
   Keep the default **Hybrid Initialization** and click **Initialize**.

6. Recalculate the solution.

   ![Run Calculation](image)
   
   Keep the **Number of Iterations** set to 300 and click **Calculate**.

7. Close ANSYS Fluent.

8. Revisit the results of the calculations in CFD-Post.

   Double-click the **Results** cell of the new-elbow fluid flow system to re-open CFD-Post where you can review the results of the new solution.


10. Save the **elbow-workbench** project in ANSYS Workbench.
11. View the list of files generated by ANSYS Workbench.

View → Files

Note the addition of the solution and state files now associated with new duplicated system.

1.4.11. Comparing the Results of Both Systems in CFD-Post

In this step, you will create a new Results system in ANSYS Workbench, use that system to compare the solutions from each of the two Fluent-based fluid flow analysis systems in CFD-Post at the same time, then review the list of files generated by ANSYS Workbench.

1. Create a Results system.

In ANSYS Workbench, drag a Results system from the Component Systems section of the Toolbox and drop it into the Project Schematic, next to the fluid flow systems.

Figure 1.28: The New Results System in the Project Schematic

2. Add the solutions of each of the systems to the Results system.

a. Select the Solution cell in the first Fluid Flow analysis system (cell A5) and drag it over the Results cell in the Results system (cell C2). This creates a transfer data connection between the two systems.

Figure 1.29: Connecting the First Fluid Flow System to the New Results System

b. Select the Solution cell in the second Fluid Flow analysis system (cell B5) and drag it over the Results cell in the Results system (cell C2). This creates a transfer data connection between the two systems.
3. Open CFD-Post to compare the results of the two fluid flow systems.

Now that the two fluid flow systems are connected to the Results system, double-click the Results cell in the Results system (cell C2) to open CFD-Post. Within CFD-Post, both geometries are displayed side by side.

Figure 1.31: CFD-Post with Both Fluid Flow Systems Displayed

a. Re-orient the display.
In each view, click the blue Z axis on the axis triad in the bottom right hand corner of the graphics display to orient the display so that the view is of the front of the elbow geometry.

---

**Important**

Alternatively, you can select the synchronization tool () in the 3D Viewer Toolbar to synchronize the views, so that when you re-orient one view, the other view is automatically updated.

---

b. Display filled contours of velocity magnitude on the symmetry plane.

i. Insert a contour object.

   **Insert → Contour**

   This displays the Insert Contour dialog box.

ii. Keep the default name of the contour (Contour 1) and click OK to close the dialog box. This displays the Details of Contour 1 view below the Outline view in CFD-Post. This view contains all of the settings for a contour object.

iii. In the Geometry tab, select fluid in the Domains list.

iv. Select symmetry in the Locations list.

v. Select Velocity in the Variable list.

vi. Click Apply. The velocity contours are displayed in each view.
c. Display filled contours of temperature on the symmetry plane.

i. Deselect the Contour 1 object under User Locations and Plots in CFD-Post to hide the first contour display.

ii. Insert another contour object.

   Insert ➔ Contour

   This displays the Insert Contour dialog box.

iii. Keep the default name of the contour (Contour 2) and click OK to close the dialog box. This displays the Details of Contour 2 view below the Outline view in CFD-Post.
iv. In the **Geometry** tab, select **fluid** in the **Domains** list.

v. Select **symmetry** in the **Locations** list.

vi. Select **Temperature** in the **Variable** list.

vii. Click **Apply**. The temperature contours are displayed in each view.

**Figure 1.33: CFD-Post Displaying Temperature Contours for Both Geometries**

4. Close the CFD-Post application.

5. Save the `elbow-workbench` project in ANSYS Workbench.

6. View the list of files associated with your project using the **Files** view.

   **View → Files**
1.5. Summary

In this tutorial, portions of ANSYS Workbench were used to compare the fluid flow through two slightly different geometries. ANSYS DesignModeler was used to create a mixing elbow geometry, ANSYS Meshing was used to create a computational mesh, ANSYS Fluent was used to calculate the fluid flow throughout the geometry using the computational mesh, and CFD-Post was used to analyze the results. In addition, the geometry was altered, a new mesh was generated, and a new solution was calculated. Finally, ANSYS Workbench was set up so that CFD-Post could directly compare the results of both calculations at the same time.
Chapter 2: Parametric Analysis in ANSYS Workbench Using ANSYS Fluent

This tutorial is divided into the following sections:

2.1. Introduction
2.2. Prerequisites
2.3. Problem Description
2.4. Setup and Solution

2.1. Introduction

This tutorial illustrates using an ANSYS Fluent fluid flow system in ANSYS Workbench to set up and solve a three-dimensional turbulent fluid flow and heat transfer problem in an automotive heating, ventilation, and air conditioning (HVAC) duct system. ANSYS Workbench uses parameters and design points to allow you to run optimization and what-if scenarios. You can define both input and output parameters in ANSYS Fluent that can be used in your ANSYS Workbench project. You can also define parameters in other applications including ANSYS DesignModeler and ANSYS CFD-Post. Once you have defined parameters for your system, a Parameters cell is added to the system and the Parameter Set bus bar is added to your project. This tutorial is designed to introduce you to the parametric analysis utility available in ANSYS Workbench.

The tutorial starts with a Fluid Flow (Fluent) analysis system with pre-defined geometry and mesh components. Within this tutorial, you will redefine the geometry parameters created in ANSYS DesignModeler by adding constraints to the input parameters. You will use ANSYS Fluent to set up and solve the CFD problem. While defining the problem set-up, you will also learn to define input parameters in ANSYS Fluent. The tutorial will also provide information on how to create output parameters in ANSYS CFD-Post.

This tutorial demonstrates how to do the following:

• Add constraints to the ANSYS DesignModeler input parameters.

• Create an ANSYS Fluent fluid flow analysis system in ANSYS Workbench.

• Set up the CFD simulation in ANSYS Fluent, which includes:
  – Setting material properties and boundary conditions for a turbulent forced convection problem.
  – Defining input parameters in Fluent

• Define output parameters in CFD-Post

• Create additional design points in ANSYS Workbench.

• Run multiple CFD simulations by updating the design points.
2.2. Prerequisites

This tutorial assumes that you are already familiar with the ANSYS Workbench interface and its project workflow (for example, ANSYS DesignModeler, ANSYS Meshing, ANSYS Fluent, and ANSYS CFD-Post). This tutorial also assumes that you have completed Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1), and that you are familiar with the ANSYS Fluent graphical user interface. Some steps in the setup and solution procedure will not be shown explicitly.

2.3. Problem Description

In the past, evaluation of vehicle air conditioning systems was performed using prototypes and testing their performance in test labs. However, the design process of modern vehicle air conditioning (AC) systems improved with the introduction of Computer Aided Design (CAD), Computer Aided Engineering (CAE) and Computer Aided Manufacturing (CAM). The AC system specification will include minimum performance requirements, temperatures, control zones, flow rates etc. Performance testing using CFD may include fluid velocity (air flow), pressure values, and temperature distribution. Using CFD enables the analysis of fluid through very complex geometry and boundary conditions.

As part of the analysis, a designer can change the geometry of the system or the boundary conditions such as the inlet velocity, flow rate, etc., and view the effect on fluid flow patterns. This tutorial illustrates the AC design process on a representative automotive HVAC system consisting of both an evaporator for cooling and a heat exchanger for heating requirements.
Figure 2.1: Automotive HVAC System
Figure 2.1: Automotive HVAC System (p. 75) shows a representative automotive HVAC system. The system has three valves (as shown in Figure 2.2: HVAC System Valve Location Details (p. 76)), which control the flow in the HVAC system. The three valves control:

- Flow over the heat exchanger coils
- Flow towards the duct controlling the flow through the floor vents
- Flow towards the front vents or towards the windshield

Air enters the HVAC system at 310 K with a velocity of 0.5 m/sec through the air inlet and passes to the evaporator and then, depending on the position of the valve controlling flow to the heat exchanger, flows over or bypasses the heat exchanger. Depending on the cooling and heating requirements, either the evaporator or the heat exchanger would be operational, but not both at the same time. The position of the other two valves controls the flow towards the front panel, the windshield, or towards the floor ducts.

The motion of the valves is constrained. The valve controlling flow over the heat exchanger varies between 25° and 90°. The valve controlling the floor flow varies between 20° and 60°. The valve controlling flow towards front panel or windshield varies between 15° and 175°.

The evaporator load is about 200 W in the cooling cycle. The heat exchanger load is about 150 W.

This tutorial illustrates the easiest way to analyze the effects of the above parameters on the flow pattern/distribution and the outlet temperature of air (entering the passenger cabin). Using the parametric
analysis capability in ANSYS Workbench, a designer can check the performance of the system at various design points.

**Figure 2.3: Flow Pattern for the Cooling Cycle**

![Flow Pattern for the Cooling Cycle](image)

### 2.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

1. **2.4.1. Preparation**
2. **2.4.2. Adding Constraints to ANSYS DesignModeler Parameters in ANSYS Workbench**
3. **2.4.3. Setting Up the CFD Simulation in ANSYS Fluent**
4. **2.4.4. Defining Input Parameters in ANSYS Fluent and Running the Simulation**
5. **2.4.5. Postprocessing and Setting the Output Parameters in ANSYS CFD-Post**
6. **2.4.6. Creating Additional Design Points in ANSYS Workbench**
7. **2.4.7. Postprocessing the New Design Points in CFD-Post**
8. **2.4.8. Summary**
2.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

   **Note**

   If you do not have a login, you can request one by clicking Customer Registration on the login page.

3. Enter the name of this tutorial into the search bar.
4. Narrow the results by using the filter on the left side of the page.
   a. Click ANSYS Fluent under Product.
   b. Click 15.0 under Version.
5. Select this tutorial from the list.
6. Click Files to download the input and solution files.
7. Unzip the workbench-parameter-tutorial_R150.zip file to your working folder.

   The extracted workbench-parameter-tutorial folder contains a single archive file fluent-workbench-param.wbpz that includes all supporting input files of the starting ANSYS Workbench project and a folder called final_project_files that includes the archived final version of the project. The final result files incorporate ANSYS Fluent and ANSYS CFD-Post settings and all already defined design points (all that is required is to update the design points in the project to generate corresponding solutions).

   **Note**

   ANSYS Fluent tutorials are prepared using ANSYS Fluent on a Windows system. The screen shots and graphic images in the tutorials may be slightly different than the appearance on your system, depending on the operating system or graphics card.

2.4.2. Adding Constraints to ANSYS DesignModeler Parameters in ANSYS Workbench

In this step, you will start ANSYS Workbench, open the project file, review existing parameters, create new parameters, and add constraints to existing ANSYS DesignModeler parameters.

1. Start ANSYS Workbench by clicking the Windows Start menu, then selecting the Workbench option in the ANSYS 15.0 program group.

   Start → All Programs → ANSYS 15.0 → Workbench 15.0
This displays the ANSYS Workbench application window, which has the **Toolbox** on the left and the **Project Schematic** to its right. Various supported applications are listed in the **Toolbox**, and the components of the analysis system are displayed in the **Project Schematic**.

---

**Note**

When you first start ANSYS Workbench, the **Getting Started** message window is displayed, offering assistance through the online help for using the application. You can keep the window open, or close it by clicking **OK**. If you need to access the online help at any time, use the **Help** menu, or press the **F1** key.

---

2. Restore the archive of the starting ANSYS Workbench project to your working directory.

   **File → Restore Archive...**

   The **Select Archive to Restore** dialog box appears.

   a. Browse to your working directory, select the project archive file `fluent-workbench-param.wbpz`, and click **Open**.

      The **Save As** dialog box appears.

   b. Browse, if necessary, to your working folder and click **Save** to restore the project file, `fluent-workbench-param.wbpj`, and a corresponding project folder, `fluent-workbench-param_files`, for this tutorial.

Now that the project archive has been restored, the project will automatically open in ANSYS Workbench.
The project (fluent-workbench-param.wbpj) already has a Fluent-based fluid flow analysis system that includes the geometry and mesh, as well as some predefined parameters. You will first examine and edit parameters within Workbench, then later proceed to define the fluid flow model in ANSYS Fluent.

3. Open the **Files** view in ANSYS Workbench so you can view the files associated with the current project and are written during the session.

   **View → Files**
Note the types of files that have been created for this project. Also note the states of the cells for the Fluid Flow (Fluent) analysis system. Since the geometry has already been defined, the status of the Geometry cell is Up-to-Date (✓). Since the mesh is not complete, the Mesh cell’s state is Refresh Required (🚫), and since the ANSYS Fluent setup is incomplete and the simulation has yet to be performed, with no corresponding results, the state for the Setup, Solution, and Results cells is Unfulfilled (🚫). For more information about cell states, see Understanding Cell States.

4. Review the input parameters that have already been defined in ANSYS DesignModeler.

   a. Double-click the Parameter Set bus bar in the ANSYS Workbench Project Schematic to open the Parameters Set tab.

      **Note**
      
      To return to viewing the Project Schematic, click the Project tab.

   b. In the Outline of All Parameters view (Figure 2.6: Parameters Defined in ANSYS DesignModeler (p. 82)), review the following existing parameters:
- The parameter $hcpos$ represents the valve position that controls the flow over the heat exchanger. When the valve is at an angle of 25°, it allows the flow to pass over the heat exchanger. When the angle is 90°, it completely blocks the flow towards the heat exchanger. Any value in between allows some flow to pass over the heat exchanger giving a mixed flow condition.

- The parameter $ftpos$ represents the valve position that controls flow towards the floor duct. When the valve is at an angle of 20°, it blocks the flow towards the floor duct and when the valve angle is 60°, it unblocks the flow.

- The parameter $wsfpos$ represents the valve position that controls flow towards the windshield and the front panel. When the valve is at an angle of 15°, it allows the entire flow to go towards the windshield. When the angle is 90°, it completely blocks the flow towards windshield as well as the front panel. When the angle is 175°, it allows the flow to go towards the windshield and the front panel.

Figure 2.6: Parameters Defined in ANSYS DesignModeler

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ID</td>
<td>Parameter Name</td>
<td>Value</td>
<td>Unit</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Input Parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Fluid Flow (FLUENT) (A1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>P1</td>
<td>$hcpos$</td>
<td>90</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>P2</td>
<td>$ftpos$</td>
<td>25</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>P3</td>
<td>$wsfpos$</td>
<td>175</td>
</tr>
<tr>
<td>*</td>
<td></td>
<td>New input parameter</td>
<td>New name</td>
<td>New expression</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>Output Parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*</td>
<td></td>
<td>New output parameter</td>
<td>New expression</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Charts</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5. Create three new input parameters.

In the row that contains **New input parameter**, click the parameter table cell under the **Parameter Name** column (the cell with **New name**) to create a new named input parameter. Create three new parameters named $input_{hcpos}$, $input_{ftpos}$, and $input_{wsfpos}$. Note the ID of the parameter that appears in column A of the table. For the new input parameters, the parameter IDs would be P4, P5, and P6, respectively. In the **Values** column, enter values for each new parameter of 15, 25, and 90, respectively.
### Figure 2.7: New Parameters Defined in ANSYS Workbench

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ID</td>
<td>Parameter Name</td>
<td>Value</td>
</tr>
<tr>
<td>2</td>
<td>Input Parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Fluid Flow (FLUENT) (A1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>P1</td>
<td>hcpos</td>
<td>90</td>
</tr>
<tr>
<td>5</td>
<td>P2</td>
<td>ftpos</td>
<td>25</td>
</tr>
<tr>
<td>6</td>
<td>P3</td>
<td>wsfpos</td>
<td>175</td>
</tr>
<tr>
<td>7</td>
<td>P4</td>
<td>input_hcpos</td>
<td>15</td>
</tr>
<tr>
<td>8</td>
<td>P5</td>
<td>input_ftpos</td>
<td>25</td>
</tr>
<tr>
<td>9</td>
<td>P6</td>
<td>input_wsfpos</td>
<td>90</td>
</tr>
<tr>
<td>+</td>
<td>New input parameter</td>
<td>New name</td>
<td>New expression</td>
</tr>
<tr>
<td>*</td>
<td>New output parameter</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6. Select the row or any cell in the row that corresponds to the `hcpos` parameter. In the **Properties of Outline** view, change the value of the `hcpos` parameter in the **Expression** field from 90 to the expression `min(max(25,P4),90)`. This puts a constraint on the value of `hcpos`, so that the value always remains between 25° and 90°. The redefined parameter `hcpos` is automatically passed to ANSYS DesignModeler. Alternatively the same constraint can also be set using the expression `max(25, min(P4,90))`. After defining this expression, the parameter becomes a derived parameter that is dependent on the value of the parameter `input_hcpos` having the parameter ID of `P4`. The derived parameters are unavailable for editing in the **Outline of All Parameters** view and could be redefined only in the **Properties of Outline** view.
7. Select the row or any cell in the row that corresponds to the $ftpos$ parameter and create a similar expression for $ftpos \cdot \min(\max(20,P5),60)$.
8. Create a similar expression for $wsfpos(\min(\max(15,P6),175))$. 

---

**Figure 2.9: Constrained Parameter $ftpos$**

<table>
<thead>
<tr>
<th>ID</th>
<th>Parameter Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>$hpos$</td>
<td>25</td>
</tr>
<tr>
<td>5</td>
<td>$ftpos$</td>
<td>25</td>
</tr>
<tr>
<td>6</td>
<td>$wsfpos$</td>
<td>175</td>
</tr>
<tr>
<td>7</td>
<td>$input_{hpos}$</td>
<td>15</td>
</tr>
<tr>
<td>8</td>
<td>$input_{ftpos}$</td>
<td>25</td>
</tr>
<tr>
<td>9</td>
<td>$input_{wsfpos}$</td>
<td>90</td>
</tr>
</tbody>
</table>
9. Click the X on the right side of the Parameters Set tab to close it and return to the Project Schematic. Note the new status of the cells in the Fluid Flow (Fluent) analysis system. Since we have changed the values of $hcpos$, $ftpos$, and $wsfpos$ to their new expressions, the Geometry and Mesh cells now indicates Refresh Required (✓).

10. Update the Geometry and Mesh cells.
   a. Right-click the Geometry cell and select the Update option from the context menu.
   b. Likewise, right-click the Mesh cell and select the Refresh option from the context menu. Once the cell is refreshed, then right-click the Mesh cell again and select the Update option from the context menu.

11. Save the project in ANSYS Workbench.
In the main menu, select **File → Save**

### 2.4.3. Setting Up the CFD Simulation in ANSYS Fluent

Now that you have edited the parameters for the project, you will set up a CFD analysis using ANSYS Fluent. In this step, you will start ANSYS Fluent, and begin setting up the CFD simulation.

1. Start ANSYS Fluent.

   In the ANSYS Workbench **Project Schematic**, double-click the **Setup** cell in the ANSYS Fluent fluid flow analysis system. You can also right-click the **Setup** cell to display the context menu where you can select the **Edit...** option.

   When ANSYS Fluent is first started, Fluent Launcher is displayed, allowing you to view and/or set certain ANSYS Fluent start-up options.

   *Fluent Launcher allows you to decide which version of ANSYS Fluent you will use, based on your geometry and on your processing capabilities.*

   ![Fluent Launcher](image)

   **Figure 2.11: ANSYS Fluent Launcher**

   a. Ensure that the proper options are enabled.

   **Important**

   Note that the **Dimension** setting is already filled in and cannot be changed, since ANSYS Fluent automatically sets it based on the mesh or geometry for the current system.
i. Ensure that the **Display Mesh After Reading**, **Embed Graphics Windows**, and **Workbench Color Scheme** options are enabled.

**Note**

An option is enabled when there is a check mark in the check box, and disabled when the check box is empty. To change an option from disabled to enabled (or vice versa), click the check box or the text.

ii. Ensure that **Serial** is selected from the **Processing Options** list.

**Important**

The memory requirements of this tutorial exceed the 2 GB per process limit of 32–bit Windows platforms. If you are planning to run this tutorial on a 32–bit Windows platform, it is necessary to enable parallel processing by selecting **Parallel** under **Processing Options** and setting **Number of Processes** to at least 2. Note that you must have the correct license support in order to use parallel processing.

Parallel processing also offers a substantial reduction in computational time. Refer to **Parallel Processing** (p. 1129) in this manual and **Starting Parallel ANSYS Fluent Using Fluent Launcher** in the **User’s Guide** for further information about using the parallel processing capabilities of ANSYS Fluent.

iii. Ensure that the **Double Precision** option is disabled.

**Note**

Fluent will retain your preferences for future sessions.

b. Click **OK** to launch ANSYS Fluent.
2. Reorder the mesh.

   **Mesh** → **Reorder** → **Domain**

   *This is done to reduce the bandwidth of the cell neighbor number and to speed up the computations. This is especially important for large cases involving 1 million or more cells. The method used to reorder the domain is the Reverse Cuthill-McKee method.*

3. Set up your models for the CFD simulation.

   a. Enable heat transfer by activating the energy equation.

      ![Models → Energy → Edit...]

      i. Enable the **Energy Equation** option.

      ii. Click **OK** to close the **Energy** dialog box.

   b. Enable the $k-$ $\varepsilon$ turbulence model.
i. Select k-epsilon (2 eqn) from the Model list.

ii. Select Enhanced Wall Treatment from the Near-Wall Treatment group box.

The default Standard Wall Functions are generally applicable when the cell layer adjacent to the wall has a y+ larger than 30. In contrast, the Enhanced Wall Treatment option provides consistent solutions for all y+ values. Enhanced Wall Treatment is recommended when using the k-epsilon model for general single-phase fluid flow problems. For more information about Near Wall Treatments in the k-epsilon model refer to Wall Treatment for RANS Models in the User’s Guide.

iii. Click OK to retain the other default settings, enable the model, and close the Viscous Model dialog box.
2.4.4. Defining Input Parameters in ANSYS Fluent and Running the Simulation

You have now started setting up the CFD analysis using ANSYS Fluent. In this step, you will define input parameters for the velocity inlet, define heat source boundary conditions for the evaporator, then calculate a solution.

1. Define an input parameter called `in_velocity` for the velocity at the inlet boundary.

   ![Boundary Conditions](inlet-air→Edit...)

   This displays the **Velocity Inlet** dialog box.

   ![Velocity Inlet Dialog Box](image)

   a. In the **Velocity Inlet** dialog box, select **New Input Parameter...** from the drop-down list for the **Velocity Magnitude**.

   This displays the **Input Parameter Properties** dialog box.
b. In the **Input Parameter Properties** dialog box, enter `in_velocity` for the **Name**, and enter 0.5 for the **Current Value**.

c. Click **OK** to close the **Input Parameter Properties** dialog box.

d. In the **Velocity Inlet** dialog box, select **Intensity and Hydraulic Diameter** from the **Specification Method** drop-down list in the **Turbulence** group box.

e. Retain the value of 5% for **Turbulent Intensity**.

f. Enter 0.061 for **Hydraulic Diameter (m)**.

2. Define an input parameter called `in_temp` for the temperature at the inlet boundary.
a. In the **Thermal** tab of the **Velocity Inlet** dialog box, select **New Input Parameter...** from the drop-down list for the **Temperature**.

b. In the **Input Parameter Properties** dialog box, enter `in_temp` for the **Name**, and enter `310` for the **Current Value**.

c. Click **OK** to close the **Input Parameter Properties** dialog box.

d. Click **OK** to close the **Velocity Inlet** dialog box.

3. Set the turbulence parameters for backflow at the front outlets and foot outlets.

   ![Boundary Conditions](image)

   a. In the **Pressure Outlet** dialog box, select **Intensity and Hydraulic Diameter** from the **Specification Method** drop-down list in the **Turbulence** group box.

   b. Retain the value of `5` for **Backflow Turbulent Intensity (%)**.

   c. Enter `0.044` for **Backflow Hydraulic Diameter (m)**.

      *These values will only be used if reversed flow occurs at the outlets. It is a good idea to set reasonable values to prevent adverse convergence behavior if backflow occurs during the calculation.*

   d. Click **OK** to close the **Pressure Outlet** dialog box.

   e. Copy the boundary conditions from **outlet-front-mid** to the other front outlet.

   ![Boundary Conditions](image)
i. Select **outlet-front-mid** in the **From Boundary Zone** selection list.

    *Scroll down, if necessary, to find **outlet-front-mid**.*

ii. Select **outlet-front-side-left** in the **To Boundary Zones** selection list.

iii. Click **Copy** to copy the boundary conditions.

    *Fluent will display a dialog box asking you to confirm that you want to copy the boundary conditions.*

iv. Click **OK** to confirm.

v. Click **Close** to close the **Copy Conditions** dialog box.

f. In a similar manner, set the backflow turbulence conditions for **outlet-foot-left** using the values in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specification Method</td>
<td>Intensity and Hydraulic Diameter</td>
</tr>
<tr>
<td>Backflow Turbulent Intensity (%)</td>
<td>5</td>
</tr>
<tr>
<td>Backflow Hydraulic Diameter (m)</td>
<td>0.052</td>
</tr>
</tbody>
</table>

g. To see all of the input and output parameters that you have defined in ANSYS Fluent, in the **Boundary conditions** task page, click the **Parameters...** button to open the **Parameters** dialog box.
These parameters are passed to ANSYS Fluent component system in ANSYS Workbench and are available for editing in ANSYS Workbench (see Figure 2.14: The Parameters View in ANSYS Workbench (p. 95)).

4. Define a heat source boundary condition for the evaporator volume.

   ![Cell Zone Conditions → fluid-evaporator → Edit...](Image)
a. In the **Fluid** dialog box, enable **Source Terms**.

b. In the **Source Terms** tab, scroll down to **Energy**, and click the **Edit...** button.
c. In the **Energy sources** dialog box, change the **Number of Energy sources** to 1.

d. For the new energy source, select **constant** from the drop-down list, and enter \(-787401.6 \text{ W/m}^3\) — based on the evaporator load (200 W) divided by the evaporator volume (0.000254 m\(^3\)) that was computed earlier.

e. Click **OK** to close the **Energy Source** dialog box.

f. Click **OK** to close the **Fluid** dialog box.

5. Set the Solution Methods

   ![Solution Methods icon]
a. Select **Coupled** in the **Scheme** drop-down list.

The pressure-based coupled solver is the recommended choice for general fluid flow simulations.

b. Select **PRESTO!** for **Pressure** and **First Order Upwind** for **Momentum** and **Energy** in the **Spatial Discretization** group box.

This tutorial is primarily intended to demonstrate the use of parameterization and design points when running Fluent from Workbench. Therefore, you will run a simplified analysis using first order discretization which will yield faster convergence. These settings were chosen to speed up solution time for this tutorial. Usually, for cases like this, we would recommend higher order discretization settings to be set for all flow equations to ensure improved results accuracy.

6. Initialize the flow field.

Solution Initialization
a. Retain the default selection of **Hybrid Initialization**.

b. Click the **Initialize** button.

7. Run the simulation in ANSYS Fluent.

## Run Calculation

a. For **Number of Iterations**, enter **1000**.

b. Click the **Calculate** button.

*The solution converges within approximately 60 iterations.*
Throughout the calculation, Fluent displays a warning in the console regarding reversed flow at the outlets. This behavior is expected in this case since air is redirected to the outlets, creating small regions of recirculation.

**Note**

The warning message can be switched off by setting the `solve/set/flow-warnings` text user interface (TUI) command to `no` in the console.

8. Close Fluent.

   File → Close Fluent

9. Save the project in ANSYS Workbench.

   File → Save

### 2.4.5. Postprocessing and Setting the Output Parameters in ANSYS CFD-Post

In this step, you will visualize the results of your CFD simulation using ANSYS CFD-Post. You will plot vectors that are colored by pressure, velocity, and temperature, on a plane within the geometry. In addition, you will create output parameters within ANSYS CFD-Post for later use in ANSYS Workbench.

In the ANSYS Workbench **Project Schematic**, double-click the **Results** cell in the ANSYS Fluent fluid flow analysis system to start CFD-Post. You can also right-click the **Results** cell to display the context menu where you can select the **Edit...** option.

The CFD-Post application appears with the automotive HVAC geometry already loaded and displayed in outline mode. Note that ANSYS Fluent results (that is, the case and data files) are also automatically loaded into CFD-Post.
1. Edit some basic settings in CFD-Post (for example, changing the background color to white).

   **Edit → Options...**

   a. In the **Options** dialog box, select **Viewer** under **CFD-Post** in the tree view.
b. Select **Solid** from the **Color Type** drop-down list.

c. Click the **Color** sample bar to cycle through common color swatches until it displays white.

**Tip**

You can also click the ellipsis icon to bring up a color selector dialog box from which you can choose an arbitrary color.

d. Click **OK** to set the white background color for the display and close the **Options** dialog box.

2. Adjust the color-map legend to show the numbers in floating format.

   a. Double-click **Default Legend View 1** in the tree view to display the **Details** view for the default legend to be used for your plots.

   b. In the **Details** view for **Default Legend View 1**, in the **Definition** tab, change the **Title Mode** to **Variable**.
c. **In the Appearance tab**, set the **Precision** to 2 and **Fixed**.

![Default Legend View 1](image)

**Details of Default Legend View 1**

<table>
<thead>
<tr>
<th>Definition</th>
<th>Appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title Mode</strong></td>
<td>Variable</td>
</tr>
<tr>
<td><strong>Show Legend Units</strong></td>
<td>✔</td>
</tr>
<tr>
<td><strong>Vertical</strong></td>
<td>Horizontal</td>
</tr>
<tr>
<td><strong>Location</strong></td>
<td></td>
</tr>
<tr>
<td><strong>X Justification</strong></td>
<td>Left</td>
</tr>
<tr>
<td><strong>Y Justification</strong></td>
<td>Top</td>
</tr>
<tr>
<td><strong>Position</strong></td>
<td>0.02 0.15</td>
</tr>
</tbody>
</table>

![Details](image)

**Details of Default Legend View 1**

<table>
<thead>
<tr>
<th>Sizing Parameters</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size</strong></td>
<td>0.6</td>
</tr>
<tr>
<td><strong>Aspect</strong></td>
<td>0.07</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Text Parameters</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Precision</strong></td>
<td>2 Fixed</td>
</tr>
<tr>
<td><strong>Value Ticks</strong></td>
<td>5</td>
</tr>
<tr>
<td><strong>Font</strong></td>
<td>Sans Serif</td>
</tr>
<tr>
<td><strong>Color Mode</strong></td>
<td>Default</td>
</tr>
<tr>
<td><strong>Colour</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Text Rotation</strong></td>
<td>0</td>
</tr>
<tr>
<td><strong>Text Height</strong></td>
<td>0.02</td>
</tr>
</tbody>
</table>

d. Click **Apply** to set the display.

3. Plot vectors colored by pressure.

a. From the main menu, select **Insert → Vector** or click **Vector** in the ANSYS Workbench toolbar.  
   *This displays the Insert Vector dialog box.*

b. Keep the default name of **Vector 1** by clicking **OK**.

c. **In the Details view** for **Vector 1**, **under the Geometry tab**, configure the following settings.
i. Select All Domains from the Domains drop-down list.

ii. Select symmetry central unit from the Locations drop-down list.

iii. Select Equally Spaced from the Sampling drop-down list.

iv. Set the # of Points to 10000.

v. Select Tangential from the Projection drop-down list.

d. In the Details view for Vector 1, under the Color tab, configure the following settings.

i. Select Variable from the Mode drop-down list.
ii. Select **Pressure** from the **Variable** drop-down list.

e. In the **Details** view for **Vector 1**, under the **Symbol** tab, configure the following settings.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Render</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Arrow</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.05</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

i. Set the **Symbol Size** to **0.05**.

ii. Enable **Normalize Symbols**.

f. Click **Apply**.

**Vector 1** appears under **User Locations and Plots** in the **Outline** tree view.

*In the graphics display window, note that symmetry-central-unit shows the vectors colored by pressure. Use the controls in CFD-Post to rotate the geometry (for example, clicking the dark blue axis in the axis triad of the graphics window). Zoom into the view as shown in Figure 2.16: Vectors Colored by Pressure (p. 106).*

---

**Note**

To better visualize the vector display, you can deselect the **Wireframe** view option under **User Locations and Plots** in the **Outline** tree view.
4. Plot vectors colored by velocity.
   
a. In the Details view for Vector 1, under the Color tab, configure the following settings.
   
i. Select Velocity from the Variable drop-down list.
   
ii. Click Apply.

   The velocity vector plot appears on the symmetry-central-unit symmetry plane.
5. Plot vectors colored by temperature.
   a. In the Details view for Vector 1, under the Color tab, configure the following settings.
      i. Select Temperature from the Variable drop-down list.
      ii. Select User Specified from the Range drop-down list.
      iii. Enter 273 K for the Min temperature value.
      iv. Enter 310 K for the Max temperature value.
      v. Click Apply.

      The user-specified range is selected much narrower than the Global and Local ranges in order to better show the variation.
Figure 2.18: Vectors Colored by Temperature

Note the orientation of the various valves and how they impact the flow field. Later in this tutorial, you will change these valve angles to see how the flow field changes.

6. Create three surface groups.

Surface groups are collections of surface locations in CFD-Post. In this tutorial, several surface groups are created in CFD-Post that will represent all of the outlets, all of the foot outlets, and all of the front outlets. Once created, specific commands (or expressions) will be applied to these groups in order to calculate a particular numerical value at that surface.

a. Create a surface group consisting of all outlets.

   i. With the Outline tab open in the CFD-Post tree view, open the Insert Surface Group dialog box.

      Insert → Location → Surface Group
ii. Enter alloutlets for the Name of the surface group, and close the Insert Surface Group dialog box.

iii. In the Details view for the alloutlets surface group, in the Geometry tab, click the ellipsis icon next to Locations to display the Location Selector dialog box.

iv. In the Location Selector dialog box, select all of the outlet surfaces (outlet foot left, outlet front mid, outlet front side left, and outlet windshield) and click OK.

v. Click Apply in the Details view for the new surface group.

   alloutlets appears under User Locations and Plots in the Outline tree view.

b. Create a surface group for the front outlets.
Perform the same steps as described above to create a surface group called frontoutlets with locations for the front outlets (outlet front mid and outlet front side left).

7. Create expressions in CFD-Post and mark them as ANSYS Workbench output parameters.

In this tutorial, programmatic commands or expressions are written to obtain numerical values for the mass flow rate from all outlets, as well as at the front outlets, windshield, and foot outlets. The surface groups you defined earlier are used to write the expressions.

a. Create an expression for the mass flow from all outlets.

   i. With the Expressions tab open in the CFD-Post tree view, open the Insert Expression dialog box.

   Insert → Expression

   ii. Enter floutfront for the Name of the expression, and close the Insert Expression dialog box.

   iii. In the Details view for the new expression, enter the following in the Definition tab.

   
   \[ -(\text{massFlow()@frontoutlets})^2 \]

   The sign convention for \text{massFlow()} is such that a positive value represents flow into the domain and a negative value represents flow out of the domain. Since you are defining an expression for outflow from the ducts, you use the negative of the \text{massFlow()} result in the definition of the expression.

   iv. Click Apply to obtain a Value for the expression.

   Note the new addition in the list of expressions in the Expressions tab in CFD-Post.

   In this case, there is a small net backflow into the front ducts.
v. Right-click the new expression and select **Use as Workbench Output Parameter** from the context menu. A small "P" with a right-pointing arrow appears on the expression's icon.

b. Create an expression for the mass flow from the wind shield.

Perform the same steps as described above to create an expression called `floutwindshield` with the following definition:

\[-(\text{massFlow}()@\text{outlet wind shield})^2\]

Right-click the new expression and select **Use as Workbench Output Parameter** from the context menu.

c. Create an expression for the mass flow from the foot outlets.

Perform the same steps as described above to create an expression called `floutfoot` with the following definition:

\[-(\text{massFlow}()@\text{outlet foot left})^2\]

Right-click the new expression and select **Use as Workbench Output Parameter** from the context menu.

d. Create an expression for the mass weighted average outlet temperature.

Perform the same steps as described above to create an expression called `outlettemp` with the following definition:

\[\text{massFlowAveAbs(Temperature)}@\text{all outlets}\]

Right-click the new expression and select **Use as Workbench Output Parameter** from the context menu.

8. Close ANSYS CFD-Post.

In the main menu, select **File → Close CFD-POST** to return to ANSYS Workbench.

9. In the **Outline of All Parameters** view, review the newly-added output parameters that you specified in ANSYS CFD-Post and when finished, click the **Project** tab to return to the **Project Schematic**.

10. If any of the cells in the analysis system require attention, update the project by clicking the **Update Project** button in the ANSYS Workbench toolbar.

11. Optionally, review the list of files generated by ANSYS Workbench. If the **Files** view is not open, select **View → Files** from the main menu.

You will notice additional files associated with the latest solution as well as those generated by CFD-Post.
12. Save the project in ANSYS Workbench.

In the main menu, select **File → Save**

**Note**

You can also select the **Save Project** option from the CFD-Post **File** menu.

### 2.4.6. Creating Additional Design Points in ANSYS Workbench

Parameters and design points are tools that allow you to analyze and explore a project by giving you the ability to run optimization and what-if scenarios. Design points are based on sets of parameter values. When you define input and output parameters in your ANSYS Workbench project, you are essentially working with a design point. To perform optimization and what-if scenarios, you create multiple design points based on your original project. In this step, you will create additional design points for your project where you will be able to perform a comparison of your results by manipulating input parameters (such as the angles of the various valves within the automotive HVAC geometry). ANSYS Workbench provides a Table of Design Points to make creating and manipulating design points more convenient.
1. Open the Table of Design Points.

   a. In the Project Schematic, double-click the Parameter Set bus bar to open the Table of Design Points view. If the table is not visible, select Table from the View menu in ANSYS Workbench.

   View → Table

   The table of design points initially contains the current project as a design point (DP0), along with its corresponding input and output parameter values.

   Figure 2.20: Table of Design Points (with DP0)

   From this table, you can create new design points (or duplicate existing design points) and edit them (by varying one or more input parameters) to create separate analyses for future comparison of data.

2. Create a design point (DP1) by duplicating the current design point (DP0).

   a. Right click the Current design point and select Duplicate Design Point from the context menu.

      The cells autofill with the values from the Current row.

   b. Scroll over to the far right to expose the Exported column in the table of design points, and select the check box in the row for the duplicated design point DP1 (cell N4).

      This allows the data from this new design point to be saved to a separate project for analysis.

   c. Click OK to acknowledge the information message prompting you to update the design points in order for the design points to be exported.

3. Create another design point (DP2) by duplicating the DP1 design point.

   a. Right click the DP1 design point and select Duplicate Design Point from the context menu.

      Since this is a duplicate of DP1, this design point will also have the ability to export its data as well.

4. Edit values for the input parameters for DP1 and DP2.

   For DP1 and DP2, edit the values for your input parameters within the Table of Design Points as follows:

<table>
<thead>
<tr>
<th></th>
<th>input_hcpos</th>
<th>input_ftpos</th>
<th>input_wsfpos</th>
<th>in_velocity</th>
<th>in_temp</th>
</tr>
</thead>
<tbody>
<tr>
<td>DP1</td>
<td>45</td>
<td>45</td>
<td>45</td>
<td>0.6</td>
<td>300</td>
</tr>
<tr>
<td>DP2</td>
<td>90</td>
<td>60</td>
<td>15</td>
<td>0.7</td>
<td>290</td>
</tr>
</tbody>
</table>
For demonstration purposes of this tutorial, in each design point, we are slightly changing the angles of each of the valves, and increasing the inlet velocity and the inlet temperature. Later, we will see how the results in each case varies.

5. Update all of your design points.

Click the **Update all Design Points** button in the ANSYS Workbench toolbar. Alternatively, you can also select one or more design points, right-click, and select **Update Selected Design Points** from the context menu. Click **OK** to acknowledge the information message notifying you that some open editors may close during the update process. By updating the design points, ANSYS Workbench takes the new values of the input parameters for each design point and updates the components of the associated system (for example, the geometry, mesh, settings, solution, and results), as well as any output parameters that have been defined.

---

**Note**

It may take significant time and/or computing resources to re-run the simulations for each design point.

When the design points have been updated, note the addition of two more ANSYS Workbench project files (and their corresponding folders) in your current working directory (`fluent-workbench-param_dp1.wbpj` and `fluent-workbench-param_dp2.wbpj`). You can open each of these projects up separately and examine the results of each parameterized simulation. If you make any changes to the design point and update the design point, then an additional ANSYS Workbench project is created (for example, `fluent-workbench-param_dp1_1.wbpj`).

6. Inspect the output parameter values in ANSYS Workbench.

Once all design points have been updated, you can use the table of design points to inspect the values of the output parameters you created in CFD-Post (for example, the mass flow parameters at the various outlets: `floutfront`, `floutfoot`, `floutwindshield`, and `outlettemp`). These, and the rest of the output parameters are listed to the far right in the table of design points.

---

**Figure 2.21: Table of Design Points (with DP0, DP1, and DP2 Defined)**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>P1 - hpos</td>
<td>P2 - ftpos</td>
<td>P3 - wpos</td>
<td>P4 - input_hpos</td>
<td>P5 - input_ftpos</td>
<td>P6 - input_wpos</td>
<td>P7 - in-velocity</td>
<td>P8 - in-temp</td>
</tr>
<tr>
<td>2</td>
<td>Units</td>
<td>m s(^{-1})</td>
<td>K</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Current</td>
<td>25</td>
<td>25</td>
<td>90</td>
<td>15</td>
<td>25</td>
<td>90</td>
<td>0.5</td>
<td>310</td>
</tr>
<tr>
<td>4</td>
<td>DP1</td>
<td>45</td>
<td>45</td>
<td>45</td>
<td>45</td>
<td>45</td>
<td>45</td>
<td>0.6</td>
<td>300</td>
</tr>
<tr>
<td>5</td>
<td>DP2</td>
<td>90</td>
<td>60</td>
<td>15</td>
<td>90</td>
<td>60</td>
<td>15</td>
<td>0.7</td>
<td>290</td>
</tr>
</tbody>
</table>

---

**Figure 2.22: Table of Design Points (Showing Output Parameters for DP0, DP1, and DP2)**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>P4 - input_hpos</td>
<td>P5 - input_ftpos</td>
<td>P6 - input_wpos</td>
<td>P7 - in-velocity</td>
<td>P8 - in-temp</td>
<td>P9 - floutfront</td>
<td>P10 - floutwindshield</td>
<td>P11 - floutfoot</td>
<td>P12 - outlettemp</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Units</td>
<td>m s(^{-1})</td>
<td>Kg m(^{-3})</td>
<td>Kg s(^{-1})</td>
<td>Kg s(^{-1})</td>
<td>Kg s(^{-1})</td>
<td>Kg s(^{-1})</td>
<td>Kg s(^{-1})</td>
<td>Kg s(^{-1})</td>
<td>Kg s(^{-1})</td>
<td>Kg s(^{-1})</td>
<td>Kg s(^{-1})</td>
<td>Kg s(^{-1})</td>
</tr>
<tr>
<td>3</td>
<td>Current</td>
<td>15</td>
<td>25</td>
<td>90</td>
<td>0.5</td>
<td>310</td>
<td>0.00000284</td>
<td>0.0113206</td>
<td>0.0210818</td>
<td>292.24</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DP1</td>
<td>45</td>
<td>45</td>
<td>45</td>
<td>45</td>
<td>45</td>
<td>45</td>
<td>0.6</td>
<td>300</td>
<td>294.98</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>DP2</td>
<td>90</td>
<td>60</td>
<td>15</td>
<td>90</td>
<td>60</td>
<td>15</td>
<td>0.7</td>
<td>290</td>
<td>0.0016706</td>
<td>0.038472</td>
<td>0.036171</td>
<td>277.13</td>
</tr>
</tbody>
</table>
7. Click the **Project** tab, just above the ANSYS Workbench toolbar to return to the **Project Schematic**.

8. View the list of files generated by ANSYS Workbench (optional).

   **View → Files**

   The additional files for the new design points are stored with their respective project files since you enabled the **Exported** option when setting them up.

9. Save the project in the current state in ANSYS Workbench.

   In the main menu, select **File → Save**.

10. Quit ANSYS Workbench.

    In the main menu, select **File → Exit**.

### 2.4.7. Postprocessing the New Design Points in CFD-Post

In this step, you will open the ANSYS Workbench project for each of the design points and inspect the vector plots based on the new results of the simulations.

1. Study the results of the first design point (DP1).

   a. Open the ANSYS Workbench project for the first design point (DP1).

      In your current working folder, double-click the `fluent-workbench-param_dp1.wbpj` file to open ANSYS Workbench.

   b. Open CFD-Post by double-clicking the **Results** cell in the Project Schematic for the Fluid Flow (Fluent) analysis system.

   c. View the vector plot colored by temperature. Ensure that **Range** in the **Color** tab is set to **User Specified** and the **Min** and **Max** temperature values are set to 273 K and 310 K, respectively.
d. View the vector plot colored by pressure. Ensure that Range in the Color tab is set to Global.
e. View the vector plot colored by velocity. Ensure that **Range** in the **Color** tab is set to **Global**.
f. When you are finished viewing results of the design point DP1 in ANSYS CFD-Post, select **File → Close CFD-Post** to quit ANSYS CFD-Post and return to the ANSYS Workbench **Project Schematic**, and then select **File → Exit** to exit from ANSYS Workbench.

2. Study the results of the second design point (DP2).
   
a. Open the ANSYS Workbench project for the second design point (DP2).

   In your current working folder, double-click the `fluent-workbench-param_dp2.wbpj` file to open ANSYS Workbench.

   b. Open CFD-Post by double-clicking the **Results** cell in the Project Schematic for the Fluid Flow (Fluent) analysis system.
c. View the vector plot colored by temperature. Ensure that Range in the Color tab is set to User Specified and the Min and Max temperature values are set and the Min and Max temperature values are set to 273 K and 310 K, respectively.

Figure 2.26: Vectors Colored by Temperature (DP2)

d. View the vector plot colored by pressure. Ensure that Range in the Color tab is set to Global.
e. View the vector plot colored by velocity. Ensure that **Range** in the **Color** tab is set to **Global**.
3. When you are finished viewing results in ANSYS CFD-Post, select **File → Close CFD-Post** to quit ANSYS CFD-Post and return to the ANSYS Workbench **Project Schematic**, and then select **File → Exit** to exit from ANSYS Workbench.

### 2.4.8. Summary

In this tutorial, input and output parameters were created within ANSYS Workbench, ANSYS Fluent, and ANSYS CFD-Post in order to study the airflow in an automotive HVAC system. ANSYS Fluent was used to calculate the fluid flow throughout the geometry using the computational mesh, and ANSYS CFD-Post was used to analyze the results. ANSYS Workbench was used to create additional design points based on the original settings, and the corresponding simulations were run to create separate projects where parameterized analysis could be performed to study the effects of variable angles of the inlet valves, velocities, and temperatures. Also, note that simplified solution settings were used in this tutorial to speed up the solution time. For more improved solution accuracy, you would typically use denser mesh and higher order discretization for all flow equations.
Chapter 3: Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow

This tutorial is divided into the following sections:

3.1. Introduction
3.2. Prerequisites
3.3. Problem Description
3.4. Setup and Solution
3.5. Summary

3.1. Introduction

This tutorial illustrates the setup and solution of a three-dimensional turbulent fluid flow and heat transfer problem in a mixing elbow. The mixing elbow configuration is encountered in piping systems in power plants and process industries. It is often important to predict the flow field and temperature field in the area of the mixing region in order to properly design the junction.

This tutorial demonstrates how to do the following:

• Launch ANSYS Fluent.
• Read an existing mesh file into ANSYS Fluent.
• Use mixed units to define the geometry and fluid properties.
• Set material properties and boundary conditions for a turbulent forced-convection problem.
• Set up a surface monitor and use it as a convergence criterion.
• Calculate a solution using the pressure-based solver.
• Visually examine the flow and temperature fields using the postprocessing tools available in ANSYS Fluent.
• Change the solver method to coupled in order to increase the convergence speed.
• Adapt the mesh based on the temperature gradient to further improve the prediction of the temperature field.

3.2. Prerequisites

This tutorial assumes that you have little or no experience with ANSYS Fluent, and so each step will be explicitly described.

3.3. Problem Description

The problem to be considered is shown schematically in Figure 3.1: Problem Specification (p. 124). A cold fluid at 20° C flows into the pipe through a large inlet, and mixes with a warmer fluid at 40° C that
enters through a smaller inlet located at the elbow. The pipe dimensions are in inches and the fluid properties and boundary conditions are given in SI units. The Reynolds number for the flow at the larger inlet is 50,800, so a turbulent flow model will be required.

**Note**

Since the geometry of the mixing elbow is symmetric, only half of the elbow must be modeled in ANSYS Fluent.

**Figure 3.1: Problem Specification**

3.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

3.4.1. Preparation
3.4.2. Launching ANSYS Fluent
3.4.3. Reading the Mesh
3.4.4. General Settings
3.4.5. Models
3.4.6. Materials
3.4.7. Cell Zone Conditions
3.4.8. Boundary Conditions
3.4.9. Solution
3.4.10. Displaying the Preliminary Solution
3.4.11. Using the Coupled Solver
3.4.12. Adapting the Mesh

3.4.1. Preparation

1. Set up a working folder on the computer you will be using.
   
   **Note**
   
   If you do not have a login, you can request one by clicking Customer Registration on the login page.
   
3. Enter the name of this tutorial into the search bar.
4. Narrow the results by using the filter on the left side of the page.
   
   a. Click ANSYS Fluent under Product.
   
   b. Click 15.0 under Version.
5. Select this tutorial from the list.
6. Click Files to download the input and solution files.
7. Unzip the introduction_R150.zip file you downloaded to your working directory. This file contains a folder, introduction, that holds the file elbow.msh that you will use in this tutorial. The introduction directory also contains a solution_files sub-folder that contains the solution files created during the preparation of this tutorial.
   
   **Note**
   
   ANSYS Fluent tutorials are prepared using ANSYS Fluent on a Windows system. The screen shots and graphic images in the tutorials may be slightly different than the appearance on your system, depending on the operating system or graphics card.

3.4.2. Launching ANSYS Fluent

1. Open the Fluent Launcher by clicking the Windows Start menu, then selecting Fluent 15.0 in the Fluid Dynamics sub-menu of the ANSYS 15.0 program group.
   
   The Fluent Launcher allows you to decide which version of ANSYS Fluent you will use, based on your geometry and on your processing capabilities.
   
   **Start → All Programs → ANSYS 15.0 → Fluid Dynamics → Fluent 15.0**
2. Ensure that the proper options are enabled.
   a. Select 3D from the Dimension list by clicking the radio button or the text.
   b. Select Serial from the Processing Options list.
   c. Enable the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color Scheme options.

   **Note**
   An option is enabled when there is a check mark in the check box, and disabled when the check box is empty. To change an option from disabled to enabled (or vice versa), click the check box or the text.

   d. Ensure that the Double-Precision option is disabled.

   **Note**
   Fluent will retain your preferences for future sessions.

   **Extra**
   You can also restore the default settings by clicking the Default button.

3. Set the working path to the directory created when you unzipped introduction_R150.zip.
a. Click the **Show More Options** button to reveal additional options.

b. Enter the path to your working directory for **Working Directory** by double-clicking the text box and typing.

Alternatively, you can click the browse button ( файл ) next to the **Working Directory** text box and browse to the directory, using the **Browse For Folder** dialog box.

4. Click **OK** to launch ANSYS Fluent.
3.4.3. Reading the Mesh

1. Read the mesh file \texttt{elbow.msh}.

   \texttt{File \to Read \to Mesh...}

   Select \texttt{Read} from the \texttt{File} menu, then select \texttt{Mesh...} to open the \texttt{Select File} dialog box.
a. Select the mesh file by clicking `elbow.msh` in the `introduction` directory created when you unzipped the original file.

b. Click OK to read the file and close the Select File dialog box.

As the mesh file is read by ANSYS Fluent, messages will appear in the console reporting the progress of the conversion. ANSYS Fluent will report that 13,852 hexahedral fluid cells have been read, along with a number of boundary faces with different zone identifiers.

After having completed reading mesh, ANSYS Fluent displays the mesh in the graphics window.

---

**Extra**

You can use the mouse to probe for mesh information in the graphics window. If you click the right mouse button with the pointer on any node in the mesh, information about the associated zone will be displayed in the console, including the name of the zone.

Alternatively, you can click the probe button (şı) in the graphics toolbar and click the left mouse button on any node. This feature is especially useful when you have several zones of the same type and you want to distinguish between them quickly.
For this 3D problem, you can make it easier to probe particular nodes by changing the view. The following table describes how to manipulate objects in the graphics window:

### Table 3.1: View Manipulation Instructions

<table>
<thead>
<tr>
<th>Action</th>
<th>Using Graphics Toolbar Buttons and the Mouse</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate view (vertical, horizontal)</td>
<td>After clicking the Rotate icon, press and hold the left mouse button and drag the mouse. Dragging side to side rotates the view about the vertical axis, and dragging up and down rotates the view about the horizontal axis.</td>
</tr>
<tr>
<td>Translate or pan view</td>
<td>After clicking the Pan icon, press and hold the left mouse button and drag the object with the mouse until the view is satisfactory.</td>
</tr>
<tr>
<td>Zoom in and out of view</td>
<td>After clicking the Zoom in/Out icon, press and hold the left mouse button and drag the mouse up and down to zoom in and out of the view.</td>
</tr>
<tr>
<td>Zoom to selected area</td>
<td>After clicking the Zoom to Area icon, press and hold the left mouse button and drag the mouse diagonally to the right. This action will cause a rectangle to appear in the display. When you release the mouse button, a new view will be displayed that consists entirely of the contents of the rectangle. Note that to zoom in, you must drag the mouse to the right, and to zoom out, you must drag the mouse to the left.</td>
</tr>
</tbody>
</table>

Clicking the **Fit to Window** icon, will cause the object to fit exactly and be centered in the window.

After you have clicked a button in the graphics toolbar, you can return to the default mouse button settings by clicking .

---

2. Manipulate the mesh display using the **Views** dialog box to obtain a front view as shown in [Figure 3.2: The Hexahedral Mesh for the Mixing Elbow](p. 132).

Select **Graphics and Animations** in the navigation pane, then click **Views...** in the **Graphics and Animations** task page.

**Graphics and Animations** → **Views...**
a. Select **front** from the **Views** selection list.

**Note**

A list item is selected if it is highlighted, and deselected if it is not highlighted.

b. Click **Apply** and close the **Views** dialog box.
**Figure 3.2: The Hexahedral Mesh for the Mixing Elbow**

You can also change the orientation of the objects in the graphics window using the axis triad as follows:

- Left-click an axis to point it in the positive direction.
- Right-click an axis to point it in the negative direction.
- Left-click the iso-ball to set the isometric view.
3.4.4. General Settings

Select **General** in the navigation pane to perform the mesh-related activities and to choose a solver.

1. Check the mesh.

![General Settings](image)

**General → Check**

ANSYS Fluent will report the results of the mesh check in the console.

Domain Extents:
- x-coordinate: min (m) = -8.000000e+000, max (m) = 8.000000e+000
- y-coordinate: min (m) = -9.134633e+000, max (m) = 8.000000e+000
- z-coordinate: min (m) = 0.000000e+000, max (m) = 2.000000e+000

Volume statistics:
- minimum volume (m^3): 5.098270e-004
- maximum volume (m^3): 2.330737e-002
- total volume (m^3): 1.607154e+002

Face area statistics:
- minimum face area (m^2): 4.865882e-003
- maximum face area (m^2): 1.017924e-001

Checking mesh.................

Done.

The mesh check will list the minimum and maximum x and y values from the mesh in the default SI unit of meters. It will also report a number of other mesh features that are checked. Any errors
in the mesh will be reported at this time. Ensure that the minimum volume is not negative, since ANSYS Fluent cannot begin a calculation when this is the case.

---

**Note**

The minimum and maximum values may vary slightly when running on different platforms.

---

2. Scale the mesh.

![Scale Mesh dialog box](image)

- a. Ensure that **Convert Units** is selected in the **Scaling** group box.

- b. Select **in** from the **Mesh Was Created In** drop-down list by first clicking the down-arrow button and then clicking the **in** item from the list that appears.

- c. Click **Scale** to scale the mesh.

---

**Warning**

Be sure to click the **Scale** button only once.

---

**Domain Extents** will continue to be reported in the default SI unit of meters.

- d. Select **in** from the **View Length Unit In** drop-down list to set inches as the working unit for length.

- e. Confirm that the domain extents are as shown in the dialog box above.

- f. Close the **Scale Mesh** dialog box.
The mesh is now sized correctly and the working unit for length has been set to inches.

**Note**

Because the default SI units will be used for everything except length, there is no need to change any other units in this problem. The choice of inches for the unit of length has been made by the actions you have just taken. If you want a different working unit for length, other than inches (for example, millimeters), click **Units...** in the **General** task page and make the appropriate change, in the **Set Units** dialog box.

3. Check the mesh.

**General → Check**

**Note**

It is a good idea to check the mesh after you manipulate it (that is, scale, convert to polyhedra, merge, separate, fuse, add zones, or smooth and swap). This will ensure that the quality of the mesh has not been compromised.

4. Retain the default settings of pressure-based steady-state solver in the **Solver** group box of the **General** task page.

**3.4.5. Models**

1. Enable heat transfer by activating the energy equation.
1. Enable the Energy Equation option.
   
a. Click OK to close the Energy dialog box.

2. Enable the $k-\varepsilon$ turbulence model.
   
   ![Energy dialog box]
   
   a. Enable the **Energy Equation** option.
   
   b. Click **OK** to close the **Energy** dialog box.
a. Select **k-epsilon** from the **Model** list.

   *The Viscous Model dialog box will expand.*

b. Retain the default selection of **Standard** in the **k-epsilon Model** group box.

c. Select **Enhanced Wall Treatment** in the **Near-Wall Treatment** group box.

---

**Note**

The default Standard Wall Functions are generally applicable if the first cell center adjacent to the wall has a $y+$ larger than 30. In contrast, the Enhanced Wall Treatment option provides consistent solutions for all $y+$ values. Enhanced Wall Treatment is recommended when using the k-epsilon model for general single-phase fluid flow problems. For more information about Near Wall Treatments in the k-epsilon model refer to **Setting Up the k-$\epsilon$ Model** in the User’s Guide.
d. Click OK to accept all the other default settings and close the Viscous Model dialog box.

### 3.4.6. Materials

1. Create a new material called water.

   ![Materials](image)

   ![Fluid](image)

   ![Create/Edit...](image)
a. Type `water` for **Name**.

b. Enter the following values in the **Properties** group box:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Density</td>
<td>1000 $\text{kg/m}^3$</td>
</tr>
<tr>
<td>$c_p$</td>
<td>4216 $\text{J/kg-K}$</td>
</tr>
<tr>
<td>Thermal Conductivity</td>
<td>0.677 $\text{W/m-K}$</td>
</tr>
<tr>
<td>Viscosity</td>
<td>8e-04 $\text{kg/m-s}$</td>
</tr>
</tbody>
</table>

c. Click **Change/Create**.

A **Question** dialog box will open, asking if you want to overwrite air. Click **No** so that the new material `water` is added to the list of materials that originally contained only `air`. 
Extra

You could have copied the material *water-liquid (h2o<\>)* from the materials database (accessed by clicking the Fluent Database... button). If the properties in the database are different from those you want to use, you can edit the values in the Properties group box in the Create/Edit Materials dialog box and click Change/Create to update your local copy. The original copy will not be affected.

d. Ensure that there are now two materials (water and air) defined locally by examining the Fluent Fluid Materials drop-down list.

Both the materials will also be listed under Fluid in the Materials task page.

e. Close the Create/Edit Materials dialog box.
### 3.4.7. Cell Zone Conditions

#### Setup and Solution

<table>
<thead>
<tr>
<th>Zone</th>
<th>Fluid Zone Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>fluid</td>
<td></td>
</tr>
</tbody>
</table>

#### Phase  

<table>
<thead>
<tr>
<th>Phase</th>
<th>Type</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>mixture</td>
<td>fluid</td>
<td>2</td>
</tr>
</tbody>
</table>

- **Porous Formulation**
  - Superficial Velocity
  - Physical Velocity

1. Set the cell zone conditions for the fluid zone (fluid).

   - **Cell Zone Conditions**  → **fluid**  → **Edit...**
a. Select **water** from the **Material Name** drop-down list.

b. Click **OK** to close the **Fluid** dialog box.
3.4.8. Boundary Conditions

1. Set the boundary conditions at the cold inlet (velocity-inlet-5).

   ![Boundary Conditions](image)

   **Tip**

   If you are unsure of which inlet zone corresponds to the cold inlet, you can probe the mesh display using the right mouse button or the probe toolbar button as described previously in this tutorial. The information will be displayed in the ANSYS Fluent console, and the zone you probed will be automatically selected from the Zone selection list in the Boundary Conditions task page.
a. Select **Components** from the **Velocity Specification Method** drop-down list.

   *The Velocity Inlet dialog box will expand.*

b. Enter 0.4 m/s for **X-Velocity**.

c. Retain the default value of 0 m/s for both **Y-Velocity** and **Z-Velocity**.

d. Select **Intensity and Hydraulic Diameter** from the **Specification Method** drop-down list in the **Turbulence** group box.

e. Retain the default value of 5 % for **Turbulent Intensity**.

f. Enter 4 inches for **Hydraulic Diameter**.

   *The hydraulic diameter $D_h$ is defined as:*

   $$D_h = \frac{4A}{P_w}$$

   *where $A$ is the cross-sectional area and $P_w$ is the wetted perimeter.*
g. Click the **Thermal** tab.

![Velocity inlet dialog box]

h. Enter \(293.15 \text{ K}\) for **Temperature**.

i. Click **OK** to close the **Velocity Inlet** dialog box.

2. In a similar manner, set the boundary conditions at the hot inlet (**velocity-inlet-6**), using the values in the following table:

<table>
<thead>
<tr>
<th>Boundary Conditions →</th>
<th>velocity-inlet-6 → Edit...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Velocity Specification</strong> Method</td>
<td><strong>Components</strong></td>
</tr>
<tr>
<td>X-Velocity</td>
<td>0 (\text{ m/s})</td>
</tr>
<tr>
<td>Y-Velocity</td>
<td>1.2 (\text{ m/s})</td>
</tr>
<tr>
<td>Z-Velocity</td>
<td>0 (\text{ m/s})</td>
</tr>
<tr>
<td><strong>Specification Method</strong></td>
<td><strong>Intensity and Hydraulic Diameter</strong></td>
</tr>
<tr>
<td>Turbulent Intensity</td>
<td>5%</td>
</tr>
<tr>
<td>Hydraulic Diameter</td>
<td>1 (\text{ inch})</td>
</tr>
<tr>
<td>Temperature</td>
<td>313.15 (\text{ K})</td>
</tr>
</tbody>
</table>
3. Set the boundary conditions at the outlet (pressure-outlet-7), as shown in the Pressure Outlet dialog box.

![Boundary Conditions](image)

**Note**

ANSYS Fluent will use the backflow conditions only if the fluid is flowing into the computational domain through the outlet. Since backflow might occur at some point during the solution procedure, you should set reasonable backflow conditions to prevent convergence from being adversely affected.

4. For the wall of the pipe (wall), retain the default value of 0 $W/m^2$ for Heat Flux in the Thermal tab.

![Boundary Conditions](image)
3.4.9. Solution

In the steps that follow, you will set up and run the calculation using the task pages listed under the Solution heading in the navigation pane.

1. Select a solver scheme.

Solution Methods

Leave the Scheme at the default SIMPLE for this calculation.
2. Enable the plotting of residuals during the calculation.

Monitors → Residuals → Edit...
a. Ensure that Plot is enabled in the Options group box.

b. Leave the Absolute Criteria of continuity at the default level of 0.001 as shown in the Residual Monitors dialog box.

c. Click OK to close the Residual Monitors dialog box.

**Note**

By default, all variables will be monitored and checked by ANSYS Fluent as a means to determine the convergence of the solution. It is a good practice to also define a surface monitor that can help evaluate whether the solution is truly converged. You will do this in the next step.

3. Define a surface monitor of average temperature at the outlet (pressure-outlet-7).

   Monitors → Create... (Surface Monitors)
a. Enter `outlet-temp-avg` for the Name of the surface monitor.

b. Enable the Plot and Write options for `outlet-temp-avg`.

c. Enter `outlet-temp-avg.out` for File Name.

d. Set Get Data Every to 3 by clicking the up-arrow button.

   This setting instructs ANSYS Fluent to update the plot of the surface monitor and write data to a file after every 3 iterations during the solution.

e. Select Mass-Weighted Average from the Report Type drop-down list.

f. Select Temperature... and Static Temperature from the Field Variable drop-down lists.

g. Select `pressure-outlet-7` from the Surfaces selection list.

h. Click OK to save the surface monitor settings and close the Surface Monitor dialog box.

The name and report type of the surface monitor you created will be displayed in the Surface Monitors selection list in the Monitors task page.

4. Set a convergence monitor for `outlet-temp-avg`.

   Monitors → Convergence Manager...
a. Activate the convergence criterion on outlet temperature by checking the **Active** box next to **outlet-temp-avg**.

b. Enter **1e-5** for **Stop Criterion**.

c. Enter **20** for **Initial Iterations to Ignore**.

d. Enter **15** for **Previous Iterations to Consider**.

e. Enable **Print**.

f. Click **OK** to save the convergence monitor settings and close the **Convergence Manager** dialog box.

These settings will cause Fluent to consider the solution converged when the monitor value for each of the previous 15 iterations is within 0.001% of the current value. Convergence of the monitor values will be checked every 3 iterations. The first 20 iterations will be ignored allowing for any initial solution dynamics to settle out. Note that the value printed to the console is the deviation between the current and previous iteration values only.

5. Initialize the flow field.

**Solution Initialization**

a. Leave the **Initialization Method** at the default **Hybrid Initialization**.
b. Click **Initialize**.

6. **Save the case file** (elbow1.cas.gz).

   **File → Write → Case...**

   ![Select File dialog box](image)

   a. (optional) Indicate the directory in which you would like the file to be saved.

      By default, the file will be saved in the directory from which you read in **elbow.msh** (that is, the **introduction** directory). You can indicate a different directory by browsing to it or by creating a new directory.

   b. **Enter** elbow1.cas.gz for **Case File**.

      Adding the extension .gz to the end of the file name extension instructs ANSYS Fluent to save the file in a compressed format. You do not have to include .cas in the extension (for example, if you enter elbow1.gz, ANSYS Fluent will automatically save the file as elbow1.cas.gz). The .gz extension can also be used to save data files in a compressed format.

   c. Ensure that the default **Write Binary Files** option is enabled, so that a binary file will be written.

   d. Click **OK** to save the case file and close the **Select File** dialog box.

7. **Start the calculation by requesting 150 iterations.**

   ![Run Calculation button](image)
a. Enter 150 for **Number of Iterations**.

b. Click **Calculate**.

**Note**

By starting the calculation, you are also starting to save the surface monitor data at the rate specified in the **Surface monitors** dialog box. If a file already exists in your working directory with the name you specified in the **Define Surface Monitor** dialog box, then a **Question** dialog box will open, asking if you would like to append the new data to the existing file. Click **No** in the **Question** dialog box, and then click **OK** in the **Warning** dialog box that follows to overwrite the existing file.

As the calculation progresses, the surface monitor history will be plotted in graphics window 2 (Figure 3.3: Convergence History of the Mass-Weighted Average Temperature (p. 154)).
Similarly, the residuals history will be plotted in window 1 in the background. You can display the residuals history by selecting window 1 from the graphics window drop-down list (Figure 3.4: Residuals (p. 155)).
Since the residual values vary slightly by platform, the plot that appears on your screen may not be exactly the same as the one shown here.

The solution will be stopped by ANSYS Fluent when any of the following occur:

- the surface monitor converges to within the tolerance specified in the Convergence Manager dialog box
- the residual monitors converge to within the tolerances specified in the Residual Monitors dialog box
- the number of iterations you requested in the Run Calculation task page has been reached

In this case, the solution is stopped when the convergence criterion on outlet temperature is satisfied, after approximately 75 iterations. The exact number of iterations for convergence will vary, depending on the platform being used. An Information dialog box will open to alert you that the calculation is complete. Click OK in the Information dialog box to proceed.
8. Examine the plots for convergence (Figure 3.3: Convergence History of the Mass-Weighted Average Temperature (p. 154) and Figure 3.4: Residuals (p. 155)).

**Note**

There are no universal metrics for judging convergence. Residual definitions that are useful for one class of problem are sometimes misleading for other classes of problems. Therefore it is a good idea to judge convergence not only by examining residual levels, but also by monitoring relevant integrated quantities and checking for mass and energy balances.

There are three indicators that convergence has been reached:

- The residuals have decreased to a sufficient degree.

  The solution has converged when the **Convergence Criterion** for each variable has been reached. The default criterion is that each residual will be reduced to a value of less than $10^{-3}$, except the **energy** residual, for which the default criterion is $10^{-6}$.

- The solution no longer changes with more iterations.

  Sometimes the residuals may not fall below the convergence criterion set in the case setup. However, monitoring the representative flow variables through iterations may show that the residuals have stagnated and do not change with further iterations. This could also be considered as convergence.

- The overall mass, momentum, energy, and scalar balances are obtained.

  You can examine the overall mass, momentum, energy and scalar balances in the **Flux Reports** dialog box. The net imbalance should be less than 0.2 % of the net flux through the domain when the solution has converged. In the next step you will check to see if the mass balance indicates convergence.

9. Examine the mass flux report for convergence.

    ![Reports ➔ Fluxes ➔ Set Up...]
a. Ensure that **Mass Flow Rate** is selected from the **Options** list.

b. Select **pressure-outlet-7, velocity-inlet-5,** and **velocity-inlet-6** from the **Boundaries** selection list.

c. Click **Compute.**

   The individual and net results of the computation will be displayed in the **Results** and **Net Results** boxes, respectively, in the **Flux Reports** dialog box, as well as in the console.

   The sum of the flux for the inlets should be very close to the sum of the flux for the outlets. The net results show that the imbalance in this case is well below the 0.2 % criterion suggested previously.

d. Close the **Flux Reports** dialog box.

10. Save the data file (**elbow1.dat.gz**).

   File → Write → Data...

   *In later steps of this tutorial you will save additional case and data files with different suffixes.*

### 3.4.10. Displaying the Preliminary Solution

In the steps that follow, you will visualize various aspects of the flow for the preliminary solution, using the task pages listed under the **Results** heading in the navigation pane.

1. Display filled contours of velocity magnitude on the symmetry plane (**Figure 3.5: Predicted Velocity Distribution after the Initial Calculation (p. 159)**).

   ![Graphics and Animations → Contours → Set Up...](image)
a. Enable **Filled** in the **Options** group box.

b. Ensure that **Node Values** is enabled in the **Options** group box.

c. Select **Velocity...** and **Velocity Magnitude** from the **Contours of** drop-down lists.

d. Select **symmetry** from the **Surfaces** selection list.

e. Click **Display** to display the contours in the active graphics window. Clicking the **Fit to Window** icon, ☐, will cause the object to fit exactly and be centered in the window.

---

**Extra**

When you probe a point in the displayed domain with the right mouse button or the probe tool, the level of the corresponding contour is highlighted in the colormap in the graphics window, and is also reported in the console.
Figure 3.5: Predicted Velocity Distribution after the Initial Calculation

2. Display filled contours of temperature on the symmetry plane (Figure 3.6: Predicted Temperature Distribution after the Initial Calculation (p. 161)).

Graphics and Animations → Contours → Set Up...
a. Select **Temperature...** and **Static Temperature** from the **Contours of** drop-down lists.

b. Click **Display** and close the **Contours** dialog box.
3. Display velocity vectors on the symmetry plane (Figure 3.9: Magnified View of Resized Velocity Vectors (p. 165)).

Graphics and Animations → Vectors → Set Up...
a. Select **symmetry** from the **Surfaces** selection list.  

b. Click **Display** to plot the velocity vectors.
The **Auto Scale** option is enabled by default in the **Options** group box. This scaling sometimes creates vectors that are too small or too large in the majority of the domain. You can improve the clarity by adjusting the **Scale** and **Skip** settings, thereby changing the size and number of the vectors when they are displayed.

c. Enter 4 for **Scale**.

d. Set **Skip** to 2.

e. Click **Display** again to redisplay the vectors.
f. Close the **Vectors** dialog box.

g. Zoom in on the vectors in the display.

*To manipulate the image, refer to Table 3.1: View Manipulation Instructions (p. 130). The image will be redisplayed at a higher magnification (Figure 3.9: Magnified View of Resized Velocity Vectors (p. 165)).*
Figure 3.9: Magnified View of Resized Velocity Vectors

h. Zoom out to the original view.

You also have the option of selecting the original view in the Views dialog box:

Graphics and Animations → Views...

Select front from the Views selection list and click Apply, then close the Views dialog box.
4. Create a line at the centerline of the outlet. For this task, you will use the **Surface** command that is at the top of the ANSYS Fluent window.

**Surface → Iso-Surface...**

![Iso-Surface dialog box]

- a. Select **Mesh...** and **Z-Coordinate** from the **Surface of Constant** drop-down lists.
- b. Click **Compute** to obtain the extent of the mesh in the $z$ direction.
  
  The range of values in the $z$ direction is displayed in the **Min** and **Max** boxes.
- c. Retain the default value of 0 inches for **Iso-Values**.
- d. Select **pressure-outlet-7** from the **From Surface** selection list.
e. Enter \( z=0 \_\text{outlet} \) for **New Surface Name**.

f. Click **Create**.

The new line surface representing the intersection of the plane \( z=0 \) and the surface pressure-outlet-7 is created, and its name \( z=0 \_\text{outlet} \) is added to the **From Surface** list in the dialog box.

After the line surface \( z=0 \_\text{outlet} \) is created, a new entry will automatically be generated for **New Surface Name**, in case you would like to create another surface.

g. Close the **Iso-Surface** dialog box.

5. Display and save an XY plot of the temperature profile across the centerline of the outlet for the initial solution (Figure 3.10: Outlet Temperature Profile for the Initial Solution (p. 168)).

![XY Plot Setup](image)

- Select **Temperature...** and **Static Temperature** from the **Y Axis Function** drop-down lists.
- Select the \( z=0 \_\text{outlet} \) surface you just created from the **Surfaces** selection list.
- Click **Plot**.
- Enable **Write to File** in the **Options** group box.
  
  *The button that was originally labeled **Plot** will change to **Write**.*
- Click **Write...** to open the **Select File** dialog box.
  - Enter **outlet_temp1.xy** for **XY File**.
  - Click **OK** to save the temperature data and close the **Select File** dialog box.
f. Close the **Solution XY Plot** dialog box.

**Figure 3.10: Outlet Temperature Profile for the Initial Solution**

---

6. Define a custom field function for the dynamic head formula \( \rho \left( \frac{|V|^2}{2} \right) \). For this task, you will use the **Define** menu that is at the top of the ANSYS Fluent window.

**Define → Custom Field Functions...**
a. Select **Density** and **Density** from the **Field Functions** drop-down lists, and click the **Select** button to add density to the **Definition** field.

b. Click the X button to add the multiplication symbol to the **Definition** field.

c. Select **Velocity**... and **Velocity Magnitude** from the **Field Functions** drop-down lists, and click the **Select** button to add $|V|$ to the **Definition** field.

d. Click $y^x$ to raise the last entry in the **Definition** field to a power, and click 2 for the power.

e. Click the / button to add the division symbol to the **Definition** field, and then click 2.

f. Enter dynamic-head for **New Function Name**.

g. Click **Define** and close the **Custom Field Function Calculator** dialog box.

7. Display filled contours of the custom field function (Figure 3.11: Contours of the Dynamic Head Custom Field Function (p. 171)).

GRAPHICS AND ANIMATIONS ➔ CONTOURS ➔ SET UP...
a. Select **Custom Field Functions...** and **dynamic-head** from the **Contours of** drop-down lists.

**Tip**

**Custom Field Functions...** is at the top of the upper **Contours of** drop-down list.

b. Ensure that **symmetry** is selected from the **Surfaces** selection list.

c. Click **Display** and close the **Contours** dialog box.
**Figure 3.11: Contours of the Dynamic Head Custom Field Function**

**Note**
You may need to change the view by zooming out after the last vector display, if you have not already done so.

8. Save the settings for the custom field function by writing the case and data files (elbow1.cas.gz and elbow1.dat.gz).

**File → Write → Case & Data...**
a. Ensure that `elbow1.cas.gz` is entered for **Case/Data File**.

**Note**

When you write the case and data file at the same time, it does not matter whether you specify the file name with a `.cas` or `.dat` extension, as both will be saved.

b. Click **OK** to save the files and close the **Select File** dialog box.

c. Click **OK** to overwrite the files that you made earlier.

### 3.4.11. Using the Coupled Solver

The elbow solution computed in the first part of this tutorial used the SIMPLE solver scheme for Pressure-Velocity coupling. For many general fluid-flow problems, convergence speed can be improved by using the **Coupled solver**. You will now change the **Solution Method** to a coupled scheme.

1. Change the solver settings.

![Solution Methods](image)
a. Select **Coupled** from the **Scheme** drop-down list.

b. Leave the **Spatial Discretization** options at their default settings.

2. Re-initialize the flow field.

   ✤ **Solution Initialization**

   ![Solution Initialization](image)

   a. Leave the **Initialization Method** at the default **Hybrid Initialization**.

   b. Click **Initialize**.

3. Run the solution for an additional 90 iterations.

   ✤ **Run Calculation**

   ![Run Calculation](image)

   a. Ensure that **90** is entered for **Number of Iterations**.

   b. Click **Calculate**.
A dialog box will appear asking if you want to append data to `outlet-temp-avg.out`. Click **No**. Another dialog box will appear asking whether to **Overwrite** `outlet-temp-avg.out`. Click **OK**.

The solution will converge in approximately 35 iterations (Figure 3.12: Residuals for the Coupled Solver Calculation (p. 174)). Note that this is faster than the convergence rate using the SIMPLE pressure-velocity coupling. The convergence history is shown in Figure 3.13: Convergence History of Mass-Weighted Average Temperature (p. 175).

**Figure 3.12: Residuals for the Coupled Solver Calculation**
3.4.12. Adapting the Mesh

For the first two runs of this tutorial, you have solved the elbow problem using a fairly coarse mesh. The elbow solution can be improved further by refining the mesh to better resolve the flow details. ANSYS Fluent provides a built-in capability to easily adapt the mesh according to solution gradients. In the following steps you will adapt the mesh based on the temperature gradients in the current solution and compare the results with the previous results.

1. Adapt the mesh in the regions of high temperature gradient. For this task, you will use the Adapt command that is at the top of the ANSYS Fluent window.

   Adapt → Gradient...
a. Ensure that **Refine** is enabled in the **Options** group box.

   ANSYS Fluent will not coarsen beyond the original mesh for a 3D mesh. Hence, it is not necessary to deselect **Coarsen** in this instance.

b. Select **Temperature...** and **Static Temperature** from the **Gradients of** drop-down lists.

c. Click **Compute**.

   ANSYS Fluent will update the **Min** and **Max** values to show the minimum and maximum temperature gradient.

d. Enter **0.003** for **Refine Threshold**.

   A general rule is to use 10% of the maximum gradient when setting the value for **Refine Threshold**.

e. Click **Mark**.

   ANSYS Fluent will report in the console that approximately 1304 cells were marked for refinement.

f. Click **Manage...** in the **Gradient Adaptation** panel to open the **Manage Adaption Registers** dialog box.
i. Click **Display**.

ANSYS Fluent will display the cells marked for adaption in the graphics window (*Figure 3.14: Cells Marked for Adaption (p. 178)*).
Extra You can change the way ANSYS Fluent displays cells marked for adaption (Figure 3.15: Alternative Display of Cells Marked for Adaption (p. 180)) by performing the following steps:

A. Click **Options...** in the **Manage Adaption Registers** dialog box to open the **Adaption Display Options** dialog box.
B. Enable **Wireframe** in the **Refine** group box.

C. Enable **Filled** in the **Options** group box in the **Adaption Display Options** dialog box.

D. Enable **Draw Mesh** in the **Options** group box.

*The Mesh Display dialog box will open.*

E. Ensure that only the **Edges** option is enabled in the **Options** group box.

F. Select **Feature** from the **Edge Type** list.

G. Select all of the items except **default-interior** from the **Surfaces** selection list.

H. Click **Display** and close the **Mesh Display** dialog box.

I. Click **OK** to close the **Adaption Display Options** dialog box.

J. Click **Display** in the **Manage Adaption Registers** dialog box.
K. Rotate the view and zoom in to get the display shown in Figure 3.15: Alternative Display of Cells Marked for Adaption (p. 180).

**Figure 3.15: Alternative Display of Cells Marked for Adaption**

L. After viewing the marked cells, rotate the view back and zoom out again.

ii. Ensure that \textit{gradient-r0} is selected from the \textbf{Registers} selection list.

iii. Click \textbf{Adapt} in the \textbf{Manage Adaption Registers} dialog box.

\textit{A Question} dialog box will open, confirming your intention to adapt the mesh. Click \textbf{Yes} to proceed.
iv. Close the Manage Adaption Registers dialog box.

g. Close the Gradient Adaption dialog box.

2. Display the adapted mesh (Figure 3.16: The Adapted Mesh (p. 182)).

General → Display...

a. Select All in the Edge Type group box.

b. Deselect all of the highlighted items from the Surfaces selection list except for symmetry.

Tip

To deselect all surfaces click the far-right unshaded button at the top of the Surfaces selection list, and then select the desired surfaces from the Surfaces selection list.

c. Click Display and close the Mesh Display dialog box.
3. Request an additional 90 iterations.

- **Run Calculation**

  Click **Calculate**.
The solution will converge after approximately 35 additional iterations (Figure 3.17: The Complete Residual History (p. 183) and Figure 3.18: Convergence History of Mass-Weighted Average Temperature (p. 184)).

**Figure 3.17: The Complete Residual History**
4. Save the case and data files for the Coupled solver solution with an adapted mesh (elbow2.cas.gz and elbow2.dat.gz).

**File → Write → Case & Data...**

a. Enter elbow2.gz for Case/Data File.

b. Click OK to save the files and close the Select File dialog box.

*The files elbow2.cas.gz and elbow2.dat.gz will be saved in your default directory.*

5. Examine the filled temperature distribution (using node values) on the revised mesh (Figure 3.19: Filled Contours of Temperature Using the Adapted Mesh (p. 185)).

**Graphics and Animations → Contours → Set Up...**
6. Display and save an XY plot of the temperature profile across the centerline of the outlet for the adapted solution (Figure 3.20: Outlet Temperature Profile for the Adapted Coupled Solver Solution (p. 187)).

        Plots → XY Plot → Set Up...
a. Disable **Write to File** in the **Options** group box.

   *The button that was originally labeled Write... will change to Plot.*

b. Ensure that **Temperature...** and **Static Temperature** are selected from the **Y Axis Function** drop-down lists.

c. Ensure that **z=0_outlet** is selected from the **Surfaces** selection list.

d. Click **Plot**.
e. Enable Write to File in the Options group box.

The button that was originally labeled Plot will change to Write...

f. Click Write... to open the Select File dialog box.

i. Enter outlet_temp2.xy for XY File.

ii. Click OK to save the temperature data.

g. Close the Solution XY Plot dialog box.

7. Display the outlet temperature profiles for both solutions on a single plot (Figure 3.21: Outlet Temperature Profiles for the Two Solutions (p. 190)).

Plot → File → Set Up...
a. Click the **Add...** button to open the **Select File** dialog box.

![Select File dialog box](image)

i. Click once on `outlet_temp1.xy` and `outlet_temp2.xy`.

![File XY Plot dialog box](image)
Each of these files will be listed with their directory in the XY File(s) list to indicate that they have been selected.

**Tip**

If you select a file by mistake, simply click the file in the XY File(s) list and then click Remove.

ii. Click OK to save the files and close the Select File dialog box.

b. Select the directory path ending in outlet_temp1.xy from the Files selection list.

c. Enter Before Adaption in the lowest text-entry box on the right (next to the Change Legend Entry button).

d. Click the Change Legend Entry button.

The item in the Legend Entries list for outlet_temp1.xy will be changed to Before Adaption. This legend entry will be displayed in the upper-left corner of the XY plot generated in a later step.

e. In a similar manner, change the legend entry for the directory path ending in outlet_temp2.xy to be Adapted Mesh.

f. Click Plot and close the File XY Plot dialog box.

**Figure 3.21: Outlet Temperature Profiles for the Two Solutions (p. 190)** shows the two temperature profiles at the centerline of the outlet. It is apparent by comparing both the shape of the profiles and the predicted outer wall temperature that the solution is highly dependent on the mesh and solution options. Specifically, further mesh adaption should be used in order to obtain a solution that is independent of the mesh.
Note

When reading and writing data values, Fluent always uses SI units. Therefore when you read in the xy data files and plot them, the position and temperature values will be plotted in SI units, regardless of the settings made in the Units... dialog box earlier in the tutorial.

Extra

You can perform additional rounds of mesh adaption based on temperature gradient and run the calculation to see how the temperature profile changes at the outlet. A case and data file (elbow3.cas.gz and elbow3.dat.gz) have been provided in the solution_files directory, in which the mesh has undergone three more levels of adaption. The resulting temperature profiles have been plotted with outlet_temp1.xy and outlet_temp2.xy in Figure 3.22: Outlet Temperature Profiles for Subsequent Mesh Adaption Steps (p. 191).
It is evident from Figure 3.22: Outlet Temperature Profiles for Subsequent Mesh Adaption Steps (p. 191) that as the mesh is adapted further, the profiles converge on a mesh-independent profile. The resulting wall temperature at the outlet is predicted to be 300.6 K after mesh independence is achieved. If the adaption steps had not been performed, the wall temperature would have incorrectly been estimated at 299.1 K.

If computational resources allow, it is always recommended to perform successive rounds of adaption until the solution is independent of the mesh (within an acceptable tolerance). Typically, profiles of important variables are examined (in this case, temperature) and compared to determine mesh independence.

### 3.5. Summary

A comparison of the convergence speed for the SIMPLE and Coupled pressure-velocity coupling schemes indicates that the latter converges much faster. With more complex meshes, the difference in speed between the two schemes can be significant.

In this problem, the flow field is decoupled from temperature, since all properties are constant. For such cases, it is more efficient to compute the flow-field solution first (that is, without solving the energy equation) and then solve for energy (that is, without solving the flow equations). You will use the **Equations** dialog box to turn the solution of the equations on and off during such a procedure.
Chapter 4: Modeling Periodic Flow and Heat Transfer

This tutorial is divided into the following sections:
4.1. Introduction
4.2. Prerequisites
4.3. Problem Description
4.4. Setup and Solution
4.5. Summary
4.6. Further Improvements

4.1. Introduction

Many industrial applications, such as steam generation in a boiler or air cooling in the coil of an air conditioner, can be modeled as two-dimensional periodic heat flow. This tutorial illustrates how to set up and solve a periodic heat transfer problem, given a pre-generated mesh.

The system that is modeled is a bank of tubes containing a flowing fluid at one temperature that is immersed in a second fluid in cross flow at a different temperature. Both fluids are water, and the flow is classified as laminar and steady, with a Reynolds number of approximately 100. The mass flow rate of the cross flow is known and the model is used to predict the flow and temperature fields that result from convective heat transfer.

Due to symmetry of the tube bank and the periodicity of the flow inherent in the tube bank geometry, only a portion of the geometry will be modeled in ANSYS Fluent, with symmetry applied to the outer boundaries. The resulting mesh consists of a periodic module with symmetry. In the tutorial, the inlet boundary will be redefined as a periodic zone, and the outflow boundary defined as its shadow.

This tutorial demonstrates how to do the following:

• Create periodic zones.
• Define a specified periodic mass flow rate.
• Model periodic heat transfer with specified temperature boundary conditions.
• Calculate a solution using the pressure-based, pseudo-transient, coupled solver.
• Plot temperature profiles on specified isosurfaces.

4.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.

4.3. Problem Description

This problem considers a 2D section of a tube bank. A schematic of the problem is shown in Figure 4.1: Schematic of the Problem (p. 194). The bank consists of uniformly-spaced tubes with a diameter of 1 cm, which are staggered across the cross-fluid flow. Their centers are separated by a distance of 2 cm in the \( x \) direction, and 1 cm in the \( y \) direction. The bank has a depth of 1 m.

Figure 4.1: Schematic of the Problem

Because of the symmetry of the tube bank geometry, only a portion of the domain must be modeled. The computational domain is shown in outline in Figure 4.1: Schematic of the Problem (p. 194). A mass flow rate of 0.05 kg/s is applied to the inlet boundary of the periodic module. The temperature of the tube wall (\( T_{\text{wall}} \)) is 400 K and the bulk temperature of the cross flow water (\( T_{\text{bulk}} \)) is 300 K. The properties of water that are used in the model are shown in Figure 4.1: Schematic of the Problem (p. 194).

4.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

4.4.1. Preparation
4.4.2. Mesh
4.4.3. General Settings
4.4.4. Models
4.4.5. Materials
4.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

   **Note**
   
   If you do not have a login, you can request one by clicking Customer Registration on the login page.

3. Enter the name of this tutorial into the search bar.
4. Narrow the results by using the filter on the left side of the page.
   a. Click ANSYS Fluent under Product.
   b. Click 15.0 under Version.
5. Select this tutorial from the list.
6. Click Files to download the input and solution files.
7. Unzip periodic_flow_heat_R150.zip to your working folder.

   The file tubebank.msh can be found in the periodic_flow_heat folder created after unzipping the file.

8. Use Fluent Launcher to start the 2D version of ANSYS Fluent.

   Fluent Launcher displays your Display Options preferences from the previous session.

   For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in the User’s Guide.

9. Ensure that the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color Scheme options are enabled.
10. Ensure that you are running in single precision (disable Double Precision).
11. Select Serial under Processing Options.

4.4.2. Mesh

1. Read the mesh file tubebank.msh.
File → Read → Mesh...

2. Check the mesh.

יש במשה את ביניים...

ANSYS Fluent will perform various checks on the mesh and report the progress in the ANSYS Fluent console window. Ensure that the minimum volume reported is a positive number.

3. Scale the mesh.

יש במשה את ביניים...

a. Select cm (centimeters) from the Mesh Was Created In drop-down list in the Scaling group box.

b. Click Scale to scale the mesh.

c. Close the Scale Mesh dialog box.

4. Check the mesh.

יש ביניים את ביניים...

Note

It is a good idea to check the mesh after you manipulate it (scale, convert to polyhedra, merge, separate, fuse, add zones, or smooth and swap.) This will ensure that the quality of the mesh has not been compromised.

5. Examine the mesh (Figure 4.2: Mesh for the Periodic Tube Bank (p. 197)).
Quadrilateral cells are used in the regions surrounding the tube walls and triangular cells are used for the rest of the domain, resulting in a hybrid mesh (see Figure 4.2: Mesh for the Periodic Tube Bank (p. 197)). The quadrilateral cells provide better resolution of the viscous gradients near the tube walls. The remainder of the computational domain is filled with triangular cells for the sake of convenience.

**Extra**

You can use the right mouse button to probe for mesh information in the graphics window. If you click the right mouse button on any node in the mesh, information will be displayed in the ANSYS Fluent console about the associated zone, including the name of the zone. This feature is especially useful when you have several zones of the same type and you want to distinguish between them quickly.

6. Create the periodic zone.
The inlet (wall-9) and outflow (wall-12) boundaries currently defined as wall zones need to be redefined as periodic using the text user interface. The wall-9 boundary will be redefined as a translationally periodic zone and wall-12 as a periodic shadow of wall-9.

a. Press <Enter> in the console to get the command prompt (>).

b. Enter the text command and input the responses outlined in boxes as shown:

```
mesh/modify-zones/make-periodic
```

Periodic zone [()] 9
Shadow zone [()] 12
Rotational periodic? (if no, translational) [yes] no
Create periodic zones? [yes] yes
Auto detect translation vector? [yes] yes

zone 12 deleted
created periodic zones.

4.4.3. General Settings

1. Retain the default settings for the solver.

![General Settings](image)

4.4.4. Models

1. Enable heat transfer.

![Models](image)
a. Enable **Energy Equation**.

b. Click **OK** to close the **Energy** dialog box.

### 4.4.5. Materials

The default properties for water defined in ANSYS Fluent are suitable for this problem. In this step, you will make sure that this material is available for selecting in future steps.

1. Add water to the list of fluid materials by copying it from the ANSYS Fluent materials database.

   ![Materials](image)

   a. Click **Fluent Database...** in the **Create/Edit Materials** dialog box to open the **Fluent Database Materials** dialog box.
i. Select **water-liquid (h2o<l>)** in the **Fluent Fluid Materials** selection list.

*Scroll down the list to find water-liquid (h2o<l>). Selecting this item will display the default properties in the dialog box.*

ii. Click **Copy** and close the **Fluent Database Materials** dialog box.

*The Create/Edit Materials dialog box will now display the copied properties for water-liquid.*
b. Click **Change/Create** and close the **Create/Edit Materials** dialog box.

### 4.4.6. Cell Zone Conditions

1. Set the cell zone conditions for the continuum fluid zone (**fluid-16**).

   ![Cell Zone Conditions](fluid-16-edit)
a. Select **water-liquid** from the **Material Name** drop-down list.

b. Click **OK** to close the **Fluid** dialog box.

### 4.4.7. Periodic Conditions

1. Define the periodic flow conditions.

   ![Boundary Conditions ➔ periodic-9 ➔ Periodic Conditions...](image)
a. Select Specify Mass Flow in the Type list. 

This will allow you to specify the Mass Flow Rate.

b. Enter 0.05 kg/s for Mass Flow Rate.

c. Click OK to close the Periodic Conditions dialog box.

4.4.8. Boundary Conditions

1. Set the boundary conditions for the bottom wall of the left tube (wall-21).

 Boundary Conditions → wall-21 → Edit...
a. Enter wall-bottom for Zone Name.

b. Click the Thermal tab.
   i. Select Temperature in the Thermal Conditions list.
   ii. Enter 400 K for Temperature.

   *These settings will specify a constant wall temperature of 400 K.*

c. Click OK to close the Wall dialog box.

2. Set the boundary conditions for the top wall of the right tube (wall-3).

   ![Boundary Conditions](image)

   a. Enter wall-top for Zone Name.

   b. Click the Thermal tab.
      i. Select Temperature from the Thermal Conditions list.
      ii. Enter 400 K for Temperature.

   c. Click OK to close the Wall dialog box.

### 4.4.9. Solution

1. Set the solution parameters.
Solution Methods

Solution Methods

Pressure-Velocity Coupling

- Select Coupled from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

Spatial Discretization

- Retain the default setting of Least Squares Cell Based for the Gradient in the Spatial Discretization group box.
- Retain the default setting of Second Order for the Pressure drop-down list.
- Retain the default setting of Second Order Upwind in the Momentum and Energy drop-down lists.
- Enable Pseudo Transient.

The Pseudo Transient option enables the pseudo transient algorithm in the coupled pressure-based solver. This algorithm effectively adds an unsteady term to the solution equations in order to improve stability and convergence behavior. Use of this option is recommended for general fluid flow problems.

2. Set the solution controls.

Solution Controls
Solution Controls

Pseudo Transient Explicit Relaxation Factors

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pressure</td>
<td>0.5</td>
</tr>
<tr>
<td>Momentum</td>
<td>0.5</td>
</tr>
<tr>
<td>Density</td>
<td>1</td>
</tr>
<tr>
<td>Body Forces</td>
<td>1</td>
</tr>
<tr>
<td>Energy</td>
<td>0.75</td>
</tr>
</tbody>
</table>

- Retain the default values in the **Pseudo Transient Explicit Relaxation Factors** group box.

  *In some cases, the default Pseudo Transient Explicit Relaxation Factors may need to be reduced in order to prevent oscillation of residual values or stabilization of residual values above the convergence criteria. For additional information about setting Pseudo Transient Explicit Relaxation Factors, see Setting Pseudo Transient Explicit Relaxation Factors in the Fluent User’s Guide.*

3. Enable the plotting of residuals during the calculation.

![Monitors → Residuals → Edit...](image)
a. Ensure **Plot** is enabled in the **Options** group box.

b. Click **OK** to close the **Residual Monitors** dialog box.

4. Initialize the solution.

   ↪ **Solution Initialization**

   ![Solution Initialization](image)

   a. Retain the default selection of **Hybrid Initialization** in the **Initialization Methods** group box.

   b. Click **Initialize**.

   c. Patch the fluid zone with the bulk upstream temperature value.

   "The Hybrid Initialization method computes the initial flow field based on inlet and outlet boundary conditions. In this case we have periodic boundary conditions with a specified upstream bulk temperature. You will patch the initialized solution with this temperature value in order to improve convergence."

   ↪ **Solution Initialization** → **Patch**

   ![Patch](image)
i. Select **Temperature** in the **Variable** selection list.

ii. Enter 300 for **Value (k)**.

   *Recall that the upstream bulk temperature, $T_{\text{bulk}}$, is specified as 300 K.*

iii. Select **fluid-16** in the **Zones to Patch** selection list.

iv. Click **Patch** and close the **Patch** dialog box.

5. Save the case file (*tubebank.cas.gz*).

   **File → Write → Case...**

6. Start the calculation by requesting 350 iterations.

   **Run Calculation**

   ![Run Calculation dialog](image)

   a. Enter 350 for **Number of Iterations**.
   
   b. Click **Calculate**.

   *The solution will converge in approximately 111 iterations.*

7. Save the case and data files (*tubebank.cas.gz* and *tubebank.dat.gz*).

   **File → Write → Case & Data...**
4.4.10. Postprocessing

1. Display filled contours of static pressure (Figure 4.3: Contours of Static Pressure (p. 210)).

   ![Graphics and Animations → Contours → Set Up...](image)

   a. Enable **Filled** in the **Options** group box.

   b. Retain the default selection of **Pressure...** and **Static Pressure** from the **Contours of** drop-down lists.

   c. Click **Display**.
d. Change the view to mirror the display across the symmetry planes (Figure 4.4: Contours of Static Pressure with Symmetry (p. 212)).

Graphics and Animations → Views...
i. Select all of the symmetry zones (symmetry-18, symmetry-13, symmetry-11, and symmetry-24) in the Mirror Planes selection list by clicking in the upper right corner.

**Note**

There are four symmetry zones in the Mirror Planes selection list because the top and bottom symmetry planes in the domain are each comprised of two symmetry zones, one on each side of the tube centered on the plane. It is also possible to generate the same display shown in Figure 4.4: Contours of Static Pressure with Symmetry (p. 212) by selecting just one of the symmetry zones on the top symmetry plane, and one on the bottom.

ii. Click **Apply** and close the **Views** dialog box.

iii. Translate the display of symmetry contours so that it is centered in the graphics window by using the left mouse button (Figure 4.4: Contours of Static Pressure with Symmetry (p. 212)).
The pressure contours displayed in Figure 4.4: Contours of Static Pressure with Symmetry (p. 212) do not include the linear pressure gradient computed by the solver. Thus, the contours are periodic at the inlet and outflow boundaries.

2. Display filled contours of static temperature (Figure 4.5: Contours of Static Temperature (p. 214)).

Graphics and Animations → Contours → Set Up...
a. Select **Temperature**... and **Static Temperature** from the **Contours of** drop-down lists.

b. Click **Display** and close the **Contours** dialog box.
Figure 4.5: Contours of Static Temperature

The contours in Figure 4.5: Contours of Static Temperature reveal the temperature increase in the fluid due to heat transfer from the tubes. The hotter fluid is confined to the near-wall and wake regions, while a narrow stream of cooler fluid is convected through the tube bank.

3. Display the velocity vectors (Figure 4.6: Velocity Vectors).

Graphics and Animations → Vectors → Set Up...
a. Enter 2 for **Scale**.

   *This will increase the size of the displayed vectors, making it easier to view the flow patterns.*

b. Retain the default selection of **Velocity** from the **Vectors of** drop-down list.

c. Retain the default selection of **Velocity**... and **Velocity Magnitude** from the **Color by** drop-down lists.

d. Click **Display** and close the **Vectors** dialog box.

e. Zoom in on the upper right portion of one of the left tubes to get the display shown in (Figure 4.6: Velocity Vectors (p. 216)), by using the middle mouse button in the graphics window.

   *The magnified view of the velocity vector plot in Figure 4.6: Velocity Vectors (p. 216) clearly shows the recirculating flow behind the tube and the boundary layer development along the tube surface.*
4. Create an isosurface on the periodic tube bank at $x = 0.01$ m (through the first column of tubes).

*This isosurface and the ones created in the steps that follow will be used for the plotting of temperature profiles.*

**Surface → Iso-Surface...**
a. Select **Mesh...** and **X-Coordinate** from the **Surface of Constant** drop-down lists.

b. Enter 0.01 for **Iso-Values**.

c. Enter x=0.01m for **New Surface Name**.

d. Click **Create**.

5. In a similar manner, create an isosurface on the periodic tube bank at x = 0.02 m (halfway between the two columns of tubes) named x=0.02m.

6. In a similar manner, create an isosurface on the periodic tube bank at x = 0.03 m (through the middle of the second column of tubes) named x=0.03m, and close the **Iso-Surface** dialog box.

7. Create an **XY** plot of static temperature on the three isosurfaces (Figure 4.7: Static Temperature at x=0.01, 0.02, and 0.03 m (p. 219)).

   ![Plots → XY Plot → Set Up...]
a. Enter 0 for X and 1 for Y in the Plot Direction group box.

With a Plot Direction vector of \((0, 1)\), ANSYS Fluent will plot the selected variable as a function of y. Since you are plotting the temperature profile on cross sections of constant x, the temperature varies with the y direction.

b. Select Temperature... and Static Temperature from the Y-Axis Function drop-down lists.

c. Select \(x=0.01\text{m}\), \(x=0.02\text{m}\), and \(x=0.03\text{m}\) in the Surfaces selection list.

Scroll down to find the \(x=0.01\text{m}\), \(x=0.02\text{m}\), and \(x=0.03\text{m}\) surfaces.

d. Click the Curves... button to open the Curves - Solution XY Plot dialog box.

This dialog box is used to define plot styles for the different plot curves.

i. Select + from the Symbol drop-down list.

Scroll up to find the + item.
ii. Click **Apply** to assign the + symbol to the $x = 0.01$ m curve.

iii. Set the **Curve #** to 1 to define the style for the $x = 0.02$ m curve.

iv. Select **x** from the **Symbol** drop-down list.

   *Scroll up to find the x item.*

v. Enter 0.5 for **Size**.

vi. Click **Apply** and close the **Curves - Solution XY Plot** dialog box.

   *Since you did not change the curve style for the $x = 0.03$ m curve, the default symbol will be used.*

    e. Click **Plot** and close the **Solution XY Plot** dialog box.

**Figure 4.7: Static Temperature at $x=0.01$, 0.02, and 0.03 m**

---

### 4.5. Summary

In this tutorial, periodic flow and heat transfer in a staggered tube bank were modeled in ANSYS Fluent. The model was set up assuming a known mass flow through the tube bank and constant wall temperatures. Due to the periodic nature of the flow and symmetry of the geometry, only a small piece of the full geometry was modeled. In addition, the tube bank configuration lent itself to the use of a hybrid mesh with quadrilateral cells around the tubes and triangles elsewhere.

The **Periodic Conditions** dialog box makes it easy to run this type of model with a variety of operating conditions. For example, different flow rates (and hence different Reynolds numbers) can be studied,
or a different inlet bulk temperature can be imposed. The resulting solution can then be examined to extract the pressure drop per tube row and overall Nusselt number for a range of Reynolds numbers.

For additional details about modeling periodic heat transfer, see Modeling Periodic Heat Transfer in the Fluent User’s Guide.

**4.6. Further Improvements**

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by adapting the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 5: Modeling External Compressible Flow

This tutorial is divided into the following sections:
5.1. Introduction
5.2. Prerequisites
5.3. Problem Description
5.4. Setup and Solution
5.5. Summary
5.6. Further Improvements

5.1. Introduction

The purpose of this tutorial is to compute the turbulent flow past a transonic airfoil at a nonzero angle of attack. You will use the Spalart-Allmaras turbulence model.

This tutorial demonstrates how to do the following:

• Model compressible flow (using the ideal gas law for density).
• Set boundary conditions for external aerodynamics.
• Use the Spalart-Allmaras turbulence model.
• Use Full Multigrid (FMG) initialization to obtain better initial field values.
• Calculate a solution using the pressure-based coupled solver with the pseudo transient option.
• Use force and surface monitors to check solution convergence.
• Check the near-wall mesh resolution by plotting the distribution of $y^+$.

5.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.
5.3. Problem Description

The problem considers the flow around an airfoil at an angle of attack $\alpha = 4^\circ$ and a free stream Mach number of $0.8$ ($M_{\infty} = 0.8$). The flow is transonic, and has a fairly strong shock near the mid-chord ($x/c = 0.45$) on the upper (suction) side. The chord length is 1 m. The geometry of the airfoil is shown in Figure 5.1: Problem Specification (p. 222).

![Figure 5.1: Problem Specification](image)

5.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

5.4.1. Preparation
5.4.2. Mesh
5.4.3. General Settings
5.4.4. Models
5.4.5. Materials
5.4.6. Boundary Conditions
5.4.7. Operating Conditions
5.4.8. Solution
5.4.9. Postprocessing

5.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.
2. Go to the ANSYS Customer Portal, [https://support.ansys.com/training](https://support.ansys.com/training).

   **Note**
   
   If you do not have a login, you can request one by clicking **Customer Registration** on the log in page.

3. Enter the name of this tutorial into the search bar.
4. Narrow the results by using the filter on the left side of the page.
   a. Click **ANSYS Fluent** under **Product**.
   b. Click **15.0** under **Version**.
5. Select this tutorial from the list.
6. Click **Files** to download the input and solution files.

7. **Unzip** `external_compressible_R150.zip` to your working folder.

   The file `airfoil.msh` can be found in the `external_compressible` folder created after unzipping the file.

8. Use Fluent Launcher to start the **2D** version of ANSYS Fluent.

   Fluent Launcher displays your **Display Options** preferences from the previous session.

   For more information about Fluent Launcher, see *Starting ANSYS Fluent Using Fluent Launcher* in the User’s Guide.

9. Ensure that the **Display Mesh After Reading**, **Embed Graphics Windows**, and **Workbench Color Scheme** options are enabled.

10. Enable **Double Precision**.

11. Ensure **Serial** is selected under **Processing Options**.

### 5.4.2. Mesh

1. Read the mesh file `airfoil.msh`.

   **File → Read → Mesh...**

2. Check the mesh.

   ![General → Check](image)

   ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Make sure that the reported minimum volume is a positive number.

   **Note**

   ANSYS Fluent will issue a warning concerning the high aspect ratios of some cells and possible impacts on calculation of Cell Wall Distance. The warning message includes recommendations for verifying and correcting the Cell Wall Distance calculation. In this particular case the cell aspect ratio does not cause problems so no further action is required. As an optional activity, you can confirm this yourself after the solution is generated by plotting Cell Wall Distance as noted in the warning message.

3. Examine the mesh (Figure 5.2: The Entire Mesh (p. 224) and Figure 5.3: Magnified View of the Mesh Around the Airfoil (p. 225)).
Quadrilateral cells were used for this simple geometry because they can be stretched easily to account for different flow gradients in different directions. In the present case, the gradients normal to the airfoil wall are much greater than those tangent to the airfoil. Consequently, the cells near the surface have high aspect ratios. For geometries that are more difficult to mesh, it may be easier to create a hybrid mesh comprised of quadrilateral and triangular cells.
A parabola was chosen to represent the far-field boundary because it has no discontinuities in slope, enabling the construction of a smooth mesh in the interior of the domain.

Extra

You can use the right mouse button to probe for mesh information in the graphics window. If you click the right mouse button on any node in the mesh, information will be displayed in the ANSYS Fluent console about the associated zone, including the name of the zone. This feature is especially useful when you have several zones of the same type and you want to distinguish between them quickly.

4. Reorder the mesh.

Mesh → Reorder → Domain
This is done to reduce the bandwidth of the cell neighbor number and to speed up the computations. This is especially important for large cases involving 1 million or more cells. The method used to reorder the domain is the Reverse Cuthill-McKee method.

### 5.4.3. General Settings

1. Set the solver settings.

   ![Solver Settings](image)

   a. Retain the default selection of **Pressure-Based** from the **Type** list.

   The pressure-based solver with the **Coupled** option for the pressure-velocity coupling is a good alternative to density-based solvers of ANSYS Fluent when dealing with applications involving high-speed aerodynamics with shocks. Selection of the coupled algorithm is made in the **Solution Methods** task page in the Solution step.

### 5.4.4. Models

1. Select the Spalart-Allmaras turbulence model.

   ![Models](image)
a. Select **Spalart-Allmaras (1eqn)** in the **Model** list.

b. Select **Strain/Vorticity-Based** in the **Spalart-Allmaras Production** list.

c. Retain the default settings in the **Model Constants** group box.

d. Click **OK** to close the **Viscous Model** dialog box.

---

**Note**

The Spalart-Allmaras model is a relatively simple one-equation model that solves a modeled transport equation for the kinematic eddy (turbulent) viscosity. This embodies a relatively new class of one-equation models in which it is not necessary to calculate a length scale related to the local shear layer thickness. The Spalart-Allmaras model was designed specifically for aerospace applications involving wall-bounded flows and has been shown to give good results for boundary layers subjected to adverse pressure gradients.

---

### 5.4.5. Materials

The default **Fluid Material** is air, which is the working fluid in this problem. The default settings need to be modified to account for compressibility and variations of the thermophysical properties with temperature.

1. Set the properties for **air**, the default fluid material.

   ![Material Properties Dialog]

   1. **Materials** → **air** → **Create/Edit...**
a. Select **ideal-gas** from the **Density** drop-down list.

   *The Energy Equation will be enabled.*

b. Select **sutherland** from the **Viscosity** drop-down list to open the **Sutherland Law** dialog box.

   Scroll down the **Viscosity** drop-down list to find **sutherland**.

i. Retain the default selection of **Three Coefficient Method** in the **Methods** list.

ii. Click **OK** to close the **Sutherland Law** dialog box.

*The Sutherland law for viscosity is well suited for high-speed compressible flows.*
c. Click **Change/Create** to save these settings.

d. Close the **Create/Edit Materials** dialog box.

While *Density* and *Viscosity* have been made temperature-dependent, *Cp (Specific Heat)* and *Thermal Conductivity* have been left constant. For high-speed compressible flows, thermal dependency of the physical properties is generally recommended. For simplicity, *Thermal Conductivity* and *Cp (Specific Heat)* are assumed to be constant in this tutorial.

### 5.4.6. Boundary Conditions

**Boundary Conditions**

1. Set the boundary conditions for **pressure-far-field-1**.

   ![Boundary Conditions](image)
a. Retain the default value of 0 Pa for **Gauge Pressure**.

**Note**

The gauge pressure in ANSYS Fluent is always relative to the operating pressure, which is defined in a separate input (see below).

b. Enter 0.8 for **Mach Number**.

c. Enter 0.997564 and 0.069756 for the **X-Component of Flow Direction** and **Y-Component of Flow Direction**, respectively.

*These values are determined by the 4° angle of attack: \( \cos 4° \approx 0.997564 \) and \( \sin 4° \approx 0.069756 \).*

d. Retain **Turbulent Viscosity Ratio** from the Specification Method drop-down list in the **Turbulence** group box.

e. Retain the default value of 10 for **Turbulent Viscosity Ratio**.

*The viscosity ratio should be between 1 and 10 for external flows.*

f. Click the **Thermal** tab and retain the default value of 300 K for **Temperature**.
g. Click **OK** to close the **Pressure Far-Field** dialog box.

### 5.4.7. Operating Conditions

1. Set the operating pressure.

   ![Operating Conditions dialog box]

   *The Operating Conditions dialog box can also be accessed from the Cell Zone Conditions task page.*

   a. Retain the default value of 101325 Pa for **Operating Pressure**.
The operating pressure should be set to a meaningful mean value in order to avoid round-off errors. The absolute pressure must be greater than zero for compressible flows. If you want to specify boundary conditions in terms of absolute pressure, you can make the operating pressure zero.

b. Click OK to close the Operating Conditions dialog box.

For information about setting the operating pressure, see Operating Pressure in the User’s Guide.

5.4.8. Solution

1. Set the solution parameters.

Solution Methods

<table>
<thead>
<tr>
<th>Solution Methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pressure-Velocity Coupling</td>
</tr>
<tr>
<td>Scheme</td>
</tr>
<tr>
<td>Spatial Discretization</td>
</tr>
<tr>
<td>Gradient</td>
</tr>
<tr>
<td>Pressure</td>
</tr>
<tr>
<td>Density</td>
</tr>
<tr>
<td>Momentum</td>
</tr>
<tr>
<td>Modified Turbulent Viscosity</td>
</tr>
<tr>
<td>Transient Formulation</td>
</tr>
<tr>
<td>Non-Iterative Time Advancement</td>
</tr>
<tr>
<td>Frozen Flux Formulation</td>
</tr>
<tr>
<td>Pseudo Transient</td>
</tr>
<tr>
<td>High Order Term Relaxation</td>
</tr>
<tr>
<td>Default</td>
</tr>
</tbody>
</table>

a. Select Coupled from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

b. Retain the default selection of Least Squares Cell Based from the Gradient drop-down list in the Spatial Discretization group box.

c. Retain the default selection of Second Order from the Pressure drop-down list.

d. Select Second Order Upwind from the Modified Turbulent Viscosity drop-down list.

e. Enable Pseudo Transient.
The Pseudo Transient option enables the pseudo transient algorithm in the coupled pressure-based solver. This algorithm effectively adds an unsteady term to the solution equations in order to improve stability and convergence behavior. Use of this option is recommended for general fluid flow problems.

2. Set the solution controls.

Solution Controls

<table>
<thead>
<tr>
<th>Pseudo Transient Explicit Relaxation Factors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Density</td>
</tr>
<tr>
<td>0.5</td>
</tr>
<tr>
<td>Body Forces</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>Modified Turbulent Viscosity</td>
</tr>
<tr>
<td>0.9</td>
</tr>
<tr>
<td>Turbulent Viscosity</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>Energy</td>
</tr>
<tr>
<td>0.75</td>
</tr>
</tbody>
</table>

- Enter 0.5 for **Density** in the **Pseudo Transient Explicit Relaxation Factors** group box.
  
  *Under-relaxing the density factor is recommended for high-speed compressible flows.*

- Enter 0.9 for **Modified Turbulent Viscosity**.
  
  *Larger under-relaxation factors (that is, closer to 1) will generally result in faster convergence. However, instability can arise that may need to be eliminated by decreasing the under-relaxation factors.*

3. Enable residual plotting during the calculation.

**Monitors** → **Residuals** → **Edit...**
a. Ensure that **Plot** is enabled in the **Options** group box and click **OK** to close the **Residual Monitors** dialog box.

4. Initialize the solution.

Solution Initialization

a. Retain the default selection of **Hybrid Initialization** from the **Initialization Methods** group box.

b. Click **Initialize** to initialize the solution.

c. Run the Full Multigrid (FMG) initialization.

   *FMG initialization often facilitates an easier start-up, where no CFL (Courant Friedrichs Lewy) ramping is necessary, thereby reducing the number of iterations for convergence.*

i. Press **Enter** in the console to get the command prompt (>).
ii. Enter the text commands and input responses as shown in the boxes. Accept the default values by pressing Enter when no input response is given:

```
solve/initialize/set-fmg-initialization
```

Customize your FMG initialization:
set the number of multigrid levels [5]

set FMG parameters on levels ..

residual reduction on level 1 is: 0.001
number of cycles on level 1 is: 100

residual reduction on level 2 is: 0.001
number of cycles on level 2 is: 50

residual reduction on level 3 is: 0.001
number of cycles on level 3 is: 100

residual reduction on level 4 is: 0.001
number of cycles on level 4 is: 500

residual reduction on level 5 [coarsest grid] is: 0.001
number of cycles on level 5 is: 500

Number of FMG (and FAS geometric multigrid) levels: 5
* FMG customization summary:
  * residual reduction on level 0 [finest grid] is: 0.001
  * number of cycles on level 0 is: 1
  * residual reduction on level 1 is: 0.001
  * number of cycles on level 1 is: 100
  * residual reduction on level 2 is: 0.001
  * number of cycles on level 2 is: 100
  * residual reduction on level 3 is: 0.001
  * number of cycles on level 3 is: 100
  * residual reduction on level 4 is: 0.001
  * number of cycles on level 4 is: 500
  * residual reduction on level 5 [coarsest grid] is: 0.001
  * number of cycles on level 5 is: 500
* FMG customization complete

set FMG courant-number [0.75]

enable FMG verbose? [no] yes

```
solve/initialize/fmg-initialization
```

Enable FMG initialization? [no] yes

---

**Note**

Whenever FMG initialization is performed, it is important to inspect the FMG initialized flow field using the postprocessing tools of ANSYS Fluent. Monitoring the normalized residuals, which are plotted in the console window, will give you an idea of the convergence of the FMG solver. You should notice that the value of the normalized residuals decreases. For information about FMG initialization, including convergence strategies, see Full Multigrid (FMG) Initialization in the User’s Guide.

---

5. Save the case and data files (airfoil.cas.gz and airfoil.dat.gz).

File → Write → Case & Data...

*It is good practice to save the case and data files during several stages of your case setup.*
6. Start the calculation by requesting 50 iterations.

   ![Run Calculation](image.png)

   a. Enter 50 for Number of Iterations.

   b. Click Calculate.

   By performing some iterations before setting up the force monitors, you will avoid large initial transients in the monitor plots. This will reduce the axes range and make it easier to judge the convergence.

7. Set the reference values that are used to compute the lift, drag, and moment coefficients.

   ![Reference Values](image.png)

   The reference values are used to nondimensionalize the forces and moments acting on the airfoil. The dimensionless forces and moments are the lift, drag, and moment coefficients.

   a. Select pressure-far-field-1 from the Compute from drop-down list.

   ANSYS Fluent will update the Reference Values based on the boundary conditions at the far-field boundary.
8. Define a force monitor to plot and write the drag coefficient for the walls of the airfoil.

**Monitors (Residuals, Statistic and Force Monitors) → Create → Drag...**

![Drag Monitor dialog box]

- Enable **Plot** in the **Options** group box.
- Enable **Write** to save the monitor history to a file.
  
  **Note**
  
  If you do not enable the **Write** option, the history information will be lost when you exit ANSYS Fluent.

- Retain the default entry of `cd-1-history` for **File Name**.
- Select **wall-bottom** and **wall-top** in the **Wall Zones** selection list.
- Enter 0.9976 for **X** and 0.06976 for **Y** in the **Force Vector** group box.
  
  *These X and Y values ensure that the drag coefficient is calculated parallel to the free-stream flow, which is 4° off of the global coordinates.*
- Click **OK** to close the **Drag Monitor** dialog box.
9. Similarly, define a force monitor for the lift coefficient.

![Monitors → Create → Lift...](image)

Enter the values for $X$ and $Y$ shown in the **Lift Monitor** dialog box.

*The $X$ and $Y$ values shown ensure that the lift coefficient is calculated normal to the free-stream flow, which is $4^\circ$ off of the global coordinates.*

10. In a similar manner, define a force monitor for the moment coefficient.

![Monitors → Create → Moment...](image)
Enter the values for the **Moment Center** and **Moment Axis** shown in the **Moment Monitor** dialog box.

11. Display filled contours of pressure overlaid with the mesh in preparation for defining a surface monitor (Figure 5.4: Pressure Contours After 50 Iterations (p. 241) and Figure 5.5: Magnified View of Pressure Contours Showing Wall-Adjacent Cells (p. 242)).

![Moment Monitor dialog box](image)

Graphics and Animations → Contours → Set Up...
a. Enable **Filled** in the **Options** group box.

b. Enable **Draw Mesh** to open the **Mesh Display** dialog box.

i. Retain the default settings.

ii. Close the **Mesh Display** dialog box.

c. Click **Display** and close the **Contours** dialog box.
Figure 5.4: Pressure Contours After 50 Iterations

The shock is clearly visible on the upper surface of the airfoil, where the pressure jumps to a higher value downstream of the low pressure area.

Note

The color indicating a high pressure area near the leading edge of the airfoil is obscured by the overlaid green mesh. To view this contour, simply disable the **Draw Mesh** option in the **Contours** dialog box and click **Display**.

d. Zoom in on the shock wave, until individual cells adjacent to the upper surface (**wall-top** boundary) are visible, as shown in Figure 5.5: Magnified View of Pressure Contours Showing Wall-Adjacent Cells (p. 242).
The magnified region contains cells that are just downstream of the shock and adjacent to the upper surface of the airfoil. In the following step, you will create a point surface inside a wall-adjacent cell, which you will use to define a surface monitor.

12. Create a point surface just downstream of the shock wave.

Surface → Point...
**Note**

You have entered the exact coordinates of the point surface so that your convergence history will match the plots and description in this tutorial. In general, however, you will not know the exact coordinates in advance, so you will need to select the desired location in the graphics window. You do not have to apply the following instructions at this point in the tutorial; they are added here for your information:

a. In the **Point Surface** dialog box, click the **Select Point with Mouse** button. A **Working** dialog box will open telling you to “Click on a location in the graphics window with the MOUSE-PROBE mouse button.”

b. Position the mouse pointer at a point located inside one of the cells adjacent to the upper surface (**wall-top** boundary), downstream of the shock (see **Figure 5.6: Pressure Contours after Creating a Point with the Mouse** (p. 244)).

c. Click the right mouse button.

d. Click **Create** to create the point surface and then close the **Point Surface** dialog box.
Figure 5.6: Pressure Contours after Creating a Point with the Mouse

13. Enable residual plotting during the calculation.

Monitors → Residuals → Edit...
a. Ensure that Plot is enabled in the Options group box.

b. Select none from the Convergence Criterion drop-down list so that automatic convergence checking does not occur.

c. Click OK to close the Residual Monitors dialog box.

14. Define a surface monitor for tracking the velocity magnitude value at the point created in the previous step.

Since the drag, lift, and moment coefficients are global variables, indicating certain overall conditions, they may converge while local conditions at specific points are still varying from one iteration to the next. To account for this, define a monitor at a point (just downstream of the shock) where there is likely to be significant variation, and monitor the value of the velocity magnitude.

Monitors (Surface Monitors) ➔ Create...
a. Enable **Plot** and **Write**.

b. Select **Vertex Average** from the **Report Type** drop-down list.

   *Scroll down the **Report Type** drop-down list to find **Vertex Average**.*

c. Select **Velocity...** and **Velocity Magnitude** from the **Field Variable** drop-down list.

d. Select **point-4** in the **Surfaces** selection list.

e. Click **OK** to close the **Surface Monitor** dialog box.

15. Save the case and data files (`airfoil-1.cas.gz` and `airfoil-1.dat.gz`).

   *File → Write → Case & Data...*

16. Continue the calculation for 200 more iterations.

   *Run Calculation*

   The force monitors (*Figure 5.8: Drag Coefficient Convergence History* (p. 247) and *Figure 5.9: Lift Coefficient Convergence History* (p. 248)) show that the case is converged after approximately 200 iterations.
Figure 5.7: Velocity Magnitude History

Convergence history of Velocity Magnitude on point-4

ANSYS Fluent (2d, dp, pbns, S-A)

Figure 5.8: Drag Coefficient Convergence History

cd-1 Convergence History

ANSYS Fluent (2d, dp, pbns, S-A)
Figure 5.9: Lift Coefficient Convergence History

Figure 5.10: Moment Coefficient Convergence History

17. Save the case and data files (airfoil-2.cas.gz and airfoil-2.dat.gz).

File → Write → Case & Data...
5.4.9. Postprocessing

1. Plot the $y^+$ distribution on the airfoil (Figure 5.11: XY Plot of $y^+$ Distribution (p. 250)).

![Solution XY Plot](image)

- **Plots** → **XY Plot** → **Set Up**...

  a. Disable **Node Values** in the **Options** group box.
  
  b. Select **Turbulence**... and **Wall Yplus** from the **Y Axis Function** drop-down list.

    **Wall Yplus** is available only for cell values.

  c. Select **wall-bottom** and **wall-top** in the **Surfaces** selection list.
  
  d. Click **Plot** and close the **Solution XY Plot** dialog box.

**Note**

The values of $y^+$ are dependent on the resolution of the mesh and the Reynolds number of the flow, and are defined only in wall-adjacent cells. The value of $y^+$ in the wall-adjacent cells dictates how wall shear stress is calculated. When you use the Spalart-Allmaras model, you should check that $y^+$ of the wall-adjacent cells is either very small (on the order of $y^+ = 1$), or approximately 30 or greater. Otherwise, you should modify your mesh.

The equation for $y^+$ is

$$y^+ = \frac{y}{\mu \sqrt{\rho \tau_w}}$$

(5.1)
where $y$ is the distance from the wall to the cell center, $\mu$ is the molecular viscosity, $\rho$ is the density of the air, and $\tau_w$ is the wall shear stress.

**Figure 5.11: XY Plot of $y^+$ Distribution (p. 250)** indicates that, except for a few small regions (notably at the shock and the trailing edge), $y^+ > 30$ and for much of these regions it does not drop significantly below 30. Therefore, you can conclude that the near-wall mesh resolution is acceptable.

**Figure 5.11: XY Plot of $y^+$ Distribution**

2. Display filled contours of Mach number (**Figure 5.12: Contour Plot of Mach Number (p. 251)**).

   ![Graphics and Animations → Contours → Set Up...](image)

   a. Ensure **Filled** is enabled in the **Options** group box.

   b. Select **Velocity...** and **Mach Number** from the **Contours of** drop-down list.

   c. Click **Display** and close the **Contours** dialog box.

   d. Zoom in on the region around the airfoil, as shown in **Figure 5.12: Contour Plot of Mach Number (p. 251)**.
Figure 5.12: Contour Plot of Mach Number

Note the discontinuity, in this case a shock, on the upper surface of the airfoil in Figure 5.12: Contour Plot of Mach Number (p. 251) at about $x/c = 0.45$.

3. Plot the pressure distribution on the airfoil (Figure 5.13: XY Plot of Pressure (p. 252)).

   ✧ Plots →  XY Plot → Set Up...

   a. Enable Node Values.

   b. Select Pressure... and Pressure Coefficient from the Y Axis Function drop-down lists.

   c. Click Plot.
Figure 5.13: XY Plot of Pressure

Notice the effect of the shock wave on the upper surface in Figure 5.13: XY Plot of Pressure (p. 252).

4. Plot the $x$ component of wall shear stress on the airfoil surface (Figure 5.14: XY Plot of $x$ Wall Shear Stress (p. 253)).

   a. Disable Node Values.

   b. Select Wall Fluxes... and X-Wall Shear Stress from the Y Axis Function drop-down lists.

   c. Click Plot and close the Solution XY Plot dialog box.

As shown in Figure 5.14: XY Plot of $x$ Wall Shear Stress (p. 253), the large, adverse pressure gradient induced by the shock causes the boundary layer to separate. The point of separation is where the wall shear stress vanishes. Flow reversal is indicated here by negative values of the $x$ component of the wall shear stress.
5. Display filled contours of the $x$ component of velocity (Figure 5.15: Contour Plot of x Component of Velocity (p. 254)).

\[\text{Graphics and Animations} \rightarrow \text{Contours} \rightarrow \text{Set Up...}\]

a. Ensure \textbf{Filled} is enabled in the \textbf{Options} group box.

b. Select \textbf{Velocity...} and \textbf{X Velocity} from the \textbf{Contours of} drop-down lists.
   
   \textit{Scroll up in the Contours of drop-down list to find X Velocity.}

   c. Click \textbf{Display} and close the \textbf{Contours} dialog box.

Note the flow reversal downstream of the shock in Figure 5.15: Contour Plot of x Component of Velocity (p. 254).
Figure 5.15: Contour Plot of x Component of Velocity

6. Plot velocity vectors (Figure 5.16: Plot of Velocity Vectors Downstream of the Shock (p. 255)).

- Graphics and Animations → Vectors → Set Up...
  a. Enter 15 for Scale.
  b. Click Display and close the Vectors dialog box.
  c. Zoom in on the flow above the upper surface at a point downstream of the shock, as shown in Figure 5.16: Plot of Velocity Vectors Downstream of the Shock (p. 255).
Flow reversal is clearly visible in Figure 5.16: Plot of Velocity Vectors Downstream of the Shock (p. 255).

5.5. Summary

This tutorial demonstrated how to set up and solve an external aerodynamics problem using the pressure-based coupled solver with pseudo transient under-relaxation and the Spalart-Allmaras turbulence model. It showed how to monitor convergence using force and surface monitors, and demonstrated the use of several postprocessing tools to examine the flow phenomena associated with a shock wave.

5.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 6: Modeling Transient Compressible Flow

This tutorial is divided into the following sections:

6.1. Introduction
6.2. Prerequisites
6.3. Problem Description
6.4. Setup and Solution
6.5. Summary
6.6. Further Improvements

6.1. Introduction

In this tutorial, ANSYS Fluent’s density-based implicit solver is used to predict the time-dependent flow through a two-dimensional nozzle. As an initial condition for the transient problem, a steady-state solution is generated to provide the initial values for the mass flow rate at the nozzle exit.

This tutorial demonstrates how to do the following:

• Calculate a steady-state solution (using the density-based implicit solver) as an initial condition for a transient flow prediction.

• Define a transient boundary condition using a user-defined function (UDF).

• Use dynamic mesh adaption for both steady-state and transient flows.

• Calculate a transient solution using the second-order implicit transient formulation and the density-based implicit solver.

• Create an animation of the transient flow using ANSYS Fluent’s transient solution animation feature.

6.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.
6.3. Problem Description

The geometry to be considered in this tutorial is shown in Figure 6.1: Problem Specification (p. 258). Flow through a simple nozzle is simulated as a 2D planar model. The nozzle has an inlet height of 0.2 m, and the nozzle contours have a sinusoidal shape that produces a 20% reduction in flow area. Due to symmetry, only half of the nozzle is modeled.

Figure 6.1: Problem Specification

6.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
- 6.4.1. Preparation
- 6.4.2. Reading and Checking the Mesh
- 6.4.3. Specifying Solver and Analysis Type
- 6.4.4. Specifying the Models
- 6.4.5. Editing the Material Properties
- 6.4.6. Setting the Operating Conditions
- 6.4.7. Creating the Boundary Conditions
- 6.4.8. Setting the Solution Parameters for Steady Flow and Solving
- 6.4.9. Enabling Time Dependence and Setting Transient Conditions
- 6.4.10. Specifying Solution Parameters for Transient Flow and Solving
- 6.4.11. Saving and Postprocessing Time-Dependent Data Sets

6.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

   Note

   If you do not have a login, you can request one by clicking Customer Registration on the log in page.

3. Enter the name of this tutorial into the search bar.
4. Narrow the results by using the filter on the left side of the page.
a. Click ANSYS Fluent under Product.

b. Click 15.0 under Version.

5. Select this tutorial from the list.

6. Click Files to download the input and solution files.

7. Unzip the unsteady_compressible_R150 file you downloaded to your working folder.

   The files nozzle.msh and pexit.c can be found in the unsteady_compressible folder created after unzipping the file.

8. Use Fluent Launcher to start the 2D version of ANSYS Fluent.

   Fluent Launcher displays your Display Options preferences from the previous session.

   For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in the Getting Started Guide.

9. Ensure that the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color Scheme options are enabled.

10. Ensure that the Serial

11. Disable the Double Precision option.

### 6.4.2. Reading and Checking the Mesh

1. Read the mesh file nozzle.msh.

   File → Read → Mesh...

   The mesh for the half of the geometry is displayed in the graphics window.

2. Check the mesh.

   General → Check

   ANSYS Fluent will perform various checks on the mesh and will report the progress in the console window. Ensure that the reported minimum volume is a positive number.

3. Verify that the mesh size is correct.

   General → Scale...
a. Close the Scale Mesh dialog box.

4. Mirror the mesh across the centerline (Figure 6.2: 2D Nozzle Mesh Display with Mirroring (p. 261)).

Views... 

a. Select symmetry in the Mirror Planes selection list.

b. Click Apply to refresh the display.

c. Close the Views dialog box.
6.4.3. Specifying Solver and Analysis Type

1. Select the solver settings.

   General
a. Select **Density-Based** from the **Type** list in the **Solver** group box.

   The density-based implicit solver is the solver of choice for compressible, transonic flows without significant regions of low-speed flow. In cases with significant low-speed flow regions, the pressure-based solver is preferred. Also, for transient cases with traveling shocks, the density-based explicit solver with explicit time stepping may be the most efficient.

b. Retain the default selection of **Steady** from the **Time** list.

   **Note**

   You will solve for the steady flow through the nozzle initially. In later steps, you will use these initial results as a starting point for a transient calculation.

2. For convenience, change the unit of measurement for pressure.

   **General → Units...**

   The pressure for this problem is specified in atm, which is not the default unit in ANSYS Fluent. You must redefine the pressure unit as atm.
a. Select **pressure** in the **Quantities** selection list.

\[\text{Scroll down the list to find} \ \text{pressure}.\]

b. Select **atm** in the **Units** selection list.

c. Close the **Set Units** dialog box.

### 6.4.4. Specifying the Models

1. Enable the energy equation.

\[\text{Models} \rightarrow \text{Energy} \rightarrow \text{Edit...}\]

2. Select the k-omega SST turbulence model.

\[\text{Models} \rightarrow \text{Viscous} \rightarrow \text{Edit...}\]
a. Select k-omega (2eqn) in the Model list.

b. Select SST in the k-omega Model group box.

c. Click OK to close the Viscous Model dialog box.

### 6.4.5. Editing the Material Properties

1. Set the properties for air, the default fluid material.

   ![Materials ➔ air ➔ Create/Edit...](image)
a. Select **ideal-gas** from the **Density** drop-down list in the **Properties** group box, so that the ideal gas law is used to calculate density.

**Note**

ANSYS Fluent automatically enables the solution of the energy equation when the ideal gas law is used, in case you did not already enable it manually in the **Energy** dialog box.

b. Retain the default values for all other properties.

c. Click the **Change/Create** button to save your change.

d. Close the **Create/Edit Materials** dialog box.

### 6.4.6. Setting the Operating Conditions

1. Set the operating pressure.

   ⚱ **Boundary Conditions → Operating Conditions...**
6.4.7. Creating the Boundary Conditions

1. Set the boundary conditions for the nozzle inlet (inlet).

   ![Boundary Conditions → inlet → Edit...](image)
a. Enter 0.9 atm for **Gauge Total Pressure**.

b. Enter 0.7369 atm for **Supersonic/Initial Gauge Pressure**.

   *The inlet static pressure estimate is the mean pressure at the nozzle exit. This value will be used during the solution initialization phase to provide a guess for the nozzle velocity.*

c. Retain **Intensity and Viscosity Ratio** from the **Specification Method** drop-down list in the **Turbulence** group box.

d. Enter 1.5% for **Turbulent Intensity**.

e. Retain the setting of 10 for **Turbulent Viscosity Ratio**.

f. Click **OK** to close the **Pressure Inlet** dialog box.

2. Set the boundary conditions for the nozzle exit (**outlet**).

   ![Boundary Conditions](Image)

   ![outlet](Image) → Edit...
a. Enter 0.7369 atm for **Gauge Pressure**.

b. Retain **Intensity and Viscosity Ratio** from the **Specification Method** drop-down list in the **Turbulence** group box.

c. Enter 1.5% for **Backflow Turbulent Intensity**.

d. Retain the setting of 10 for **Backflow Turbulent Viscosity Ratio**.

   *If substantial backflow occurs at the outlet, you may need to adjust the backflow values to levels close to the actual exit conditions.*

e. Click **OK** to close the **Pressure Outlet** dialog box.

### 6.4.8. Setting the Solution Parameters for Steady Flow and Solving

*In this step, you will generate a steady-state flow solution that will be used as an initial condition for the time-dependent solution.*

1. Set the solution parameters.
<table>
<thead>
<tr>
<th>Solution Methods</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Formulation</em></td>
</tr>
<tr>
<td>Implicit</td>
</tr>
<tr>
<td><em>Flux Type</em></td>
</tr>
<tr>
<td>Roe-FDS</td>
</tr>
<tr>
<td><em>Spatial Discretization</em></td>
</tr>
<tr>
<td>Gradient</td>
</tr>
<tr>
<td>Least Squares Cell Based</td>
</tr>
<tr>
<td>Flow</td>
</tr>
<tr>
<td>Second Order Upwind</td>
</tr>
<tr>
<td>Turbulent Kinetic Energy</td>
</tr>
<tr>
<td>Second Order Upwind</td>
</tr>
<tr>
<td>Specific Dissipation Rate</td>
</tr>
<tr>
<td>Second Order Upwind</td>
</tr>
</tbody>
</table>

- Retain the default selection of **Least Squares Cell Based** from the **Gradient** drop-down list in the **Spatial Discretization** group box.

- Select **Second Order Upwind** from the **Turbulent Kinetic Energy** and **Specific Dissipation Rate** drop-down lists.

  Second-order discretization provides optimum accuracy.

2. Modify the Courant Number.

  Solution Controls
a. Set the Courant Number to 5.0.

**Note**

The default Courant number for the density-based implicit formulation is 5. For relatively simple problems, setting the Courant number to 10, 20, 100, or even higher value may be suitable and produce fast and stable convergence. However, if you encounter convergence difficulties at the startup of the simulation of a properly set up problem, then you should consider setting the Courant number to its default value of 5. As the solution progresses, you can start to gradually increase the Courant number until the final convergence is reached.

b. Retain the default values for the Under-Relaxation Factors.

3. Enable the plotting of residuals.

   ![Monitors] ![Residuals] ![Edit...]


a. Ensure that **Plot** is enabled in the **Options** group box.

b. Select **none** from the **Convergence Criterion** drop-down list.

c. Click **OK** to close the **Residual Monitors** dialog box.

4. Enable the plotting of mass flow rate at the flow exit.

![Monitors (Surface Monitors) → Create...](image)
a. Enable **Plot** and **Write**.

**Note**

When **Write** is enabled in the **Surface Monitor** dialog box, the mass flow rate history will be written to a file. If you do not enable the write option, the history information will be lost when you exit ANSYS Fluent.

b. Enter `noz_ss.out` for **File Name**.

c. Select **Mass Flow Rate** in the **Report Type** drop-down list.

d. Select **outlet** in the **Surfaces** selection list.

e. Click **OK** to close the **Surface Monitor** dialog box.

5. Save the case file (`noz_ss.cas.gz`).

   **File → Write → Case...**

6. Initialize the solution.

   **Solution Initialization**
a. Retain the default selection of **Hybrid Initialization** from the **Initialization Methods** group box.

b. Click **Initialize**.

7. Set up gradient adaption for dynamic mesh refinement.

**Adapt → Gradient...**

You will enable dynamic adaption so that the solver periodically refines the mesh in the vicinity of the shocks as the iterations progress. The shocks are identified by their large pressure gradients.

![Gradient Adaption Window](image)

a. Select **Gradient** from the **Method** group box.

The mesh adaption criterion can either be the gradient or the curvature (second gradient). Because strong shocks occur inside the nozzle, the gradient is used as the adaption criterion.

b. Select **Scale** from the **Normalization** group box.

Mesh adaption can be controlled by the raw (or standard) value of the gradient, the scaled value (by its average in the domain), or the normalized value (by its maximum in the domain). For dynamic...
mesh adaption, it is recommended that you use either the scaled or normalized value because the raw values will probably change strongly during the computation, which would necessitate a readjustment of the coarsen and refine thresholds. In this case, the scaled gradient is used.

c. Enable **Dynamic** in the **Dynamic** group box.

d. Enter **100** for the **Interval**.

   For steady-state flows, it is sufficient to only seldomly adapt the mesh—in this case an interval of 100 iterations is chosen. For time-dependent flows, a considerably smaller interval must be used.

e. Retain the default selection of **Pressure...** and **Static Pressure** from the **Gradients of** drop-down lists.

f. Enter **0.3** for **Coarsen Threshold**.

g. Enter **0.7** for **Refine Threshold**.

   As the refined regions of the mesh get larger, the coarsen and refine thresholds should get smaller. A coarsen threshold of 0.3 and a refine threshold of 0.7 result in a “medium” to “strong” mesh refinement in combination with the scaled gradient.

h. Click **Apply** to store the information.

i. Click the **Controls...** button to open the **Mesh Adaption Controls** dialog box.

   ![Mesh Adaption Controls dialog box]

   Retain the default selection of **fluid** in the **Zones** selection list.

   ii. Enter **20000** for **Max # of Cells**.

      To restrict the mesh adaption, the maximum number of cells can be limited. If this limit is violated during the adaption, the coarsen and refine thresholds are adjusted to respect the maximum number of cells. Additional restrictions can be placed on the minimum cell volume, minimum number of cells, and maximum level of refinement.

   iii. Click **OK** to save your settings and close the **Mesh Adaption Controls** dialog box.
j. Click **Close** to close the **Gradient Adaption** dialog box.

8. Start the calculation by requesting **500 iterations**.

**Run Calculation**

- **Number of Iterations**: 500
- **Profile Update Interval**: 1
- **Solution Steering**
- **Data File Quantities**
- **Acoustic Signals**

a. Enter 500 for **Number of Iterations**.

b. Click **Calculate** to start the steady flow simulation.

**Figure 6.3: Mass Flow Rate History**

Convergence history of Mass Flow Rate on outlet
9. Save the case and data files (noz_ss.cas.gz and noz_ss.dat.gz).

   File → Write → Case & Data...

   **Note**

   When you write the case and data files at the same time, it does not matter whether you specify the file name with a .cas or .dat extension, as both will be saved.

10. Click **OK** in the **Question** dialog box to overwrite the existing file.

11. Review a mesh that resulted from the dynamic adaption performed during the computation.

   ![Graphics and Animations → Mesh → Set Up...](image)

   The **Mesh Display** dialog box appears.

   a. Ensure that only the **Edges** option is enabled in the **Options** group box.

   b. Select **Feature** from the **Edge Type** list.

   c. Ensure that all of the items are selected from the **Surfaces** selection list.

   d. Click **Display** and close the **Mesh Display** dialog box.

   The mesh after adaption is displayed in graphic windows (Figure 6.4: 2D Nozzle Mesh after Adaption (p. 277))
Figure 6.4: 2D Nozzle Mesh after Adaption

Zoom in using the middle mouse button to view aspects of your mesh. Notice that the cells in the regions of high pressure gradients have been refined.

12. Display the steady flow contours of static pressure (Figure 6.5: Contours of Static Pressure (Steady Flow) (p. 279)).

Graphics and Animations → Contours → Set Up...
a. Enable **Filled** in the **Options** group box.

b. Click **Display** and close the **Contours** dialog box.
The steady flow prediction in Figure 6.5: Contours of Static Pressure (Steady Flow) (p. 279) shows the expected pressure distribution, with low pressure near the nozzle throat.

13. Display the steady-flow velocity vectors (Figure 6.6: Velocity Vectors (Steady Flow) (p. 281)).

Graphics and Animations → Vectors → Set Up...
a. Retain all default settings.

b. Click **Display** and close the **Vectors** dialog box.

*You can zoom in to view the recirculation of the velocity vectors.*

The steady flow prediction in **Figure 6.6: Velocity Vectors (Steady Flow) (p. 281)** shows the expected form, with a peak velocity of approximately 300 m/s through the nozzle.
Figure 6.6: Velocity Vectors (Steady Flow)

To improve the clarity of the flow pattern, you can increase the size of the displayed velocity vectors by increasing the value in the Scale field.

14. Check the mass flux balance.

Warning

Although the mass flow rate history indicates that the solution is converged, you should also check the mass flux throughout the domain to ensure that mass is being conserved.
a. Retain the default selection of **Mass Flow Rate**.

b. Select **inlet** and **outlet** in the **Boundaries** selection list.

c. Click **Compute** and examine the values displayed in the dialog box.

```
Warning
The net mass imbalance should be a small fraction (for example, 0.1%) of the total flux through the system. The imbalance is displayed in the lower right field under **Net Results**. If a significant imbalance occurs, you should decrease your residual tolerances by at least an order of magnitude and continue iterating.
```

d. Close the **Flux Reports** dialog box.

### 6.4.9. Enabling Time Dependence and Setting Transient Conditions

*In this step you will define a transient flow by specifying a transient pressure condition for the nozzle.*

1. Enable a time-dependent flow calculation.
a. Select **Transient** in the **Time** list.

2. Read the user-defined function (pexit.c), in preparation for defining the transient condition for the nozzle exit.

**Define → User-Defined → Functions → Interpreted...**

The pressure at the outlet is defined as a wave-shaped profile, and is described by the following equation:

\[
p_{\text{exit}}(t) = 0.12 \sin(\omega t) + \overline{p}_{\text{exit}}
\]  

(6.1)

where

\[
\omega = \text{circular frequency of transient pressure (rad/s)}
\]

\[
\overline{p}_{\text{exit}} = \text{mean exit pressure (atm)}
\]

In this case, \(\omega = 2200\) rad/s, and \(\overline{p}_{\text{exit}} = 0.7369\) atm.

A user-defined function (pexit.c) has been written to define the equation (Equation 6.1 (p. 283)) required for the pressure profile.

**Note**

To input the value of Equation 6.1 (p. 283) in the correct units, the function pexit.c has to be written in SI units.

More details about user-defined functions can be found in the UDF Manual.
a. Enter `pexit.c` for **Source File Name**.

If the UDF source file is not in your working directory, then you must enter the entire directory path for **Source File Name** instead of just entering the file name.

b. Click **Interpret**.

The user-defined function has already been defined, but it must be compiled within ANSYS Fluent before it can be used in the solver.

c. Close the **Interpreted UDFs** dialog box.

3. Set the transient boundary conditions at the nozzle exit (**outlet**).

![Boundary Conditions](image)

**Boundary Conditions → outlet → Edit...**
a. Select **udf transient_pressure** (the user-defined function) from the **Gauge Pressure** drop-down list.

b. Click **OK** to close the **Pressure Outlet** dialog box.

4. Update the gradient adaption parameters for the transient case.

   **Adapt → Gradient...**

   a. Enter **10** for **Interval** in the **Dynamic** group box.

      *For the transient case, the mesh adaption will be done every 10 time steps.*

   b. Enter **0.3** for **Coarsen Threshold**.

   c. Enter **0.7** for **Refine Threshold**.

      *The refine and coarsen thresholds have been changed during the steady-state computation to meet the limit of 20000 cells. Therefore, you must reset these parameters to their original values.*

   d. Click **Apply** to store the values.

   e. Click **Controls...** to open the **Mesh Adaption Controls** dialog box.

      i. Enter **8000** for **Min # of Cells**.

      ii. Enter **30000** for **Max # of Cells**.

         *You must increase the maximum number of cells to try to avoid readjustment of the coarsen and refine thresholds. Additionally, you must limit the minimum number of cells to 8000, because you should not have a coarse mesh during the computation (the current mesh has approximately 20000 cells).*

      iii. Click **OK** to close the **Mesh Adaption Controls** dialog box.

   f. Close the **Gradient Adaption** dialog box.

**6.4.10. Specifying Solution Parameters for Transient Flow and Solving**

1. Modify the plotting of the mass flow rate at the nozzle exit.

   ![Monitors (Surface Monitors)](surf-mon-1) → Edit...

   *Because each time step requires 10 iterations, a smoother plot will be generated by plotting at every time step.*
a. Set **Window** to **3**.

b. Enter `noz_uns.out` for **File Name**.

c. Select **Time Step** from the **X Axis** drop-down list.

d. Select **Time Step** from the **Get Data Every** drop-down list.

e. Click **OK** to close the **Surface Monitor** dialog box.

2. Save the transient solution case file (`noz_uns.cas.gz`).

   **File** → **Write** → **Case**...

3. Modify the plotting of residuals.

   ![Residuals Monitor](image)

   a. Ensure that **Plot** is enabled in the **Options** group box.

   b. Ensure **none** is selected from the **Convergence Criterion** drop-down list.

   c. Set the **Iterations to Plot** to **100**.

   d. Click **OK** to close the **Residual Monitors** dialog box.

4. Set the time step parameters.
Run Calculation

The selection of the time step is critical for accurate time-dependent flow predictions. Using a time step of $2.85596 \times 10^{-5}$ seconds, 100 time steps are required for one pressure cycle. The pressure cycle begins and ends with the initial pressure at the nozzle exit.

- Enter $2.85596 \times 10^{-5}$ s for **Time Step Size**.
- Enter 600 for **Number of Time Steps**.
- Enter 10 for **Max Iterations/Time Step**.
- Click **Calculate** to start the transient simulation.

**Warning**

Calculating 600 time steps will require significant CPU resources. Instead of calculating the solution, you can read the data file (noz_uns.dat.gz) with the precalculated solution. This data file can be found in the folder where you found the mesh and UDF files.
By requesting 600 time steps, you are asking ANSYS Fluent to compute six pressure cycles. The mass flow rate history is shown in Figure 6.7: Mass Flow Rate History (Transient Flow) (p. 288).

Figure 6.7: Mass Flow Rate History (Transient Flow)

---

5. Optionally, you can review the effect of dynamic mesh adaption performed during transient flow computation as you did in steady-state flow case.

6. Save the transient case and data files (`noz_uns.cas.gz` and `noz_uns.dat.gz`).

File → Write → Case & Data...

6.4.11. Saving and Postprocessing Time-Dependent Data Sets

At this point, the solution has reached a time-periodic state. To study how the flow changes within a single pressure cycle, you will now continue the solution for 100 more time steps. You will use ANSYS Fluent’s solution animation feature to save contour plots of pressure and Mach number at each time step, and the autosave feature to save case and data files every 10 time steps. After the calculation is complete, you will use the solution animation playback feature to view the animated pressure and Mach number plots over time.

1. Request the saving of case and data files every 10 time steps.

   Calculation Activities (Autosave Every) → Edit...
a. Enter 10 for **Save Data File Every**.

b. Select **Each Time** for **Save Associated Case Files**.

c. Retain the default selection of **time-step** from the **Append File Name with** drop-down list.

d. Enter **noz_anim** for **File Name**.

   When ANSYS Fluent saves a file, it will append the time step value to the file name prefix (noz_anim). The standard extensions (.cas and .dat) will also be appended. This will yield file names of the form noz_anim-1-00640.cas and noz_anim-1-00640.dat, where 00640 is the time step number.

   Optionally, you can add the extension .gz to the end of the file name (for example, noz_anim.gz), which will instruct ANSYS Fluent to save the case and data files in compressed format, yielding file names of the form noz_anim-1-00640.cas.gz.

e. Click **OK** to close the **Autosave** dialog box.

---

**Extra**

If you have constraints on disk space, you can restrict the number of files saved by ANSYS Fluent by enabling the **Retain Only the Most Recent Files** option and setting the **Maximum Number of Data Files** to a nonzero number.

---

2. Create animation sequences for the nozzle pressure and Mach number contour plots.

   ✤ **Calculation Activities (Solution Animations) → Create/Edit...**
a. Set **Animation Sequences** to 2.

b. Enter **pressure** for the **Name** of the first sequence and **mach-number** for the second sequence.

c. Select **Time Step** from the **When** drop-down lists for both sequences.

   *The default value of 1 in the **Every** integer number entry box instructs ANSYS Fluent to update the animation sequence at every time step.*

d. Click the **Define...** button for **pressure** to open the associated **Animation Sequence** dialog box.

   i. Select **In Memory** from the **Storage Type** group box.

      *The **In Memory** option is acceptable for a small 2D case such as this. For larger 2D or 3D cases, saving animation files with either the **Metafile** or **PPM Image** option is preferable, to avoid using too much of your machine’s memory.*

   ii. Enter **4** for **Window** and click the **Set** button.
iii. Select **Contours** from the **Display Type** group box to open the **Contours** dialog box.

A. Ensure that **Filled** is enabled in the **Options** group box.

B. Disable **Auto Range**.

C. Retain the default selection of **Pressure...** and **Static Pressure** from the **Contours of** drop-down lists.

D. Enter 0.25 atm for **Min** and 1.25 atm for **Max**.

   *This will set a fixed range for the contour plot and subsequent animation.*

E. Click **Display** and close the **Contours** dialog box.

   *Figure 6.8: Pressure Contours at t=0.017136 s (p. 292) shows the contours of static pressure in the nozzle after 600 time steps.*
iv. Click **OK** to close the **Animation Sequence** dialog box associated with the pressure sequence.

e. Click the **Define...** button for **mach-number** to open the associated **Animation Sequence** dialog box.

   i. Ensure that **In Memory** is selected in the **Storage Type** list.

   ii. Enter 5 for **Window** and click the **Set** button.

   iii. Select **Contours** in the **Display Type** group box to open the **Contours** dialog box.

      A. Select **Velocity...** and **Mach Number** from the **Contours of** drop-down lists.

      B. Ensure that **Filled** is enabled from the **Options** group box.

      C. Disable **Auto Range**.
D. Enter 0.00 for **Min** and 1.30 for **Max**.

E. Click **Display** and close the **Contours** dialog box.

*Figure 6.9: Mach Number Contours at t=0.017136 s (p. 293) shows the Mach number contours in the nozzle after 600 time steps.*

*Figure 6.9: Mach Number Contours at t=0.017136 s*

iv. Click **OK** to close the **Animation Sequence** dialog box associated with the **mach-number** sequence.

f. Click **OK** to close the **Solution Animation** dialog box.

3. Continue the calculation by requesting 100 time steps.

**Run Calculation**
By requesting 100 time steps, you will march the solution through an additional 0.0028 seconds, or roughly one pressure cycle.

With the autosave and animation features active (as defined previously), the case and data files will be saved approximately every 0.00028 seconds of the solution time; animation files will be saved every 0.000028 seconds of the solution time.

Enter 100 for **Number of Time Steps** and click **Calculate**.

When the calculation finishes, you will have ten pairs of case and data files and there will be 100 pairs of contour plots stored in memory. In the next few steps, you will play back the animation sequences and examine the results at several time steps after reading in pairs of newly saved case and data files.

4. Change the display options to include double buffering.

   ![Graphics and Animations Options...](image)

   Double buffering will allow for a smoother transition between the frames of the animations.
a. Retain the **Double Buffering** option in the **Rendering group** box.

b. Enter 4 for **Active Window** and click the **Set** button.

---

**Note**

Alternatively, you can change the active window using the drop-down list at the top of the graphics window.

---

c. Click **Apply** and close the **Display Options** dialog box.

5. Play the animation of the pressure contours.

[Graphics and Animations → Solution Animation Playback → Set Up...]
a. Retain the default selection of **pressure** in the **Sequences** selection list.

   Ensure that window 4 is visible in the viewer. If it is not, select it from the drop-down list at the top left of the viewer window.

b. Click the play button (the second from the right in the group of buttons in the **Playback** group box).

c. Close the **Playback** dialog box.

   *Examples of pressure contours at $t = 0.017993$ s (the 630th time step) and $t = 0.019135$ s (the 670th time step) are shown in Figure 6.10: Pressure Contours at $t=0.017993$ s (p. 297) and Figure 6.11: Pressure Contours at $t=0.019135$ s (p. 298).*

6. In a similar manner to steps 4 and 5, select the appropriate active window and sequence name for the Mach number contours.

   *Examples of Mach number contours at $t = 0.017993$ s and $t = 0.019135$ s are shown in Figure 6.12: Mach Number Contours at $t=0.017993$ s (p. 299) and Figure 6.13: Mach Number Contours at $t=0.019135$ s (p. 300).*
Figure 6.10: Pressure Contours at t=0.017993 s
Figure 6.11: Pressure Contours at t=0.019135 s

Contour of Static Pressure (atm) (Time=1.9135e-02)

ANSYS Fluent (2d, dbns imp, sstkW, transient)
Figure 6.12: Mach Number Contours at t=0.017993 s

Contours of Mach Number (Time=1.7993e-02)

ANSYS Fluent (2d, dbns imp, sstkw, transient)
**Figure 6.13: Mach Number Contours at t=0.019135 s**

Extra

ANSYS Fluent gives you the option of exporting an animation as an MPEG file or as a series of files in any of the hardcopy formats available in the **Save Picture** dialog box (including TIFF and PostScript).

To save an MPEG file, select **MPEG** from the **Write/Record Format** drop-down list in the **Playback** dialog box and then click the **Write** button. The MPEG file will be saved in your working folder. You can view the MPEG movie using an MPEG player (for example, Windows Media Player or another MPEG movie player).

To save a series of TIFF, PostScript, or other hardcopy files, select **Picture Frames** in the **Write/Record Format** drop-down list in the **Playback** dialog box. Click the **Picture Options...** button to open the **Save Picture** dialog box and set the appropriate parameters for saving the hardcopy files. Click **Apply** in the **Save Picture** dialog box to save your modified settings. Click **Save...** to select a directory in which to save the files. In the...
**Playback** dialog box, click the **Write** button. ANSYS Fluent will replay the animation, saving each frame to a separate file in your working folder.

If you want to view the solution animation in a later ANSYS Fluent session, you can select **Animation Frames** as the **Write/Record Format** and click **Write**.

---

**Warning**

Since the solution animation was stored in memory, it will be lost if you exit ANSYS Fluent without saving it in one of the formats described previously. Note that only the animation-frame format can be read back into the **Playback** dialog box for display in a later ANSYS Fluent session.

7. Read the case and data files for the 660th time step (noz_anim–1–00660.cas.gz and noz_anim–1–00660.dat.gz) into ANSYS Fluent.

8. Plot vectors at \( t = 0.018849 \) s (Figure 6.14: Velocity Vectors at \( t=0.018849 \) s (p. 302)).

- **Graphics and Animations → Vectors → Set Up...**

  ![Vectors and Animations dialog box](image)

  a. Ensure **Auto Scale** is enabled under **Options**.

  b. Retain the default values for all other properties.
c. Click **Display** and close the **Vectors** dialog box.

**Figure 6.14: Velocity Vectors at t=0.018849 s**

The transient flow prediction in **Figure 6.14: Velocity Vectors at t=0.018849 s (p. 302)** shows the expected form, with peak velocity of approximately 241 m/s through the nozzle at \( t = 0.018849 \) seconds.

9. In a similar manner to steps 7 and 8, read the case and data files saved for other time steps of interest and display the vectors.

**6.5. Summary**

In this tutorial, you modeled the transient flow of air through a nozzle. You learned how to generate a steady-state solution as an initial condition for the transient case, and how to set solution parameters for implicit time-stepping.

You also learned how to manage the file saving and graphical postprocessing for time-dependent flows, using file autosaving to automatically save solution information as the transient calculation proceeds.
Finally, you learned how to use ANSYS Fluent’s solution animation tool to create animations of transient data, and how to view the animations using the playback feature.

6.6. Further Improvements

This tutorial guides you through the steps to generate a second-order solution. You may be able to increase the accuracy of the solution even further by using an appropriate higher-order discretization scheme and by adapting the mesh further. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 7: Modeling Radiation and Natural Convection

This tutorial is divided into the following sections:

7.1. Introduction
7.2. Prerequisites
7.3. Problem Description
7.4. Setup and Solution
7.5. Summary
7.6. Further Improvements

7.1. Introduction

In this tutorial, combined radiation and natural convection are solved in a three-dimensional square box on a mesh consisting of hexahedral elements.

This tutorial demonstrates how to do the following:

• Use the surface-to-surface (S2S) radiation model in ANSYS Fluent.
• Set the boundary conditions for a heat transfer problem involving natural convection and radiation.
• Calculate a solution using the pressure-based solver.
• Display velocity vectors and contours of wall temperature, surface cluster ID, and radiation heat flux.

7.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.

7.3. Problem Description

The problem to be considered is shown schematically in Figure 7.1: Schematic of the Problem (p. 306). A three-dimensional box (0.25 m × 0.25 m × 0.25 m) has a hot wall of aluminum at 473.15 K. All other walls are made of an insulation material and are subject to radiative and convective heat transfer to the surroundings, which are at 293.15 K. Gravity acts downwards. The medium contained in the box is assumed not to emit, absorb, or scatter radiation. All walls are gray. The objective is to compute the
flow and temperature patterns in the box, as well as the wall heat flux, using the surface-to-surface (S2S) model available in ANSYS Fluent.

The working fluid has a Prandtl number of approximately 0.71, and the Rayleigh number based on \( L \) (0.25) is \( 1 \times 10^8 \). This means the flow is most likely laminar. The Planck number \( k/(4\sigma L T_0^3) \) is 0.006, and measures the relative importance of conduction to radiation.

**Figure 7.1: Schematic of the Problem**

7.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

- 7.4.1. Preparation
- 7.4.2. Reading and Checking the Mesh
- 7.4.3. Specifying Solver and Analysis Type
- 7.4.4. Specifying the Models
- 7.4.5. Defining the Materials
- 7.4.6. Specifying Boundary Conditions
- 7.4.7. Obtaining the Solution
- 7.4.8. Postprocessing
- 7.4.9. Comparing the Contour Plots after Varying Radiating Surfaces
- 7.4.10. S2S Definition, Solution, and Postprocessing with Partial Enclosure

**7.4.1. Preparation**

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

**Note**

If you do not have a login, you can request one by clicking **Customer Registration** on the login page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   a. Click **ANSYS Fluent** under **Product**.
   b. Click **15.0** under **Version**.

5. Select this tutorial from the list.

6. Click **Files** to download the input and solution files.

7. Unzip **radiation_natural_convection_R150.zip** to your working folder.

   *The mesh file rad.msh.gz can be found in the radiation_natural_convection folder created after unzipping the file.*

8. Use Fluent Launcher to start the **3D** version of ANSYS Fluent.

   Fluent Launcher displays your **Display Options** preferences from the previous session.

   For more information about Fluent Launcher, see *Starting ANSYS Fluent Using Fluent Launcher* in the User’s Guide.

9. Ensure that the **Display Mesh After Reading**, **Embed Graphics Windows**, and **Workbench Color Scheme** options are enabled.

10. Run in single precision (disable **Double Precision**).

11. Ensure that **Serial** is selected under **Processing Options**.

### 7.4.2. Reading and Checking the Mesh

1. Read the mesh file **rad.msh.gz**.

   *File ➔ Read ➔ Mesh...*

   *As the mesh is read, messages will appear in the console reporting the progress of the reading and the mesh statistics. The mesh size will be reported as 64,000 cells. Once reading is complete, the mesh will be displayed in the graphics window.*
Figure 7.2: Graphics Display of Mesh

General

Check ANSYS Fluent will perform various checks on the mesh and report the progress in the console. Make sure that the reported minimum volume is a positive number.

7.4.3. Specifying Solver and Analysis Type

1. Confirm the solver settings and enable gravity.
a. Retain the default settings of pressure-based steady-state solver in the Solver group box.

b. Enable the Gravity option.

c. Enter $-9.81 \text{ m/s}^2$ for $Y$ in the Gravitational Acceleration group box.

7.4.4. Specifying the Models

1. Enable the energy equation.

![Energy Equation]

2. Set up the Surface to Surface (S2S) radiation model.

![Radiation Model]
a. Select **Surface to Surface (S2S)** from the **Model** list.

You will be prompted with a message box directing you to click **OK** in the **Radiation Model** dialog box and re-open it to set the S2S options. When you re-open the dialog box, the additional inputs for the S2S model will be visible.

![Radiation Model dialog box](image)

The surface-to-surface (S2S) radiation model can be used to account for the radiation exchange in an enclosure of gray-diffuse surfaces. The energy exchange between two surfaces depends in part on their size, separation distance, and orientation. These parameters are accounted for by a geometric function called a “view factor”.

The S2S model assumes that all surfaces are gray and diffuse. Thus according to the gray-body model, if a certain amount of radiation is incident on a surface, then a fraction is reflected, a fraction is absorbed, and a fraction is transmitted. The main assumption of the S2S model is that any absorption, emission, or scattering of radiation by the medium can be ignored. Therefore only “surface-to-surface” radiation is considered for analysis.

For most applications the surfaces in question are opaque to thermal radiation (in the infrared spectrum), so the surfaces can be considered opaque. For gray, diffuse, and opaque surfaces it is valid to assume that the emissivity is equal to the absorptivity and that reflectivity is equal to 1 minus the emissivity.

When the S2S model is used, you also have the option to define a “partial enclosure”. This option allows you to disable the view factor calculation for walls with negligible emission/absorption or walls that have uniform temperature. The main advantage of this option is to speed up the view factor calculation and the radiosity calculation.
b. Click the **Settings...** button to open the **View Factors and Clustering** dialog box.

*You will define the view factor and cluster parameters.*

![View Factors and Clustering dialog box](image)

i. Retain the value of 1 for **Faces per Surface Cluster for Flow Boundary Zones** in the **Manual** group box.

ii. Click **Apply to All Walls**.

The S2S radiation model is computationally very expensive when there are a large number of radiating surfaces. The number of radiating surfaces is reduced by clustering surfaces into surface “clusters.” The surface clusters are made by starting from a face and adding its neighbors and their neighbors until a specified number of faces per surface cluster is collected.

For a small problem, the default value of 1 for **Faces per Surface Cluster for Flow Boundary Zones** is acceptable. For a large problem you can increase this number to reduce the memory requirement for the view factor file that is saved in a later step. This may also lead to some reduction in the computational expense. However, this is at the cost of some accuracy. This tutorial illustrates the influence of clusters.

iii. Ensure **Ray Tracing** is selected from the **Method** list in the **View Factors** group box.
iv. Click **OK** to close the **View Factors and Clustering** dialog box.

c. Click the **Compute/Write/Read...** button in the **View Factors and Clustering** group box to open the **Select File** dialog box and to compute the view factors.

*The file created in this step will store the cluster and view factor parameters.*

i. Enter `rad_1.s2s.gz` as the file name for **S2S File**.

ii. Click **OK** in the **Select File** dialog box.

---

### Note

The size of the view factor file can be very large if not compressed. It is highly recommended to compress the view factor file by providing `.gz` or `.Z` extension after the name (that is, `rad_1.gz` or `rad_1.Z`). For small files, you can provide the `.s2s` extension after the name.

*ANSYS Fluent will print an informational message describing the progress of the view factor calculation in the console.*

d. Click **OK** to close the **Radiation Model** dialog box.

### 7.4.5. Defining the Materials

1. Set the properties for air.

   ![Materials】 > **air** > **Create/Edit...**

---

![Create/Edit Materials](image)
a. Select incompressible-ideal-gas from the Density drop-down list.

b. Enter 1021 J/kg-K for Cp (Specific Heat).

c. Enter 0.0371 W/m-K for Thermal Conductivity.

d. Enter 2.485e-05 kg/m-s for Viscosity.

e. Retain the default value of 28.966 kg/kmol for Molecular Weight.

f. Click Change/Create and close the Create/Edit Materials dialog box.

2. Define the new material, insulation.

Materials → Solid → Create/Edit...

a. Enter insulation for Name.

b. Delete the entry in the Chemical Formula field.

c. Enter 50 kg/m$^3$ for Density.

d. Enter 800 J/kg-K for Cp (Specific Heat).

e. Enter 0.09 W/m-K for Thermal Conductivity.

f. Click Change/Create.

g. Click No when the Question dialog box appears, asking if you want to overwrite aluminum.
The Create/Edit Materials dialog box will be updated to show the new material, insulation, in the Fluent Solid Materials drop-down list.

h. Close the Create/Edit Materials dialog box.

7.4.6. Specifying Boundary Conditions

1. Set the boundary conditions for the front wall (w-high-x).

Boundary Conditions → w-high-x → Edit...

The Wall dialog box appears.
a. Click the Thermal tab and select Mixed from the Thermal Conditions list.

b. Select insulation from the Material Name drop-down list.

c. Enter 5 W/m²-K for Heat Transfer Coefficient.

d. Enter 293.15 K for Free Stream Temperature.

e. Enter 0.75 for External Emissivity.

f. Enter 293.15 K for External Radiation Temperature.

g. Enter 0.95 for Internal Emissivity.

h. Enter 0.05 m for Wall Thickness.

i. Click OK to close the Wall dialog box.

2. Copy boundary conditions to define the side walls w-high-z and w-low-z.

   Boundary Conditions → Copy...
a. Select **w-high-x** from the **From Boundary Zone** selection list.

b. Select **w-high-z** and **w-low-z** from the **To Boundary Zones** selection list.

c. Click **Copy**.

d. Click **OK** when the **Question** dialog box opens asking whether you want to copy the boundary conditions of w-high-x to all the selected zones.

e. Close the **Copy Conditions** dialog box.

3. Set the boundary conditions for the heated wall (**w-low-x**).

   ![Boundary Conditions](image)

   ![Wall](image)
a. Click the **Thermal** tab and select **Temperature** from the **Thermal Conditions** list.

b. Retain the default selection of **aluminum** from the **Material Name** drop-down list.

c. Enter 473.15 K for **Temperature**.

d. Enter 0.95 for **Internal Emissivity**.

e. Click **OK** to close the **Wall** dialog box.

4. Set the boundary conditions for the top wall (w-high-y).

   ![Boundary Conditions](image)

   - Click the **Thermal** tab and select **Mixed** from the **Thermal Conditions** list.
   - Select **insulation** from the **Material Name** drop-down list.
   - Enter 3 W/m²-K for **Heat Transfer Coefficient**.
   - Enter 293.15 K for **Free Stream Temperature**.
   - Enter 0.75 for **External Emissivity**.
   - Enter 293.15 K for **External Radiation Temperature**.
   - Enter 0.95 for **Internal Emissivity**.
   - Enter 0.05 m for **Wall Thickness**.
i. Click OK to close the Wall dialog box.

5. Copy boundary conditions to define the bottom wall (w-low-y) as previously done in this tutorial.

![Boundary Conditions → Copy...](image)

a. Select w-high-y from the **From Boundary Zone** selection list.

b. Select w-low-y from the **To Boundary Zones** selection list.

c. Click **Copy**.

d. Click OK when the Question dialog box opens asking whether you want to copy the boundary conditions of w-high-y to all the selected zones.

e. Close the **Copy Conditions** dialog box.

### 7.4.7. Obtaining the Solution

1. Set the solution parameters.

![Solution Methods](image)
a. Select **Coupled** from the **Scheme** drop-down list in the **Pressure-Velocity Coupling** group box.

b. Select **Body Force Weighted** from the **Pressure** drop-down list in the **Spatial Discretization** group box.

c. Retain the default selection of **Second Order Upwind** from the **Momentum** and **Energy** drop-down lists.

d. Enable the **Pseudo Transient** option.

2. Initialize the solution.

Solution Initialization
a. Retain the default selection of **Hybrid Initialization** from the **Initialization Methods** list.

b. Click **Initialize**.

3. Define a surface monitor to aid in judging convergence.

   *It is good practice to use monitors of physical solution quantities together with residual monitors when determining whether a solution is converged. In this step you will set up a surface monitor of the average temperature on the z=0 plane.*

   a. Create the new surface, **zz_center_z**.

   **Surface → Iso-Surface...**

   i. Select **Mesh...** and **Z-Coordinate** from the **Surface of Constant** drop-down lists.

   ii. Click **Compute** and retain the default value of **0** for **Iso-Values**.
iii. Enter `zz_center_z` for **New Surface Name**.

**Note**

If you want to delete or otherwise manipulate any surfaces, click **Manage...** to open the **Surfaces** dialog box.

iv. Click **Create** and close the **Iso-Surface** dialog box.

b. Create the surface monitor.

¢ Monitors (Surface Monitors) → Create...

![Surface Monitor dialog box](image)

i. Retain the default entry of **surf-mon-1** for the **Name** of the surface monitor.

ii. Enable the **Plot** option.

**Note**

Unlike residual values, data from other monitors is not saved as part of the solution set when the ANSYS Fluent data file is saved. If you want to access the surface monitor data in future ANSYS Fluent sessions, you can enable the **Write** option and enter a **File Name** for the monitor output.
iii. Select **Area-Weighted Average** from the **Report Type** drop-down list.
iv. Select **Temperature**... and **Static Temperature** from the **Field Variable** drop-down lists.
v. Select **zz_center_z** from the **Surfaces** selection list.
vi. Click **OK** to save the surface monitor settings and close the **Surface Monitor** dialog box.

4. Save the case file (rad_a_1.cas.gz)
   **File → Write → Case...**

5. Start the calculation by requesting 300 iterations.

**Run Calculation**

a. Select **User Specified** from the **Time Step Method** list.
b. Retain the default value of 1 for **Pseudo Time Step**.
c. Enter 300 for **Number of Iterations**.
d. Click **Calculate**.
The surface monitor history shows that the average temperature on **zz_center_z** has stabilized, thus confirming that the solution has indeed reached convergence. You can view the behavior of the residuals (Figure 7.4: Scaled Residuals (p. 324)) by selecting **Scaled Residuals** from the graphics window drop-down list.
7.4.8. Postprocessing

1. Create a new surface, $zz_{x\_side}$, which will be used later to plot wall temperature.

   Surface → Line/Rake...

   ![Line/Rake Surface dialog box]

   - Options: Line Tool
   - Type: Line
   - Number of Points: 10
   - End Points:
     - x0 (m): -0.125
     - x1 (m): 0.125
     - y0 (m): 0
     - y1 (m): 0
     - z0 (m): 0.125
     - z1 (m): 0.125
   - New Surface Name: $zz_{x\_side}$
a. Enter \((-0.125, 0, 0.125)\) for \((x_0, y_0, z_0)\), respectively.

b. Enter \((0.125, 0, 0.125)\) for \((x_1, y_1, z_1)\), respectively.

c. Enter \(zz_x\text{_side}\) for New Surface Name.

---

**Note**

If you want to delete or otherwise manipulate any surfaces, click **Manage**... to open the Surfaces dialog box.

---

d. Click **Create** and close the Line/Rake Surface dialog box.

2. Display contours of static temperature.

   ![Graphics and Animations](Contours_Setup.png)

   a. Enable the **Filled** option in the Options group box.

   b. Select **Temperature**... and **Static Temperature** from the Contours of drop-down lists.

   c. Select **zz_center_z** from the Surfaces selection list.

   d. Enable the **Draw Mesh** option in the Options group box to open the Mesh Display dialog box.

      i. Select **Outline** from the Edge Type list.

      ii. Click **Display** and close the Mesh Display dialog box.
The outline of the geometry is displayed in the graphics window.

e. Disable the **Auto Range** option.

f. Enter 421 K for **Min** and 473.15 K for **Max**.

g. Click **Display** and rotate the view as shown in Figure 7.5: Contours of Static Temperature (p. 326).

*Figure 7.5: Contours of Static Temperature*

![Contours of Static Temperature](image)

A regular check for most buoyant cases is to look for evidence of stratification in the temperature field. This is observed as nearly horizontal bands of similar temperature. These may be broken or disturbed by buoyant plumes. For this case you can expect reasonable stratification with some disturbance at the vertical walls where the air is driven around. Inspection of the temperature contours in Figure 7.5: Contours of Static Temperature (p. 326) reveals that the solution appears as expected.

3. Display contours of wall temperature (surfaces in contact with the fluid).

![Graphics and Animations](image) \(\rightarrow\) \(\rightarrow\) **Contours** \(\rightarrow\) **Set Up...**
a. Ensure that the **Filled** option is enabled in the **Options** group box.

b. Disable the **Node Values** option.

c. Select **Temperature...** and **Wall Temperature** from the **Contours of** drop-down lists.

d. Select all surfaces except **default-interior** and **zz_x_side** in the **Surfaces** selection list.

e. Disable the **Auto Range** and **Draw Mesh** options.

f. Enter 413 K for **Min** and 473.15 K for **Max**.

g. Click **Display**, and rotate the view as shown in Figure 7.6: **Contours of Wall Temperature** (p. 328).

\[ \text{Graphics and Animations} \rightarrow \text{Contours} \rightarrow \text{Set Up...} \]
a. Ensure that the Filled option is enabled in the Options group box.

b. Select Wall Fluxes... and Radiation Heat Flux from the Contours of drop-down list.

c. Make sure that all surfaces except default-interior and zz_x_side are selected in the Surfaces selection list.

d. Click Display.

e. Close the Contours dialog box.

*Figure 7.7: Contours of Radiation Heat Flux (p. 330) shows the radiating wall (w-low-x) with positive heat flux and all other walls with negative heat flux.*
Figure 7.7: Contours of Radiation Heat Flux

5. Display vectors of velocity magnitude.

Graphics and Animations → Vectors → Set Up...
a. Retain the default selection of **Velocity** from the **Vectors of** drop-down list.

b. Retain the default selection of **Velocity**... and **Velocity Magnitude** from the **Color by** drop-down lists.

c. Select **zz_center_z** from the **Surfaces** selection list.

d. Enable the **Draw Mesh** option in the **Options** group box to open the **Mesh Display** dialog box.
   
   i. Ensure that **Outline** is selected from the **Edge Type** list.
   
   ii. Click **Display** and close the **Mesh Display** dialog box.

e. Enter **7** for **Scale**.

f. Click **Display** and rotate the view as shown in Figure 7.8: Vectors of Velocity Magnitude (p. 332).

g. Close the **Vectors** dialog box.
6. Compute view factors and radiation emitted from the front wall \((w\text{-high-x})\) to all other walls.

In the main menu, select \textbf{Report} \(\rightarrow\) \textbf{S2S Information}...
a. Ensure that the View Factors option is enabled in the Report Options group box.

b. Enable the Incident Radiation option.

c. Select w-high-x from the From selection list.

d. Select all zones except w-high-x from the To selection list.

e. Click Compute and close the S2S Information dialog box.

The computed values of the view factors and incident radiation are displayed in the console. A view factor of approximately 0.2 for each wall is a good value for the square box.

7. Compute the total heat transfer rate.

_reports → __fluxes → set up...
a. Select **Total Heat Transfer Rate** from the **Options** list.

b. Select all boundary zones except **default-interior** from the **Boundaries** selection list.

c. Click **Compute**.

---

**Note**

The energy imbalance is approximately 0.04%.

---

8. Compute the total heat transfer rate for **w-low-x**.

   ![Reports ➔ Fluxes ➔ Set Up...](image)
a. Retain the selection of **Total Heat Transfer Rate** from the **Options** list.

b. Deselect all boundary zones and select **w-low-x** from the **Boundaries** selection list.

c. Click **Compute**.

---

**Note**

The net heat load is approximately 63 W.

---

9. Compute the radiation heat transfer rate.

🔗 **Reports → Fluxes → Set Up...**
a. Select **Radiation Heat Transfer Rate** from the **Options** list.

b. Select all boundary zones except **default-interior** from the **Boundaries** selection list.

c. Click **Compute**.

---

**Note**

The heat imbalance is approximately -0.014 W.

---

10. Compute the radiation heat transfer rate for **w-low-x**.

   ![Reports ➔ Fluxes ➔ Set Up...](image)
a. Retain the selection of **Radiation Heat Transfer Rate** from the **Options** list.

b. Deselect all boundary zones and select **w-low-x** from the **Boundaries** selection list.

c. Click **Compute** and close the **Flux Reports** dialog box.

*The net heat load is approximately 51 W. After comparing the total heat transfer rate and radiation heat transfer rate, it can be concluded that radiation is the dominant mode of heat transfer.*

11. Display the temperature profile for the side wall.

\[\text{Plots} \to \text{XY Plot} \to \text{Set Up...}\]
a. Select **Temperature...** and **Wall Temperature** from the **Y Axis Function** drop-down lists.

b. Retain the default selection of **Direction Vector** from the **X Axis Function** drop-down list.

c. Select **zz_x_side** from the **Surfaces** selection list.

d. Click **Plot** (Figure 7.9: Temperature Profile Along the Outer Surface of the Box (p. 339)).

e. Enable the **Write to File** option and click the **Write...** button to open the **Select File** dialog box.
   
   i. Enter **tp_1.xy** for **XY File**.
   
   ii. Click **OK** in the **Select File** dialog box.

f. Disable the **Write to File** option.

g. Close the **Solution XY Plot** dialog box.
Figure 7.9: Temperature Profile Along the Outer Surface of the Box

12. Save the case and data files (rad_b_1.cas.gz and rad_b_1.dat.gz).

File → Write → Case & Data...

7.4.9. Comparing the Contour Plots after Varying Radiating Surfaces

1. Increase the number of faces per cluster to 10.

Models → Radiation → Edit...

a. Click the Settings... button to open the View Factors and Clustering dialog box.

i. Enter 10 for Faces per Surface Cluster for Flow Boundary Zones in the Manual group box.

ii. Click Apply to All Walls.

iii. Click OK to close the View Factors and Clustering dialog box.

b. Click the Compute/Write/Read... button to open the Select File dialog box and to compute the view factors.

Specify a name for the S2S file that will store the cluster and view factor parameters.

i. Enter rad_10.s2s.gz for S2S File.

ii. Click OK in the Select File dialog box.
c. Click OK to close the Radiation Model dialog box.

2. In the Solution Initialization task page, click Initialize.

   Solution Initialization

3. Start the calculation by requesting 300 iterations.

   Run Calculation

   The solution will converge in approximately 280 iterations.

4. Save the case and data files (rad_10.cas.gz and rad_10.dat.gz).

   File → Write → Case & Data...

5. In a similar manner described in the steps 11.a – 11.g of Postprocessing (p. 324), display the temperature profile for the side wall and write it to a file named tp_10.xy.

6. Repeat the procedure, outlined in steps 1 – 5 of this section, for 100, 400, 800, and 1600 faces per surface cluster and save the respective S2S files (for example, rad_100.s2s.gz), case and data files (for example, rad_100.cas.gz), and temperature profile files (for example, tp_100.xy).

7. Display contours of wall temperature for all six cases, in the manner described in step 3 of Postprocessing (p. 324).

   Graphics and Animations → Contours → Set Up...
Figure 7.10: Contours of Wall Temperature: 1 Face per Surface Cluster

Contours of Wall Temperature (K)

ANSYS Fluent (3d, pbns, lam)
Figure 7.11: Contours of Wall Temperature: 10 Faces per Surface Cluster
Figure 7.12: Contours of Wall Temperature: 100 Faces per Surface Cluster

Contours of Wall Temperature (K)

ANSYS Fluent (3d, pbns, lam)
Figure 7.13: Contours of Wall Temperature: 400 Faces per Surface Cluster

Contours of Wall Temperature (K)

ANSYS Fluent (3d, pblns, lam)
Figure 7.14: Contours of Wall Temperature: 800 Faces per Surface Cluster
8. Display contours of surface cluster ID for 1600 faces per surface cluster (Figure 7.16: Contours of Surface Cluster ID—1600 Faces per Surface Cluster (FPSC) (p. 348)).

Graphics and Animations → Contours → Set Up...
a. Ensure that the **Filled** option is enabled in the **Options** group box.

b. Ensure that the **Node Values** option is disabled.

c. Select **Radiation...** and **Surface Cluster ID** from the **Contours of** drop-down lists.

d. Ensure that all surfaces except **default-interior** and **zz_x_side** are selected in the **Surfaces** selection list.

e. Click **Display** and rotate the view as shown in **Figure 7.16: Contours of Surface Cluster ID—1600 Faces per Surface Cluster (FPSC)** (p. 348).

f. Close the **Contours** dialog box.
9. Read `rad_400.cas.gz` and `rad_400.dat.gz` and, in a similar manner to the previous step, display contours of surface cluster ID (Figure 7.17: Contours of Surface Cluster ID—400 FPSC (p. 349)).
Figure 7.17: Contours of **Surface Cluster ID**—400 FPSC

Figure 7.17: **Surface Cluster ID**—400 FPSC (p. 349) shows contours of **Surface Cluster ID** for 400 FPSC. This case shows better clustering compared to all of the other cases.

10. Create a plot that compares the temperature profile plots for 1, 10, 100, 400, 800, and 1600 FPSC.

   ➥ **Plots** → **File** → **Set Up...**

   a. Click the **Add...** button to open the **Select File** dialog box.

   i. Select the file `tp_1.xy` that you created in step 11 of Postprocessing (p. 324).

   ii. Click **OK** to close the **Select File** dialog box.

b. Change the legend entry for the data series.
i. Enter Faces/Cluster in the **Legend Title** text box.

ii. Enter 1 in the text box to the left of the **Change Legend Entry** button.

iii. Click **Change Legend Entry**.

   ANSYS Fluent will update the Legend Entry text for the file `tp_1.xy`.

c. Load the files `tp_10.xy`, `tp_100.xy`, `tp_400.xy`, `tp_800.xy`, and `tp_1600.xy` and change their legend entries accordingly, in a manner similar to the previous two steps (a and b).

d. Click the **Axes...** button to open the **Axes** dialog box.

i. Ensure X is selected from the **Axis** list.

ii. Enter 3 for **Precision** in the **Number Format** group box and click **Apply**.

iii. Select Y from the **Axis** list.

iv. Enter 2 for **Precision** and click **Apply**.

v. Close the **Axes** dialog box.
7.4.10. S2S Definition, Solution, and Postprocessing with Partial Enclosure

As mentioned previously, when the S2S model is used, you also have the option to define a “partial enclosure”; that is, you can disable the view factor calculation for walls with negligible emission/absorption, or walls that have uniform temperature. Even though the view factor will not be computed for these walls, they will still emit radiation at a fixed temperature called the “partial enclosure temperature”. The main advantage of this is to speed up the view factor and the radiosity calculation.

In the steps that follow, you will specify the radiating wall (w-low-x) as a boundary zone that is not participating in the S2S radiation model. Consequently, you will specify the partial enclosure temperature for the wall. Note that the partial enclosure option may not yield accurate results in cases that have multiple wall boundaries that are not participating in S2S radiation and that each have different temperatures. This is because a single partial enclosure temperature is applied to all of the non-participating walls.

1. Read the case file saved previously for the S2S model (rad_b_1.cas.gz).

   File → Read → Case...

2. Set the partial enclosure parameters for the S2S model.

   Boundary Conditions → w-low-x → Edit...
a. Click the **Radiation** tab.

b. Disable the **Participates in View Factor Calculation** option in the **S2S Parameters** group box.

c. Click **OK** to close the **Wall** dialog box.

*Click **OK** to close the dialog box informing you that you must recompute viewfactors.*

3. Compute the view factors for the S2S model.

    ![Models → Radiation → Edit...](image)

a. Click the **Settings...** button to open the **View Factors and Clustering** dialog box.

b. Click the **Select...** button to open the **Participating Boundary Zones** dialog box.
i. Enter 473.15 K for Non-Participating Boundary Zones Temperature.

ii. Click OK to close the Participating Boundary Zones dialog box.

   Click OK to close the dialog box informing you that you must recompute viewfactors.

   c. Click OK to close the View Factors and Clustering dialog box.

   d. Click the Compute/Write/Read... button to open the Select File dialog box and to compute the view factors.

   The view factor file will store the view factors for the radiating surfaces only. This may help you control the size of the view factor file as well as the memory required to store view factors in ANSYS Fluent. Furthermore, the time required to compute the view factors will be reduced, as only the view factors for radiating surfaces will be calculated.

---

**Note**

You should compute the view factors only after you have specified the boundaries that will participate in the radiation model using the Boundary Conditions dialog box. If you first compute the view factors and then make a change to the boundary conditions, ANSYS Fluent will use the view factor file stored previously for calculating a solution, in which case, the changes that you made to the model will not be used for the calculation. Therefore, you should recomputate the view factors and save the case file whenever you modify the number of objects that will participate in radiation.
i. Enter `rad_partial.s2s.gz` for **S2S File**.

ii. Click **OK** in the **Select File** dialog box.

e. Click **OK** to close the **Radiation Model** dialog box.

4. In the **Solution Initialization** task page, click **Initialize**.

**Solution Initialization**

5. Start the calculation by requesting 300 iterations.

**Run Calculation**

*The solution will converge in approximately 275 iterations.*

6. Save the case and data files (`rad_partial.cas.gz` and `rad_partial.dat.gz`).

File → Write → Case & Data...

7. Compute the radiation heat transfer rate.

**Reports** → **Fluxes** → **Set Up**...

![Flux Reports dialog box](image)

a. Ensure that **Radiation Heat Transfer Rate** is selected from the **Options** list.

b. Select all boundary zones except **default-interior** from the **Boundaries** selection list.

c. Click **Compute** and close the **Flux Reports** dialog box.

*The Flux Reports dialog box does not report any heat transfer rate for the radiating wall (**w-low-x**), because you specified that it not participate in the view factor calculation. The remaining walls report...*
similar rates to those obtained in step 9 of Postprocessing (p. 324), indicating that in this case the use of a partial enclosure saved computation time without significantly affecting the results.

8. Compare the temperature profile for the side wall to the profile saved in tp_1.xy.

\[ \text{Plots} \rightarrow \text{XY Plot} \rightarrow \text{Set Up...} \]

a. Display the temperature profile for the side wall, \texttt{zz_x_side}, and write it to a file named \texttt{tp_partial.xy}, in a manner similar to the instructions shown in step 11 of Postprocessing (p. 324).

b. Click Load File... to open the Select File dialog box.
   i. Select \texttt{tp_1.xy}.
   ii. Click OK to close the Select File dialog box.

c. Click Plot.

d. Close the Solution XY Plot dialog box.

\textbf{Figure 7.19: Wall Temperature Profile Comparison}

\textit{further confirms that the use of a partial enclosure did not significantly affect the results.}

\textbf{7.5. Summary}

In this tutorial you studied combined natural convection and radiation in a three-dimensional square box and compared how varying the settings of the surface-to-surface (S2S) radiation model affected
the results. The S2S radiation model is appropriate for modeling the enclosure radiative transfer without participating media, whereas the methods for participating radiation may not always be efficient.

For more information about the surface-to-surface (S2S) radiation model, see Modeling Radiation in the User's Guide.

### 7.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 8: Using the Discrete Ordinates Radiation Model

This tutorial is divided into the following sections:

8.1. Introduction
8.2. Prerequisites
8.3. Problem Description
8.4. Setup and Solution
8.5. Summary
8.6. Further Improvements

8.1. Introduction

This tutorial illustrates the set up and solution of flow and thermal modelling of a headlamp. The discrete ordinates (DO) radiation model will be used to model the radiation.

This tutorial demonstrates how to do the following:

• Read an existing mesh file into ANSYS Fluent.
• Set up the DO radiation model.
• Set up material properties and boundary conditions.
• Solve for the energy and flow equations.
• Initialize and obtain a solution.
• Postprocess the resulting data.
• Understand the effect of pixels and divisions on temperature predictions and solver speed.

8.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.
8.3. Problem Description

The problem to be considered is illustrated in Figure 8.1: Schematic of the Problem (p. 358), showing a simple two-dimensional section of a headlamp construction. The key components to be included are the bulb, reflector, baffle, lens, and housing. For simplicity, the heat output will only be considered from the bulb surface rather than the filament of the bulb. The radiant load from the bulb will cover all thermal radiation—this includes visible (light) as well as infrared radiation.

The ambient conditions to be considered are quiescent air at 20°C. Heat exchange between the lamp and the surroundings will occur by conduction, convection and radiation. The rear reflector is assumed to be well insulated and heat losses will be ignored. The purpose of the baffle is to shield the lens from direct radiation. Both the reflector and baffle are made from polished metal having a low emissivity and mirror-like finish; their combined effect should distribute the light and heat from the bulb across the lens. The lens is made from glass and has a refractive index of 1.5.

Figure 8.1: Schematic of the Problem

8.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

8.4.1. Preparation
8.4.2. Mesh
8.4.3. General Settings
8.4.4. Models
8.4.5. Materials
8.4.6. Cell Zone Conditions
8.4.7. Boundary Conditions
8.4.8. Solution
8.4.9. Postprocessing
8.4.10. Iterate for Higher Pixels
8.4.11. Iterate for Higher Divisions
8.4.12. Make the Reflector Completely Diffuse
8.4.13. Change the Boundary Type of Baffle

8.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

   **Note**

   If you do not have a login, you can request one by clicking **Customer Registration** on the login page.

3. Enter the name of this tutorial into the search bar.
4. Narrow the results by using the filter on the left side of the page.
   a. Click **ANSYS Fluent** under **Product**.
   b. Click **15.0** under **Version**.
5. Select this tutorial from the list.
6. Click **Files** to download the input and solution files.
7. Unzip `do_rad_R150.zip` to your working folder.

   *The mesh file `do.msh.gz` can be found in the `do_rad` folder created after unzipping the file.*
8. Use Fluent Launcher to start the **2D** version of ANSYS Fluent.

   Fluent Launcher displays your **Display Options** preferences from the previous session.

   For more information about Fluent Launcher, see **Starting ANSYS Fluent Using Fluent Launcher** in the User’s Guide.
9. Ensure that the **Display Mesh After Reading**, **Embed Graphics Windows**, and **Workbench Color Scheme** options are enabled.
10. Run in single precision (disable **Double Precision**).
11. Ensure that **Serial** is selected under **Processing Options**.

8.4.2. Mesh

1. Read the mesh file `do.msh.gz`.

   `File → Read → Mesh...`
As the mesh file is read, ANSYS Fluent will report the progress in the console.

8.4.3. General Settings

1. Check the mesh.

   General → Check

   ANSYS Fluent will perform various checks on the mesh and report the progress in the console. Ensure that the reported minimum volume is a positive number.

2. Scale the mesh.

   General → Scale...

   ![Scale Mesh dialog box]

   a. Select mm from the View Length Unit In drop-down list.

      The Domain Extents will be reported in mm.

   b. Select mm from the Mesh Was Created In drop-down list.

   c. Click Scale and close the Scale Mesh dialog box.

3. Check the mesh.

   General → Check

   **Note**

   It is good practice to check the mesh after manipulating it (scale, convert to polyhedra, merge, separate, fuse, add zones, or smooth and swap).

4. Examine the mesh.
5. Change the unit of temperature to centigrade.

 América General ➔ Units...
a. Select **temperature** from the **Quantities** selection list.

b. Select **c** from the **Units** selection list.

c. Close the **Set Units** dialog box.

6. Confirm the solver settings and enable gravity.

**General**

![General settings](image-url)
a. Retain the default selections in the **Solver** group box.

b. Enable **Gravity**.

c. Enter $-9.81 \text{ m/s}^2$ for **Gravitational Acceleration** in the Y direction.

### 8.4.4. Models

1. Enable the energy equation.

   ![Energy dialog box]

2. Enable the **DO** radiation model.

   ![Radiation Model dialog box]

   a. Select **Discrete Ordinates (DO)** in the **Model** list.

      *The **Radiation Model** dialog box expands to show the related inputs.*

   b. Set the **Energy Iterations per Radiation Iteration** to 1.

      *As radiation will be the dominant mode of heat transfer, it is beneficial to reduce the interval between calculations. For this small 2D case we will reduce it to 1.*

   c. Retain the default settings for **Angular Discretization**.
Using the Discrete Ordinates Radiation Model

d. Click OK to close the Radiation Model dialog box.

An Information dialog box will appear, indicating that material properties have changed.

e. Click OK in the Information dialog box.

![Information Dialog Box]

8.4.5. Materials

1. Set the properties for air.

![Create/Edit Materials Dialog Box]

a. Select incompressible-ideal-gas from the Density drop-down list.

Since pressure variations are insignificant compared to temperature variation, we choose incompressible-ideal-gas law for density.

b. Retain the default settings for all other parameters.

c. Click Change/Create and close the Create/Edit Materials dialog box.
2. Create a new material, **lens**.

[Image of Create/Edit Materials window]

a. Enter **lens** for **Name** and delete the entry in the **Chemical Formula** field.

b. Enter **2200 Kg/m³** for **Density**.

c. Enter **830 J/Kg-K** for **Cp (Specific Heat)**.

d. Enter **1.5 W/m-K** for **Thermal Conductivity**.

e. Enter **200 1/m** for **Absorption Coefficient**.

f. Enter **1.5** for **Refractive Index**.

g. Click **Change/Create**.

A **Question** dialog box will open, asking if you want to overwrite **aluminum**.
h. Click No in the Question dialog box to retain aluminum and add the new material (lens) to the materials list.

The Create/Edit Materials dialog box will be updated to show the new material, lens, in the ANSYS Fluent Solid Materials drop-down list.

i. Close the Create/Edit Materials dialog box.

8.4.6. Cell Zone Conditions

Cell Zone Conditions

1. Ensure that air is selected for fluid.

Cell Zone Conditions → fluid → Edit...
a. Retain the default selection of **air** from the **Material Name** drop-down list.

b. Click **OK** to close the **Fluid** dialog box.

2. Set the cell zone conditions for the **lens**.

   ![Cell Zone Conditions](image)

   ![Lens](image) → **Edit...**
a. Select **lens** from the **Material Name** drop-down list.

b. Enable **Participates In Radiation**.

c. Click **OK** to close the **Solid** dialog box.

**8.4.7. Boundary Conditions**

Boundary Conditions
1. Set the boundary conditions for the **baffle**.

   ![Boundary Conditions](#) → **baffle** → **Edit...**
Using the Discrete Ordinates Radiation Model

1. Set the boundary conditions for the baffle-shadow.

   ![Wall dialog box](image)

   a. Click the **Thermal** tab and enter \(0.1\) for **Internal Emissivity**.

   b. Click the **Radiation** tab and enter \(0\) for **Diffuse Fraction**.

   c. Click **OK** to close the **Wall** dialog box.

2. Set the boundary conditions for the **baffle-shadow**.

   ![Boundary Conditions](image)
a. Click the **Thermal** tab and enter 0.1 for **Internal Emissivity**.

b. Click the **Radiation** tab and enter 0 for **Diffuse Fraction**.

c. Click **OK** to close the **Wall** dialog box.

3. Set the boundary conditions for the **bulb-outer**.

   ![Boundary Conditions](bulb-outer>Edit...)

---

*release: 15.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.*

371
a. Click the **Thermal** tab and enter **150000 W/m$^2$** for **Heat Flux**.

   The circumference of **bulb-outer** is approximately 0.004 m. Therefore the 600 W/m lineal heat flux specified in the problem description corresponds to 150000 W/m$^2$.

b. Retain the value of 1 for **Internal Emissivity**.

c. Click **OK** to close the **Wall** dialog box.

4. Set the boundary conditions for the **housing**.

   ![Boundary Conditions → housing → Edit...](image)
a. Click the **Thermal** tab and select **Mixed** in the **Thermal Conditions** group box.

b. Enter 10 W/m²·K for **Heat Transfer Coefficient**.

c. Enter 20°C for **Free Stream Temperature**.

d. Retain the value of 1 for **External Emissivity**.

e. Enter 20°C for **External Radiation Temperature**.

f. Enter 0.5 for **Internal Emissivity**.

g. Click **OK** to close the **Wall** dialog box.

5. Set the boundary conditions for the **lens-inner**.

   ![Wall dialog box](image)

   **Boundary Conditions** → **lens-inner** → **Edit**

   The inner and outer surface of the lens will be set to semi-transparent conditions. This allows radiation to be transmitted through the wall between the two adjacent participating cell zones. It also calculates the effects of reflection and refraction at the interface. These effects occur because of the change in refractive index (set through the material properties) and are a function of the incident angle of the radiation and the surface finish. In this case, the lens is assumed to have a very smooth surface so the diffuse fraction will be set to 0.

   On the internal walls (wall/wall-shadows) it is important to note the adjacent cell zone: this is the zone the surface points into and may influence the settings on the diffuse fraction (these can be different on both sides of the wall).
a. Click the **Radiation** tab.

b. Select **semi-transparent** from the **BC Type** drop-down list.

c. Enter 0 for **Diffuse Fraction**.

d. Click **OK** to close the **Wall** dialog box.

6. Set the boundary conditions for the **lens-inner-shadow**.

![Wall dialog box](image)

**Boundary Conditions → lens-inner-shadow → Edit...**

a. Click the **Radiation** tab.

b. Retain the selection of **semi-transparent** from the **BC Type** drop-down list.

c. Enter 0 for **Diffuse Fraction**.

d. Click **OK** to close the **Wall** dialog box.

7. Set the boundary conditions for the **lens-outer**.

![Wall dialog box](image)

**Boundary Conditions → lens-outer → Edit...**

*The surface of the lamp cools mainly by natural convection to the surroundings. As the outer lens is transparent it must also lose radiation to the surroundings, while the surroundings will supply a small source of background radiation associated with the temperature. For the lens, a semi-transparent condition*
is used on the outside wall. A mixed thermal condition provides the source of background radiation as well as calculating the convective cooling on the outer lens wall. For a semi-transparent wall, the source of background radiation is added directly to the DO radiation rather than to the energy equation; an external emissivity of 1 is used, in keeping with the assumption of a small object in a large enclosure. As the background radiation is supplied from the thermal conditions, there is no need to supply this as a source of irradiation under the **Radiation** tab for the wall boundary condition. The only other setting required here is the surface finish of the outer surface of the lens; the diffuse fraction should be set to 0 as the lens is assumed to be smooth.

![Wall Properties](image)

**Setup and Solution**

a. Click the **Thermal** tab and select **Mixed** in the **Thermal Conditions** group box.

b. Enter 10 W/m²–K for **Heat Transfer Coefficient**.

c. Enter 20°C for **Free Stream Temperature**.

d. Retain the value of 1 for **External Emissivity**.

   For a semi-transparent wall the internal emissivity has no effect as there is no absorption or emission on the surface. So the set value is irrelevant.

e. Enter 20°C for **External Radiation Temperature**.

f. Ensure that **aluminum** is selected from the **Material Name** drop-down list.

   Because lens-outer is modeled as a zero-thickness wall, the choice of material is unimportant.

g. Click the **Radiation** tab.
h. Select **semi-transparent** from the **BC Type** drop-down list.

i. Enter 0 for **Diffuse Fraction**.

j. Click **OK** to close the **Wall** dialog box.

8. Set the boundary conditions for the **reflector**.

   ![Wall dialog box]

   Like the baffles, the reflector is made of highly polished aluminum, giving it highly reflective surface property; about 90% of incident radiation reflects from this surface so only about 10% gets absorbed. Based on Kirchhoff’s law, we can assume emissivity equals absorptivity. Therefore, we apply internal emissivity = 0.1. We also assume a clean reflector (diffuse fraction = 0).

   a. Click the **Thermal** tab and enter 0.1 for **Internal Emissivity**.

   b. Click the **Radiation** tab and enter 0 for **Diffuse Fraction**.

   c. Click **OK** to close the **Wall** dialog box.

**8.4.8. Solution**

1. Set the solution parameters.
### Solution Methods

<table>
<thead>
<tr>
<th>Solution Methods</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pressure-Velocity Coupling</strong></td>
</tr>
<tr>
<td>Scheme: SIMPLE</td>
</tr>
<tr>
<td><strong>Spatial Discretization</strong></td>
</tr>
<tr>
<td>Gradient: Least Squares Cell Based</td>
</tr>
<tr>
<td>Pressure</td>
</tr>
<tr>
<td>Body Force Weighted</td>
</tr>
<tr>
<td>Momentum</td>
</tr>
<tr>
<td>Energy</td>
</tr>
<tr>
<td>Second Order Upwind</td>
</tr>
<tr>
<td>Discrete Ordinates</td>
</tr>
<tr>
<td>First Order Upwind</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transient Formulation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-Iterative Time Advancement</td>
</tr>
<tr>
<td>Frozen Flux Formulation</td>
</tr>
<tr>
<td>Pseudo Transient</td>
</tr>
<tr>
<td>High Order Term Relaxation</td>
</tr>
</tbody>
</table>

#### a. Select **Body Force Weighted** from the **Pressure** drop-down list in the **Spatial Discretization** group box.

#### 2. Set the under-relaxation factors.

### Solution Controls
a. Enter 0.7 for Pressure.

b. Enter 0.6 for Momentum.

3. Reduce the convergence criteria.

Monitors → Residuals → Edit...
a. Enter 1e-4 for **Absolute Criteria** for continuity.

b. Ensure that **Print to Console** and **Plot** are enabled.

c. Click **OK** to close the **Residual Monitors** dialog box.

4. Initialize the solution.

**Solution Initialization**

- Retain the selection of **Hybrid Initialization** from the **Initialization Methods** group box.
- Click **Initialize**.

5. Save the case file (do.cas.gz)

   - **File** → **Write** → **Case...**

6. Start the calculation by requesting 1500 iterations.

**Run Calculation**

- **Number of Iterations**: 1500
- **Profile Update Interval**: 1
- **Data File Quantities**
- **Acoustic Signals**
a. Enter 1500 for **Number of Iterations**.

b. Click **Calculate**.

**Figure 8.3: Residuals**

The solution will converge in approximately 1180 iterations.

7. Save the case and data files (**do.cas.gz** and **do.dat.gz**).

   **File → Write → Case & Data...**

**8.4.9. Postprocessing**

1. Display velocity vectors.

   **Graphics and Animations → Vectors → Set Up...**
a. Enter 10 for **Scale**.

b. Retain the default selection of **Velocity** from the **Vectors of** drop-down list.

c. Retain the default selection of **Velocity**... and **Velocity Magnitude** from the **Color by** drop-down list.

d. Click **Display** (Figure 8.4: Vectors of Velocity Magnitude (p. 382)).

e. Close the **Vectors** dialog box.

---

**Tip**

You may need to click the **Fit to Window** button to center the vector graphic in your graphics window.
Using the Discrete Ordinates Radiation Model

2. Create the new surface, lens.

Surface → Zone...
a. Select **lens** from the **Zone** selection list.

b. Click **Create** and close the **Zone Surface** dialog box.

3. Display contours of static temperature.

   ![Contour Setup](image)

   a. Enable **Filled** in the **Options** group box.

   b. Disable **Global Range** in the **Options** group box.
c. Select **Temperature**... and **Static Temperature** from the **Contours of** drop-down lists.

d. Select **lens** from the **Surfaces** selection list.

e. Click **Display** (Figure 8.5: **Contours of Static Temperature** (p. 384)).

**Figure 8.5: Contours of Static Temperature**

f. Close the **Contours** dialog box.

4. Display temperature profile for the **lens-inner**.

   ![Plots → XY Plot → Set Up...](image)
a. Disable both Node Values and Position on X Axis in the Options group box.

b. Enable Position on Y Axis.

c. Enter 0 and 1 for X and Y, respectively, in the Plot Direction group box.

d. Retain the default selection of Direction Vector from the Y Axis Function drop-down list.

e. Select Temperature... and Wall Temperature from the X Axis Function drop-down lists.

f. Select lens-inner from the Surfaces selection list.

g. Click the Axes... button to open the Axes - Solution XY Plot dialog box.
Using the Discrete Ordinates Radiation Model

(i) Ensure that X is selected in the **Axis** list.
(ii) Enter Temperature on Lens Inner for **Label**.
(iii) Select **float** from the **Type** drop-down list in the **Number Format** group box.
(iv) Set **Precision** to 0.
(v) Click **Apply**.

![Axes - Solution XY Plot dialog box](image)

(vi) Select Y in the **Axis** list.
(vii) Enter Y Position on Lens Inner for **Label**.
(viii) Select **float** from the **Type** drop-down list in the **Number Format** group box.
(ix) Set **Precision** to 0.
(x) Click **Apply** and close the **Axes - Solution XY Plot** dialog box.

(h) Click the **Curves...** button to open the **Curves - Solution XY Plot** dialog box.
i. Select the line pattern as shown in the **Curves - Solution XY Plot** dialog box.

ii. Select the symbol pattern as shown in the **Curves - Solution XY Plot** dialog box.

iii. Click **Apply** and close the **Curves - Solution XY Plot** dialog box.

i. Click **Plot** (Figure 8.6: Temperature Profile for lens-inner (p. 387)).

**Figure 8.6: Temperature Profile for lens-inner**

j. Enable **Write to File** and click the **Write...** button to open the **Select File** dialog box.

i. Enter `do_2x2_1x1.xy` for **XY File**.

ii. Click **OK** to close the **Select File** dialog box.
Using the Discrete Ordinates Radiation Model

k. Close the Solution XY Plot dialog box.

### 8.4.10. Iterate for Higher Pixels

1. Increase pixelation for accuracy.

   Models → Radiation → Edit...

   For semi-transparent and reflective surfaces, increasing accuracy by increasing pixilation is more efficient than increasing theta and phi divisions.

   ![Radiation Model Dialog Box]

   a. Set both Theta Pixels and Phi Pixels to 2.
   b. Click OK to close the Radiation Model dialog box.

2. Request 1500 more iterations.

   ![Run Calculation]

   The solution will converge in approximately 500 additional iterations.

3. Save the case and data files (do_2x2_2x2_pix.cas.gz and do_2x2_2x2_pix.dat.gz).

   File → Write → Case & Data...

4. Display temperature profile for the lens-inner.

   Plots → XY Plot → Set Up...

   a. Disable Write to File.
   b. Retain the default settings and plot the temperature profile.
   c. Enable Write to File and click the Write... button to open the Select File dialog box.
i. Enter `do_2x2_2x2_pix.xy` for **XY File**.

ii. Click **OK** to close the **Select File** dialog box.

d. Click the **Load File...** button to open the **Select File** dialog box.

i. Select `do_2x2_1x1.xy`.

ii. Click **OK** to close the **Select File** dialog box.

e. Click the **Curves...** button to open **Curves - Solution XY Plot** dialog box.

i. Set **Curve #** to 1.

ii. Select the line pattern as shown in the **Curves - Solution XY Plot** dialog box.

iii. Select the symbol pattern as shown in the **Curves - Solution XY Plot** dialog box.

iv. Click **Apply** and close the **Curves - Solution XY Plot** dialog box.

![Curves - Solution XY Plot dialog box](image)

f. Disable **Write to File**.

g. Click **Plot** (**Figure 8.7: Temperature Profile for lens-inner** (p. 390)).
h. Close the Solution XY Plot dialog box.

5. Increase both Theta Pixels and Phi Pixels to 3 and continue iterations.

   - Models → Radiation → Edit...

6. Click the Calculate button.

   - Run Calculation

   The solution will converge in approximately 450 additional iterations.

7. Save the case and data files (do_2x2_3x3_pix.cas.gz and do_2x2_3x3_pix.dat.gz).

   File → Write → Case & Data...

8. Display temperature profile for the lens-inner.

   - Plots → XY Plot → Set Up...

a. Ensure that Write to File is disabled.

b. Ensure that all files are deselected from the File Data selection list.

c. Ensure that lens-inner is selected from the Surfaces selection list.

d. Click Plot.
e. Enable **Write to File** and save the file as `do_2x2_3x3_pix.xy`.

9. Repeat the procedure for 10 **Theta Pixels** and **Phi Pixels** and save the case and data files (`do_2x2_10x10_pix.cas.gz` and `do_2x2_10x10_pix.dat.gz`).
   a. Save the file as `do_2x2_10x10_pix.xy`.

10. Read in all the files and plot them.

    ![Plots → XY Plot → Set Up...](image)

    a. Disable **Write to File**.

    b. Click the **Load File...** button to open the **Select File** dialog box.

       i. Select all the xy files and close the **Select File** dialog box.

       **Note**

       Selected files will be listed in the **XY File(s)** selection list.

       *Make sure you deselect lens-inner from the **Surfaces** list so that there is no duplicated plot.*

   c. Click the **Curves...** button to open **Curves - Solution XY Plot** dialog box.

      ![Curves - Solution XY Plot](image)

      i. Select the line pattern as shown in the **Curves - Solution XY Plot** dialog box.

      ii. Select the symbol pattern as shown in the **Curves - Solution XY Plot** dialog box.

      iii. Click **Apply** to save the settings for curve zero.

      iv. Set **Curve #** to 1.

      v. Follow the above instructions for curves 2, 3, and 4.

      vi. Click **Apply** and close the **Curves - Solution XY Plot** dialog box.

   d. Click **Plot** (Figure 8.8: Temperature Profile (p. 392)).

   e. Close the **Solution XY Plot** dialog box.
8.4.11. Iterate for Higher Divisions

1. Retain the default division as a base for comparison.

- **Models → Radiation → Edit...**

  ![Radiation Model](image)

  a. Retain both **Theta Divisions** and **Phi Divisions** as 2.
b. Enter a value of 3 for **Theta Pixels** and **Phi Pixels**.

c. Click **OK** to close the **Radiation Model** dialog box.

*This creates a baseline giving better solution efficiency.*

2. Request 1500 more iterations.

❖ **Run Calculation**

*The solution will converge in approximately 500 iterations.*

3. Save the case and data files (do\_2x2\_3x3\_div.cas.gz and do\_2x2\_3x3\_div.dat.gz).

**File** → **Write** → **Case & Data**...

4. Display temperature profiles for the **lens-inner**.

❖ **Plots** → ☀ **XY Plot** → **Set Up**...

a. Select all the files from the **File Data** selection list.

b. Click **Free Data** to remove the files from the list.

c. Retain the settings for **Y axis Function** and **X axis Function**.

d. Select **lens-inner** from the **Surfaces** selection list.

e. Click **Plot**.

f. Enable **Write to File** and click the **Write...** button to open the **Select File** dialog box.

   i. Enter do\_2x2\_3x3\_div.xy for **XY File** and close the **Select File** dialog box.

5. Repeat the procedure for 3 **Theta Divisions** and **Phi Divisions**.

a. Save the file as do\_3x3\_3x3\_div.xy.

6. Save the case and data files (do\_3x3\_3x3\_div.cas.gz and do\_3x3\_3x3\_div.dat.gz).

**File** → **Write** → **Case & Data**...

7. Repeat the procedure for 5 **Theta Divisions** and **Phi Divisions**.

a. Save the file as do\_5x5\_3x3\_div.xy.

8. Read in all the files for **Theta Divisions** and **Phi Divisions** of 2, 3, and 5 and display temperature profiles.

*Make sure you deselect **lens-inner** from the **Surfaces** list so that no plots are duplicated.*
9. Save the case and data files (do_5x5_3x3_div.cas.gz and do_5x5_3x3_div.dat.gz).

   File → Write → Case & Data...

10. Compute the total heat transfer rate.

   Reports → Fluxes → Set Up...
a. Select **Total Heat Transfer Rate** in the **Options** group box.

b. Select all zones from the **Boundaries** selection list.

c. Click **Compute**.

---

**Note**

The net heat load is -0.0499 W, which equates to an imbalance of approximately 0.008% when compared against the heat load of the bulb.

11. Compute the radiation heat transfer rate.

\[\text{Reports} \rightarrow \text{Fluxes} \rightarrow \text{Set Up...}\]
a. Select **Radiation Heat Transfer Rate** in the **Options** group box.

b. Retain the selection of all boundary zones from the **Boundaries** selection list.

c. Click **Compute** and close the **Flux Reports** dialog box.

---

**Note**

The net heat load is approximately 154 W.

---

12. Compute the radiation heat transfer rate incident on the surfaces.

 Reports → Surface Integrals → Set Up...
Set up and Solution

13. Compute the reflected radiation flux.

- **Reports** → **Surface Integrals** → **Set Up**...
a. Retain the selection of **Integral** from the **Report Type** drop-down list.

b. Select **Wall Fluxes...** and **Reflected Radiation Flux** from the **Field Variable** drop-down lists.

c. Select all surfaces except **air-interior** and **lens-interior** from the **Surfaces** selection list.

d. Click **Compute**.

Reflected radiation flux values are printed in the console for all the zones. The zone **baffle** is facing the filament and its shadow (**baffle-shadow**) is facing the lens. There is much more reflection on the filament side than on the lens side, as expected.

**lens-inner** is facing the fluid and **lens-inner-shadow** is facing the lens. Due to different refractive indexes and non-zero absorption coefficient on the lens, there is some reflection at the interface. Reflection on **lens-inner-shadow** is the reflected energy of the incident radiation from the lens side. Reflection on **lens-inner** is the reflected energy of the incident radiation from the fluid side.

14. Compute the transmitted radiation flux.

![Reports → Surface Integrals → Set Up...](image-url)
a. Retain the selection of **Integral** from the **Report Type** drop-down list.

b. Select **Wall Fluxes...** and **Transmitted Radiation Flux** from the **Field Variable** drop-down lists.

c. Ensure that all surfaces are selected except **air-interior** and **lens-interior** from the **Surfaces** selection list.

d. Click **Compute**.

*Transmitted radiation flux values are printed in the console for all the zones. All surfaces are opaque except lens. Zero transmission for all surfaces indicate that they are opaque.*

15. Compute the absorbed radiation flux.

❖ **Reports** → Sousha Integrals → Set Up...
a. Retain the selection of **Integral** from the **Report Type** drop-down list.

b. Select **Wall Fluxes...** and **Absorbed Radiation Flux** from the **Field Variable** drop-down lists.

c. Ensure that all surfaces are selected except **air-interior** and **lens-interior** from the **Surfaces** selection list.

d. Click **Compute**.

e. Close the **Surface Integrals** dialog box.

Absorption will only occur on opaque surface with a non-zero internal emissivity adjacent to participating cell zones. Note that absorption will not occur on a semi-transparent wall (irrespective of the setting for internal emissivity). In semi-transparent media, absorption and emission will only occur as a volumetric effect in the participating media with non-zero absorption coefficients.

### 8.4.12. Make the Reflector Completely Diffuse

1. Read in the case and data files (**do_3x3_3x3_div.cas.gz** and **do_3x3_3x3_div.dat.gz**).
2. Increase the diffuse fraction for **reflector**.

   ![Boundary Conditions](reflector-edit)
a. Click the **Radiation** tab and enter 1 for **Diffuse Fraction**.

b. Click **OK** to close the **Wall** dialog box.

3. Request another 1500 iterations.

**Run Calculation**

*The solution will converge in approximately 700 additional iterations.*

4. Plot the temperature profiles with the increased diffuse fraction for the **reflector**.

   ![Setup and Solution](image)

   *Plots → XY Plot → Set Up...*

   a. Save the file as `do_3x3_3x3_div_df=1.xy`.

   b. Save the case and data files as `do_3x3_3x3_div_df1.cas.gz` and `do_3x3_3x3_div_df1.dat.gz`.
8.4.13. Change the Boundary Type of Baffle

1. Read in the case and data files (do_3x3_3x3_div.cas.gz and do_3x3_3x3_div.dat.gz).
2. Change the boundary type of baffle to interior.

   - **Boundary Conditions → baffle**
     
     a. Select **interior** from the **Type** drop-down list.
        
        A **Question** dialog box will open, asking if you want to change **Type of baffle** to **interior**.
        
        ![Question dialog box]

     b. Click **Yes** in the **Question** dialog box.
3. Reduce the under-relaxation factors.

**Solution Controls**

a. Enter 0.5 for **Pressure**.

b. Enter 0.3 for **Momentum**.


**Run Calculation**

*The solution will converge in approximately 1750 additional iterations.*

5. Plot the temperature profile for **lens-inner** based on the modified **baffle**.

**Plots → XY Plot → Set Up...**

a. Save the file as do_3x3_3x3_div_baf_int.xy.

b. Save the case and data files as do_3x3_3x3_div_int.cas.gz and do_3x3_3x3_div_int.dat.gz.
8.5. Summary

This tutorial demonstrated the modeling of radiation using the discrete ordinates (DO) radiation model in ANSYS Fluent. In this tutorial, you learned the use of angular discretization and pixelation available in the discrete ordinates radiation model and solved for different values of Pixels and Divisions. You studied the change in behavior for higher absorption coefficient. Changes in internal emissivity, refractive index, and diffuse fraction are illustrated with the temperature profile plots.

8.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 9: Using a Non-Conformal Mesh

This tutorial is divided into the following sections:

9.1. Introduction
9.2. Prerequisites
9.3. Problem Description
9.4. Setup and Solution
9.5. Summary
9.6. Further Improvements

9.1. Introduction

Film cooling is a process that is used to protect turbine vanes in a gas turbine engine from exposure to hot combustion gases. This tutorial illustrates how to set up and solve a film cooling problem using a non-conformal mesh. The system that is modeled consists of three parts: a duct, a hole array, and a plenum. The duct is modeled using a hexahedral mesh, and the plenum and hole regions are modeled using a tetrahedral mesh. These two meshes are merged together to form a “hybrid” mesh, with a non-conformal interface boundary between them.

Due to the symmetry of the hole array, only a portion of the geometry is modeled in ANSYS Fluent, with symmetry applied to the outer boundaries. The duct contains a high-velocity fluid in streamwise flow (Figure 9.1: Schematic of the Problem (p. 406)). An array of holes intersects the duct at an inclined angle, and a cooler fluid is injected into the holes from a plenum. The coolant that moves through the holes acts to cool the surface of the duct, downstream of the injection. Both fluids are air, and the flow is classified as turbulent. The velocity and temperature of the streamwise and cross-flow fluids are known, and ANSYS Fluent is used to predict the flow and temperature fields that result from convective heat transfer.

This tutorial demonstrates how to do the following:

• Merge hexahedral and tetrahedral meshes to form a hybrid mesh.

• Create a non-conformal mesh interface.

• Model heat transfer across a non-conformal interface with specified temperature and velocity boundary conditions.

• Calculate a solution using the pressure-based solver.

• Plot temperature profiles on specified iso-surfaces.

9.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
9.3. Problem Description

This problem considers a model of a 3D section of a film cooling test rig. A schematic of the problem is shown in Figure 9.1: Schematic of the Problem (p. 406). The problem consists of a duct, 49 inches long, with cross-sectional dimensions of 0.75 inches × 5 inches. An array of uniformly-spaced holes is located at the bottom of the duct. Each hole has a diameter of 0.5 inches, is inclined at 35 degrees, and is spaced 1.5 inches apart laterally. Cooler injected air enters the system through the plenum having cross-sectional dimensions of 3.3 inches × 1.25 inches.

Only a portion of the domain must be modeled because of the symmetry of the geometry. The bulk temperature of the streamwise air \( (T_\infty) \) is 450 K, and the velocity of the air stream is 20 m/s. The bottom wall of the duct that intersects the hole array is assumed to be a completely insulated (adiabatic) wall. The secondary (injected) air enters the plenum at a uniform velocity of 0.4559 m/s. The temperature of the injected air \( (T_{\text{inject}}) \) is 300 K. The properties of air that are used in the model are also mentioned in Figure 9.1: Schematic of the Problem (p. 406).

Figure 9.1: Schematic of the Problem
9.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

9.4.1. Preparation
9.4.2. Mesh
9.4.3. General Settings
9.4.4. Models
9.4.5. Materials
9.4.6. Cell Zone Conditions
9.4.7. Operating Conditions
9.4.8. Boundary Conditions
9.4.9. Mesh Interfaces
9.4.10. Solution
9.4.11. Postprocessing

9.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

   **Note**
   
   If you do not have a login, you can request one by clicking **Customer Registration** on the login page.

3. Enter the name of this tutorial into the search bar.
4. Narrow the results by using the filter on the left side of the page.
   a. Click **ANSYS Fluent** under **Product**.
   b. Click **15.0** under **Version**.
5. Select this tutorial from the list.
6. Click **Files** to download the input and solution files.
7. Unzip **non_conformal_mesh_R150.zip** to your working folder.

   The input files **film_hex.msh** and **film_tet.msh** can be found in the **non_conformal_mesh** folder created after unzipping the file.

8. Use Fluent Launcher to start the **3D** version of ANSYS Fluent.

   Fluent Launcher displays your **Display Options** preferences from the previous session.

   For more information about Fluent Launcher, see **Starting ANSYS Fluent Using Fluent Launcher in the Fluent Getting Started Guide**.
9. Ensure that the **Display Mesh After Reading, Embed Graphics Windows, and Workbench Color Scheme** options are enabled.

10. Run in single precision (disable **Double Precision**).

11. Ensure you are running in **Serial** under **Processing Options**.

### 9.4.2. Mesh

1. Read the hex mesh file `film_hex.msh`.
   
   ![File ➔ Read ➔ Mesh...]

2. Append the tet mesh file `film_tet.msh`.
   
   ![Mesh ➔ Zone ➔ Append Case File...]
   
   *The Append Case File... functionality allows you to combine two mesh files into one single mesh file.*

3. Check the mesh.
   
   ![General ➔ Check](image)
   
   *ANSYS Fluent will perform various checks on the mesh and report the progress in the console. Make sure that the reported minimum volume is a positive number.*

4. Scale the mesh and change the unit of length to inches.
   
   ![General ➔ Scale...](image)
   
   a. Ensure that **Convert Units** is selected in the **Scaling** group box.
   
   b. Select **in** from the **Mesh Was Created In** drop-down list by first clicking the down-arrow button and then clicking the **in** item from the list that appears.
c. Click **Scale** to scale the mesh.

   _Domain Extents will continue to be reported in the default SI unit of meters._

d. Select **in** from the View Length Unit **In** drop-down list to set inches as the working unit for length.

e. Close the **Scale Mesh** dialog box.

5. Check the mesh.

   ![General → Check](image)

   **Note**

   It is a good idea to check the mesh after you manipulate it (that is, scale, convert to polyhedra, merge, separate, fuse, add zones, or smooth and swap.) This will ensure that the quality of the mesh has not been compromised.

6. Display an outline of the 3D mesh.

   ![General → Display...](image)

   a. Retain the default selections in the **Surfaces** list.

   b. Click **Display**.

   c. Close the **Mesh Display** dialog box.

7. Manipulate the mesh display to obtain a front view as shown in Figure 9.2: Hybrid Mesh for Film Cooling Problem (p. 410).

   ![Graphics and Animations → Views...](image)

   a. Select **front** in the **Views** list.
b. Click **Apply**.

c. Close the **Views** dialog box.

**Figure 9.2: Hybrid Mesh for Film Cooling Problem**

8. **Zoom in using the middle mouse button to view the hole and plenum regions** (**Figure 9.3: Hybrid Mesh (Zoomed-In View)** (p. 411)).
In Figure 9.3: Hybrid Mesh (Zoomed-In View) (p. 411), you can see the quadrilateral faces of the hexahedral cells that are used to model the duct region and the triangular faces of the tetrahedral cells that are used to model the plenum and hole regions, resulting in a hybrid mesh.

**Extra**

You can use the right mouse button to check which zone number corresponds to each boundary. If you click the right mouse button on one of the boundaries in the graphics window, its zone number, name, and type will be printed in the ANSYS Fluent console. This feature is especially useful when you have several zones of the same type and you want to distinguish between them quickly.

### 9.4.3. General Settings

1. Retain the default solver settings.
9.4.4. Models

1. Enable heat transfer by enabling the energy equation.

   ![ Models → Energy → Edit... ]

   a. Click OK to close the Energy dialog box.

2. Enable the standard $k-\varepsilon$ turbulence model.

   ![ Models → Viscous → Edit... ]
a. Select k-epsilon (2eqn) in the Model list.

The Viscous Model dialog box will expand to show the additional input options for the $k-\varepsilon$ model.

b. Select Enhanced Wall Treatment for the Near-Wall Treatment.

**Note**

The default Standard Wall Functions are generally applicable if the first cell center adjacent to the wall has a $y+$ larger than 30. In contrast, the Enhanced Wall Treatment option provides consistent solutions for all $y+$ values. Enhanced Wall Treatment is recommended when using the k-epsilon model for general single-phase fluid flow problems. For more information about Near Wall Treatments in the k-epsilon model refer to Setting Up the $k-\varepsilon$ Model in the User's Guide.
c. Retain the default settings for the remaining parameters.

d. Click **OK** to close the **Viscous Model** dialog box.

### 9.4.5. Materials

1. Define the material properties.

   ![Create/Edit Materials dialog box]

   a. Retain the selection of **air** from the **Fluent Fluid Materials** drop-down list.

   b. Select **incompressible-ideal-gas** law from the **Density** drop-down list.

   The incompressible ideal gas law is used when pressure variations are small but temperature variations are large. The incompressible ideal gas option for density treats the fluid density as a function of temperature only. If the above condition is satisfied, the incompressible ideal gas law generally gives better convergence compared to the ideal gas law, without sacrificing accuracy.

   c. Retain the default values for all other properties.

   d. Click **Change/Create** and close the **Create/Edit Materials** dialog box.

### 9.4.6. Cell Zone Conditions

1. Set the conditions for the fluid in the duct (**fluid-9**).

   ![Cell Zone Conditions dialog box]
a. Change the **Zone Name** from *fluid-9* to *fluid-duct*.

b. Retain the default selection of *air* from the **Material Name** drop-down list.

c. Click **OK** to close the **Fluid** dialog box.

2. Set the conditions for the fluid in the first plenum and hole (*fluid-8*).

   ![Fluid dialog box](image)

   a. Change the **Zone Name** from *fluid-8* to *fluid-plenum1*.

   b. Retain the default selection of *air* from the **Material Name** drop-down list.

   c. Click **OK** to close the **Fluid** dialog box.

3. Set the conditions for the fluid in the second plenum and hole (*fluid-9.1*).

   ![Fluid dialog box](image)

   a. Change the **Zone Name** from *fluid-9.1* to *fluid-duct*.
a. Change the Zone Name from fluid-9.1 to fluid-plenum2.

b. Retain the default selection of air from the Material Name drop-down list.

c. Click OK to close the Fluid dialog box.

9.4.7. Operating Conditions

- Boundary Conditions → Operating Conditions...

1. Retain the default operating conditions.

   ![Operating Conditions dialog box]

2. Click OK to close the Operating Conditions dialog box.

   For the incompressible-ideal-gas law selected here for air, the constant pressure used for the density calculation is the Operating Pressure specified in this dialog box. So, make sure that the Operating Pressure is close to the mean pressure of the domain.

9.4.8. Boundary Conditions

1. Set the boundary conditions for the streamwise flow inlet (velocity-inlet-1).

   - Boundary Conditions → velocity-inlet-1 → Edit...
a. Change the Zone Name from velocity-inlet-1 to velocity-inlet-duct.

b. Enter 20 m/s for the Velocity Magnitude.

c. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the Turbulence group box.

d. Enter 1% and 5 in for the Turbulent Intensity and the Hydraulic Diameter, respectively.

e. Click the Thermal tab and enter 450 K for the Temperature.

f. Click OK to close the Velocity Inlet dialog box.

2. Set the boundary conditions for the first injected stream inlet (velocity-inlet-5).

   ![Boundary Conditions](velocity-inlet-5>Edit...)
a. Change the Zone Name from velocity-inlet-5 to velocity-inlet-plenum1.

b. Enter 0.4559 m/s for the Velocity Magnitude.


d. Enter 1% for Turbulent Intensity and retain the default setting of 10 for Turbulent Viscosity Ratio.

e. Click the Thermal tab and retain the setting of 300 K for Temperature.

f. Click OK to close the Velocity Inlet dialog box.

In the absence of any identifiable length scale for turbulence, the Intensity and Viscosity Ratio method should be used.

For more information about setting the boundary conditions for turbulence, see Modeling Turbulence in the User's Guide.

3. Copy the boundary conditions set for the first injected stream inlet.

Boundary Conditions → velocity-inlet-plenum1 → Copy...
a. Select `velocity-inlet-plenum1` in the **From Boundary Zone** selection list.

b. Select `velocity-inlet-6` in the **To Boundary Zones** selection list.

c. Click **Copy**.

   A **Warning** dialog box will open, asking if you want to copy `velocity-inlet-plenum1` boundary conditions to `(velocity-inlet-6)`. Click **OK**.

d. Close the **Copy Conditions** dialog box.

   **Warning**

   Copying a boundary condition does not create a link from one zone to another. If you want to change the boundary conditions on these zones, you will have to change each one separately.

4. Set the boundary conditions for the second injected stream inlet (`velocity-inlet-6`).

   ![Boundary Conditions](velocity-inlet-6 → Edit...)
a. Change the **Zone Name** from `velocity-inlet-6` to `velocity-inlet-plenum2`.

b. Verify that the boundary conditions were copied correctly.

c. Click **OK** to close the **Velocity Inlet** dialog box.

5. Set the boundary conditions for the flow exit (**pressure-outlet-1**).

   ![Boundary Conditions → pressure-outlet-1 → Edit...](image)
a. Change the Zone Name from pressure-outlet-1 to pressure-outlet-duct.

b. Retain the default setting of 0 Pa for Gauge Pressure.


d. Enter 1% for Backflow Turbulent Intensity and retain the default setting of 10 for Backflow Turbulent Viscosity Ratio.

e. Click the Thermal tab and enter 450 K for Backflow Total Temperature.

f. Click OK to close the Pressure Outlet dialog box.

6. Retain the default boundary conditions for the plenum and hole walls (wall-4 and wall-5).

Boundary Conditions → wall-4 → Edit...
7. Verify that the symmetry planes are set to the correct type in the **Boundary Conditions** task page.

- **Boundary Conditions**
a. Select symmetry-1 in the Zone list.

b. Ensure that symmetry is selected from the Type drop-down list.

c. Similarly, verify that the zones symmetry-5, symmetry-7, symmetry-tet1, and symmetry-tet2 are set to the correct type.

8. Define the zones on the non-conformal boundary as interface zones by changing the Type for wall-1, wall-7, and wall-8 to interface.

The non-conformal mesh interface contains three boundary zones: wall-1, wall-7, and wall-8. wall-1 is the bottom surface of the duct, wall-7 and wall-8 represent the holes through which the cool air is injected from the plenum (Figure 9.4: Mesh for the wall-1 and wall-7 Boundaries (p. 425)). These boundaries were defined as walls in the original mesh files (film_hex.msh and film_tet.msh) and must be redefined as interface boundary types.

a. Open the Mesh Display dialog box.

   General → Display...
i. Deselect all surfaces by clicking [ ] to the far right of **Surfaces**.

ii. Collapse the list of surfaces by clicking [ ].

iii. Expand the **wall** branch by **Ctrl** + left-clicking **+wall- [5,0]** in the **Surfaces** group box.

iv. Select **wall-1**, **wall-7**, and **wall-8** from the **Surfaces** selection list.

   *Use the scrollbar to access the surfaces that are not initially visible.*

v. Click **Display** and close the **Mesh Display** dialog box.

b. Display the bottom view.

   ![Graphics and Animations → Views...](image)

i. Select **bottom** in the **Views** list and click **Apply**.

ii. Close the **Views** dialog box.

*Zoom in using the middle mouse button. Figure 9.4: Mesh for the wall-1 and wall-7 Boundaries (p. 425) shows the mesh for the **wall-1** and **wall-7** boundaries (that is, hole-1). Similarly, you can zoom in to see the mesh for the **wall-1** and **wall-8** boundaries (that is, hole-2).*
c. Select wall-1 in the Zone list and select interface as the new Type.

- Boundary Conditions
A Question dialog box will open, asking if it is OK to change the type of wall-1 from wall to interface. Click Yes in the Question dialog box.

The Interface dialog box will open and give the default name for the newly-created interface zone.

i. Change the Zone Name to interface-duct.

ii. Click OK to close the Interface dialog box.

d. Similarly, convert wall-7 and wall-8 to interface boundary zones, specifying interface-hole1 and interface-hole2 for Zone Name, respectively.

9.4.9. Mesh Interfaces

In this step, you will create a non-conformal mesh interface between the hexahedral and tetrahedral meshes.
1. Select interface-hole1 and interface-hole2 in the Interface Zone 1 selection list.

   **Warning**

   When one interface zone is smaller than the other, choose the smaller zone as Interface Zone 1.

2. Select interface-duct from the Interface Zone 2 selection list.

3. Enter junction for Mesh Interface.

4. Click Create.

   In the process of creating the mesh interface, ANSYS Fluent will create three new wall boundary zones: wall-24, wall-25, and wall-26.

   • wall-24 and wall-25 are the non-overlapping regions of the interface-hole1 and interface-hole2 zones that result from the intersection of the interface-hole1, interface-hole2, and interface-duct boundary zones. They are listed under Boundary Zone 1 in the Create/Edit Mesh Interfaces dialog box. These wall boundaries are empty, since interface-hole1 and interface-hole2 are completely contained within the interface-duct boundary.
• **wall-26** is the non-overlapping region of the **interface-duct** zone that results from the intersection of the three interface zones, and is listed under **Boundary Zone 2** in the **Create/Edit Mesh Interfaces** dialog box.

You will **not** be able to display these walls.

**Warning**

You need to set boundary conditions for **wall-26** (since it is not empty). In this case, the default settings are used.

5. Close the **Create/Edit Mesh Interfaces** dialog box.

### 9.4.10. Solution

1. Set the solution parameters.

   **Solution Methods**

   ![Solution Methods](image)

   a. Select **Coupled** from the **Scheme** drop-down list.
b. Select **Second Order Upwind** from the **Turbulent Kinetic Energy** and **Turbulent Dissipation Rate** drop-down lists in the **Spatial Discretization** group box.

2. Enable the plotting of residuals.

   ![Residual Monitors](image)

   a. Ensure that **Plot** is enabled in the **Options** group box.

   b. Click **OK** to close the **Residual Monitors** panel.

3. Initialize the solution.

   ![Solution Initialization](image)

   a. Retain the default selection of **Hybrid Initialization** from the **Initialization Methods** group box.
4. Save the case file (filmcool.cas.gz).

   File → Write → Case...

5. Start the calculation by requesting 250 iterations.

   **Run Calculation**

   ![Run Calculation Interface]

   a. Enter 250 for the **Number of Iterations**.

   b. Click **Calculate**.

   The solution converges after approximately 45 iterations.

6. Save the case and data files (filmcool.cas.gz and filmcool.dat.gz).

   File → Write → Case & Data...

   **Note**

   If you choose a file name that already exists in the current directory, ANSYS Fluent will prompt you for confirmation to overwrite the file.

   **Note**

   For flows in complex topologies, hybrid initialization will provide better initial velocity and pressure fields than standard initialization. This will help to improve the convergence behavior of the solver.
9.4.11. Postprocessing

1. Display filled contours of static pressure (Figure 9.5: Contours of Static Pressure (p. 432)).

   ![Graphics and Animations → Contours → Set Up...](image)

   a. Enable **Filled** in the **Options** group box.

   b. Ensure that **Pressure...** and **Static Pressure** are selected from the **Contours of** drop-down lists.


   *Use the scroll bar to access the surfaces that are not initially visible in the *Contours* dialog box.*

   d. Click **Display** and close the **Contours** dialog box.
The maximum pressure change (see Figure 9.5: Contours of Static Pressure (p. 432)) is only 232 Pa. Compared to a mean pressure of 1.013e5 Pa, the variation is less than 0.3%, therefore the use of the incompressible ideal gas law is appropriate.

e. Reset the view to the default view if you changed the default display of the mesh.

Graphics and Animations → Views...
i. Click **Default** in the **Actions** group box and close the **Views** dialog box.

f. Zoom in on the view to display the contours at the holes (Figure 9.6: Contours of Static Pressure at the First Hole (p. 434) and Figure 9.7: Contours of Static Pressure at the Second Hole (p. 435)).
Figure 9.6: Contours of Static Pressure at the First Hole

Contours of Static Pressure (pascal)

ANSYS Fluent (3d, pbns, ske)
Note the high/low pressure zones on the upstream/downstream sides of the coolant hole, where the jet first penetrates the primary flow in the duct.

2. Display filled contours of static temperature (Figure 9.8: Contours of Static Temperature (p. 437) and Figure 9.9: Contours of Static Temperature (Zoomed-In View) (p. 438)).

Graphics and Animations → Contours → Set Up...
a. Select **Temperature**... and **Static Temperature** from the **Contours of** drop-down lists.

b. Disable **Auto Range** in the **Options** group box so that you can change the maximum and minimum temperature gradient values to be plotted.

c. Enter **300** for **Min** and **450** for **Max**.

d. Disable **Clip to Range** in the **Options** group box.

e. Ensure that **interface-duct**, **interface-hole1**, **interface-hole2**, **symmetry-1**, **symmetry-tet1**, **symmetry-tet2**, **wall-4**, and **wall-5** are selected from the **Surfaces** selection list.

f. Click **Display** and close the **Contours** dialog box.
g. Zoom in on the view to get the display shown in Figure 9.9: Contours of Static Temperature (Zoomed-In View) (p. 438).
3. Display the velocity vectors (Figure 9.10: Velocity Vectors (p. 440)).

```
Graphics and Animations ➔ Vectors ➔ Set Up...
```
a. Ensure that **Velocity**... and **Velocity Magnitude** are selected from the **Color by** drop-down lists.

b. Ensure that **Auto Range** is enabled in the **Options** group box.

c. Enter 2 for the **Scale**.

   *This enlarges the displayed vectors, making it easier to view the flow patterns.*


   *Use the scroll bar to access the surfaces that are not initially visible in the dialog box.*

e. Click **Display** and close the **Vectors** dialog box.

f. Zoom in on the view to get the display shown in **Figure 9.10: Velocity Vectors (p. 440)**.

*In **Figure 9.10: Velocity Vectors (p. 440)**, the flow pattern in the vicinity of the coolant hole shows the level of penetration of the coolant jet into the main flow. Note that the velocity field varies smoothly across the non-conformal interface.*
4. Create an iso-surface along a horizontal cross-section of the duct, 0.1 inches above the bottom, at \( y = 0.1 \) inches.

\[ \text{Surface } \rightarrow \text{Iso-Surface...} \]
a. Select Mesh... and Y-Coordinate from the Surface of Constant drop-down lists.

b. Enter 0.1 for Iso-Values.

c. Enter y=0.1in for New Surface Name.

d. Click Create.

e. Close the Iso-Surface dialog box.

5. Create an XY plot of static temperature on the iso-surface created (Figure 9.11: Static Temperature at y=0.1 in (p. 443)).

 Navigation to: Plots → XY Plot → Set Up...
a. Retain the default values in the Plot Direction group box.

b. Select Temperature... and Static Temperature from the Y-Axis Function drop-down lists.

c. Select y=0.1 in in the Surfaces selection list.

Scroll down using the scroll bar to access y=0.1 in.

d. Click Plot.

In Figure 9.11: Static Temperature at y=0.1 in (p. 443), you can see how the temperature of the fluid changes as the cool air from the injection holes mixes with the primary flow. The temperature is coolest just downstream of the holes. You can also make a similar plot on the lower wall to examine the wall surface temperature.

e. Close the Solution XY Plot dialog box.
9.5. Summary

This tutorial demonstrated how the non-conformal mesh interface capability in ANSYS Fluent can be used to handle hybrid meshes for complex geometries, such as the film cooling hole configuration examined here. One of the principal advantages of this approach is that it allows you to merge existing component meshes together to create a larger, more complex mesh system, without requiring that the different components have the same node locations on their shared boundaries. Thus, you can perform parametric studies by merging the desired meshes, creating the non-conformal interface(s), and solving the model. For example, in the present case, you can do the following:

- Use a different hole/plenum mesh.
- Reposition the existing hole/plenum mesh.
- Add additional hole/plenum meshes to create aligned or staggered multiple-hole arrays.

9.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by adapting the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 10: Modeling Flow Through Porous Media

This tutorial is divided into the following sections:

10.1. Introduction
10.2. Prerequisites
10.3. Problem Description
10.4. Setup and Solution
10.5. Summary
10.6. Further Improvements

10.1. Introduction

Many industrial applications such as filters, catalyst beds and packing, involve modeling the flow through porous media. This tutorial illustrates how to set up and solve a problem involving gas flow through porous media.

The industrial problem solved here involves gas flow through a catalytic converter. Catalytic converters are commonly used to purify emissions from gasoline and diesel engines by converting environmentally hazardous exhaust emissions to acceptable substances. Examples of such emissions include carbon monoxide (CO), nitrogen oxides (NOx), and unburned hydrocarbon fuels. These exhaust gas emissions are forced through a substrate, which is a ceramic structure coated with a metal catalyst such as platinum or palladium.

The nature of the exhaust gas flow is a very important factor in determining the performance of the catalytic converter. Of particular importance is the pressure gradient and velocity distribution through the substrate. Hence CFD analysis is used to design efficient catalytic converters. By modeling the exhaust gas flow, the pressure drop and the uniformity of flow through the substrate can be determined. In this tutorial, ANSYS Fluent is used to model the flow of nitrogen gas through a catalytic converter geometry, so that the flow field structure may be analyzed.

This tutorial demonstrates how to do the following:

• Set up a porous zone for the substrate with appropriate resistances.
• Calculate a solution for gas flow through the catalytic converter using the pressure-based solver.
• Plot pressure and velocity distribution on specified planes of the geometry.
• Determine the pressure drop through the substrate and the degree of non-uniformity of flow through cross sections of the geometry using X-Y plots and numerical reports.

10.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
10.3. Problem Description

The catalytic converter modeled here is shown in Figure 10.1: Catalytic Converter Geometry for Flow Modeling (p. 446). The nitrogen flows through the inlet with a uniform velocity of 22.6 m/s, passes through a ceramic monolith substrate with square-shaped channels, and then exits through the outlet.

![Figure 10.1: Catalytic Converter Geometry for Flow Modeling](image)

While the flow in the inlet and outlet sections is turbulent, the flow through the substrate is laminar and is characterized by inertial and viscous loss coefficients along the inlet axis. The substrate is impermeable in other directions. This characteristic is modeled using loss coefficients that are three orders of magnitude higher than in the main flow direction.

10.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

10.4.1. Preparation
10.4.2. Mesh
10.4.3. General Settings
10.4.4. Models
10.4.5. Materials
10.4.6. Cell Zone Conditions
10.4.7. Boundary Conditions
10.4.8. Solution
10.4.9. Postprocessing
10.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

   **Note**
   
   If you do not have a login, you can request one by clicking Customer Registration on the login page.

3. Enter the name of this tutorial into the search bar.
4. Narrow the results by using the filter on the left side of the page.
   a. Click ANSYS Fluent under Product.
   b. Click 15.0 under Version.
5. Select this tutorial from the list.
6. Click Files to download the input and solution files.
7. Unzip porous_R150.zip to your working folder.

   The mesh file catalytic_converter.msh can be found in the porous directory created after unzipping the file.
8. Use the Fluent Launcher to start the 3D version of ANSYS Fluent.
   Fluent Launcher displays your Display Options preferences from the previous session.
   For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in the User’s Guide.
9. Ensure that the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color Scheme options are enabled.
10. Enable Double-Precision.
11. Ensure you are running in Serial under Processing Options.

10.4.2. Mesh

1. Read the mesh file (catalytic_converter.msh).
   
   File → Read → Mesh...
2. Check the mesh.
General → Check

ANSYS Fluent will perform various checks on the mesh and report the progress in the console. Make sure that the reported minimum volume is a positive number.

3. Scale the mesh.

General → Scale...

![Scale Mesh dialog box](image)

a. Select mm from the Mesh Was Created In drop-down list.

b. Click Scale.

c. Select mm from the View Length Unit In drop-down list.

   All dimensions will now be shown in millimeters.

d. Close the Scale Mesh dialog box.

4. Check the mesh.

General → Check

Note

It is a good idea to check the mesh after you manipulate it (that is, scale, convert to polyhedra, merge, separate, fuse, add zones, or smooth and swap.) This will ensure that the quality of the mesh has not been compromised.

5. Examine the mesh.
Rotate the view and zoom in to get the display shown in Figure 10.2: Mesh for the Catalytic Converter Geometry (p. 449). The hex mesh on the geometry contains a total of 34,580 cells.

**Figure 10.2: Mesh for the Catalytic Converter Geometry**

10.4.3. General Settings

- General
1. Retain the default solver settings.

10.4.4. Models

1. Select the standard $k-\varepsilon$ turbulence model.

Expand Models $\rightarrow$ Viscous $\rightarrow$ Edit...
a. Select \textbf{k-epsilon (2eqn)} in the \textbf{Model} list.

\textit{The original Viscous Model dialog box will now expand.}

b. Retain the default settings for \textbf{k-epsilon Model} and \textbf{Near-Wall Treatment} and click \textbf{OK} to close the \textbf{Viscous Model} dialog box.

\section*{10.4.5. Materials}

1. Add nitrogen to the list of fluid materials by copying it from the \textbf{Fluent Database} of materials.

\begin{itemize}
  \item [Materials \rightarrow ] air \rightarrow Create/Edit...
\end{itemize}
a. Click the **Fluent Database...** button to open the **Fluent Database Materials** dialog box.
i. Select **nitrogen (n2)** in the **Fluent Fluid Materials** selection list.

ii. Click **Copy** to copy the information for nitrogen to your list of fluid materials.

iii. Close the **Fluent Database Materials** dialog box.

b. Click **Change/Create** and close the **Create/Edit Materials** dialog box.

### 10.4.6. Cell Zone Conditions

#### 10.4.6. Cell Zone Conditions
1. Set the cell zone conditions for the fluid (fluid).

   Cell Zone Conditions → fluid → Edit...
a. Select nitrogen from the Material Name drop-down list.

b. Click OK to close the Fluid dialog box.

2. Set the cell zone conditions for the substrate (substrate).

   Cell Zone Conditions → substrate → Edit...
a. Select **nitrogen** from the **Material Name** drop-down list.

b. Enable **Porous Zone** to activate the porous zone model.

c. Enable **Laminar Zone** to solve the flow in the porous zone without turbulence.

d. Click the **Porous Zone** tab.

   i. Make sure that the principal direction vectors are set as shown in **Table 10.1: Values for the Principle Direction Vectors** (p. 457).
ANSYS Fluent automatically calculates the third (z-direction) vector based on your inputs for the first two vectors. The direction vectors determine which axis the viscous and inertial resistance coefficients act upon.

Table 10.1: Values for the Principle Direction Vectors

<table>
<thead>
<tr>
<th>Axis</th>
<th>Direction-1 Vector</th>
<th>Direction-2 Vector</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Y</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Z</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Use the scroll bar to access the fields that are not initially visible in the dialog box.

ii. Enter the values in Table 10.2: Values for the Viscous and Inertial Resistance (p. 457) Viscous Resistance and Inertial Resistance.

Direction-2 and Direction-3 are set to arbitrary large numbers. These values are several orders of magnitude greater than that of the Direction-1 flow and will make any radial flow insignificant.

Scroll down to access the fields that are not initially visible in the panel.

Table 10.2: Values for the Viscous and Inertial Resistance

<table>
<thead>
<tr>
<th>Direction</th>
<th>Viscous Resistance (1/m²)</th>
<th>Inertial Resistance (1/m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direction-1</td>
<td>3.846e+07</td>
<td>20.414</td>
</tr>
<tr>
<td>Direction-2</td>
<td>3.846e+10</td>
<td>20414</td>
</tr>
<tr>
<td>Direction-3</td>
<td>3.846e+10</td>
<td>20414</td>
</tr>
</tbody>
</table>

e. Click OK to close the Fluid dialog box.

10.4.7. Boundary Conditions

Boundary Conditions
1. Set the velocity and turbulence boundary conditions at the inlet (inlet).

- **Boundary Conditions → inlet → Edit...**
a. Enter 22.6 m/s for **Velocity Magnitude**.

b. Select **Intensity and Hydraulic Diameter** from the **Specification Method** drop-down list in the **Turbulence** group box.

c. Enter 10% for the **Turbulent Intensity**.

d. Enter 42 mm for the **Hydraulic Diameter**.

e. Click **OK** to close the **Velocity Inlet** dialog box.

2. Set the boundary conditions at the outlet (**outlet**).

   ![Boundary Conditions](image)

   - **Boundary Conditions** → **Edit...**
a. Retain the default setting of 0 for **Gauge Pressure**.

b. Select **Intensity and Hydraulic Diameter** from the **Specification Method** drop-down list in the **Turbulence** group box.

c. Retain the default value of 5% for the **Backflow Turbulent Intensity**.

d. Enter 42 mm for the **Backflow Hydraulic Diameter**.

e. Click **OK** to close the **Pressure Outlet** dialog box.

3. Retain the default boundary conditions for the walls (**substrate-wall** and **wall**).

**10.4.8. Solution**

1. Set the solution parameters.

   ![Solution Methods](Image)
a. Select **Coupled** from the **Scheme** drop-down list.

b. Retain the default selection of **Least Squares Cell Based** from the **Gradient** drop-down list in the **Spatial Discretization** group box.

c. Retain the default selection of **Second Order Upwind** from the **Momentum** drop-down list.

d. Enable **Pseudo Transient**.

2. Enable the plotting of residuals during the calculation.

   ![Monitors] ![Residuals] ![Edit...]
a. Retain the default settings.

b. Click **OK** to close the **Residual Monitors** dialog box.

3. Enable the plotting of the mass flow rate at the outlet.

   ![Monitors (Surface Monitors) → Create...](image)
a. Enable **Plot** and **Write**.

b. Select **Mass Flow Rate** from the **Report Type** drop-down list.

c. Select **outlet** in the **Surfaces** selection list.

d. Click **OK** to close the **Surface Monitor** dialog box.

4. Initialize the solution from the inlet.

---

**Solution Initialization**

**Solution Initialization**

**Initialization Methods**

- Hybrid Initialization
- Standard Initialization

**Initial Values**

- **Gauge Pressure (pascal)**: 1.455192e-11
- **X Velocity (m/s)**: 22.6
- **Y Velocity (m/s)**: -1.340561e-15
- **Z Velocity (m/s)**: -1.324296e-32
- **Turbulent Kinetic Energy (m²/s²)**: 7.6614
- **Turbulent Dissipation Rate (m²/s³)**: 1185.214
a. Select **Standard Initialization** from the **Initialization Methods** group box.

**Warning**

**Standard Initialization** is the recommended initialization method for porous media simulations. The default **Hybrid initialization** method does not account for the porous media properties, and depending on boundary conditions, may produce an unrealistic initial velocity field. For porous media simulations, the **Hybrid initialization** method can only be used with the **Maintain Constant Velocity Magnitude** option.

b. Retain the default settings for Standard Initialization method.

c. Click **Initialize** once more.

5. Save the case file (**catalytic_converter.cas.gz**).

6. Run the calculation by requesting 100 iterations.

**Run Calculation**

a. Enter **100** for **Number of Iterations**.
b. Click **Calculate** to begin the iterations.

*The solution will converge in approximately 65 iterations. The mass flow rate monitor flattens out, as seen in Figure 10.3: Surface Monitor Plot of Mass Flow Rate with Number of Iterations (p. 465).*

**Figure 10.3: Surface Monitor Plot of Mass Flow Rate with Number of Iterations**

7. Save the case and data files (**catalytic_converter.cas.gz** and **catalytic_converter.dat.gz**).

   **File → Write → Case & Data...**

   **Note**

   If you choose a file name that already exists in the current folder, ANSYS Fluent will prompt you for confirmation to overwrite the file.

### 10.4.9. Postprocessing

1. Create a surface passing through the centerline for postprocessing purposes.

   **Surface → Iso-Surface...**
a. Select **Mesh...** and **Y-Coordinate** from the **Surface of Constant** drop-down lists.

b. Click **Compute** to calculate the **Min** and **Max** values.

c. Retain the default value of **0** for **Iso-Values**.

d. Enter **y=0** for **New Surface Name**.

e. Click **Create**.

**Note**

To interactively place the surface on your mesh, use the slider bar in the **Iso-Surface** dialog box.

2. Create cross-sectional surfaces at locations on either side of the substrate, as well as at its center.

   **Surface** → **Iso-Surface...**
a. Select **Mesh...** and **X-Coordinate** from the **Surface of Constant** drop-down lists.

b. Click **Compute** to calculate the **Min** and **Max** values.

c. Enter 95 for **Iso-Values**.

d. Enter **x=95** for the **New Surface Name**.

e. Click **Create**.

f. In a similar manner, create surfaces named **x=130** and **x=165** with **Iso-Values** of 130 and 165, respectively.

g. Close the **Iso-Surface** dialog box after all the surfaces have been created.

3. Create a line surface for the centerline of the porous media.

   **Surface** → **Line/Rake...**
a. Enter the coordinates of the end points of the line in the **End Points** group box as shown.

b. Enter *porous-cl* for the **New Surface Name**.

c. Click **Create** to create the surface.

d. Close the **Line/Rake Surface** dialog box.

4. Display the two wall zones (**substrate-wall** and **wall**).

   - **Graphics and Animations** → **Mesh** → **Set Up...**
a. Disable **Edges** and enable **Faces** in the **Options** group box.

b. Deselect **inlet** and **outlet** in the **Surfaces** selection list, and make sure that only **substrate-wall** and **wall** are selected.

c. Click **Display** and close the **Mesh Display** dialog box.

5. Set the lighting for the display.

![Graphics and Animations → Options...](image)

a. Disable **Double Buffering** in the **Rendering** group box.

b. Enable **Lights On** in the **Lighting Attributes** group box.

c. Select **Gouraud** from the **Lighting** drop-down list.

d. Click **Apply** and close the **Display Options** dialog box.

6. Set the transparency parameter for the wall zones (**substrate-wall** and **wall**).

![Graphics and Animations → Scene...](image)
7. Display velocity vectors on the $y=0$ surface (Figure 10.4: Velocity Vectors on the $y=0$ Plane (p. 472)).

![Scene Description dialog box]

- Select **substrate-wall** and **wall** in the Names selection list.
- Click the Display... button in the Geometry Attributes group box to open the Display Properties dialog box.
  - Ensure that **Red**, **Green**, and **Blue** sliders are set to the maximum position (that is, 255).
  - Set the Transparency slider to 70.
  - Click Apply and close the Display Properties dialog box.
- Click Apply and close the Scene Description dialog box.

Graphics and Animations → Vectors → Set Up...
a. Enable **Draw Mesh** in the **Options** group box to open the **Mesh Display** dialog box.

i. Ensure that **substrate-wall** and **wall** are selected in the **Surfaces** selection list.

ii. Click **Display** and close the **Mesh Display** dialog box.
b. Enter 5 for **Scale**.

c. Set **Skip** to 1.

d. Select **y=0** in the **Surfaces** selection list.

e. Click **Display** and close the **Vectors** dialog box.

**Figure 10.4: Velocity Vectors on the y=0 Plane**

The flow pattern shows that the flow enters the catalytic converter as a jet, with recirculation on either side of the jet. As it passes through the porous substrate, it decelerates and straightens out, and exhibits a more uniform velocity distribution. This allows the metal catalyst present in the substrate to be more effective.

8. Display filled contours of static pressure on the **y=0** plane (**Figure 10.5: Contours of Static Pressure on the y=0 plane (p. 474)**).
Graphics and Animations → Contours → Set Up...

![Contours Dialog Box](image)

- Enable **Filled** in the **Options** group box.
- Enable **Draw Mesh** to open the **Mesh Display** dialog box.
  - Ensure that **substrate-wall** and **wall** are selected in the **Surfaces** selection list.
  - Click **Display** and close the **Mesh Display** dialog box.
- Ensure that **Pressure...** and **Static Pressure** are selected from the **Contours of** drop-down lists.
- Select **y=0** in the **Surfaces** selection list.
- Click **Display** and close the **Contours** dialog box.

The pressure changes rapidly in the middle section, where the fluid velocity changes as it passes through the porous substrate. The pressure drop can be high, due to the inertial and viscous resistance of the porous media. Determining this pressure drop is one of the goals of the CFD analysis. In the next step, you will learn how to plot the pressure drop along the centerline of the substrate.
9. Plot the static pressure across the line surface **porous-cl** (Figure 10.6: Plot of Static Pressure on the porous-cl Line Surface (p. 475)).

![Graph showing contours of static pressure on the y=0 plane.](image)

**Figure 10.5: Contours of Static Pressure on the y=0 plane**

Contours of Static Pressure (pascal)

ANSYS Fluent (3d, dp, pbns, ske)

- 6.50e+02
- 5.98e+02
- 5.45e+02
- 4.93e+02
- 4.40e+02
- 3.86e+02
- 3.35e+02
- 2.83e+02
- 2.30e+02
- 1.78e+02
- 1.26e+02
- 7.31e+01
- 2.06e+01
- 3.18e+01
- 8.42e+01
- 1.37e+02
- 1.89e+02
- 2.42e+02
- 2.94e+02
- 3.46e+02
- 3.99e+02
a. Ensure that **Pressure...** and **Static Pressure** are selected from the **Y Axis Function** drop-down lists.

b. Select **porous-cl** in the **Surfaces** selection list.

c. Click **Plot** and close the **Solution XY Plot** dialog box.

**Figure 10.6: Plot of Static Pressure on the porous-cl Line Surface**
As seen in Figure 10.6: Plot of Static Pressure on the porous-cl Line Surface (p. 475), the pressure drop across the porous substrate is approximately 300 Pa.

10. Display filled contours of the velocity in the X direction on the \(x=95\), \(x=130\), and \(x=165\) surfaces (Figure 10.7: Contours of the X Velocity on the \(x=95\), \(x=130\), and \(x=165\) Surfaces (p. 477)).

\[ \text{Graphics and Animations} \rightarrow \text{Contours} \rightarrow \text{Set Up...} \]

![Contours Dialog Box]

- Enable **Filled** in the **Options** group box.
- Enable **Draw Mesh** to open the **Mesh Display** dialog box.
  - Ensure that **substrate-wall** and **wall** are selected in the **Surfaces** selection list.
  - Click **Display** and close the **Mesh Display** dialog box.
- Disable **Global Range** in the **Options** group box.
- Select **Velocity...** and **X Velocity** from the **Contours of** drop-down lists.
- Select \(x=130\), \(x=165\), and \(x=95\) in the **Surfaces** selection list.
- Click **Display** and close the **Contours** dialog box.
The velocity profile becomes more uniform as the fluid passes through the porous media. The velocity is very high at the center (the area in red) just before the nitrogen enters the substrate and then decreases as it passes through and exits the substrate. The area in green, which corresponds to a moderate velocity, increases in extent.

11. Use numerical reports to determine the average, minimum, and maximum of the velocity distribution before and after the porous substrate.

 Reports → → Surface Integrals → Set Up...
a. Select **Mass-Weighted Average** from the **Report Type** drop-down list.

b. Select **Velocity** and **X Velocity** from the **Field Variable** drop-down lists.

c. Select **x=165** and **x=95** in the **Surfaces** selection list.

d. Click **Compute**.

e. Select **Facet Minimum** from the **Report Type** drop-down list and click **Compute**.

f. Select **Facet Maximum** from the **Report Type** drop-down list and click **Compute**.

The numerical report of average, maximum and minimum velocity can be seen in the main ANSYS Fluent console.

g. Close the **Surface Integrals** dialog box.

The spread between the average, maximum, and minimum values for X velocity gives the degree to which the velocity distribution is non-uniform. You can also use these numbers to calculate the velocity ratio (that is, the maximum velocity divided by the mean velocity) and the space velocity (that is, the product of the mean velocity and the substrate length).

*Custom field functions and UDFs can be also used to calculate more complex measures of non-uniformity, such as the standard deviation and the gamma uniformity index.*

<table>
<thead>
<tr>
<th>Mass-Weighted Average</th>
<th>X Velocity (m/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>x=165</td>
<td>4.0394797</td>
</tr>
<tr>
<td>x=95</td>
<td>5.2982397</td>
</tr>
<tr>
<td><strong>Net</strong></td>
<td><strong>4.67579652</strong></td>
</tr>
</tbody>
</table>
10.5. Summary

In this tutorial, you learned how to set up and solve a problem involving gas flow through porous media in ANSYS Fluent. You also learned how to perform appropriate postprocessing. Flow non-uniformities were rapidly discovered through images of velocity vectors and pressure contours. Surface integrals and xy-plots provided purely numeric data.

For additional details about modeling flow through porous media (including heat transfer and reaction modeling), see Porous Media Conditions in the User’s Guide.

10.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 11: Using a Single Rotating Reference Frame

This tutorial is divided into the following sections:

11.1. Introduction
11.2. Prerequisites
11.3. Problem Description
11.4. Setup and Solution
11.5. Summary
11.6. Further Improvements
11.7. References

11.1. Introduction

This tutorial considers the flow within a 2D, axisymmetric, co-rotating disk cavity system. Understanding the behavior of such flows is important in the design of secondary air passages for turbine disk cooling.

This tutorial demonstrates how to do the following:

- Set up a 2D axisymmetric model with swirl, using a rotating reference frame.
- Use the standard $k-\varepsilon$ and RNG $k-\varepsilon$ turbulence models.
- Calculate a solution using the pressure-based solver.
- Display velocity vectors and contours of pressure.
- Set up and display XY plots of radial velocity and wall $y^+$ distribution.
- Restart the solver from an existing solution.

11.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

- Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
- Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
- Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.
11.3. Problem Description

The problem to be considered is shown schematically in Figure 11.1: Problem Specification (p. 482). This case is similar to a disk cavity configuration that was extensively studied by Pincombe [1].

Air enters the cavity between two co-rotating disks. The disks are 88.6 cm in diameter and the air enters at 1.146 m/s through a circular bore 8.86 cm in diameter. The disks, which are 6.2 cm apart, are spinning at 71.08 rpm, and the air enters with no swirl. As the flow is diverted radially, the rotation of the disk has a significant effect on the viscous flow developing along the surface of the disk.

Figure 11.1: Problem Specification

As noted by Pincombe [1], there are two nondimensional parameters that characterize this type of disk cavity flow: the volume flow rate coefficient, \( C_w \), and the rotational Reynolds number, \( Re_\phi \). These parameters are defined as follows:

\[
C_w = \frac{Q}{v r_{out}} \tag{11.1}
\]

\[
Re_\phi = \frac{\Omega r_{out}^2}{v} \tag{11.2}
\]

where \( Q \) is the volumetric flow rate, \( \Omega \) is the rotational speed, \( v \) is the kinematic viscosity, and \( r_{out} \) is the outer radius of the disks. Here, you will consider a case for which \( C_w = 1092 \) and \( Re_\phi = 10^5 \).
11.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

11.4.1. Preparation
11.4.2. Mesh
11.4.3. General Settings
11.4.4. Models
11.4.5. Materials
11.4.6. Cell Zone Conditions
11.4.7. Boundary Conditions
11.4.8. Solution Using the Standard $k-\varepsilon$ Model
11.4.9. Postprocessing for the Standard $k-\varepsilon$ Solution
11.4.10. Solution Using the RNG $k-\varepsilon$ Model
11.4.11. Postprocessing for the RNG $k-\varepsilon$ Solution

11.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.
   
   **Note**
   
   If you do not have a login, you can request one by clicking Customer Registration on the log in page.

3. Enter the name of this tutorial into the search bar.
4. Narrow the results by using the filter on the left side of the page.
   a. Click ANSYS Fluent under Product.
   b. Click 15.0 under Version.
5. Select this tutorial from the list.
6. Click Files to download the input and solution files.
7. Unzip single_rotating_R150.zip to your working folder.

    *The file disk.msh can be found in the single_rotating folder created after unzipping the file.*
8. Use Fluent Launcher to start the 2D Single Precision version of ANSYS Fluent.

    Fluent Launcher displays your Display Options preferences from the previous session.

    For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in the Fluent Getting Started Guide.
9. Ensure that the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color Scheme options are enabled.

10. Run in Serial under Processing Options.

### 11.4.2. Mesh

1. Read the mesh file (disk.msh).

   File → Read → Mesh...

   As ANSYS Fluent reads the mesh file, it will report its progress in the console.

### 11.4.3. General Settings

1. Check the mesh.

   ![General → Check]

   ANSYS Fluent will perform various checks on the mesh and report the progress in the console. Make sure that the reported minimum volume is a positive number.

   **Note**

   ANSYS Fluent will issue a warning concerning the high aspect ratios of some cells and possible impacts on calculation of Cell Wall Distance. The warning message includes recommendations for verifying and correcting the Cell Wall Distance calculation. In this particular case the cell aspect ratio does not cause problems so no further action is required. As an optional activity, you can confirm this yourself after the solution is generated by plotting Cell Wall Distance as noted in the warning message.

2. Examine the mesh (Figure 11.2: Mesh Display for the Disk Cavity (p. 485)).
Figure 11.2: Mesh Display for the Disk Cavity

Extra

You can use the right mouse button to check which zone number corresponds to each boundary. If you click the right mouse button on one of the boundaries in the graphics window, information will be displayed in the ANSYS Fluent console about the associated zone, including the name of the zone. This feature is especially useful when you have several zones of the same type and you want to distinguish between them quickly.

3. Define new units for angular velocity and length.

General → Units...

In the problem description, angular velocity and length are specified in rpm and cm, respectively, which is more convenient in this case. These are not the default units for these quantities.
a. Select **angular-velocity** from the **Quantities** list, and **rpm** in the **Units** list.

b. Select **length** from the **Quantities** list, and **cm** in the **Units** list.

c. Close the **Set Units** dialog box.

4. Specify the solver formulation to be used for the model calculation and enable the modeling of axisymmetric swirl.

**General**

a. Retain the default selection of **Pressure-Based** in the **Type** list.

b. Retain the default selection of **Absolute** in the **Velocity Formulation** list.
For a rotating reference frame, the absolute velocity formulation has some numerical advantages.

c. Select **Axisymmetric Swirl** in the **2D Space** list.

### 11.4.4. Models

1. Enable the standard $k-\varepsilon$ turbulence model with the enhanced near-wall treatment.

   ![Viscous Model Dialog Box](image)

a. Select **k-epsilon (2 eqn)** in the **Model** list.

   *The Viscous Model dialog box will expand.*

b. Retain the default selection of **Standard** in the **k-epsilon Model** list.

c. Select **Enhanced Wall Treatment** in the **Near-Wall Treatment** list.

d. Click **OK** to close the **Viscous Model** dialog box.

   *The ability to calculate a swirl velocity permits the use of a 2D mesh, so the calculation is simpler and more economical to run. This is especially important for problems where the enhanced wall*
treatment is used. The near-wall flow field is resolved through the viscous sublayer and buffer zones (that is, the first mesh point away from the wall is placed at a $y^+$ of the order of 1).

For details, see Enhanced Wall Treatment $\varepsilon$-Equation (EWT-$\varepsilon$) of the Theory Guide.

11.4.5. Materials

For the present analysis, you will model air as an incompressible fluid with a density of 1.225 kg/m$^3$ and a dynamic viscosity of $1.7894 \times 10^{-5}$ kg/m·s. Since these are the default values, no change is required in the Create/Edit Materials dialog box.

1. Retain the default properties for air.

2. Click Close to close the Create/Edit Materials dialog box.

For details, see Physical Properties in the User's Guide.
11.4.6. Cell Zone Conditions

Set up the present problem using a rotating reference frame for the fluid. Then define the disk walls to rotate with the moving frame.

**Cell Zone Conditions**

<table>
<thead>
<tr>
<th>Zone</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>fluid-7</td>
<td></td>
</tr>
</tbody>
</table>

1. Define the rotating reference frame for the fluid zone (**fluid-7**).

   ![Cell Zone Conditions](image)

   **Cell Zone Conditions → fluid-7 → Edit...**
a. Enable **Frame Motion**.

b. Click the **Reference Frame** tab.

c. Enter 71.08 rpm for **Speed** in the **Rotational Velocity** group box.

d. Click **OK** to close the **Fluid** dialog box.

**11.4.7. Boundary Conditions**

**Boundary Conditions**
1. Set the following conditions at the flow inlet (velocity-inlet-2).

   # Boundary Conditions → velocity-inlet-2 → Edit...
a. Select **Components** from the **Velocity Specification Method** drop-down list.

b. Enter \(1.146\) m/s for **Axial-Velocity**.

c. Retain the default selection of **Intensity and Viscosity Ratio** from the **Specification Method** drop-down list in the **Turbulence** group box.

d. Retain the default value of \(5\%\) for **Turbulent Intensity**.

e. Enter \(5\) for **Turbulent Viscosity Ratio**.

f. Click **OK** to close the **Velocity Inlet** dialog box.

2. Set the following conditions at the flow outlet (**pressure-outlet-3**).

   ![Boundary Conditions](boundary_conditions_icon)

   **Boundary Conditions →** **pressure-outlet-3 → Edit...**
a. Select **From Neighboring Cell** from the **Backflow Direction Specification Method** drop-down list.

b. Click **OK** to close the **Pressure Outlet** dialog box.

---

**Note**

ANSYS Fluent will use the backflow conditions only if the fluid is flowing into the computational domain through the outlet. Since backflow might occur at some point during the solution procedure, you should set reasonable backflow conditions to prevent convergence from being adversely affected.

---

3. Accept the default settings for the disk walls (wall-6).

\[\text{Boundary Conditions} \rightarrow \text{wall-6} \rightarrow \text{Edit}\]
a. Click **OK** to close the **Wall** dialog box.

**Note**

A Stationary Wall condition implies that the wall is stationary with respect to the adjacent cell zone. Hence, in the case of a rotating reference frame a Stationary Wall is actually rotating with respect to the absolute reference frame. To specify a non-rotating wall in this case you would select Moving Wall (i.e., moving with respect to the rotating reference frame). Then you would specify an absolute rotational speed of 0 in the Motion group box.

### 11.4.8. Solution Using the Standard k-ε Model

1. Set the solution parameters.

**Solution Methods**
a. Select **Coupled** from the **Scheme** drop-down list in the **Pressure-Velocity Coupling** group box.

b. Retain the default selection of **Least Squares Cell Based** from the **Gradient** list in the **Spatial Discretization** group box.

c. Select **PRESTO!** from the **Pressure** drop-down list in the **Spatial Discretization** group box.

   The PRESTO! scheme is well suited for steep pressure gradients involved in rotating flows. It provides improved pressure interpolation in situations where large body forces or strong pressure variations are present as in swirling flows.

d. Select **Second Order Upwind** from the **Turbulent Kinetic Energy** and **Turbulent Dissipation Rate** drop-down lists.

   *Use the scroll bar to access the discretization schemes that are not initially visible in the task page.*

e. Enable **Pseudo Transient**.

   The Pseudo Transient option enables the pseudo transient algorithm in the coupled pressure-based solver. This algorithm effectively adds an unsteady term to the solution equations in order to improve stability and convergence behavior. Use of this option is recommended for general fluid flow problems.

2. Set the solution controls.
a. Retain the default values in the **Pseudo Transient Explicit Relaxation Factors** group box.

**Note**

For this problem, the default explicit relaxation factors are satisfactory. However, if the solution diverges or the residuals display large oscillations, you may need to reduce the relaxation factors from their default values.

For tips on how to adjust the explicit relaxation parameters for different situations, see *Setting Pseudo Transient Explicit Relaxation Factors* in the User’s Guide.

3. Enable the plotting of residuals during the calculation.

 Bolsa Controls

![Solution Controls](image)

Pseudo Transient Explicit Relaxation Factors

- Pressure: 0.5
- Momentum: 0.5
- Density: 1
- Body Forces: 1
- Swirl Velocity: 0.75

Default
Equations... Limits... Advanced...

Help

Monitors → Residuals → Edit...
4. Enable the plotting of mass flow rate at the flow exit.

Monitors (Surface Monitors) ➔ Create...
a. Enable the **Plot** and **Write** options for *surf-mon-1*.

**Note**

When the **Write** option is selected in the **Surface Monitor** dialog box, the mass flow rate history will be written to a file. If you do not enable the **Write** option, the history information will be lost when you exit ANSYS Fluent.

b. Select **Mass Flow Rate** from the **Report Type** drop-down list.

c. Select **pressure-outlet-3** from the **Surfaces** selection list.

d. Click **OK** in the **Surface Monitor** dialog box to enable the monitor.

5. Initialize the solution.

   ![Solution Initialization](image)
a. Retain the default selection of Hybrid Initialization from the Initialization Methods group box.

b. Click Initialize.

---

**Note**

For flows in complex topologies, hybrid initialization will provide better initial velocity and pressure fields than standard initialization. This in general will help in improving the convergence behavior of the solver.

---

6. Save the case file (disk-ke.cas.gz).

   File → Write → Case...

7. Start the calculation by requesting 600 iterations.

   🔼 Run Calculation
Run Calculation

流畅区

- Time Step Method: Automatic
- Length Scale Method: Conservative
- Verbosity: 0
- Timescale Factor: 1
- Number of Iterations: 600
- Reporting Interval: 1
- Profile Update Interval: 1

b. Click **Calculate**.

Throughout the calculation, ANSYS Fluent will report reversed flow at the exit. This is reasonable for the current case. The solution should be sufficiently converged after approximately 550 iterations. The mass flow rate history is shown in **Figure 11.3: Mass Flow Rate History (k- ε Turbulence Model) (p. 501)**.
Extra

Here we have retained the default Timescale Factor of 1 in the Run Calculation panel. When performing a Pseudo Transient calculation, larger values of Timescale Factor may speed up convergence of the solution. However, setting Timescale Factor too large may cause the solution to diverge and fail to complete. As an optional activity, you can re-initialize the solution and try running the calculation with Timescale Factor set to 2. Observe the convergence behavior and the number of iterations before convergence. Then try the same again with Timescale Factor set to 4. For more information on setting Timescale Factor and the Pseudo Transient solver settings, refer to Solving Pseudo-Transient Flow in the Fluent User’s Guide.

8. Check the mass flux balance.

Warning

Although the mass flow rate history indicates that the solution is converged, you should also check the net mass fluxes through the domain to ensure that mass is being conserved.
a. Select velocity-inlet-2 and pressure-outlet-3 from the Boundaries selection list.

b. Retain the default Mass Flow Rate option.

c. Click Compute and close the Flux Reports dialog box.

**Warning**

The net mass imbalance should be a small fraction (for example, 0.5%) of the total flux through the system. If a significant imbalance occurs, you should decrease the residual tolerances by at least an order of magnitude and continue iterating.

9. Save the data file (disk-ke.dat.gz).

   File → Write → Data...

   **Note**

   If you choose a file name that already exists in the current folder, ANSYS Fluent will prompt you for confirmation to overwrite the file.

11.4.9. Postprocessing for the Standard k-ε Solution

1. Display the velocity vectors.

   🕵️‍♂️ Graphics and Animations → 📊 Vectors → Set Up...
a. Enter 50 for **Scale**

b. Set **Skip** to 1.

c. Click the **Vector Options...** button to open the **Vector Options** dialog box.

i. Disable **Z Component**.

   *This allows you to examine only the non-swirling components.*

ii. Click **Apply** and close the **Vector Options** dialog box.

d. Click **Display** in the **Vectors** dialog box to plot the velocity vectors.
A magnified view of the velocity field displaying a counter-clockwise circulation of the flow is shown in Figure 11.4: Magnified View of Velocity Vectors within the Disk Cavity (p. 504).

**Figure 11.4: Magnified View of Velocity Vectors within the Disk Cavity**

![Velocity Field Diagram]

Velocity Vectors Colored By Velocity Magnitude (m/s)

ANSYS Fluent (ex, swir, plns, ske)

e. Close the **Vectors** dialog box.

2. Display filled contours of static pressure.

![Graphics and Animations} ➔ Contours ➔ Set Up...](Diagram)
a. Enable **Filled** in the **Options** group box.

b. Retain the selection of **Pressure...** and **Static Pressure** from the **Contours of** drop-down lists.

c. Click **Display** and close the **Contours** dialog box.

*The pressure contours are displayed in Figure 11.5: Contours of Static Pressure for the Entire Disk Cavity (p. 506). Notice the high pressure that occurs on the right disk near the hub due to the stagnation of the flow entering from the bore.*
3. Create a constant \(y\)-coordinate line for postprocessing.

**Surface \(\rightarrow\) Iso-Surface...**
a. Select Mesh... and Y-Coordinate from the Surface of Constant drop-down lists.

b. Click Compute to update the minimum and maximum values.

c. Enter 37 in the Iso-Values field.

   This is the radial position along which you will plot the radial velocity profile.

d. Enter y=37 cm for the New Surface Name.

e. Click Create to create the isosurface.

   Note
   The name you use for an isosurface can be any continuous string of characters (without spaces).

f. Close the Iso-Surface dialog box.

4. Plot the radial velocity distribution on the surface y=37 cm.

   ◀plots ▶ XY Plot ▶ Set Up...
a. Select **Velocity...** and **Radial Velocity** from the **Y Axis Function** drop-down lists.

b. Select the y-coordinate line **y=37cm** from the **Surfaces** selection list.

c. Click **Plot**.

*Figure 11.6: Radial Velocity Distribution—Standard k- ε Solution (p. 509) shows a plot of the radial velocity distribution along y=37 cm.*
d. Enable **Write to File** in the **Options** group box to save the radial velocity profile.

e. Click the **Write...** button to open the **Select File** dialog box.

   i. Enter `ke-data.xy` in the **XY File** text entry box and click **OK**.

5. Plot the wall $y+$ distribution on the rotating disk wall along the radial direction ([Figure 11.7: Wall Yplus Distribution on wall-6— Standard k-$\varepsilon$ Solution (p. 511)].)

   ![Plots → XY Plot → Set Up...](image)
a. Disable **Write to File** in the **Options** group box.

b. Select **Turbulence...** and **Wall Yplus** from the **Y Axis Function** drop-down lists.

c. Deselect **y=37cm** and select **wall-6** from the **Surfaces** selection list.

d. Enter 0 and 1 for **X** and **Y** respectively in the **Plot Direction** group box.

**Note**

The change in Plot Direction is required because we are plotting y+ along the radial dimension of the disk which is oriented with Y-axis.

e. Click the **Axes...** button to open the **Axes - Solution XY Plot** dialog box.
i. Retain the default selection of X from the Axis group box.

ii. Disable Auto Range in the Options group box.

iii. Retain the default value of 0 for Minimum and enter 43 for Maximum in the Range group box.

iv. Click Apply and close the Axes - Solution XY Plot dialog box.

f. Click Plot in the Solution XY Plot dialog box.

Figure 11.7: Wall Yplus Distribution on wall-6— Standard k- ε Solution(p. 511) shows a plot of wall y+ distribution along wall-6.

Figure 11.7: Wall Yplus Distribution on wall-6— Standard k- ε Solution
g. Enable **Write to File** in the **Options** group box to save the wall $y^+$ profile.

h. Click the **Write...** button to open the **Select File** dialog box.

i. Enter `ke-yplus.xy` in the **XY File** text entry box and click **OK**.

---

### Note

Ideally, while using enhanced wall treatment, the wall $y^+$ should be in the order of 1 (at least less than 5) to resolve the viscous sublayer. The plot justifies the applicability of enhanced wall treatment to the given mesh.

---

i. Close the **Solution XY Plot** dialog box.

### 11.4.10. Solution Using the RNG $k$-$\varepsilon$ Model

Recalculate the solution using the RNG $k$-$\varepsilon$ turbulence model.

1. Enable the RNG $k$-$\varepsilon$ turbulence model with the enhanced near-wall treatment.

   ![Models ➔ Viscous ➔ Edit...](#)
a. Select **RNG** in the **k-epsilon Model** list.

b. Enable **Differential Viscosity Model** and **Swirl Dominated Flow** in the **RNG Options** group box.

   The differential viscosity model and swirl modification can provide better accuracy for swirling flows such as the disk cavity.

   For more information, see **RNG Swirl Modification** of the **Theory Guide**.

c. Retain **Enhanced Wall Treatment** as the **Near-Wall Treatment**.

d. Click **OK** to close the **Viscous Model** dialog box.

2. Continue the calculation by requesting 300 iterations.

   **Run Calculation**

   The solution converges after approximately 220 additional iterations.
3. Save the case and data files (disk-rng.cas.gz and disk-rng.dat.gz).

   File → Write → Case & Data...

11.4.11. Postprocessing for the RNG $k-\varepsilon$ Solution

1. Plot the radial velocity distribution for the RNG $k-\varepsilon$ solution and compare it with the distribution for the standard $k-\varepsilon$ solution.

   Plots → XY Plot → Set Up...

   ![Solution XY Plot settings](image)

   a. Enter 1 and 0 for X and Y respectively in the Plot Direction group box.
   b. Select Velocity... and Radial Velocity from the Y Axis Function drop-down lists.
   c. Select $y=37\text{cm}$ and deselect wall-6 from the Surfaces selection list.
   d. Disable the Write to File option.
   e. Click the Load File... button to load the $k-\varepsilon$ data.
      i. Select the file ke-data.xy in the Select File dialog box.
      ii. Click OK.
   f. Click the Axes... button to open the Axes - Solution XY Plot dialog box.
      i. Enable Auto Range in the Options group box.
      ii. Click Apply and close the Axes - Solution XY Plot dialog box.
   g. Click the Curves... button to open the Curves - Solution XY Plot dialog box, where you will define a different curve symbol for the RNG $k-\varepsilon$ data.
i. Retain 0 for the **Curve #**.

ii. Select **X** from the **Symbol** drop-down list.

iii. Click **Apply** and close the **Curves - Solution XY Plot** dialog box.

h. Click **Plot** in the **Solution XY Plot** dialog box (Figure 11.8: Radial Velocity Distribution — RNG $k$-$\varepsilon$ and Standard $k$-$\varepsilon$ Solutions (p. 515)).

**Figure 11.8: Radial Velocity Distribution — RNG $k$-$\varepsilon$ and Standard $k$-$\varepsilon$ Solutions**

The peak velocity predicted by the RNG $k$-$\varepsilon$ solution is higher than that predicted by the standard $k$-$\varepsilon$ solution. This is due to the less diffusive character of the RNG $k$-$\varepsilon$ model. Adjust the range of the $x$ axis to magnify the region of the peaks.

i. Click the **Axes...** button to open the **Axes - Solution XY Plot** dialog box, where you will specify the $x$-axis range.
i. Disable Auto Range in the Options group box.

ii. Retain the value of 0 for Minimum and enter 1 for Maximum in the Range dialog box.

iii. Click Apply and close the Axes - Solution XY Plot dialog box.

j. Click Plot.

*The difference between the peak values calculated by the two models is now more apparent.*

**Figure 11.9: RNG $k\varepsilon$ and Standard $k\varepsilon$ Solutions (x=0 cm to x=1 cm)**

2. Plot the wall $y+$ distribution on the rotating disk wall along the radial direction **Figure 11.10: wall-6 — RNG $k\varepsilon$ and Standard $k\varepsilon$ Solutions (x=0 cm to x=43 cm)** (p. 518)
a. Select Turbulence... and Wall Yplus from the Y Axis Function drop-down lists.

b. Deselect y=37cm and select wall-6 from the Surfaces selection list.

c. Enter 0 and 1 for X and Y respectively in the Plot Direction group box.

d. Select any existing files that appear in the File Data selection list and click the Free Data button to remove the file.

e. Click the Load File... button to load the RNG $k-$ $\varepsilon$ data.

   i. Select the file ke-yplus.xy in the Select File dialog box.

   ii. Click OK.

f. Click the Axes... button to open the Axes - Solution XY Plot dialog box.

   i. Retain the default selection of X from the Axis group box.

   ii. Retain the default value of 0 for Minimum and enter 43 for Maximum in the Range group box.

   iii. Click Apply and close the Axes - Solution XY Plot dialog box.

g. Click Plot in the Solution XY Plot dialog box.
11.5. Summary

This tutorial illustrated the setup and solution of a 2D, axisymmetric disk cavity problem in ANSYS Fluent. The ability to calculate a swirl velocity permits the use of a 2D mesh, thereby making the calculation simpler and more economical to run than a 3D model. This can be important for problems where the enhanced wall treatment is used, and the near-wall flow field is resolved using a fine mesh (the first mesh point away from the wall being placed at a y+ on the order of 1).

For more information about mesh considerations for turbulence modeling, see Model Hierarchy in the User's Guide.

11.6. Further Improvements

The case modeled in this tutorial lends itself to parametric study due to its relatively small size. Here are some things you may want to try:

• Separate wall-6 into two walls.

  Mesh → Separate → Faces...

  Specify one wall to be stationary, and rerun the calculation.

• Use adaption to see if resolving the high velocity and pressure-gradient region of the flow has a significant effect on the solution.
• Introduce a non-zero swirl at the inlet or use a velocity profile for fully-developed pipe flow. This is probably more realistic than the constant axial velocity used here, since the flow at the inlet is typically being supplied by a pipe.

• Model compressible flow (using the ideal gas law for density) rather than assuming incompressible flow text.

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).

11.7. References

Chapter 12: Using Multiple Reference Frames

This tutorial is divided into the following sections:

12.1. Introduction
12.2. Prerequisites
12.3. Problem Description
12.4. Setup and Solution
12.5. Summary
12.6. Further Improvements

12.1. Introduction

Many engineering problems involve rotating flow domains. One example is the centrifugal blower unit that is typically used in automotive climate control systems. For problems where all the moving parts (fan blades, hub and shaft surfaces, etc.) are rotating at a prescribed angular velocity, and the stationary walls (for example, shrouds, duct walls) are surfaces of revolution with respect to the axis of rotation, the entire domain can be referred to as a single rotating frame of reference. However, when each of the several parts is rotating about a different axis of rotation, or about the same axis at different speeds, or when the stationary walls are not surfaces of revolution (such as the volute around a centrifugal blower wheel), a single rotating coordinate system is not sufficient to “immobilize” the computational domain so as to predict a steady-state flow field. In such cases, the problem must be formulated using multiple reference frames.

In ANSYS Fluent, the flow features associated with one or more rotating parts can be analyzed using the multiple reference frame (MRF) capability. This model is powerful in that multiple rotating reference frames can be included in a single domain. The resulting flow field is representative of a snapshot of the transient flow field in which the rotating parts are moving. However, in many cases the interface can be chosen in such a way that the flow field at this location is independent of the orientation of the moving parts. In other words, if an interface can be drawn on which there is little or no angular dependence, the model can be a reliable tool for simulating time-averaged flow fields. It is therefore very useful in complicated situations where one or more rotating parts are present.

This tutorial illustrates the procedure for setting up and solving a problem using the MRF capability. As an example, the flow field on a 2D section of a centrifugal blower will be calculated. Although this is a general methodology that can be applied to cases where more than one reference frame is moving, this example will be limited to a single rotating reference frame.

This tutorial demonstrates how to do the following:

- Create mesh interfaces from interface-zones defined during meshing.
- Specify different frames of reference for different fluid zones.
- Set the relative velocity of each wall.
- Calculate a solution using the pressure-based solver.
12.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

- Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
- Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
- Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

This tutorial also assumes that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.

In general, to solve problems using the MRF feature, you should be familiar with the concept of creating multiple fluid zones in your mesh generator.

12.3. Problem Description

This problem considers a 2D section of a generic centrifugal blower. A schematic of the problem is shown in Figure 12.1: Schematic of the Problem (p. 522). The blower consists of 32 blades, each with a chord length of 13.5 mm. The blades are located approximately 56.5 mm (measured from the leading edge) from the center of rotation. The radius of the outer wall varies logarithmically from 80 mm to 146.5 mm. You will simulate the flow under no load, or free-delivery conditions when inlet and outlet pressures are at ambient conditions (0 Pa gauge). This corresponds to the maximum flow-rate of the blower when sitting in free air. The blades are rotating with an angular velocity of 2500 rpm. The flow is assumed to be turbulent.

Figure 12.1: Schematic of the Problem
12.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

12.4.1. Preparation
12.4.2. Reading and Checking the Mesh and Setting the Units
12.4.3. Specifying Solver and Analysis Type
12.4.4. Specifying the Models
12.4.5. Specifying Materials
12.4.6. Specifying Cell Zone Conditions
12.4.7. Setting Boundary Conditions
12.4.8. Defining Mesh Interfaces
12.4.9. Obtaining the Solution
12.4.10. Step 9: Postprocessing

12.4.1. Preparation

To access tutorials and their input files on the ANSYS Customer Portal, go to [http://support.ansys.com/training](http://support.ansys.com/training).

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, [https://support.ansys.com/training](https://support.ansys.com/training).

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   a. Click **ANSYS Fluent** under **Product**.
   b. Click **15.0** under **Version**.

5. Select this tutorial from the list.

6. Click **Files** to download the input and solution files.

7. Unzip the `multiple_rotating_R150.zip` file you have downloaded to your working folder.
   
   *The file, `blower-2d.msh` can be found in the `multiple_rotating` directory created after unzipping the file.*

8. Use Fluent Launcher to start the **2D** version of ANSYS Fluent.
   
   Fluent Launcher displays your **Display Options** preferences from the previous session.
For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in the Fluent Getting Started Guide.

9. Ensure that the **Display Mesh After Reading**, **Embed Graphics Windows**, and **Workbench Color Scheme** options are enabled.

10. Ensure that the **Serial** processing option is selected.

11. Enable **Double Precision**.

### 12.4.2. Reading and Checking the Mesh and Setting the Units

1. Read the mesh file (*blower-2d.msh*).
   
   File → Read → Mesh...
   
   The geometry and mesh are displayed in graphics window (Figure 12.2: Mesh of the 2D Centrifugal Blower (p. 525))

2. Check the mesh.
   
   ![General → Check](image)
   
   ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Make sure that the reported minimum volume is a positive number. It will also issue warnings about unassigned interface zones. You do not need to take any action now. You will set up the mesh interfaces in a later step.

3. Examine the mesh.
   
   The mesh consists of three fluid zones, **fluid-casing**, **fluid-inlet**, and **fluid-rotor**. These are reported in the console when the mesh is read. In the Mesh Display dialog box, the fluid zones are reported as interior zones **default-interior**, **default-interior:013**, and **default-interior:015** respectively. The fluid zone containing the blades will be solved in a rotational reference frame.
Figure 12.2: Mesh of the 2D Centrifugal Blower

The fluid zones are bounded by interface zones that appear in the mesh display in yellow. These interface boundaries were used in the mesh generator to separate the fluid zones, and will be used to create mesh interfaces between adjacent fluid zones when the boundary conditions are set later in this tutorial.

4. Set the units for angular velocity.

General → Units...

In the problem description, angular velocity is specified in rpm rather than in the default unit of rad/s.
a. Select **angular-velocity** from the **Quantities** list and **rpm** in the **Units** list.

b. Close the **Set Units** dialog box.

### 12.4.3. Specifying Solver and Analysis Type

1. Retain the default settings of the pressure-based steady-state solver in the **Solver** group box.

### General

**Mesh**
- Scale
- Check
- Report Quality
- Display

**Solver**
- **Type**: Pressure-Based
- **Velocity Formulation**: Absolute
- **Time**: Steady
- **2D Space**: Planar

### 12.4.4. Specifying the Models

1. Enable the standard $k-\varepsilon$ turbulence model.
a. Select **k-epsilon (2eqn)** in the **Model** list.

b. Select **Enhanced Wall Treatment** in the **Near-Wall Treatment** list.

c. Click **OK** to close the **Viscous Model** dialog box.

### 12.4.5. Specifying Materials

1. Retain the default properties for air.

   **Materials → air → Create/Edit...**
Extra

If needed, you could modify the fluid properties for air or copy another material from the database.

2. Click Close to close the Create/Edit Materials dialog box.

For details, see Physical Properties in the User’s Guide.
12.4.6. Specifying Cell Zone Conditions

1. Define the boundary conditions for the rotational reference frame (fluid-rotor).

   - Cell Zone Conditions → fluid-rotor → Edit...
a. Enable **Frame Motion**.

*The dialog box will expand to show the relevant inputs.*

b. Under the **Reference Frame** tab, retain the **Rotation-Axis Origin** default setting of \((0, 0)\).

*This is the center of curvature for the circular boundaries of the rotating zone.*

c. Enter \(-2500\) rpm for **Speed** in the **Rotational Velocity** group box.

---

**Note**

The speed is entered as a negative value because the rotor is rotating clockwise which is in the negative sense about the z-axis.
d. Click **OK** to close the **Fluid** dialog box.

**Note**
Since the other fluid zones are stationary, you do not need to set any boundary conditions for them. If one or more of the remaining fluid zones were also rotating, you would need to set the appropriate rotational speed for them.

**Tip**
In this example, the names of the fluid-zones in the mesh file leave no ambiguity as to which is the rotating fluid zone. In the event that you have a mesh without clear names, you may have difficulty identifying the various fluid-zones. Unlike interior zones, the fluid-zones cannot be individually selected and displayed from the **Mesh Display** dialog box. However, you can use commands in the text interface to display them.

**Cell Zone Conditions → Display Mesh...**

i. Click the interior zones, **default-interior**, **default-interior:013**, and **default-interior:015** in the **Surfaces** selection list to deselect them.

ii. Click **Display**.

  *Only the domain boundaries and interface zones will be displayed.*

iii. Press the **Enter** key to get the > prompt.

iv. Type the commands, in the console, as shown.

```plaintext
> display
/display> zone-mesh ()
zone id/name(1) [()]  4
zone id/name(2) [()]  <Enter>
```

The resulting display shows that the zone with ID 4 (in this case **fluid-rotor**) corresponds to the rotating region.

v. Close the **Mesh Display** dialog box.
12.4.7. Setting Boundary Conditions

1. Set the boundary conditions for the flow inlet (inlet) as specified in the problem description (see Figure 12.1: Schematic of the Problem (p. 522)).

\[ \text{Boundary Conditions} \rightarrow \text{inlet} \rightarrow \text{Edit...} \]
a. Review the boundary condition definition for the pressure-inlet type. Leave the settings at their defaults.

b. Click **OK** to close the **Pressure Inlet** dialog box.

---

**Note**

All pressures that you specify in ANSYS Fluent are gauge pressures, relative to the operating pressure specified in the **Operating Conditions** dialog box. By default, the operating pressure is 101325 Pa.

For details, see **Operating Pressure** in the **User’s Guide**.

2. Review and retain the default values for the boundary conditions for the flow outlet (**outlet**) so that the backflow turbulence parameters for the flow outlet (**outlet**) are set to the same values used for **inlet**.

---

**Note**

The backflow values are used only if reversed flow occurs at the outlet, but it is a good idea to use reasonable values, even if you do not expect any backflow to occur.

3. Define the velocity of the wall zone representing the blades (**blades**) relative to the moving fluid zone.

    ![Boundary Conditions](image) → **blades** → **Edit...**
With fluid-rotor set to a rotating reference frame, blades becomes a moving wall.

a. Select Moving Wall in the Wall Motion list.

The Wall dialog box will expand to show the wall motion parameters.

b. Retain the default selection of Relative to Adjacent Cell Zone and select Rotational in the Motion group box.

c. Retain the default value of 0 rpm for (relative) Speed.

d. Click OK to close the Wall dialog box.

The Rotation-Axis Origin should be located at $x = 0\ m$ and $y = 0\ m$. With these settings, the blades will move at the same speed as the surrounding fluid.

### 12.4.8. Defining Mesh Interfaces

Recall that the fluid domain is defined as three distinct fluid zones. You must define mesh interfaces between the adjacent fluid zones so that ANSYS Fluent can solve the flow equations across the interfaces.
1. Set up the mesh interface between **fluid-inlet** and **fluid-rotor**.

Mesh Interfaces → Create/Edit...

- a. Enter int1 under **Mesh Interface** to name this interface definition.
- b. Select interface-1 for **Interface Zone 1** and interface-2 for **Interface Zone 2**.
  
  *You can use the Draw button to help identify the interface-zones.*
- c. Click **Create** in order to create the mesh interface, int1.
- d. In a similar manner, define a mesh interface called int2 between interface-3 and interface-4.
- e. Close the **Create/Edit Mesh Interfaces** dialog box.

**12.4.9. Obtaining the Solution**

1. Set the solution parameters.

Solution Methods
Using Multiple Reference Frames

Solution Methods

Pressure-Velocity Coupling

- Scheme dropdown list
  - Coupled

Spatial Discretization

- Gradient dropdown list
  - Least Squares Cell Based
- Pressure
  - Second Order
- Momentum
  - Second Order Upwind
- Turbulent Kinetic Energy
  - Second Order Upwind
- Turbulent Dissipation Rate
  - Second Order Upwind

Transient Formulation

- Non-Iterative Time Advancement
- Frozen Flux Formulation
- Pseudo Transient
- High Order Term Relaxation: Options...
- Default

Help

---

(a) Select **Coupled** from **Scheme** drop-down list in the **Pressure-Velocity Coupling** group box.

(b) Select Second Order Upwind for **Turbulent Kinetic Energy** and **Turbulent Dissipation Rate** in the **Spatial Discretization** group box.

*The second-order scheme will provide a more accurate solution.*

2. Enable that plotting of residuals during the calculation.

   ✅ Monitors → Residuals → Edit...
a. Ensure that Plot is enabled in the Options group box.

b. Enter $5 \times 10^{-5}$ under Absolute Criteria for the continuity equation.

   *For this problem, the default value of 0.001 is insufficient for the flow rate in the blower to fully converge. All other settings should remain at their default values.*

c. Click OK to close the Residual Monitors dialog box.

3. Create a surface monitor and plot the volume flow rate at the flow outlet.

   ![Monitors (Surface Monitors) → Create...](image)
a. Enable the **Plot** and **Write** options for *surf-mon-1*.

**Note**

When the **Write** option is selected in the **Surface Monitor** dialog box, the mass flow rate history will be written to a file. If you do not enable the **Write** option, the history information will be lost when you exit ANSYS Fluent.

b. Select **Volume Flow Rate** from the **Report Type** drop-down list.

c. Select **outlet** from the **Surfaces** selection list.

d. Click **OK** in the **Surface Monitor** dialog box to enable the monitor.

4. Initialize the solution.

   ![Solution Initialization](image)
a. Retain the default selection of **Hybrid Initialization** in the **Initialization Methods** group box.

b. Click **Initialize** to initialize the solution.

**Note**

For flows in complex topologies, hybrid initialization will provide better initial velocity and pressure fields than standard initialization. This in general will help in improving the convergence behavior of the solver.

5. Save the case file (*blower.cas.gz*).

   *File → Write → Case...*

6. Start the calculation by requesting 150 iterations.

**Run Calculation**

a. Enter **150** for **Number of Iterations**.
b. Click **Calculate**.

*Early in the calculation, ANSYS Fluent will report that there is reversed flow occurring at the exit. This is due to the sudden expansion, which results in a recirculating flow near the exit.*

The solution will converge in approximately 95 iterations (when all residuals have dropped below their respective criteria).

**Figure 12.3: History of Volume Flow Rate on outlet**

*The surface monitor history indicates that the flow rate at the outlet has ceased changing significantly, further indicating that the solution has converged. The volume flow rate is approximately 3.49 m³/s.*

---

**Note**

You can examine the residuals history by selecting it from the graphics window dropdown list.

---

7. **Save the case and data files** (blower2.cas.gz and blower2.dat.gz).
File → Write → Case & Data...

**Note**

It is good practice to save the case file whenever you are saving the data. This will ensure that the relevant parameters corresponding to the current solution data are saved accordingly.

### 12.4.10. Step 9: Postprocessing

1. Display filled contours of static pressure (Figure 12.4: Contours of Static Pressure (p. 542)).

   ![Graphics and Animations → Contours → Set Up...](image)

   a. Enable **Filled** in the **Options** group box.
   
   b. Select **Pressure...** and **Static Pressure** from the **Contours of** drop-down lists.
   
   c. Click **Display** and close the **Contours** dialog box (see Figure 12.4: Contours of Static Pressure (p. 542)).

   Pressure distribution in the flow domain is plotted in graphics window.
2. Display absolute velocity vectors (Figure 12.5: Velocity Vectors (p. 544)).

Graphics and Animations → Vectors → Set Up...
a. Enter 10 for **Scale**.

*By default, **Auto Scale** is chosen. This will automatically scale the length of velocity vectors relative to the size of the smallest cell in the mesh. To increase the length of the "scaled" vectors, set the **Scale** factor to a value greater than 1.*

b. Retain the default selection of **Velocity** from the **Vectors of** drop-down list.

c. Retain the default selection of **Velocity...** and **Velocity Magnitude** from the **Color by** drop-down list.

d. Click **Display** and close the **Vectors** dialog box (see **Figure 12.5: Velocity Vectors (p. 544)**).
The velocity vectors show an area of flow separation near the bottom of the outlet duct. You can zoom in on this area and see the flow recirculation.

3. Display relative velocity vectors with respect to the rotational reference frame (fluid-rotor).

Graphics and Animations → Vectors → Set Up...
a. In the Reference Values task page, select fluid-rotor from the Reference Zone drop-down list.

b. In the Vectors dialog box, select Relative Velocity from the Vectors of drop-down list.

c. Select Velocity... and Relative Velocity Magnitude from the Color by drop-down list.

d. Set Scale to 2.

e. Click Display and close the Vectors dialog box.

   The relative air velocity vectors viewed in the frame of reference rotating with the rotor are displayed.

f. Zoom in on the rotor blade region as shown in Figure 12.6: Relative Velocity Vectors (p. 546) and examine the air flow through the rotor blade passages.
4. Report the mass flux at inlet and outlet.

Reports → Fluxes → Set Up...
a. Retain the selection of **Mass Flow Rate** in the **Options** group box.

b. Select **inlet** and **outlet** in the **Boundaries** selection list.

c. Click **Compute**.

   *The net mass imbalance should be no more than a small fraction (say, 0.5%) of the total flux through the system. If a significant imbalance occurs, you should decrease your residual tolerances by at least an order of magnitude and continue iterating.*

   *The flux report will compute fluxes only for boundary zones.*

d. Close the **Flux Reports** dialog box.

---

**Note**

*You can use the **Surface Integrals** option to report fluxes on surfaces or planes.*

![Flux Reports dialog box](image)

---

**12.5. Summary**

This tutorial illustrates the procedure for setting up and solving problems with multiple reference frames using ANSYS Fluent. Although this tutorial considers only one rotating fluid zone, extension to multiple rotating fluid zones is straightforward as long as you delineate each fluid zone.

Note that this tutorial was solved using the default absolute velocity formulation. For some problems involving rotating reference frames, you may want to use the relative velocity formulation. See the ANSYS Fluent User’s Guide for details.
12.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 13: Using the Mixing Plane Model

This tutorial is divided into the following sections:

13.1. Introduction
13.2. Prerequisites
13.3. Problem Description
13.4. Setup and Solution
13.5. Summary
13.6. Further Improvements

13.1. Introduction

This tutorial considers the flow in an axial fan with a rotor in front and stators (vanes) in the rear. This configuration is typical of a single-stage axial flow turbomachine. By considering the rotor and stator together in a single calculation, you can determine the interaction between these components.

This tutorial demonstrates how to do the following:

• Use the standard $k-\varepsilon$ model with enhanced wall treatment.
• Use a mixing plane to model the rotor-stator interface.
• Calculate a solution using the pressure-based solver.
• Compute and display circumferential averages of total pressure on a surface.

13.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.

13.3. Problem Description

The problem to be considered is shown schematically in Figure 13.1: Problem Specification (p. 550). The rotor and stator consist of 9 and 12 blades, respectively. A steady-state solution for this configuration using only one rotor blade and one stator blade is desired. Since the periodic angles for the rotor and stator are different, a mixing plane must be used at the interface.
The mixing plane is defined at the rotor outlet / stator inlet. The mesh is set up with periodic boundaries on either side of the rotor and stator blades. A pressure inlet is used at the upstream boundary and a pressure outlet at the downstream boundary. Ambient air is drawn into the fan (at 0 Pa gauge total pressure) and is exhausted back out to the ambient environment (0 Pa static pressure). The hub and blade of the rotor are assumed to be rotating at 1800 rpm.

**Figure 13.1: Problem Specification**

![Diagram showing the mixing plane setup with labeled parts: rotor, stator, inlet, outlet, and rotation angle \( \omega = 1800 \text{ rpm} \).]

### 13.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

- **13.4.1. Preparation**
- **13.4.2. Mesh**
- **13.4.3. General Settings**
- **13.4.4. Models**
- **13.4.5. Mixing Plane**
- **13.4.6. Materials**
- **13.4.7. Cell Zone Conditions**
- **13.4.8. Boundary Conditions**
- **13.4.9. Solution**
- **13.4.10. Postprocessing**

#### 13.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.
2. Go to the ANSYS Customer Portal, [https://support.ansys.com/training](https://support.ansys.com/training).

**Note**

If you do not have a login, you can request one by clicking **Customer Registration** on the log in page.

3. Enter the name of this tutorial into the search bar.
4. Narrow the results by using the filter on the left side of the page.
5. Select this tutorial from the list.

6. Click **Files** to download the input and solution files.

7. **Unzip** **mixing_plane_R150.zip** to your working folder.

   The file **fanstage.msh** can be found in the **mixing_plane** directory created after unzipping the file.

   Copy the **fanstage.msh** file into your working directory.

8. Use Fluent Launcher to start the **3D** version of ANSYS Fluent.

   Fluent Launcher displays your **Display Options** preferences from the previous session.

   For more information about Fluent Launcher, see **Starting ANSYS Fluent Using Fluent Launcher** in the User’s Guide.

9. Ensure that the **Display Mesh After Reading**, **Embed Graphics Windows**, and **Workbench Color Scheme** options are enabled.

10. Run in single precision (disable **Double Precision**).

11. Ensure **Serial** is selected under **Processing Options**.

### 13.4.2. Mesh

1. Read the mesh file **fanstage.msh**.

   **File → Read → Mesh...**

   As ANSYS Fluent reads the mesh file, it will report its progress in the console.

### 13.4.3. General Settings

1. Check the mesh.

   **General → Check**

   ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure that the reported minimum volume is a positive number. You will notice that ANSYS Fluent issues several warning messages concerning translation vectors with suggestions to check periodic setup. These arise because you have not yet specified the periodicity for zones 11 and 22. You can ignore these warnings because you will specify the periodicity in a later step.

2. Display the mesh (Figure 13.2: Mesh Display for the Multistage Fan (p. 553)).

   **General → Display...**
Using the Mixing Plane Model

a. Select only **rotor-blade**, **rotor-hub**, **rotor-inlet-hub**, **stator-blade**, and **stator-hub** from the **Surfaces** selection list.

b. Click **Display** and close the **Mesh Display** dialog box.
Figure 13.2: Mesh Display for the Multistage Fan

You can use the right mouse button to check which zone number corresponds to each boundary. If you click the right mouse button on one of the boundaries in the graphics window, its zone number, name, and type will be printed in the ANSYS Fluent console. This feature is especially useful when you have several zones of the same type and you want to distinguish between them quickly.

3. Retain the default solver settings.

General
4. Define new units for angular velocity.

General → Units...

The angular velocity for this problem is known in rpm, which is not the default unit for angular velocity. You will need to redefine the angular velocity units as rpm.

a. Select angular-velocity from the Quantities selection list and rpm from the Units selection list.

b. Close the Set Units dialog box.

13.4.4. Models

1. Enable the standard $k$-$\varepsilon$ turbulence model with enhanced wall treatment.
a. Select \textbf{k-epsilon (2 eqn)} from the \textbf{Model} list.

\textit{The Viscous Model dialog box will expand.}

b. Retain the default selection of \textbf{Standard} from the \textbf{k-epsilon Model} list.

c. Select \textbf{Enhanced Wall Treatment} from the \textbf{Near-Wall Treatment} list.

d. Click \textbf{OK} to close the \textbf{Viscous Model} dialog box.

\textbf{13.4.5. Mixing Plane}

\textbf{Define} \rightarrow \textbf{Mixing Planes...}

\textit{In this step, you will create the mixing plane between the pressure outlet of the rotor and the pressure inlet of the stator.}
1. Select **pressure-outlet-rotor** from the **Upstream Zone** selection list.

2. Select **pressure-inlet-stator** from the **Downstream Zone** selection list.

3. Retain the selection of **Area** from the **Averaging Method** list.

4. Click **Create** and close the **Mixing Planes** dialog box.

**ANSYS Fluent will name the mixing plane by combining the names of the zones selected as the** **Upstream Zone** **and Downstream Zone. This new name will be displayed in the Mixing Plane list.**

The essential idea behind the mixing plane concept is that each fluid zone (stator and rotor) is solved as a steady-state problem. At some prescribed iteration interval, the flow data at the mixing plane interface is averaged in the circumferential direction on both the rotor outlet and the stator inlet boundaries. ANSYS Fluent uses these circumferential averages to define “profiles” of flow properties. These profiles are then used to update boundary conditions along the two zones of the mixing plane interface.

In this example, profiles of averaged total pressure ($p_t$), static pressure ($p_s$), direction cosines of the local flow angles in the radial, tangential, and axial directions ($\alpha_r$, $\alpha_t$, $\alpha_a$), turbulent kinetic energy ($k$), turbulent dissipation rate ($\varepsilon$), and radius ($r$) are computed at the rotor exit and used to update boundary conditions at the stator inlet. Likewise, the same profiles (except for that of total pressure) are computed at the stator inlet and used as a boundary condition on the rotor exit.

The default method for calculating mixing plane profiles uses an area-weighted averaging approach. This method allows reasonable profiles of all variables to be created, regardless of the mesh topology. In some cases, a mass flow-weighted averaging may be appropriate (for example, with compressible turbomachinery flows). For such cases, **Mass** should be selected from the **Averaging Method** list. A third averaging approach (the **Mixed-Out** average) is also available for flows with ideal gases. Refer to Choosing an Averaging Method in the Theory Guide for more information on these averaging methods.

You can view the profiles computed at the rotor exit and stator inlet in the **Profiles** dialog box.

**Define → Profiles...**
You will also see that these profiles appear in the boundary conditions dialog boxes for the rotor exit and stator inlet.

For more information on mixing planes, see The Mixing Plane Model in the User’s Guide.

13.4.6. Materials

1. Retain the default properties for air.

   🔄 Materials → ⚥ air → Create/Edit...

   a. Review the default properties for air.
For the present analysis, you will model air as an incompressible fluid with a density of 1.225 kg/m$^3$ and a dynamic viscosity of $1.7894 \times 10^{-5}$ kg/m-s. Since these are the default values, no change is required in the Create/Edit Materials dialog box.

b. Close the Create/Edit Materials dialog box.

13.4.7. Cell Zone Conditions

1. Set the conditions for the rotor fluid (fluid-rotor).

   ![Cell Zone Conditions](image)

   1. Set the conditions for the rotor fluid (fluid-rotor).
a. Enable **Frame Motion**.

b. Enter $-1$ for $Z$ in the **Rotation-Axis Direction** group box.

According to the right-hand rule (see *Figure 13.1: Problem Specification (p. 550)*), the axis of rotation is the $-Z$ axis.

c. Enter **1800 rpm** for **Speed** in the **Rotational Velocity** group box.

d. Click **OK** to close the **Fluid** dialog box.

2. Set the conditions for the stator fluid (**fluid-stator**).

   ◆ **Cell Zone Conditions** → **fluid-stator** → **Edit...**
a. Enter \(-1\) for \(Z\) in the Rotation-Axis Direction group box. Even though Frame Motion is not enabled for the fluid-stator zone, the rotational axis specification must be consistent between zones.

b. Click OK to close the Fluid dialog box.

### 13.4.8. Boundary Conditions

#### Boundary Conditions
1. Specify rotational periodicity for the periodic boundary of the rotor (**periodic-11**).

   ![Boundary Conditions](Boundary_Conditions.png)

   - Select **Rotational** from the **Periodic Type** list.
   - Click **OK** to close the **Periodic** dialog box.

2. Specify rotational periodicity for the periodic boundary of the stator (**periodic-22**).

   ![Boundary Conditions](Boundary_Conditions.png)

   - Select **Rotational** from the **Periodic Type** list.
   - Click **OK** to close the **Periodic** dialog box.
3. Set the conditions for the pressure inlet of the rotor (*pressure-inlet-rotor*).

![Pressure Inlet dialog box](image)

- a. Select **Direction Vector** from the **Direction Specification Method** drop-down list.
- b. Enter 0 for **X-Component of Flow Direction**.

---

Release 15.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
c. Enter -1 for **Z-Component of Flow Direction**.

d. Retain the selection of **Intensity and Viscosity Ratio** from the **Specification Method** drop-down list.

e. Retain the default, 5% for **Turbulence Intensity** and enter 5 for **Turbulent Viscosity Ratio**.

f. Click **OK** to close the **Pressure Inlet** dialog box.

4. Retain the default settings for the pressure inlet of the stator (**pressure-inlet-stator**).

**Boundary Conditions → pressure-inlet-stator → Edit...**

*The profiles computed at the rotor outlet are used to update the boundary conditions at the stator inlet. These profiles were set automatically when the mixing plane was created. Therefore, you do not need to set any parameters in this dialog box.*

![Pressure Inlet dialog box](image)

a. Verify that the settings are defined by the fields of the **pressure-outlet-rotor** profile.

b. Click **OK** to close the **Pressure Inlet** dialog box.

5. Retain the default settings for the pressure outlet of the rotor (**pressure-outlet-rotor**).
The **Backflow Direction Specification Method** was set to **Direction Vector** when you created the mixing plane, and the **Coordinate System** to **Cylindrical** (as for the stator inlet). The values for the direction cosines are taken from the profiles at the stator.

a. Verify that the settings are defined by the fields of the **pressure-inlet-stator** profile.

b. Click **OK** to close the **Pressure Outlet** dialog box.

6. Set the conditions for the pressure outlet of the stator (**pressure-outlet-stator**).
a. Retain the default selection of Normal to Boundary from the Backflow Direction Specification Method drop-down list.

In problems where a backflow exists at the pressure outlet boundary (for example, a torque-converter), you can use this option to specify the direction of the backflow.

b. Enable the Radial Equilibrium Pressure Distribution option.

This option accounts for the pressure distribution that results from rotation by calculating the pressure gradient according to

$$
\frac{\partial p}{\partial r} = \frac{\rho v_\theta^2}{r}
$$

where \(v_\theta\) is the tangential velocity. This option is appropriate for axial flow configurations with relatively straight flow paths (that is, little change in radius from inlet to exit).

c. Retain the default selection of Intensity and Viscosity Ratio from the Specification Method drop-down list.

d. Enter 1% for Backflow Turbulent Intensity.

e. Enter 1 for Backflow Turbulent Viscosity Ratio.

f. Click OK to close the Pressure Outlet dialog box.

7. Retain the default conditions for the rotor-hub.

 Boundary Conditions → rotor-hub → Edit...
For a rotating reference frame, ANSYS Fluent assumes by default that walls rotate with the rotating reference frame, and hence are stationary with respect to it. Since the **rotor-hub** is rotating, you should retain the default settings.

![Wall settings dialog box](image)

8. Set the conditions for the inlet hub of the rotor (**rotor-inlet-hub**).

   ![Boundary Conditions](image)  
   **Boundary Conditions → rotor-inlet-hub → Edit...**
a. Select Moving Wall from the Wall Motion list.

   The Wall dialog box will expand to show the wall motion inputs.

b. Select Absolute and Rotational in the Motion group box.

c. Enter −1 for Z in the Rotation-Axis Direction group box.

d. Click OK to close the Wall dialog box.

   These conditions set the rotor-inlet-hub to be a stationary wall in the absolute frame.

9. Set the conditions for the shroud of the rotor inlet (rotor-inlet-shroud).

   Boundary Conditions → rotor-inlet-shroud → Edit...
a. Select Moving Wall from the Wall Motion list.

b. Select Absolute and Rotational in the Motion group box.

c. Enter \(-1\) for \(Z\) in the Rotation-Axis Direction group box.

d. Click OK to close the Wall dialog box.

These conditions will set the rotor-inlet-shroud to be a stationary wall in the absolute frame.

10. Set the conditions for the rotor shroud (rotor-shroud).

Boundary Conditions → rotor-shroud → Edit...
a. Select **Moving Wall** from the **Wall Motion** list.

b. Select **Absolute** and **Rotational** in the **Motion** group box.

c. Enter −1 for **Z** in **Rotation-Axis Direction** group box.

d. Click **OK** to close the **Wall** dialog box.

*These conditions will set the rotor-shroud to be a stationary wall in the absolute frame.*

### 13.4.9. Solution

1. Set the solution parameters.

   ✶ **Solution Methods**
a. Select **Coupled** from the **Scheme** drop-down list in the **Pressure-Velocity Coupling** group box.

b. Ensure that **Second Order Upwind** is selected from the **Momentum** drop-down list in the **Spatial Discretization** group box.

c. Select **Power Law** from the **Turbulent Kinetic Energy** drop-down list.

d. Select **Power Law** from the **Turbulent Dissipation Rate** drop-down list.

e. Enable the **Pseudo Transient** option.

2. Set the solution controls.

   - **Solution Controls**
a. Enter 0.2 for **Pressure** in the **Pseudo Transient Explicit Relaxation Factors** group box.

b. Enter 0.5 for **Turbulent Kinetic Energy**.

c. Enter 0.5 for **Turbulent Dissipation Rate**.

*Scroll down to find the **Turbulent Dissipation Rate** number-entry box.*

---

**Note**

For this problem, it was found that these under-relaxation factors worked well.

---

For tips on how to adjust the under-relaxation parameters for different situations, see **Setting Under-Relaxation Factors** in the **User’s Guide**.

3. Enable the plotting of residuals during the calculation.

   ✇ **Monitors** → 📊 **Residuals** → **Edit...**
a. Ensure that the **Plot** option is enabled in the **Options** group box.

b. Click **OK** to close the **Residual Monitors** dialog box.

4. Enable the plotting of mass flow rate at the flow exit.

   ![Monitors (Surface Monitors) → Create...](image)
a. Retain **surf-mon-1** for **Name**.

b. Enable the **Plot** and **Write** options.

c. Retain **surf-mon-1.out** for **File Name**.

d. Select **Mass Flow Rate** from the **Report Type** drop-down list.

e. Select **pressure-outlet-stator** from the **Surfaces** selection list.

f. Click **OK** to close the **Surface Monitor** dialog box.

5. Initialize the flow field.

**Solution Initialization**
a. Retain the default selection of *Hybrid Initialization* from the *Initialization Methods* list.

b. Click *Initialize*.

---

**Note**

A warning is displayed in the console stating that the convergence tolerance of 1.000000e-06 has not been reached during Hybrid Initialization. This means that the default number of iterations is not enough. You will increase the number of iterations and re-initialize the flow. For more information refer to *Hybrid Initialization* in the *User's Guide*.

c. Click *More Settings...* to open the *Hybrid Initialization* dialog box.
i. Increase the **Number of Iterations** to 15.

ii. Click **OK** to close the **Hybrid Initialization** dialog box.

d. Click **Initialize** once more.

---

**Note**

Click **OK** in the **Question** dialog box to discard the current data. After completing 15 iterations, the console displays a message that hybrid initialization is done.

---

**Note**

For flows in complex topologies, hybrid initialization will provide better initial velocity and pressure fields than standard initialization. This will help to improve the convergence behavior of the solver.

---

6. Save the case file (*fanstage.cas.gz*).

   **File → Write → Case...**

7. Start the calculation by requesting 200 iterations.

   ![Run Calculation](image-url)

   **Run Calculation**

   - **Check Case...**
   - **Preview Mesh Motion...**
   - **Fluid Time Scale**
     - **Time Step Method**
       - **User Specified**
       - **Automatic**
     - **Pseudo Time Step (s)**: 0.01
   - **Number of Iterations**: 200
   - **Reporting Interval**: 1
   - **Profile Update Interval**: 1
   - **Data File Quantities...**
   - **Acoustic Signals...**
   - **Calculate**
   - **Help**
a. Select **User Specified** from the **Time Step Method** list.

**Note**

While the **Automatic** method is suitable for most cases, for this problem you will specify a pseudo time step that is larger than the default value, in order to accelerate the convergence. For information on how the pseudo time step is automatically set, see **Automatic Pseudo Transient Time Step** in the **Theory Guide**.

b. Enter 0.01 s for **Pseudo Time Step**.

c. Enter 200 for **Number of iterations**.

d. Click **Calculate**.

*The solution will converge after approximately 110 iterations, as shown in Figure 13.3: Mass Flow Rate History (p. 576). However, the residual history plot is only one indication of solution convergence.*

**Figure 13.3: Mass Flow Rate History**

![Graph showing mass flow rate history](image)

Convergence history of Mass Flow Rate on pressure-outlet-stator

8. Save the case and data files (**fanstage-1.cas.gz** and **fanstage-1.dat.gz**).

   File → Write → Case & Data...

9. Check the mass flux balance.
Reports → Fluxes → Set Up...

**Warning**

Although the mass flow rate history indicates that the solution is converged, you should also check the mass fluxes through the domain to ensure that mass is being conserved.

![Flux Reports](image)

a. Retain the default selection of **Mass Flow Rate** from the **Options** list.

b. Click ⬤, to the right of **Boundaries**, and select **+pressure-[4,0]** in the **Boundaries** group box.

   *This selects* **pressure-inlet-rotor**, **pressure-inlet-stator**, **pressure-outlet-rotor**, and **pressure-outlet-stator**.

c. Click **Compute**.

**Warning**

The net mass imbalance should be a small fraction (approximately 0.5%) of the total flux through the system. If a significant imbalance occurs, you should decrease your residual tolerances by at least an order of magnitude and continue iterating.

**Note**

The fluxes are different for the portions of the rotor and stator that have been modeled. However, the flux for the whole rotor and the whole stator are both approximately
equal to 0.2292 kg/s (that is, 0.02547 × 9 rotor blades, and 0.01910 × 12 stator blades).

d. Close the Flux Reports dialog box.

**13.4.10. Postprocessing**

1. Create an isosurface at \( y = 0.12 \) m.

   **Surface \( \rightarrow \) Iso-Surface...**

   ![Iso-Surface dialog box]

   The surface \( y = 0.12 \) m is a midspan slice through the mesh. This view is useful for looking at the blade-to-blade flow field.

   a. Select Mesh... and Y-Coordinate from the Surface of Constant drop-down lists.

   b. Click Compute to update the minimum and maximum values.

   c. Enter 0.12 m for Iso-Values.

   d. Enter \( y = 0.12 \) for New Surface Name.

   e. Click Create to create the isosurface.

2. Create an isosurface at \( z = -0.1 \) m.

   **Surface \( \rightarrow \) Iso-Surface...**

   The surface \( z = -0.1 \) m is an axial plane downstream of the stator. This will be used to plot circumferentially averaged profiles.

   a. Select Mesh... and Z-Coordinate from the Surface of Constant drop-down lists.
b. Click **Compute** to update the minimum and maximum values.

c. Enter \(-0.1\) m for **Iso-Values**.

d. Enter \(z=-0.1\) for **New Surface Name**.

---

**Note**

The default name that ANSYS Fluent displays in the **New Surface Name** field (that is, **z-coordinate-17**) indicates that this is surface number 17. This fact will be used later in the tutorial when you plot circumferential averages.

---

e. Click **Create** to create the isosurface.

f. Close the **Iso-Surface** dialog box.

3. Display velocity vectors on the midspan surface \(y=0.12\) (Figure 13.4: Velocity Vectors on \(y=0.12\) Near the Stator Blade (p. 580)).

**Graphics and Animations → Vectors → Set Up...**

![Vectors dialog box](image)

a. Retain the default selection of **arrow** from the **Style** drop-down list.

b. Enter 10 for **Scale**.

c. Set **Skip** to 2.

d. Select **y=0.12** from the **Surfaces** selection list.

e. Click **Display** to plot the velocity vectors.

f. Rotate and zoom the view to get the display shown in **Figure 13.4: Velocity Vectors on y=0.12 Near the Stator Blade** (p. 580).

**Figure 13.4: Velocity Vectors on y=0.12 Near the Stator Blade**

Plotting the velocity field in this manner gives a good indication of the midspan flow over the stator. For the rotor, it is instructive to similarly plot the relative velocity field.

g. Close the **Vectors** dialog box.

4. Plot a circumferential average of the total pressure on the plane \( z = -0.1 \).

a. Type the text commands in the console as follows:
>plot
/plot> circum-avg-radial
averages of> total-pressure
on surface [] 17
number of bands [5] 15

Note

Surface 17 is the surface \( z=-0.1 \) you created earlier. For increased resolution, 15 bands are used instead of the default 5.

b. Enter the name of the output file as `circum-plot.xy` when prompted.

```
Computing r-coordinate ...
Clipping to r-coordinate ... done.
Computing "total-pressure" ...
Computing averages ... done.
filename [""] "circum-plot.xy"
```

c. Retain the default of no when asked to order points.

```
order points? [no] no
```

d. Display the circumferential average.

```
Plots ➔ File ➔ Set Up...
```

```
File XY Plot

Plot Title: Circumferential Averages
Legend Title: Total Pressure

Files
C:\mixing_plane\solution_files\circum-plot.xy
C:\mixing_plane\solution_files\circum-plot.xy

Legend Entries
Circumferential Averages
Circumferential Averages
```

i. Click Add... and select the file `circum-plot.xy` in the Select File dialog box.

ii. Click Plot and close the File XY Plot dialog box.

*The radial variation in the total pressure is very non-uniform, as shown in Figure 13.5: Plot of Circumferential Average of the Total Pressure on \( z=-0.1 \) Plane (p. 582). The losses are largest near the hub.*
5. Display filled contours of total pressure.

- Graphics and Animations → Contours → Set Up...
a. Enable **Filled** in the **Options** group box.

b. Retain the default selections of **Pressure...** and **Total Pressure** from the **Contours of** drop-down lists.

c. Select **rotor-blade** and **rotor-hub** from the **Surfaces** selection list.

d. Click **Compute**.

e. Click **Display** and close the **Contours** dialog box.

f. Rotate the view to get the display as shown in **Figure 13.6: Contours of Total Pressure for the Rotor Blade and Hub (p. 584)**.

The pressure contours are displayed in **Figure 13.6: Contours of Total Pressure for the Rotor Blade and Hub (p. 584)**. Notice the high pressure that occurs on the leading edge of the rotor blade due to the motion of the blade.
6. Display the total pressure profiles at the outlet of the rotor.

![Figure 13.6: Contours of Total Pressure for the Rotor Blade and Hub](image)

Contours of Static Pressure (pascal)  ANSYS Fluert (3d, pbns, ske)

- Plots → Profile Data → Set Up...
a. Ensure that `pressure-outlet-rotor` is selected from the **Profile** selection list.

b. Ensure that `p0` is selected from the **Y Axis Function** selection list.

c. Click **Plot** and close the **Plot Profile Data** dialog box.

**Figure 13.7: Profile Plot of Total Pressure for the Rotor**

---

**Note**

The profiles shown are area-averaged profiles computed by the mixing plane model.
13.5. Summary

This tutorial has demonstrated the use of the mixing plane model for a typical axial flow turbomachine configuration. The mixing plane model is useful for predicting steady-state flow in a turbomachine stage, where local interaction effects (such as wake and shock wave interaction) are secondary. If local effects are important, then a transient, sliding mesh calculation is required.

13.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by adapting the mesh. Adapting the mesh can also ensure that your solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 14: Using Sliding Meshes

This tutorial is divided into the following sections:

14.1. Introduction
14.2. Prerequisites
14.3. Problem Description
14.4. Setup and Solution
14.5. Summary
14.6. Further Improvements

14.1. Introduction

The analysis of turbomachinery often involves the examination of the transient effects due to flow interaction between the stationary components and the rotating blades. In this tutorial, the sliding mesh capability of ANSYS Fluent is used to analyze the transient flow in an axial compressor stage. The rotor-stator interaction is modeled by allowing the mesh associated with the rotor blade row to rotate relative to the stationary mesh associated with the stator blade row.

This tutorial demonstrates how to do the following:

• Create periodic zones.
• Set up the transient solver and cell zone and boundary conditions for a sliding mesh simulation.
• Set up the mesh interfaces for a periodic sliding mesh model.
• Sample the time-dependent data and view the mean value.

14.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.

14.3. Problem Description

The model represents a single-stage axial compressor comprised of two blade rows. The first row is the rotor with 16 blades, which is operating at a rotational speed of 37,500 rpm. The second row is the stator with 32 blades. The blade counts are such that the domain is rotationally periodic, with a periodic
angle of 22.5 degrees. This enables you to model only a portion of the geometry, namely, one rotor blade and two stator blades. Due to the high Reynolds number of the flow and the relative coarseness of the mesh (both blade rows are comprised of only 13,856 cells total), the analysis will employ the inviscid model, so that ANSYS Fluent is solving the Euler equations.

**Figure 14.1: Rotor-Stator Problem Description**

14.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

14.4.1. Preparation
14.4.2. Mesh
14.4.3. General Settings
14.4.4. Models
14.4.5. Materials
14.4.6. Cell Zone Conditions
14.4.7. Boundary Conditions
14.4.8. Operating Conditions
14.4.9. Mesh Interfaces
14.4.10. Solution
14.4.11. Postprocessing

**14.4.1. Preparation**

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

   **Note**

   If you do not have a login, you can request one by clicking Customer Registration on the login page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   a. Click ANSYS Fluent under Product.
   b. Click 15.0 under Version.

5. Select this tutorial from the list.

6. Click Files to download the input and solution files.

7. Unzip sliding_mesh_R150.zip to your working folder.
   
   *The mesh file axial_comp.msh can be found in the sliding_mesh directory created after unzipping the file.*

8. Use Fluent Launcher to start the 3D version of ANSYS Fluent.

   Fluent Launcher displays your Display Options preferences from the previous session.

   For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in the User’s Guide.

9. Ensure that the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color Scheme options are enabled.

10. Enable single precision (disable Double Precision).

11. Run in Serial under Processing Options.

### 14.4.2. Mesh

1. Read in the mesh file axial_comp.msh.

   ![File → Read → Mesh...](image)

### 14.4.3. General Settings

1. Check the mesh.

   ![General → Check](image)

   *ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure that the reported minimum volume is a positive number.*
Warnings will be displayed regarding unassigned interface zones, resulting in the failure of the mesh check. You do not need to take any action at this point, as this issue will be rectified when you define the mesh interfaces in a later step.

2. Examine the mesh (Figure 14.2: Rotor-Stator Display (p. 590)).

Orient the view to display the mesh as shown in Figure 14.2: Rotor-Stator Display (p. 590). The inlet of the rotor mesh is colored blue, the interface between the rotor and stator meshes is colored yellow, and the outlet of the stator mesh is colored red.

Figure 14.2: Rotor-Stator Display

3. Use the text user interface to change zones `rotor-per-1` and `rotor-per-3` from wall zones to periodic zones.
   a. Press `<Enter>` in the console to get the command prompt (`>`).
   b. Type the commands as shown below in the console:
> mesh

/mesh> modify-zones

/mesh/modify-zones> list-zones

<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
<th>type</th>
<th>material</th>
<th>kind</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>fluid-rotor</td>
<td>fluid</td>
<td>air</td>
<td>cell</td>
</tr>
<tr>
<td>28</td>
<td>fluid-stator</td>
<td>fluid</td>
<td>air</td>
<td>cell</td>
</tr>
<tr>
<td>2</td>
<td>default-interior:0</td>
<td>interior</td>
<td></td>
<td>face</td>
</tr>
<tr>
<td>15</td>
<td>default-interior</td>
<td>interior</td>
<td></td>
<td>face</td>
</tr>
<tr>
<td>3</td>
<td>rotor-hub</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>4</td>
<td>rotor-shroud</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>7</td>
<td>rotor-blade-1</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>8</td>
<td>rotor-blade-2</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>16</td>
<td>stator-hub</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>17</td>
<td>stator-shroud</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>20</td>
<td>stator-blade-1</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>21</td>
<td>stator-blade-2</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>22</td>
<td>stator-blade-3</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>23</td>
<td>stator-blade-4</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>5</td>
<td>rotor-inlet</td>
<td>pressure-inlet</td>
<td></td>
<td>face</td>
</tr>
<tr>
<td>19</td>
<td>stator-outlet</td>
<td>pressure-outlet</td>
<td></td>
<td>face</td>
</tr>
<tr>
<td>10</td>
<td>rotor-per-1</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>12</td>
<td>rotor-per-2</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>24</td>
<td>stator-per-2</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>26</td>
<td>stator-per-1</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>6</td>
<td>rotor-interface</td>
<td>interface</td>
<td></td>
<td>face</td>
</tr>
<tr>
<td>18</td>
<td>stator-interface</td>
<td>interface</td>
<td></td>
<td>face</td>
</tr>
<tr>
<td>11</td>
<td>rotor-per-4</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>9</td>
<td>rotor-per-3</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>25</td>
<td>stator-per-4</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
<tr>
<td>27</td>
<td>stator-per-3</td>
<td>wall</td>
<td>aluminum</td>
<td>face</td>
</tr>
</tbody>
</table>

/mesh/modify-zones> make-periodic
Periodic zone [()] 10
Shadow zone [()] 9
Rotational periodic? (if no, translational) [yes] yes
Create periodic zones? [yes] yes

zone 9 deleted
created periodic zones.

4. Similarly, change the following wall zone pairs to periodic zones:

<table>
<thead>
<tr>
<th>Zone Pairs</th>
<th>Respective Zone IDs</th>
</tr>
</thead>
<tbody>
<tr>
<td>rotor-per-2 and rotor-per-4</td>
<td>12 and 11</td>
</tr>
<tr>
<td>stator-per-1 and stator-per-3</td>
<td>26 and 27</td>
</tr>
<tr>
<td>stator-per-2 and stator-per-4</td>
<td>24 and 25</td>
</tr>
</tbody>
</table>

5. Define the solver settings.

General
a. Retain the default selection of Pressure-Based in the Type list.

b. Select Transient in the Time list.

6. Define the units for the model.

General → Units...

a. Select angular-velocity from the Quantities selection list.

b. Select rpm from the Units selection list.

c. Select pressure from the Quantities selection list.

Scroll down the Quantities list to find pressure.

d. Select atm from the Units selection list.
e. Close the Set Units dialog box.

14.4.4. Models

1. Enable the inviscid model.

   ![Models → Viscous → Edit...](image)

   a. Select Inviscid in the Model list.

   b. Click OK to close the Viscous Model dialog box.

14.4.5. Materials

1. Specify air (the default material) as the fluid material, using the ideal gas law to compute density.

   ![Materials → air → Create/Edit...](image)
a. Retain the default entry of air in the Name text entry field.

b. Select ideal-gas from the Density drop-down list in the Properties group box.

c. Retain the default values for all other properties.

d. Click Change/Create and close the Create/Edit Materials dialog box.

As reported in the console, ANSYS Fluent will automatically enable the energy equation, since this is required when using the ideal gas law to compute the density of the fluid.

14.4.6. Cell Zone Conditions

Cell Zone Conditions
1. Set the boundary conditions for the fluid in the rotor (fluid-rotor).

   ☞ Cell Zone Conditions → fluid-rotor → Edit...
a. Enable **Mesh Motion**.

b. Click the **Mesh Motion** tab.

c. Retain the default values of \((0, 0, 1)\) for \(X\), \(Y\), and \(Z\) in the **Rotation-Axis Direction** group box.

d. Enter 37500 rpm for **Speed** in the **Rotational Velocity** group box.

e. Click **OK** to close the **Fluid** dialog box.

2. Set the boundary conditions for the fluid in the stator (**fluid-stator**).

   ![Cell Zone Conditions → fluid-stator → Edit...](image)
a. Retain the default values of (0, 0, 1) for \(X\), \(Y\), and \(Z\) in the Rotation-Axis Direction group box.

b. Click OK to close the Fluid dialog box.

### 14.4.7. Boundary Conditions

**Boundary Conditions**
1. Set the boundary conditions for the inlet (rotor-inlet).

   ![Boundary Conditions](rotor-inlet)

   - **Boundary Conditions → rotor-inlet → Edit...**

   ![Pressure Inlet](rotor-inlet)

   a. Enter 1.0 atm for **Gauge Total Pressure**.
b. Enter 0.9 atm for **Supersonic/Initial Gauge Pressure**.

c. Click the **Thermal** tab and enter 288 K for **Total Temperature**.

![Pressure Inlet Dialog Box](image1)

d. Click **OK** to close the **Pressure Inlet** dialog box.

2. Set the boundary conditions for the outlet (**stator-outlet**).

**Boundary Conditions → stator-outlet → Edit...**

![Pressure Outlet Dialog Box](image2)

a. Enter 1.08 atm for **Gauge Pressure**.

b. Enable **Radial Equilibrium Pressure Distribution**.

c. Click the **Thermal** tab and enter 288 K for **Backflow Total Temperature**.
d. Click **OK** to close the **Pressure Outlet** dialog box.

---

**Note**

The momentum settings and temperature you input at the pressure outlet will be used only if flow enters the domain through this boundary. It is important to set reasonable values for these downstream scalar values, in case flow reversal occurs at some point during the calculation.

---

3. Retain the default boundary conditions for all wall zones.

   ![Boundary Conditions](rotor-blade-1>Edit...
Note

For wall zones, ANSYS Fluent always imposes zero velocity for the normal velocity component, which is required whether or not the fluid zone is moving. This condition is all that is required for an inviscid flow, as the tangential velocity is computed as part of the solution.

14.4.8. Operating Conditions

1. Set the operating pressure.

 Boundary Conditions → Operating Conditions...

a. Enter 0 atm for Operating Pressure.
b. Click **OK** to close the **Operating Conditions** dialog box.

*Since you have specified the boundary condition inputs for pressure in terms of absolute pressures, you have to set the operating pressure to zero. Boundary condition inputs for pressure should always be relative to the value used for operating pressure.*

### 14.4.9. Mesh Interfaces

1. Create a periodic mesh interface between the rotor and stator mesh regions.

   ![Mesh Interfaces Create/Edit...](image)

   a. Enter `int` for **Mesh Interface**.

   b. Enable **Periodic Repeats** in the **Interface Options** group box.

   *Enabling this option, allows ANSYS Fluent to treat the interface between the sliding and non-sliding zones as periodic where the two zones do not overlap.*
c. Select **rotor-interface** from the **Interface Zone 1** selection list.

**Note**

In general, when one interface zone is smaller than the other, it is recommended that you choose the smaller zone as **Interface Zone 1**. In this case, since both zones are approximately the same size, the order is not significant.

d. Select **stator-interface** from the **Interface Zone 2** selection list.

e. Click **Create** and close the **Create/Edit Mesh Interfaces** dialog box.

2. Check the mesh again to verify that the warnings displayed earlier have been resolved.

14.4.10. **Solution**

1. Set the solution parameters.

   **Solution Methods**

   a. Select **Coupled** from the **Pressure-Velocity Coupling** group box.
2. Change the Solution Controls

Solution Controls

- Enter 0.5 for Momentum and Pressure in the Explicit Relaxation Factors group box.
- Enter 0.9 for Temperature in the Under-Relaxation Factors group box.

3. Enable the plotting of residuals during the calculation.

Monitors → Residuals → Edit...
a. Ensure that the Plot is selected in the Options group box.

b. Select relative from the Convergence Criterion drop-down list.

c. Enter 0.01 for Relative Criteria for each Residual (continuity, x-velocity, y-velocity, z-velocity, and energy).

d. Click OK to close the Residual Monitors dialog box.

4. Enable the plotting of mass flow rate at the inlet (rotor-inlet).

Monitors (Surface Monitors) → Create...
a. Retain the default entry of **surf-mon-1** for **Name**.

b. Enable **Plot** and **Write**.

c. Retain the default entry of **surf-mon-1.out** for **File Name**.

d. Select **Flow Time** from the **X Axis** drop-down list.

e. Select **Time Step** from the **Get Data Every** drop-down list.

f. Select **Mass Flow Rate** from the **Report Type** drop-down list.

g. Select **rotor-inlet** from the **Surfaces** selection list.

h. Click **OK** to close the **Surface Monitor** dialog box.

5. Enable the plotting of mass flow rate at the outlet (**stator-outlet**).
a. Retain the default entry of **surf-mon-2** for **Name**.
b. Enable **Plot** and **Write**.
c. Retain the default entry of **surf-mon-2.out** for **File Name**.
d. Select **Flow Time** from the **X Axis** drop-down list.
e. Select **Time Step** from the **Get Data Every** drop-down list.
f. Select **Mass Flow Rate** from the **Report Type** drop-down list.
g. Select **stator-outlet** from the **Surfaces** selection list.
h. Click **OK** to close the **Surface Monitor** dialog box.

6. Enable the plotting of the area-weighted average of the static pressure at the interface (**stator-interface**).

≦**Monitors (Surface Monitors) → Create...**
a. Retain the default entry of `surf-mon-3` for Name.

b. Enable Plot and Write.

c. Retain the default entry of `surf-mon-3.out` for File Name.

d. Select Flow Time from the X Axis drop-down list.

e. Select Time Step from the Get Data Every drop-down list.

f. Select Area-Weighted Average from the Report Type drop-down list.

g. Retain the default selection of Pressure... and Static Pressure from the Field Variable drop-down lists.

h. Select stator-interface from the Surfaces selection list.

i. Click OK to close the Surface Monitor dialog box.

7. Initialize the solution using the values at the inlet (rotor-inlet).

Solution Initialization
a. Select rotor-inlet from the Compute from drop-down list.

b. Select Absolute in the Reference Frame list.

c. Click Initialize.

8. Save the initial case file (axial_comp.cas.gz).

   File → Write → Case...

9. Run the calculation for one revolution of the rotor.

   Run Calculation
a. Enter \[6.667 \times 10^{-6}\] s for **Time Step Size**.

The time step is set such that the passing of a single rotor blade is divided into 15 time steps. There are 16 blades on the rotor. Therefore, in each time step the rotor rotates \[\frac{360^\circ}{16} / 15 = 1.5\] degrees. With a rotational speed of 37,500 rpm (225,000 deg/sec), 1.5 degrees of rotation takes \[\frac{1.5}{2.25 \times 10^5} = 6.667 \times 10^{-6}\] sec.

b. Enter 240 for **Number of Time Steps**.

There are 16 blades on the rotor, and each rotor blade period corresponds to 15 time steps (see above). Therefore, a complete revolution of the rotor will take \[16 \times 15 = 240\] time steps.

c. Retain the default setting of 20 for **Max Iterations/Time Step**.

d. Click **Calculate**.

The calculation will run for approximately 4,200 iterations.

The residuals jump at the beginning of each time step and then fall at least two to three orders of magnitude. Also, the relative convergence criteria is achieved before reaching the maximum iteration limit (20) for each time step, indicating the limit does not need to be increased.
Figure 14.3: Residual History for the First Revolution of the Rotor

10. Examine the monitor histories for the first revolution of the rotor (Figure 14.4: Mass Flow Rate at the Inlet During the First Revolution (p. 612), Figure 14.5: Mass Flow Rate at the Outlet During the First Revolution (p. 613), and Figure 14.6: Static Pressure at the Interface During the First Revolution (p. 614)).
Figure 14.4: Mass Flow Rate at the Inlet During the First Revolution

Convergence history of Mass Flow Rate on rotor-inlet (Time=1.5000e-03)
Figure 14.5: Mass Flow Rate at the Outlet During the First Revolution

Convergence history of Mass Flow Rate on stator-outlet (Time=1.8000e-03)

ANSYS Fluent (3d, pbns, transient)
Figure 14.6: Static Pressure at the Interface During the First Revolution

The monitor histories show that the large variations in flow rate and interface pressure that occur early in the calculation are greatly reduced as time-periodicity is approached.

11. Save the case and data files (axial_comp-0240.cas.gz and axial_comp-0240.dat.gz).

File ➔ Write ➔ Case & Data...

Note

It is a good practice to save the case file whenever you are saving the data file especially for sliding mesh model. This is because the case file contains the mesh information, which is changing with time.

Note

For transient-state calculations, you can add the character string %t to the file name so that the iteration number is automatically appended to the name (for example, by entering axial_comp-%t for the File Name in the Select File dialog box, ANSYS Fluent will save files with the names axial_comp-0240.cas and axial_comp-0240.dat).
12. Rename the monitor files in preparation for further iterations.

![Monitors → surf-mon-1 → Edit...](image)

By saving the monitor histories under a new file name, the range of the axes will automatically be set to show only the data generated during the next set of iterations. This will scale the plots so that the fluctuations are more visible.

a. Enter `surf-mon-1b.out` for **File Name**.

b. Click **OK** to close the **Surface Monitor** dialog box.


14. Continue the calculation for 720 more time steps to simulate three more revolutions of the rotor.

![Run Calculation](image)
Note

Calculating three more revolutions will require some additional CPU time. If you choose, instead of calculating the solution, you can read a data file (axial_comp-0960.dat.gz) with the precalculated solution for this tutorial. This data file can be found in the sliding_mesh directory.

The calculation will run for approximately 11,600 more iterations.

15. Examine the monitor histories for the next three revolutions of the rotor to verify that the solution is time-periodic (Figure 14.7: Mass Flow Rate at the Inlet During the Next 3 Revolutions (p. 617) Figure 14.8: Mass Flow Rate at the Outlet During the Next 3 Revolutions (p. 618), and Figure 14.9: Static Pressure at the Interface During the Next 3 Revolutions (p. 619)).

Note

If you read the provided data file instead of iterating the solution for three revolutions, the monitor histories can be displayed by using the File XY Plot dialog box.

Plots → File → Set Up...
Click the **Add** button in the **File XY Plot** dialog box to select one of the monitor histories from the **Select File** dialog box, click **OK**, and then click **Plot**. To obtain a better view of the data, you may want to manually change the ranges of the axes.

**Figure 14.7: Mass Flow Rate at the Inlet During the Next 3 Revolutions**

---

**Convergence history of Mass Flow Rate on rotor-inlet (Time=6.4000e-03)**

ANSYS Fluent (3d, pbn5, transient)
**Figure 14.8: Mass Flow Rate at the Outlet During the Next 3 Revolutions**

Convergence history of Mass Flow Rate on stator-outlet (Time=6.4000e-03)

ANSYS Fluent (3d, pbns, transient)
Figure 14.9: Static Pressure at the Interface During the Next 3 Revolutions

16. Save the case and data files (`axial_comp-0960.cas.gz` and `axial_comp-0960.dat.gz`).

   **File → Write → Case & Data...**

17. Change the file names for `surf-mon-1b.out`, `surf-mon-2b.out`, and `surf-mon-3b.out` to `surf-mon-1c.out`, `surf-mon-2c.out`, and `surf-mon-3c.out`, respectively (as described in a previous step), in preparation for further iterations.

18. Add a point at the interface of the stator.

   **Surface → Point...**
a. Enter $-0.02$ for $x_0$, $-0.08$ for $y_0$, and $-0.036$ for $z_0$ in the **Point Surface** dialog box.

b. Retain the default, point-1 for **New Surface Name**.

c. Click **Create** and close the **Point Surface** dialog box.

19. Enable plotting of the static pressure at a point on the stator interface (point-1).

**Monitor (Surface Monitors) → Create...**

- a. Retain the default entry of **surf-mon-4** for **Name**.
b. Enable **Plot** and **Write**.

c. Retain the default entry of **surf-mon-4.out** for **File Name**.

d. Select **Flow Time** from the **X Axis** drop-down list.

e. Select **Time Step** from the **Get Data Every** drop-down list.

f. Select **Vertex Average** from the **Report Type** drop-down list.

g. Retain the defaults of **Pressure** and **Static Pressure** for **Field Variable**.

h. Select **point-1** from the **Surfaces** selection list.

i. Click **OK** to close the **Surface Monitor** dialog box.

20. Continue the calculation for one final revolution of the rotor, while saving data samples for the postprocessing of the time statistics.

**Run Calculation**

<table>
<thead>
<tr>
<th>Run Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Run Calculation dialog box" /></td>
</tr>
</tbody>
</table>

a. Enter **240** for **Number of Time Steps**.

b. Enable **Data Sampling for Time Statistics** in the **Options** group box.
Enabling **Data Sampling for Time Statistics** causes ANSYS Fluent to calculate and store mean and root-mean-square (RMS) values of various quantities and field functions over the calculation interval.

c. Click **Calculate**.

*The calculation will run for approximately 3,800 more iterations.*

21. Save the case and data files (*axial_comp-1200.cas.gz* and *axial_comp-1200.dat.gz*).

**File → Write → Case & Data...**

**Figure 14.10: Static Pressure at a Point on The Stator Interface During the Final Revolution**

---

14.4.11. Postprocessing

*In the next three steps you will examine the time-averaged values for the mass flow rates at the inlet and the outlet during the final revolution of the rotor. By comparing these values, you will verify the conservation of mass on a time-averaged basis for the system over the course of one revolution.*

1. Examine the time-averaged mass flow rate at the inlet during the final revolution of the rotor (as calculated from *surf-mon-1c.out*).

   **Plots → FFT → Set Up...**
a. Click the **Load Input File...** button to open the **Select File** dialog box.

i. Select **All Files** from the **files of type:** drop-down list.

ii. Select **surf-mon-1c.out** from the list of files.
iii. Click OK to close the Select File dialog box.

b. Click the **Plot/Modify Input Signal...** button to open the **Plot/Modify Input Signal** dialog box.

![Plot/Modify Input Signal dialog box](image)

i. Examine the values for **Min**, **Max**, **Mean**, and **Variance** in the **Signal Statistics** group box.

ii. Close the **Plot/Modify Input Signal** dialog box.

c. Select the directory path ending in **surf-mon-1c.out** from the **Files** selection list.

d. Click the **Free File Data** button.

2. Examine the time-averaged mass flow rate at the outlet during the final revolution of the rotor (as calculated from **surf-mon-2c.out**), and plot the data.

![Plots → FFT → Set Up...](image)

a. Click the **Load Input File...** button to open the **Select File** dialog box.

   i. Select **All Files** from the **files of type**: drop-down list.

   ii. Select **surf-mon-2c.out** from the list of files.

   iii. Click **OK** to close the **Select File** dialog box.

b. Click the **Plot/Modify Input Signal...** button to open the **Plot/Modify Input Signal** dialog box.
i. Examine the values for Min, Max, and Variance in the Signal Statistics group box.

ii. Click Set Defaults.

iii. Click Apply/Plot to display the area-weighted average of mass flow rate at the outlet (Figure 14.11: Area-Weighted Average Mass Flow Rate at the Outlet During the Final Revolution (p. 626)).
iv. Close the **Plot/Modify Input Signal** dialog box.

3. Examine the vertex-averaged static pressure at the stator during the final revolution of the rotor (as calculated from `surf-mon-4.out`), and plot the data.

   ![FFT Set Up...](image)

   - Click the **Load Input File...** button to open the **Select File** dialog box.
     - Select **All Files** from the **Files of type:** drop-down list.
     - Select `surf-mon-4.out` from the list of files.
     - Click **OK** to close the **Select File** dialog box.

   b. Click the **Plot/Modify Input Signal...** button to open the **Plot/Modify Input Signal** dialog box.
i. Enable **Subtract Mean Value** in the **Options** group box.

ii. Click **Apply/Plot**.

iii. Close the **Plot/Modify Input Signal** dialog box.

c. Click **Plot FFT** in the **Fourier Transform** dialog box.

d. Click **Axes...** to open the **Axes - Fourier Transform** dialog box.
Using Sliding Meshes

e. Select **exponential** from the **Type** drop-down list, and set **Precision** to 1 in the **Number Format** group box.

f. Click **Apply** and close the **Axes - Fourier Transform** dialog box.

g. Click **Plot FFT** and close the **Fourier Transform** dialog box.

**Figure 14.12: FFT of Static Pressure at the Stator**
The FFT plot clearly shows that the pressure fluctuations due to interaction at the interface are dominated by the rotor and stator blade passing frequencies (which are 10 kHz and 20 kHz, respectively) and their higher harmonics.

4. Display contours of the mean static pressure on the walls of the axial compressor.

**Graphics and Animations → Contours → Set Up...**

![Contours dialog box](image)

a. Enable **Filled** in the **Options** group box.

b. Select **Unsteady Statistics...** and **Mean Static Pressure** from the **Contours of** drop-down lists.

c. Select **wall** from the **Surface Types** selection list.

   *Scroll down the **Surface Types** selection list to find **wall**.*

d. Click **Display** and close the **Contours** dialog box.

e. Rotate the view to get the display as shown in Figure 14.13: Mean Static Pressure on the Outer Shroud of the Axial Compressor (p. 630).

*Shock waves are clearly visible in the flow near the outlets of the rotor and stator, as seen in the areas of rapid pressure change on the outer shroud of the axial compressor.*
### Figure 14.13: Mean Static Pressure on the Outer Shroud of the Axial Compressor

![Contour plot of mean static pressure on the outer shroud](image)

**Contours of Mean Static Pressure (atm) (Time=8.0000e-03)**

### 14.5. Summary

This tutorial has demonstrated the use of the sliding mesh model for analyzing transient rotor-stator interaction in an axial compressor stage. The model utilized the coupled pressure-based solver in conjunction with the transient algorithm to compute the inviscid flow through the compressor stage. The solution was calculated over time until the monitored variables displayed time-periodicity (which required several revolutions of the rotor), after which time-averaged data was collected while running the case for the equivalent of one additional rotor revolution (240 time steps).

The Fast Fourier Transform (FFT) utility in ANSYS Fluent was employed to determine the time averages from stored monitor data. You also used the FFT utility to examine the frequency content of the transient monitor data. The observed peak corresponds to the passing frequency and the higher harmonics of the passing frequency, which occurred at approximately 10,000 Hz.

### 14.6. Further Improvements

This tutorial guides you through the steps to reach a second-order solution. You may be able to obtain a more accurate solution by adapting the mesh. Adapting the mesh can also ensure that your solution is independent of the mesh. These steps are demonstrated in *Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow* (p. 123).
Chapter 15: Using Dynamic Meshes

This tutorial is divided into the following sections:

15.1. Introduction
15.2. Prerequisites
15.3. Problem Description
15.4. Setup and Solution
15.5. Summary
15.6. Further Improvements

15.1. Introduction

In ANSYS Fluent the dynamic mesh capability is used to simulate problems with boundary motion, such as check valves and store separations. The building blocks for dynamic mesh capabilities within ANSYS Fluent are three dynamic mesh schemes, namely, smoothing, layering, and remeshing. A combination of these three schemes is used to tackle the most challenging dynamic mesh problems. However, for simple dynamic mesh problems involving linear boundary motion, the layering scheme is often sufficient. For example, flow around a check valve can be simulated using only the layering scheme. In this tutorial, such a case will be used to demonstrate the layering feature of the dynamic mesh capability in ANSYS Fluent.

Check valves are commonly used to allow unidirectional flow. For instance, they are often used to act as a pressure-relieving device by only allowing fluid to leave the domain when the pressure is higher than a certain level. In such a case, the check valve is connected to a spring that acts to push the valve to the valve seat and to shut the flow. But when the pressure force on the valve is greater than the spring force, the valve will move away from the valve seat and allow fluid to leave, thus reducing the pressure upstream. Gravity could be another factor in the force balance, and can be considered in ANSYS Fluent. The deformation of the valve is typically neglected, thus allowing for a rigid body Fluid Structure Interaction (FSI) calculation, for which a user-defined function (UDF) is provided.

This tutorial provides information for performing basic dynamic mesh calculations by demonstrating how to do the following:

- Use the dynamic mesh capability of ANSYS Fluent to solve a simple flow-driven rigid-body motion problem.
- Set boundary conditions for internal flow.
- Compile a User-Defined Function (UDF) to specify flow-driven rigid-body motion.
- Calculate a solution using the pressure-based solver.

15.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

- Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.

15.3. Problem Description

The check valve problem to be considered is shown schematically in Figure 15.1: Problem Specification (p. 632). A 2D axisymmetric valve geometry is used, consisting of a mass flow inlet on the left, and a pressure outlet on the right, driving the motion of a valve. In this case, the transient motion of the valve due to spring force, gravity, and hydrodynamic force is studied. Note, however, that the valve in this case is not completely closed. Since dynamic mesh problems require that at least one layer remains in order to maintain the topology, a small gap will be created between the valve and the valve seat.

Figure 15.1: Problem Specification

15.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

15.4.1. Preparation
15.4.2. Mesh
15.4.3. General Settings
15.4.4. Models
15.4.5. Materials
15.4.6. Boundary Conditions
15.4.7. Solution: Steady Flow
15.4.8. Time-Dependent Solution Setup
15.4.9. Mesh Motion
15.4.10. Time-Dependent Solution
15.4.11. Postprocessing

15.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.


---

**Note**

If you do not have a login, you can request one by clicking **Customer Registration** on the login page.
3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   a. Click **ANSYS Fluent** under **Product**.
   b. Click **15.0** under **Version**.

5. Select this tutorial from the list.

6. Click **Files** to download the input and solution files.

7. Unzip **dynamic_mesh_R150.zip** to your working folder.

   *The mesh and source files* **valve.msh** *and* **valve.c** *can be found in the* **dynamic_mesh** *directory created after unzipping the file.*

   *A user-defined function will be used to define the rigid-body motion of the valve geometry. This function has already been written (valve.c). You will only need to compile it within ANSYS Fluent.*

8. Use the Fluent Launcher to start the **2D** version of ANSYS Fluent.

   Fluent Launcher displays your **Display Options** preferences from the previous session.

   Note that this tutorial has been generated using single precision, so you should ensure that **Double Precision** is disabled if you want to match the tutorial setup exactly.

   For more information about Fluent Launcher, see **Starting ANSYS Fluent Using Fluent Launcher** in the User’s Guide.

9. Ensure that the **Display Mesh After Reading**, **Embed Graphics Windows**, and **Workbench Color Scheme** options are enabled.

10. Run in **Serial** under **Processing Options**.

### 15.4.2. Mesh

1. Read the mesh file **valve.msh**.

   ![File → Read → Mesh](image)

### 15.4.3. General Settings

1. Check the mesh.

   ![General → Check](image)

   **Note**

   You should always make sure that the cell minimum volume is not negative, since ANSYS Fluent cannot begin a calculation if this is the case.
2. Change the display units for length to mm.

   - **General → Units...**
     a. In the *Set Units* dialog box select *length* under *Quantities* and *mm* under *Units*.
     b. Close the *Set Units* dialog box.

3. Display the mesh (Figure 15.2: Initial Mesh for the Valve (p. 635)).

   - **General → Display...**
     
     ![Mesh Display](image)

     a. Deselect *axis-inlet*, *axis-move*, *inlet*, and *outlet* from the *Surfaces* selection list.
     b. Click *Display*.
c. Close the **Mesh Display** dialog box.

4. Enable an axisymmetric steady-state calculation.

![Figure 15.2: Initial Mesh for the Valve](image-url)

**Mesh Display (2d, pbns, lam)**
a. Select **Axisymmetric** from the **2D Space** list.

### 15.4.4. Models

**Models**

1. Enable the standard \( k-\varepsilon \) turbulence model.
a. Select k-epsilon (2 eqn) from the Model list and retain the default selection of Standard in the k-epsilon Model group box.

b. Select Enhanced Wall Treatment for the Near-Wall Treatment.

c. Click OK to close the Viscous Model dialog box.

15.4.5. Materials

Materials
1. Apply the ideal gas law for the incoming air stream.

   Materials → Fluid → Create/Edit...
a. Select **ideal-gas** from the **Density** drop-down list.

b. Click **Change/Create**.

c. Close the **Create/Edit Materials** dialog box.

### 15.4.6. Boundary Conditions

*Dynamic mesh motion and all related parameters are specified using the items in the **Dynamic Mesh** task page, not through the **Boundary Conditions** task page. You will set these conditions in a later step.*

1. Set the conditions for the mass flow inlet (**inlet**).

   ![Boundary Conditions → inlet](image)

   *Since the inlet boundary is assigned to a wall boundary type in the original mesh, you will need to explicitly assign the inlet boundary to a mass flow inlet boundary type in ANSYS Fluent.*
a. Select **mass-flow-inlet** from the **Type** drop-down list in the **Boundary Conditions** task page.

b. Click **Yes** when ANSYS Fluent asks you if you want to change the zone type.

*The Mass-Flow Inlet boundary condition dialog box will open.*
i. Enter 0.0116 kg/s for **Mass Flow Rate**.

ii. Select **Normal to Boundary** from the **Direction Specification Method** drop-down list.

iii. Select **Intensity and Hydraulic Diameter** from the **Specification Method** drop-down list in the **Turbulence** group box.

iv. Retain 5% for **Turbulent Intensity**.

v. Enter 20 mm for the **Hydraulic Diameter**.

vi. Click **OK** to close the **Mass-Flow Inlet** dialog box.

2. Set the conditions for the exit boundary (**outlet**).
Since the outlet boundary is assigned to a wall boundary type in the original mesh, you will need to explicitly assign the outlet boundary to a pressure outlet boundary type in ANSYS Fluent.

a. Select pressure-outlet from the Type drop-down list in the Boundary Conditions task page.

b. Click Yes when ANSYS Fluent asks you if you want to change the zone type.

The Pressure Outlet boundary condition dialog box will open.
i. Select From Neighboring Cell from the Backflow Direction Specification Method drop-down list.

ii. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the Turbulence group box.

iii. Retain 5% for Backflow Turbulent Intensity.

iv. Enter 50 mm for Backflow Hydraulic Diameter.

v. Click OK to close the Pressure Outlet dialog box.

3. Set the boundary type to axis for both the axis-inlet and the axis-move boundaries.

**Boundary Conditions**

*Since the axis-inlet and the axis-move boundaries are assigned to a wall boundary type in the original mesh, you will need to explicitly assign these boundaries to an axis boundary type in ANSYS Fluent.*

a. Select axis-inlet from the Zone list and select axis from the Type list.

b. Click Yes when ANSYS Fluent asks you if you want to change the zone type.

c. Retain the default Zone Name in the Axis dialog box and click OK to close the Axis dialog box.

d. Select axis-move from the Zone list and select axis from the Type list.

e. Click Yes when ANSYS Fluent asks you if you want to change the zone type.

f. Retain the default Zone Name in the Axis dialog box and click OK to close the Axis dialog box.
15.4.7. Solution: Steady Flow

In this step, you will generate a steady-state flow solution that will be used as an initial condition for the time-dependent solution.

1. Set the solution parameters.

   ![Solution Methods](image)

   - Select **Coupled** from the **Scheme** drop-down list.
   - Select **PRESTO!** from the **Pressure** drop-down list.
   - Retain the default of **Second Order Upwind** in the **Density** drop-down list.
   - Retain the default of **Second Order Upwind** in the **Momentum** drop-down list.
   - Retain the defaults of **First Order Upwind** in the **Turbulent Kinetic Energy** and **Turbulent Dissipation Rate** drop-down lists.
   - Retain the default of **Second Order Upwind** in the **Energy** drop-down list.

2. Set the relaxation factors.
### Solution Controls

<table>
<thead>
<tr>
<th>Flow Courant Number</th>
<th>200</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explicit Relaxation Factors</td>
<td></td>
</tr>
<tr>
<td>Momentum</td>
<td>0.75</td>
</tr>
<tr>
<td>Pressure</td>
<td>0.75</td>
</tr>
<tr>
<td>Density</td>
<td>1</td>
</tr>
<tr>
<td>Body Forces</td>
<td>1</td>
</tr>
<tr>
<td>Turbulent Kinetic Energy</td>
<td>0.8</td>
</tr>
<tr>
<td>Turbulent Dissipation Rate</td>
<td>0.8</td>
</tr>
<tr>
<td>Turbulent Viscosity</td>
<td>1</td>
</tr>
</tbody>
</table>

3. Enable the plotting of residuals during the calculation.

- Retain the default values for **Under-Relaxation Factors** in the **Solution Controls** task page.
- Enable the plotting of residuals during the calculation.
a. Ensure that **Plot** is enabled in the **Options** group box.

b. Click **OK** to close the **Residual Monitors** dialog box.

4. Initialize the solution.

**Solution Initialization**

a. Retain the default **Hybrid Initialization** in the **Initialization Methods** group box.

b. Click **Initialize** in the **Solution Initialization** task page.

---

**Note**

A warning is displayed in the console stating that the convergence tolerance of 1.000000e-06 not reached during Hybrid Initialization. This means that the default number of iterations is not enough. You will increase the number of iterations and
re-initialize the flow. For more information refer to Hybrid Initialization in the User’s Guide.

c. Click More Settings....

![Hybrid Initialization dialog box]

i. Increase the **Number of Iterations** to 20.

ii. Click **OK** to close the Hybrid Initialization dialog box.

d. Click **Initialize** once more.

---

**Note**

Click **OK** in the **Question** dialog box, where it asks to discard the current data. The console displays that hybrid initialization is done.

---

**Note**

For flows in complex topologies, hybrid initialization will provide better initial velocity and pressure fields than standard initialization. This will help to improve the convergence behavior of the solver.

---

5. Save the case file *(valve_init.cas.gz)*.

   **File** → **Write** → **Case...**
6. Start the calculation by requesting 150 iterations.

![Run Calculation](image)

Click **Calculate**.

The solution converges in approximately 115 iterations.

7. Save the case and data files (*valve_init.cas.gz* and *valve_init.dat.gz*).

File ➔ Write ➔ Case & Data...

**15.4.8. Time-Dependent Solution Setup**

1. Enable a time-dependent calculation.
a. Select **Transient** from the **Time** list in the **General** task page.

### 15.4.9. Mesh Motion

1. Select and compile the user-defined function (UDF).

   **Define → User-Defined → Functions → Compiled...**

   a. Click **Add...** in the **Source Files** group box.

      **The Select File** dialog box will open.

      i. Select the source code **valve.c** in the **Select File** dialog box, and click **OK**.

   b. Click **Build** in the **Compiled UDFs** dialog box.
The UDF is already defined, but it must be compiled within ANSYS Fluent before it can be used in the solver. Here you will create a library with the default name of libudf in your working folder. If you want to use a different name, you can enter it in the **Library Name** field. In this case you need to make sure that you will open the correct library in the next step.

A dialog box will appear warning you to make sure that the UDF source files are in the directory that contains your case and data files. Click **OK** in the warning dialog box.

c. Click **Load** to load the UDF library you just compiled.

When the UDF is built and loaded, it is available to hook to your model. Its name will appear as **valve::libudf** and can be selected from drop-down lists of various dialog boxes.

2. Hook your model to the UDF library.

    **Define → User-Defined → Function Hooks...**

![User-Defined Function Hooks](image_url)

a. Click the **Edit...** button next to **Read Data** to open the **Read Data Functions** dialog box.

   i. Select **reader::libudf** from the **Available Read Data Functions** selection list.

   ii. Click **Add** to add the selected function to the **Selected Read Data Functions** selection list.

   iii. Click **OK** to close the **Read Data Functions** dialog box.

b. Click the **Edit...** button next to **Write Data** to open the **Write Data Functions** dialog box.

   i. Select **writer::libudf** from the **Available Write Data Functions** selection list.

   ii. Click **Add** to add the selected function to the **Selected Write Data Functions** selection list.

   iii. Click **OK** to close the **Write Data Functions** dialog box.
These two functions will read/write the position of the center of gravity (CG) and velocity in the X direction to the data file. The location of the CG and the velocity are necessary for restarting a case. When starting from an intermediate case and data file, ANSYS Fluent needs to know the location of the CG and velocity, which are the initial conditions for the motion calculation. Those values are saved in the data file using the writer UDF and will be read in using the reader UDF when reading the data file.

c. Click OK to close the User-Defined Function Hooks dialog box.

3. Enable dynamic mesh motion and specify the associated parameters.

 Dynamic Mesh

a. Enable Dynamic Mesh in the Dynamic Mesh task page.

For more information on the available models for moving and deforming zones, see Modeling Flows Using Sliding and Dynamic Meshes in the User’s Guide.

b. Disable Smoothing and enable Layering in the Mesh Methods group box.

ANSYS Fluent will automatically flag the existing mesh zones for use of the different dynamic mesh methods where applicable.
c. Click the Settings... button to open the Mesh Method Settings dialog box.

![Mesh Method Settings dialog box]

i. Click the Layering tab.

ii. Select Ratio Based in the Options group box.

iii. Retain the default settings of 0.4 and 0.2 for Split Factor and Collapse Factor, respectively.

iv. Click OK to close the Mesh Method Settings dialog box.

4. Specify the motion of the fluid region (fluid-move).

   Dynamic Mesh → Create/Edit...

   *The valve motion and the motion of the fluid region are specified by means of the UDF valve.*
a. Select **fluid-move** from the **Zone Names** drop-down list.

b. Retain the default selection of **Rigid Body** in the **Type** group box.

c. Ensure that **valve::libudf** is selected from the **Motion UDF/Profile** drop-down list in the **Motion Attributes** tab to hook the UDF to your model.

d. Retain the default settings of \((0, 0)\) mm for **Center of Gravity Location**, and \(0\) for **Center of Gravity Orientation**.

   *Specifying the CG location and orientation is not necessary in this case, because the valve motion and the initial CG position of the valve are already defined by the UDF.*

e. Click **Create**.

5. Specify the meshing options for the stationary layering interface (**int-layering**) in the **Dynamic Mesh Zones** dialog box.
a. Select **int-layering** from the **Zone Names** drop-down list.

b. Select **Stationary** in the **Type** group box.

c. Click the **Meshing Options** tab.
   
   i. Enter **0.5 mm** for **Cell Height** of the fluid-move **Adjacent Zone**.
   
   ii. Retain the default value of **0 mm** for the **Cell Height** of the fluid-inlet **Adjacent zone**.

d. Click **Create**.

6. Specify the meshing options for the stationary outlet (**outlet**) in the **Dynamic Mesh Zones** dialog box.

   a. Select **outlet** from the **Zone Names** drop-down list.

   b. Retain the previous selection of **Stationary** in the **Type** group box.

   c. Click the **Meshing Options** tab and enter **1.9 mm** for the **Cell Height** of the fluid-move **Adjacent Zone**.

   d. Click **Create**.

7. Specify the meshing options for the stationary seat valve (**seat-valve**) in the **Dynamic Mesh Zones** dialog box.

   a. Select **seat-valve** from the **Zone Names** drop-down list.
b. Retain the previous selection of **Stationary** in the **Type** group box.

c. Click the **Meshing Options** tab and enter 0.5 mm for **Cell Height** of the fluid-move **Adjacent Zone**.

d. Click **Create**.

8. Specify the motion of the valve (**valve**) in the **Dynamic Mesh Zones** dialog box.

   a. Select **valve** from the **Zone Names** drop-down list.

   b. Select **Rigid Body** in the **Type** group box.

   c. Click the **Motion Attributes** tab.

      i. Ensure that **valve::libudf** is selected from the **Motion UDF/Profile** drop-down list to hook the UDF to your model.

      ii. Retain the default settings of (0, 0) mm for **Center of Gravity Location**, and 0 for **Center of Gravity Orientation**.

   d. Click the **Meshing Options** tab and enter 0 mm for the **Cell Height** of the fluid-move **Adjacent zone**.

   e. Click **Create** and close the **Dynamic Mesh Zones** dialog box.

In many MDM problems, you may want to preview the mesh motion before proceeding. In this problem, the mesh motion is driven by the pressure exerted by the fluid on the valve and acting against the inertia of the valve. Hence, for this problem, mesh motion in the absence of a flow field solution is meaningless, and you will not use this feature here.

### 15.4.10. Time-Dependent Solution

1. Set the solution parameters.

   ◦ **Solution Methods**
a. Select PISO from the Scheme drop-down list in Pressure-Velocity Coupling group box.

b. Enter 0 for Skewness Correction.

c. Retain all of the other previously set schemes and defaults.

2. Set the relaxation factors.

Solution Controls
a. Enter 0.6 for **Pressure** in the **Under-Relaxation Factors** group box.

b. Enter 0.4 for **Turbulent Kinetic Energy**.

c. Enter 0.4 for **Turbulent Dissipation Rate**.

3. Request that case and data files are automatically saved every 50 time steps.

- **Calculation Activities (Autosave Every (Time Steps)) → Edit...**
Using Dynamic Meshes

4. Create animation sequences for the static pressure contour plots and velocity vectors plots for the valve.

**Calculation Activities (Solution Animations) → Create/Edit...**

*Use the solution animation feature to save contour plots of temperature every five time steps. After the calculation is complete, you use the solution animation playback feature to view the animated temperature plots over time.*
a. Set **Animation Sequences** to 2.

b. Enter pressure in the **Name** text box for the first animation.

c. Enter vv in the **Name** text box for the second animation.

d. Set **Every** to 5 for both animation sequences.

   The default value of 1 instructs ANSYS Fluent to update the animation sequence at every time step. For this case, this would generate a large number of files.

e. Select **Time Step** from the **When** drop-down list for pressure and vv.

f. Click the **Define...** button next to pressure to open the **Animation Sequence** dialog box.
i. Retain the default selection of **Metafile** in the **Storage Type** group box.

**Note**

If you want to store the plots in a folder other than your working folder, enter the folder path in the **Storage Directory** text box. If this field is left blank (the default), the files will be saved in your working folder (that is, the folder where you started ANSYS Fluent).

ii. Set **Window** number to 1 and click **Set**.

iii. Select **Contours** in the **Display Type** group box to open the **Contours** dialog box.

   ![Contours Dialog Box](image)

   A. Enable **Filled** in the **Options** group box.
   
   B. Retain the default selection of **Pressure...** and **Static Pressure** from the **Contours of** drop-down lists.
   
   C. Click **Display** (Figure 15.3: Contours of Static Pressure at t=0 s (p. 661)).
   
   D. Close the **Contours** dialog box.
Figure 15.3: Contours of Static Pressure at t=0 s

iv. Click OK in the Animation Sequence dialog box.

The Animation Sequence dialog box will close, and the check box in the Active column next to pressure in the Solution Animation dialog box will be enabled.

g. Click the Define... button next to \( \mathbf{v} \mathbf{v} \) to open the Animation Sequence dialog box.

i. Retain the default selection of Metafile in the Storage Type group box.

ii. Set Window to 2 and click Set.

iii. Select Vectors in the Display Type group box to open the Vectors dialog box.
A. Retain all the other default settings.

B. Click **Display** (Figure 15.4: Vectors of Velocity at t=0 s (p. 663)).

C. Close the **Vectors** dialog box.
iv. Click **OK** in the **Animation Sequence** dialog box.

The **Animation Sequence** dialog box will close, and the check box in the **Active** column next to **vv** in the **Solution Animation** dialog box will be enabled.

h. Click **OK** to close the **Solution Animation** dialog box.

5. Set the time step parameters for the calculation.

Run Calculation
a. Enter 0.0001 s for **Time Step Size**.

b. Retain 20 for **Max Iterations/Time Step**.

_In the accurate solution of a real-life time-dependent CFD problem, it is important to make sure that the solution converges at every time step to within the desired accuracy. Here the first few time steps will only come to a reasonably converged solution._

6. Save the initial case and data files for this transient problem (valve_tran-0.000000.cas.gz and valve_tran-0.000000.dat.gz).

   **File → Write → Case & Data...**

7. Request 150 time steps and calculate a solution.

---

**Extra**

If you decide to read in the case file that is provided for this tutorial on the Customer Portal, you will need to compile the UDF associated with this tutorial in your working folder. This is necessary because ANSYS Fluent will expect to find the correct UDF libraries in your working folder when reading the case file.
The UDF (valve.c) that is provided can be edited and customized by changing the parameters as required for your case. In this tutorial, the values necessary for this case were preset in the source code. These values may be modified to best suit your model.

15.4.11. Postprocessing

1. Inspect the solution at the final time step.

   a. Inspect the contours of static pressure in the valve (Figure 15.5: Contours of Static Pressure After 150 Time Steps (p. 666)).

   ![Graphics and Animations → Contours → Set Up...](image)

Note

You may need to switch to Window 1 (using the drop-down list at the upper left corner of the graphics window) to view the contour plot.
Figure 15.5: Contours of Static Pressure After 150 Time Steps

b. Inspect the velocity vectors near the point where the valve meets the seat valve (Figure 15.6: Velocity Vectors After 150 Time Steps (p. 667)).

Graphics and Animations → Vectors → Set Up...
2. Play the animation of the pressure contours.
   
a. Graphics and Animations → Solution Animation Playback → Set Up...
b. Select pressure from the Sequences list in the Animation Sequences box of the Playback dialog box.

*If the Sequences list is empty, click Read... to select the pressure.cxa sequence file from your working directory.*

The playback control buttons will become active.

c. Set the slider bar above Replay Speed about halfway in between Slow and Fast.

d. Retain the default settings in the rest of the dialog box and click the button.

*You may have to change the Viewer window to see the animation. In the drop-down menu at the top of the Viewer, set the window number to 1, which corresponds to the Window number for pressure that you set in the Animation Sequence dialog box.*

3. Play the animation of the velocity vectors.

a. Select vv from the Sequences list in the Animation Sequences box of the Playback dialog box.

*If the Sequences list does not contain vv, click Read... to select the vv.cxa sequence file from your working directory.*

b. Retain the default settings in the rest of the dialog box and click the button.

*You may have to change the Viewer window to see the animation. In the drop-down menu at the top of the Viewer, set the window number to 2, which corresponds to the Window number for vv that you set in the Animation Sequence dialog box.*

For additional information on animating the solution, see Modeling Transient Compressible Flow (p. 257) and see Animating the Solution of the User’s Guide.

c. Close the Playback dialog box.
4. You can also inspect the solution at different intermediate time steps.
   a. Read the corresponding case and data files (for example, valve_tran-1-0.010000.cas.gz and valve_tran-1-0.010000.dat.gz).

   File → Read → Case & Data...

   b. Display the desired contours and vectors.

15.5. Summary

In this tutorial, a check valve is used to demonstrate the dynamic layering capability within ANSYS Fluent, using one of the three dynamic mesh schemes available. You were also shown how to perform a one degree of freedom (1DoF) rigid body FSI by means of a user-defined function (UDF). ANSYS Fluent can also perform a more general six degrees of freedom (6DoF) rigid body FSI using a built-in 6DoF solver.

If you decide to run this tutorial in parallel, make sure you use Principal Axes as the partitioning method.

15.6. Further Improvements

This tutorial guides you through the steps to generate an initial first-order solution. You may be able to increase the accuracy of the solution further by using an appropriate higher-order discretization scheme. For a more accurate solution, you can increase the number of layers across the valve seat area. This can be achieved either by using a finer mesh at the valve seat area and/or using a non-constant layer height instead of a constant layer height, as demonstrated in this tutorial.
Chapter 16: Modeling Species Transport and Gaseous Combustion

This tutorial is divided into the following sections:

16.1. Introduction
16.2. Prerequisites
16.3. Problem Description
16.4. Background
16.5. Setup and Solution
16.6. Summary
16.7. Further Improvements

16.1. Introduction

This tutorial examines the mixing of chemical species and the combustion of a gaseous fuel.

A cylindrical combustor burning methane ($\text{CH}_4$) in air is studied using the eddy-dissipation model in ANSYS Fluent.

This tutorial demonstrates how to do the following:

- Enable physical models, select material properties, and define boundary conditions for a turbulent flow with chemical species mixing and reaction.
- Initiate and solve the combustion simulation using the pressure-based solver.
- Examine the reacting flow results using graphics.
- Predict thermal and prompt NOx production.
- Use custom field functions to compute NO parts per million.

16.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

- Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
- Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
- Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.
To learn more about chemical reaction modeling, see Modeling Species Transport and Finite-Rate Chemistry in the User's Guide and Species Transport and Finite-Rate Chemistry in the Theory Guide. Otherwise, no previous experience with chemical reaction or combustion modeling is assumed.

16.3. Problem Description

The cylindrical combustor considered in this tutorial is shown in Figure 16.1: Combustion of Methane Gas in a Turbulent Diffusion Flame Furnace (p. 672). The flame considered is a turbulent diffusion flame. A small nozzle in the center of the combustor introduces methane at $80 \text{ m/s}$. Ambient air enters the combustor coaxially at $0.5 \text{ m/s}$. The overall equivalence ratio is approximately 0.76 (approximately 28% excess air). The high-speed methane jet initially expands with little interference from the outer wall, and entrains and mixes with the low-speed air. The Reynolds number based on the methane jet diameter is approximately $5.7 \times 10^3$.

![Figure 16.1: Combustion of Methane Gas in a Turbulent Diffusion Flame Furnace](image)

16.4. Background

In this tutorial, you will use the generalized eddy-dissipation model to analyze the methane-air combustion system. The combustion will be modeled using a global one-step reaction mechanism, assuming complete conversion of the fuel to $\text{CO}_2$ and $\text{H}_2\text{O}$. The reaction equation is

$$\text{CH}_4 + 2\text{O}_2 \rightarrow \text{CO}_2 + 2\text{H}_2\text{O}$$

This reaction will be defined in terms of stoichiometric coefficients, formation enthalpies, and parameters that control the reaction rate. The reaction rate will be determined assuming that turbulent mixing is the rate-limiting process, with the turbulence-chemistry interaction modeled using the eddy-dissipation model.

16.5. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

16.5.1. Preparation
16.5.2. Mesh
16.5.3. General Settings
16.5.4. Models
16.5.5. Materials
16.5.6. Boundary Conditions
16.5.7. Initial Reaction Solution
16.5.8. Postprocessing
16.5.9. NOx Prediction
16.5.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.


   **Note**
   
   If you do not have a login, you can request one by clicking *Customer Registration* on the login page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   
   a. Click *ANSYS Fluent* under *Product*.
   
   b. Click *15.0* under *Version*.

5. Select this tutorial from the list.

6. Click *Files* to download the input and solution files.

7. Unzip *species_transport_R150.zip* to your working folder.

   *The file* gascomb.msh *can be found in the species_transport folder created after unzipping the file.*

8. Use Fluent Launcher to start the **2D** version of ANSYS Fluent.

   Fluent Launcher displays your *Display Options* preferences from the previous session.

   *For more information about Fluent Launcher, see *Starting ANSYS Fluent Using Fluent Launcher in the Fluent Getting Started Guide.*

9. Ensure that the *Display Mesh After Reading*, *Embed Graphics Windows*, and *Workbench Color Scheme* options are enabled.

10. Enable *Double-Precision*.

11. Ensure *Serial* is selected under *Processing Options*.

16.5.2. Mesh

1. Read the mesh file gascomb.msh.

   **File → Read → Mesh...**

   *After reading the mesh file, ANSYS Fluent will report that 1615 quadrilateral fluid cells have been read, along with a number of boundary faces with different zone identifiers.*
16.5.3. General Settings

1. Check the mesh.

   ![General → Check]

   ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure that the reported minimum volume reported is a positive number.

   **Note**

   ANSYS Fluent will issue a warning concerning the high aspect ratios of some cells and possible impacts on calculation of Cell Wall Distance. The warning message includes recommendations for verifying and correcting the Cell Wall Distance calculation. In this particular case the cell aspect ratio does not cause problems so no further action is required. As an optional activity, you can confirm this yourself after the solution is generated by plotting Cell Wall Distance as noted in the warning message.

2. Scale the mesh.

   ![General → Scale...]

   Since this mesh was created in units of millimeters, you will need to scale the mesh into meters.

   ![Scale Mesh]

   a. Select **mm** from the Mesh Was Created In drop-down list in the Scaling group box.
   b. Click **Scale**.
   c. Ensure that **m** is selected from the View Length Unit In drop-down list.
   d. Ensure that **Xmax** and **Ymax** are set to 1.8 m and 0.225 m respectively.
The default SI units will be used in this tutorial, hence there is no need to change any units in this problem.

e. Close the Scale Mesh dialog box.

3. Check the mesh.

**General → Check**

**Note**

You should check the mesh after you manipulate it (scale, convert to polyhedra, merge, separate, fuse, add zones, or smooth and swap). This will ensure that the quality of the mesh has not been compromised.

4. Examine the mesh with the default settings.
Figure 16.2: The Quadrilateral Mesh for the Combustor Model

Extra

You can use the right mouse button to probe for mesh information in the graphics window. If you click the right mouse button on any node in the mesh, information will be displayed in the ANSYS Fluent console about the associated zone, including the name of the zone. This feature is especially useful when you have several zones of the same type and you want to distinguish between them quickly.

5. Select **Axisymmetric** in the 2D Space list.

General
16.5.4. Models

1. Enable heat transfer by enabling the energy equation.

   ![Models → Energy → Edit...]

2. Select the standard $k-\varepsilon$ turbulence model.

   ![Models → Viscous → Edit...]
a. Select **k-epsilon** in the **Model** list.

   The *Viscous Model* dialog box will expand to provide further options for the **k-epsilon** model.

b. Retain the default settings for the **k-epsilon** model.

c. Click **OK** to close the **Viscous Model** dialog box.

3. Enable chemical species transport and reaction.

   **Models → Species → Edit...**
a. Select **Species Transport** in the **Model** list.

   The **Species Model** dialog box will expand to provide further options for the **Species Transport** model.

b. Enable **Volumetric** in the **Reactions** group box.

c. Select **methane-air** from the **Mixture Material** drop-down list.

   **Scroll down the list to find methane-air.**

   **Note**

   The **Mixture Material** list contains the set of chemical mixtures that exist in the ANSYS Fluent database. You can select one of the predefined mixtures to access a complete description of the reacting system. The chemical species in the system and their physical and thermodynamic properties are defined by your selection of the mixture material. You can alter the mixture material selection or modify the mixture material properties using the **Create/Edit Materials** dialog box (see Materials (p. 680)).

d. Select **Eddy-Dissipation** in the **Turbulence-Chemistry Interaction** group box.

   The eddy-dissipation model computes the rate of reaction under the assumption that chemical kinetics are fast compared to the rate at which reactants are mixed by turbulent fluctuations (eddies).

e. Click **OK** to close the **Species Model** dialog box.

   An **Information** dialog box will open, reminding you to confirm the property values before continuing. Click **OK** to continue.
Prior to listing the properties that are required for the models you have enabled, ANSYS Fluent will display a warning about the symmetry zone in the console. You may have to scroll up to see this warning.

Warning: It appears that symmetry zone 5 should actually be an axis (it has faces with zero area projections). Unless you change the zone type from symmetry to axis, you may not be able to continue the solution without encountering floating point errors.

In the axisymmetric model, the boundary conditions should be such that the centerline is an axis type instead of a symmetry type. You will change the symmetry zone to an axis boundary in Boundary Conditions (p. 683).

16.5.5. Materials

In this step, you will examine the default settings for the mixture material. This tutorial uses mixture properties copied from the Fluent Database. In general, you can modify these or create your own mixture properties for your specific problem as necessary.

1. Confirm the properties for the mixture materials.

Material → Mixture → Create/Edit...

The Create/Edit Materials dialog box will display the mixture material (methane-air) that was selected in the Species Model dialog box. The properties for this mixture material have been copied from the Fluent Database... and will be modified in the following steps.
a. Click the **Edit...** button to the right of the **Mixture Species** drop-down list to open the **Species** dialog box.

You can add or remove species from the mixture material as necessary using the **Species** dialog box.

i. Retain the default selections from the **Selected Species** selection list.
The species that make up the methane-air mixture are predefined and require no modification.

ii. Click **OK** to close the **Species** dialog box.

b. Click the **Edit...** button to the right of the **Reaction** drop-down list to open the **Reactions** dialog box.

```
Reactions
dialog box.
```

![Reactions dialog box](image)

The eddy-dissipation reaction model ignores chemical kinetics (the Arrhenius rate) and uses only the parameters in the **Mixing Rate** group box in the **Reactions** dialog box. The **Arrhenius Rate** group box will therefore be inactive. The values for **Rate Exponent** and **Arrhenius Rate** parameters are included in the database and are employed when the alternate finite-rate/eddy-dissipation model is used.

i. Retain the default values in the **Mixing Rate** group box.

ii. Click **OK** to close the **Reactions** dialog box.

c. Retain the selection of **incompressible-ideal-gas** from the **Density** drop-down list.

d. Retain the selection of **mixing-law** from the **Cp (Specific Heat)** drop-down list.
e. Retain the default values for **Thermal Conductivity**, **Viscosity**, and **Mass Diffusivity**.

![Create/Edit Materials dialog box]

f. Click **Change/Create** to accept the material property settings.

g. Close the **Create/Edit Materials** dialog box.

*The calculation will be performed assuming that all properties except density and specific heat are constant. The use of constant transport properties (viscosity, thermal conductivity, and mass diffusivity coefficients) is acceptable because the flow is fully turbulent. The molecular transport properties will play a minor role compared to turbulent transport.*

### 16.5.6. Boundary Conditions

**Boundary Conditions**
1. Convert the symmetry zone to the axis type.

**Boundary Conditions → symmetry-5**

The symmetry zone must be converted to an axis to prevent numerical difficulties where the radius reduces to zero.

a. Select **axis** from the **Type** drop-down list.

   A **Question** dialog box will open, asking if it is OK to change the type of **symmetry-5** from symmetry to axis. **Click Yes** to continue.

   ![Question Dialog Box]

   The **Axis** dialog box will open and display the default name for the newly created axis zone. **Click OK** to continue.
2. Set the boundary conditions for the air inlet (velocity-inlet-8).

Boundary Conditions → velocity-inlet-8 → Edit...

To determine the zone for the air inlet, display the mesh without the fluid zone to see the boundaries. Use the right mouse button to probe the air inlet. ANSYS Fluent will report the zone name (velocity-inlet-8) in the console.

- a. Enter air-inlet for Zone Name. This name is more descriptive for the zone than velocity-inlet-8.
- b. Enter 0.5 m/s for Velocity Magnitude.
- c. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the Turbulence group box.
- d. Enter 10 % for Turbulent Intensity.
- e. Enter 0.44 m for Hydraulic Diameter.
f. Click the **Thermal** tab and retain the default value of 300 K for **Temperature**.

g. Click the **Species** tab and enter 0.23 for **o2** in the **Species Mass Fractions** group box.

![Velocity Inlet dialog box](image)

h. Click **OK** to close the **Velocity Inlet** dialog box.

3. Set the boundary conditions for the fuel inlet (**velocity-inlet-6**).

   ![Boundary Conditions](image)
a. Enter fuel-inlet for Zone Name.  
   *This name is more descriptive for the zone than velocity-inlet-6.*

b. Enter 80 m/s for the Velocity Magnitude.

c. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the Turbulence group box.

d. Enter 10 % for Turbulent Intensity.

e. Enter 0.01 m for Hydraulic Diameter.

f. Click the Thermal tab and retain the default value of 300 K for Temperature.

g. Click the Species tab and enter 1 for ch4 in the Species Mass Fractions group box.

h. Click OK to close the Velocity Inlet dialog box.

4. Set the boundary conditions for the exit boundary (pressure-outlet-9).

   ![Boundary Conditions](image) → ![pressure-outlet-9](image) → Edit...
a. Retain the default value of 0 Pa for **Gauge Pressure**.

b. Select **Intensity and Hydraulic Diameter** from the **Specification Method** drop-down list in the **Turbulence** group box.

c. Enter 10 % for **Backflow Turbulent Intensity**.

d. Enter 0.45 m for **Backflow Hydraulic Diameter**.

e. Click the **Thermal** tab and retain the default value of 300 K for **Backflow Total Temperature**.

f. Click the **Species** tab and enter 0.23 for **o2** in the **Species Mass Fractions** group box.

g. Click **OK** to close the **Pressure Outlet** dialog box.

*The Backflow values in the Pressure Outlet dialog box are utilized only when backflow occurs at the pressure outlet. Always assign reasonable values because backflow may occur during intermediate iterations and could affect the solution stability.*

5. Set the boundary conditions for the outer wall (**wall-7**).

- **Boundary Conditions → wall-7 → Edit...**

  *Use the mouse-probe method described for the air inlet to determine the zone corresponding to the outer wall.*
a. Enter outer-wall for Zone Name.

   This name is more descriptive for the zone than wall-7.

b. Click the Thermal tab.

   i. Select Temperature in the Thermal Conditions list.

   ii. Retain the default value of 300 K for Temperature.

c. Click OK to close the Wall dialog box.

6. Set the boundary conditions for the fuel inlet nozzle (wall-2).

   Boundary Conditions → wall-2 → Edit...
a. Enter nozzle for Zone Name.

This name is more descriptive for the zone than wall-2.

b. Click the Thermal tab.

i. Retain the default selection of Heat Flux in the Thermal Conditions list.

ii. Retain the default value of 0 $W/m^2$ for Heat Flux, so that the wall is adiabatic.

c. Click OK to close the Wall dialog box.

16.5.7. Initial Reaction Solution

You will first calculate a solution for the basic reacting flow neglecting pollutant formation. In a later step, you will perform an additional analysis to simulate NOx.

1. Select the Coupled Pseudo Transient solution method.
a. Select **Coupled** from the **Scheme** drop-down list in the **Pressure-Velocity Coupling** group box.

b. Retain the default selections in the **Spatial Discretization** group box.

c. Enable **Pseudo Transient**.

*The Pseudo Transient option enables the pseudo transient algorithm in the coupled pressure-based solver. This algorithm effectively adds an unsteady term to the solution equations in order to improve stability and convergence behavior. Use of this option is recommended for general fluid flow problems.*

2. Modify the solution controls.

<Solution Controls>
a. Enter 0.25 under *Density* in the **Pseudo Transient Explicit Relaxation Factors** group box.

The default explicit relaxation parameters in ANSYS Fluent are appropriate for a wide range of general fluid flow problems. However, in some cases it may be necessary to reduce the relaxation factors to stabilize the solution. Some experimentation is typically necessary to establish the optimal values. For this tutorial, it is sufficient to reduce the density explicit relaxation factor to 0.25 for stability.

b. Click **Advanced...** to open the **Advanced Solution Controls** dialog box and select the **Expert** tab.

The Expert tab in the Advanced Solution Controls dialog box allows you to individually specify the solution method and Pseudo Transient Time Scale Factors for each equation, except for the flow equations. When using the Pseudo Transient method for general reacting flow cases, increasing the species and energy time scales is recommended.
i. Enable the pseudo-transient method for \texttt{ch4}, \texttt{o2}, \texttt{co2}, \texttt{h2o}, and \textbf{Energy} in the \textbf{Expert} tab, by selecting each one under \texttt{On/Off}.

ii. Enter 1.0 for the \textbf{Time Scale Factor} for \texttt{ch4}, \texttt{o2}, \texttt{co2}, \texttt{h2o}, and \textbf{Energy}.

iii. Click \textbf{OK} to close the \textbf{Advanced Solution Controls} dialog box.

3. Ensure the plotting of residuals during the calculation.

\begin{itemize}
  \item \textbf{Monitors} $\rightarrow$ \textbf{Residuals} $\rightarrow$ \textbf{Edit...}
\end{itemize}
a. Ensure that Plot is enabled in the Options group box.

b. Click OK to close the Residual Monitors dialog box.

4. Initialize the field variables.

   Solution Initialization

   a. Click Initialize to initialize the variables.

5. Save the case file (gascomb1.cas.gz).

   File → Write → Case...

   a. Enter gascomb1.cas.gz for Case File.

   b. Ensure that Write Binary Files is enabled to produce a smaller, unformatted binary file.

   c. Click OK to close the Select File dialog box.
6. Run the calculation by requesting 200 iterations.

- Select Aggressive from the Length Scale Method drop-down list.

  *When using the Automatic Time Step Method ANSYS Fluent computes the Pseudo Transient time step based on characteristic length and velocity scales of the problem. The Conservative Length Scale Method uses the smaller of two computed length scales emphasizing solution stability. The Aggressive Length Scale Method uses the larger of the two which may provide faster convergence in some cases.*

- Enter 5 for the Timescale Factor.

  *The Timescale Factor allows you to further manipulate the computed Time Step calculated by ANSYS Fluent. Larger time steps can lead to faster convergence. However, if the time step is too large it can lead to solution instability.*

- Enter 200 for Number of Iterations.

- Click Calculate.

  *The solution will converge after approximately 160 iterations.*

7. Save the case and data files (gascombl.cas.gz and gascombl.dat.gz).
16.5.8. Postprocessing

Review the solution by examining graphical displays of the results and performing surface integrations at the combustor exit.

1. Report the total sensible heat flux.

   **Reports → Fluxes → Set Up...**

   ![Flux Reports](image)

   a. Select **Total Sensible Heat Transfer Rate** in the **Options** list.
   b. Select all the boundaries from the **Boundaries** selection list (you can click the select-all button ( ));
   c. Click **Compute** and close the **Flux Reports** dialog box.

   **Note**

   The energy balance is good because the net result is small compared to the heat of reaction.
2. Display filled contours of temperature (Figure 16.3: Contours of Temperature (p. 697)).

Graphics and Animations → Contours → Set Up...

a. Ensure that Filled is enabled in the Options group box.
b. Select Temperature... and Static Temperature in the Contours of drop-down lists.
c. Click Display.

Figure 16.3: Contours of Temperature

The peak temperature is approximately 2310 K.

3. Display velocity vectors (Figure 16.4: Velocity Vectors (p. 699)).

Graphics and Animations → Vectors → Set Up...
a. Enter 0.01 for Scale.

b. Click the Vector Options... button to open the Vector Options dialog box.

i. Enable Fixed Length.

The fixed length option is useful when the vector magnitude varies dramatically. With fixed length vectors, the velocity magnitude is described only by color instead of by both vector length and color.

ii. Click Apply and close the Vector Options dialog box.

C. Click Display and close the Vectors dialog box.
4. Display filled contours of stream function (Figure 16.5: Contours of Stream Function (p. 700)).

- Graphics and Animations → Contours → Set Up...

a. Select Velocity... and Stream Function from the Contours of drop-down lists.

b. Click Display.
**Figure 16.5: Contours of Stream Function**

The entrainment of air into the high-velocity methane jet is clearly visible in the streamline display.

5. Display filled contours of mass fraction for CH$_4$ (*Figure 16.6: Contours of CH4 Mass Fraction (p. 701))*.

   - **Graphics and Animations → Contours → Set Up...**
     a. Select **Species...** and **Mass fraction of ch4** from the **Contours of** drop-down lists.
     b. Click **Display**.
6. In a similar manner, display the contours of mass fraction for the remaining species $\text{O}_2$, $\text{CO}_2$, and $\text{H}_2\text{O}$ (Figure 16.7: Contours of O2 Mass Fraction (p. 702), Figure 16.8: Contours of CO2 Mass Fraction (p. 703), and Figure 16.9: Contours of H2O Mass Fraction (p. 704)) Close the Contours dialog box when all of the species have been displayed.
Figure 16.7: Contours of O2 Mass Fraction

Contours of Mass fraction of O2

ANSYS Fluent (axi, dp, pbns, spe, ske)
Figure 16.8: Contours of CO2 Mass Fraction
7. Determine the average exit temperature.

Reports → Surface Integrals → Set Up...
a. Select **Mass-Weighted Average** from the **Report Type** drop-down list.

b. Select **Temperature...** and **Static Temperature** from the **Field Variable** drop-down lists.

   The mass-averaged temperature will be computed as:

   \[
   T = \frac{\int T \rho \vec{v} \cdot dA}{\int \rho \vec{v} \cdot dA}
   \]  

(16.2)

c. Select **pressure-outlet-9** from the **Surfaces** selection list, so that the integration is performed over this surface.

d. Click **Compute**.

   The **Mass-Weighted Average** field will show that the exit temperature is approximately 1840 K.

8. Determine the average exit velocity.

   ![Reports → Surface Integrals → Set Up...]
a. Select **Area-Weighted Average** from the **Report Type** drop-down list.

b. Select **Velocity...** and **Velocity Magnitude** from the **Field Variable** drop-down lists.

   The area-weighted velocity-magnitude average will be computed as:

   $\bar{v} = \frac{1}{A} \int v dA$ \hspace{1cm} (16.3)

c. Click **Compute**.

   The **Area-Weighted Average** field will show that the exit velocity is approximately 3.30 m/s.

d. Close the **Surface Integrals** dialog box.

### 16.5.9. NOx Prediction

In this section you will extend the ANSYS Fluent model to include the prediction of NOx. You will first calculate the formation of both thermal and prompt NOx, then calculate each separately to determine the contribution of each mechanism.

1. Enable the NOx model.

   ![Models → NOx → Edit...]
a. Enable Thermal NOx and Prompt NOx in the Pathways group box.

b. Select ch4 from the Fuel Species selection list.

c. Click the Turbulence Interaction Mode tab.
i. Select **temperature** from the **PDF Mode** drop-down list.

*This will enable the turbulence-chemistry interaction. If turbulence interaction is not enabled, you will be computing NOx formation without considering the important influence of turbulent fluctuations on the time-averaged reaction rates.*

ii. Retain the default selection of **beta** from the **PDF Type** drop-down list and enter **20** for **PDF Points**.

*The value for **PDF Points** is increased from **10** to **20** to obtain a more accurate NOx prediction.*

iii. Select **transported** from the **Temperature Variance** drop-down list.

d. Select **partial-equilibrium** from the **[O] Model** drop-down list in the **Formation Model Parameters** group box in the **Thermal** tab.

*The partial-equilibrium model is used to predict the O radical concentration required for thermal NOx prediction.*

e. Click the **Prompt** tab.
i. Retain the default value of 1 for Fuel Carbon Number.

ii. Enter 0.76 for Equivalence Ratio.

All of the parameters in the Prompt tab are used in the calculation of prompt NOx formation. The Fuel Carbon Number is the number of carbon atoms per molecule of fuel. The Equivalence Ratio defines the fuel-air ratio (relative to stoichiometric conditions).

f. Click Apply to accept these changes and close the NOx Model dialog box.

2. Enable the calculation of NO species only and temperature variance.

Solution Controls → Equations...
a. Deselect all variables except Pollutant no and Temperature Variance from the Equations selection list.

b. Click OK to close the Equations dialog box.

You will predict NOx formation in a “postprocessing” mode, with the flow field, temperature, and hydrocarbon combustion species concentrations fixed. Hence, only the NO equation will be computed. Prediction of NO in this mode is justified on the grounds that the NO concentrations are very low and have negligible impact on the hydrocarbon combustion prediction.

3. Modify the solution controls for Pollutant no and Temperature Variance.

Solution Controls

a. Set the Time Scale Factor for Pollutant no and Temperature Variance to 10.
i. Click Advanced... to open the Advanced Solution Controls dialog box.

ii. Enable the pseudo-transient method for Pollutant no and Temperature Variance, by selecting them under On/Off in the Expert tab of the Advanced Solution Controls dialog box.

iii. Enter 10 for Time Scale Factor for Pollutant no and Temperature Variance.

iv. Close the Advanced Solution Controls dialog box.

b. Enter 1 for Pollutant no and Temperature Variance in the Pseudo Transient Explicit Relaxation Factors group box.

4. Confirm the convergence criterion for the NO species equation.

Monitor Residuals > Edit...
a. Ensure that the **Absolute Criteria** for `pollut_no` is set to $1e^{-06}$.

b. Click OK to close the **Residual Monitors** dialog box.

5. Request 25 more iterations.

![Residual Monitors dialog box]

Run Calculation

_The solution will converge in approximately 11 iterations._

6. Save the new case and data files (`gascomb2.cas.gz` and `gascomb2.dat.gz`).

File → Write → Case & Data...

7. Review the solution by displaying contours of NO mass fraction (Figure 16.10: Contours of NO Mass Fraction — Prompt and Thermal NOx Formation (p. 713)).

Graphics and Animations → Contours → Set Up...

a. Disable **Filled** in the **Options** group box.

b. Select **NOx**... and **Mass fraction of Pollutant no** from the **Contours of** drop-down lists.

c. Click **Display** and close the **Contours** dialog box.
8. Calculate the average exit NO mass fraction.
a. Select **Mass-Weighted Average** from the **Report Type** drop-down list.

b. Select **NOx...** and **Mass fraction of Pollutant no** from the **Field Variable** drop-down lists.

c. Ensure that **pressure-outlet-9** is selected from the **Surfaces** selection list.

d. Click **Compute**.

   *The Mass-Weighted Average field will show that the exit NO mass fraction is approximately 0.00421.*

e. Close the **Surface Integrals** dialog box.

9. Disable the prompt NOx mechanism in preparation for solving for thermal NOx only.

   ![Models → NOx → Edit...](image)

   a. Click the **Formation** tab and disable **Prompt NOx**.
   
   b. Click **Apply** and close the **NOx Model** dialog box.


   ![Run Calculation](image)

   *The solution will converge in approximately 6 iterations.*

11. Review the thermal NOx solution by viewing contours of NO mass fraction (*Figure 16.11: Contours of NO Mass Fraction—Thermal NOx Formation (p. 715)).*

   ![Graphics and Animations → Contours → Set Up...](image)
a. Ensure that **NOx...** and **Mass fraction of Pollutant no** are selected from the **Contours of** drop-down list.

b. Click **Display** and close the **Contours** dialog box.

**Figure 16.11: Contours of NO Mass Fraction—Thermal NOx Formation**

Note that the concentration of NO is slightly lower without the prompt NOx mechanism.

12. Compute the average exit NO mass fraction with only thermal NOx formation.

**Tip**

Follow the same procedure you used earlier for the calculation with both thermal and prompt NOx formation.
The Mass-Weighted Average field will show that the exit NO mass fraction with only thermal NOx formation (without prompt NOx formation) is approximately 0.004174.

13. Solve for prompt NOx production only.

- Models → NOx → Edit...
  - a. Disable Thermal NOx in the Pathways group box.
  - b. Enable Prompt NOx.
  - c. Click Apply and close the NOx Model dialog box.


- Run Calculation

The solution will converge in approximately 13 iterations.

15. Review the prompt NOx solution by viewing contours of NO mass fraction (Figure 16.12: Contours of NO Mass Fraction—Prompt NOx Formation (p. 717)).

- Graphics and Animations → Contours → Set Up...
The prompt NOx mechanism is most significant in fuel-rich flames. In this case the flame is lean and prompt NO production is low.

16. Compute the average exit NO mass fraction only with prompt NOx formation.

Tip

Follow the same procedure you used earlier for the calculation with both thermal and prompt NOx formation.
The **Mass-Weighted Average** field will show that the exit NO mass fraction with only prompt NOx formation is approximately 9.975e-05.

**Note**

The individual thermal and prompt NO mass fractions do not add up to the levels predicted with the two models combined. This is because reversible reactions are involved. NO produced in one reaction can be destroyed in another reaction.

17. Use a custom field function to compute NO parts per million (ppm).

The $NO_{ppm}$ will be computed from the following equation:

$$NO_{ppm} = \frac{NO_{molefraction} \times 10^6}{1 - H_2O_{molefraction}}$$

(16.4)

**Note**

This is the dry ppm. Therefore, the value is normalized by removing the water mole fraction in the denominator.

**Define → Custom Field Functions...**

a. Select **NOx**... and **Mole fraction of Pollutant no** from the **Field Functions** drop-down lists, and click the **Select** button to enter `molef-pollut-pollutant-0` in the **Definition** field.

b. Click the appropriate calculator buttons to enter

$*10^6/(1-$
in the **Definition** field, as shown in the previous dialog box.

---

**Tip**

If you make a mistake, click the **DEL** button on the calculator pad to delete the last item you added to the function definition.

---

For more explicit instructions on using the **Custom Field Function** calculator buttons, see Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).

c. Select **Species...** and **Mole fraction of h2o** from the **Field Functions** drop-down lists, and click the **Select** button to enter **molef-h2o** in the **Definition** field.

d. Click the **) button to complete the field function.

e. Enter **no-ppm** for **New Function Name**.

f. Click **Define** to add the new field function to the variable list and close the **Custom Field Function Calculator** dialog box.

18. Display contours of NO ppm (Figure 16.13: Contours of NO ppm — Prompt NOx Formation (p. 720)).

---

**Graphics and Animations → Contours → Set Up...**

a. Select **Custom Field Functions...** and **no-ppm** from the **Contours of** drop-down lists.

   *Scroll up the list to find **Custom Field Functions**....*

b. Click **Display** and close the **Contours** dialog box.
The contours closely resemble the mass fraction contours (Figure 16.12: Contours of NO Mass Fraction—Prompt NOx Formation (p. 717)), as expected.

16.6. Summary

In this tutorial you used ANSYS Fluent to model the transport, mixing, and reaction of chemical species. The reaction system was defined by using a mixture-material entry in the ANSYS Fluent database. The procedures used here for simulation of hydrocarbon combustion can be applied to other reacting flow systems.

The NOx production in this case was dominated by the thermal NO mechanism. This mechanism is very sensitive to temperature. Every effort should be made to ensure that the temperature solution is not overpredicted, since this will lead to unrealistically high predicted levels of NO.
16.7. Further Improvements

Further improvements can be expected by including the effects of intermediate species and radiation, both of which will result in lower predicted combustion temperatures.

The single-step reaction process used in this tutorial cannot account for the moderating effects of intermediate reaction products, such as CO and H₂. Multiple-step reactions can be used to address these species. If a multi-step Magnussen model is used, considerably more computational effort is required to solve for the additional species. Where applicable, the nonpremixed combustion model can be used to account for intermediate species at a reduced computational cost.

For more details on the nonpremixed combustion model, see Modeling Non-Premixed Combustion in the User’s Guide.

Radiation heat transfer tends to make the temperature distribution more uniform, thereby lowering the peak temperature. In addition, radiation heat transfer to the wall can be very significant (especially here, with the wall temperature set at 300 K). The large influence of radiation can be anticipated by computing the Boltzmann number for the flow:

\[ B_0 = \frac{\left( \rho U C_p \right)_{\text{inlet}}}{\sigma T_{AF}^3} \sim \frac{\text{convection}}{\text{radiation}} \]

where \( \sigma \) is the Boltzmann constant \( (5.729 \times 10^{-8} \, \text{W/m}^2\cdot\text{K}^4) \) and \( T_{AF} \) is the adiabatic flame temperature. For a quick estimate, assume \( \rho = 1 \, \text{kg/m}^3, U = 0.5 \, \text{m/s}, \) and \( C_p = 1000 \, \text{J/kg} - \text{K} \) (the majority of the inflow is air). Assume \( T_{AF} = 2000 \, \text{K} \). The resulting Boltzmann number is \( B_0 = 1.09 \), which shows that radiation is of approximately equal importance to convection for this problem.

For details on radiation modeling, see Modeling Radiation in the User’s Guide.

This tutorial guides you through the steps to reach an initial set of solutions. You may be able to obtain a more accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 17: Using the Non-Premixed Combustion Model

This tutorial is divided into the following sections:
17.1. Introduction
17.2. Prerequisites
17.3. Problem Description
17.4. Setup and Solution
17.5. Summary
17.6. References
17.7. Further Improvements

17.1. Introduction

The goal of this tutorial is to accurately model the combustion processes in a 300 KW BERL combustor. The reaction can be modeled using either the species transport model or the non-premixed combustion model. In this tutorial you will set up and solve a natural gas combustion problem using the non-premixed combustion model for the reaction chemistry.

This tutorial demonstrates how to do the following:

• Define inputs for modeling non-premixed combustion chemistry.

• Prepare the PDF table in ANSYS Fluent.

• Solve a natural gas combustion simulation problem.

• Use the Discrete Ordinates (DO) radiation model for combustion applications.

• Use the $k-\varepsilon$ turbulence model.

The non-premixed combustion model uses a modeling approach that solves transport equations for one or two conserved scalars (mixture fractions). Multiple chemical species, including radicals and intermediate species, may be included in the problem definition. Their concentrations will be derived from the predicted mixture fraction distribution.

Property data for the species are accessed through a chemical database, and turbulence-chemistry interaction is modeled using a $\beta$-function for the PDF. For details on the non-premixed combustion modeling approach, see Modeling Non-Premixed Combustion in the User’s Guide.

17.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.

17.3. Problem Description

The flow considered is an unstaged natural gas flame in a 300 kW swirl-stabilized burner. The furnace is vertically-fired and of octagonal cross-section with a conical furnace hood and a cylindrical exhaust duct. The furnace walls are capable of being refractory-lined or water-cooled. The burner features 24 radial fuel ports and a bluff centerbody. Air is introduced through an annular inlet and movable swirl blocks are used to impart swirl. The combustor dimensions are described in Figure 17.1: Problem Description (p. 724), and Figure 17.2: Close-Up of the Burner (p. 725) shows a close-up of the burner assuming 2D axisymmetry. The boundary condition profiles, velocity inlet boundary conditions of the gas, and temperature boundary conditions are based on experimental data [1].

Figure 17.1: Problem Description
17.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

17.4.1. Preparation
17.4.2. Reading and Checking the Mesh
17.4.3. Specifying Solver and Analysis Type
17.4.4. Specifying the Models
17.4.5. Defining Materials and Properties
17.4.6. Specifying Boundary Conditions
17.4.7. Specifying Operating Conditions
17.4.8. Obtaining Solution
17.4.9. Postprocessing
17.4.10. Energy Balances Reporting

17.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

   **Note**

   If you do not have a login, you can request one by clicking Customer Registration on the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   a. Click ANSYS Fluent under Product.
   b. Click 15.0 under Version.

5. Select this tutorial from the list.

6. Click Files to download the input and solution files.

7. Unzip non_premix_combustion_R150.zip to your working folder.

   The files, berl.msh and berl.prof, can be found in the non_premix_combustion folder, which will be created after unzipping the file.

   The mesh file, berl.msh, is a quadrilateral mesh describing the system geometry shown in Figure 17.1: Problem Description (p. 724) and Figure 17.2: Close-Up of the Burner (p. 725).

8. Use Fluent Launcher to start the 2D version of ANSYS Fluent.

   Fluent Launcher displays your Display Options preferences from the previous session.

9. Ensure that the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color Scheme options are enabled.

10. Enable Double-Precision.

    For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in the Getting Started Guide.

11. Ensure that the Serial processing option is selected.

### 17.4.2. Reading and Checking the Mesh

1. Read the mesh file berl.msh.

   **File → Read → Mesh...**

   The ANSYS Fluent console will report that the mesh contains 9784 quadrilateral cells. A warning will be generated informing you to consider making changes to the zone type, or to change the problem definition to axisymmetric. You will change the problem to axisymmetric swirl in Specifying Solver and Analysis Type (p. 730).

2. Check the mesh.
ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure that the reported minimum volume is a positive number.

3. Scale the mesh.

a. Select mm from the View Length Unit In drop-down list.

All dimensions will now be shown in millimeters.

b. Select mm from the Mesh Was Created In drop-down list in the Scaling group box.

c. Click Scale and verify that the domain extents are as shown in the Scale Mesh dialog box.

d. Close the Scale Mesh dialog box.

4. Check the mesh.

Note

It is a good idea to check the mesh after you manipulate it (that is, scale, convert to polyhedra, merge, separate, fuse, add zones, or smooth and swap.) This will ensure that the quality of the mesh has not been compromised.

5. Examine the mesh (Figure 17.3: 2D BERL Combustor Mesh Display (p. 728)).
Due to the mesh resolution and the size of the domain, you may find it more useful to display just the outline, or to zoom in on various portions of the mesh display.

**Extra**

You can use the mouse zoom button (middle button, by default) to zoom in to the display and the mouse probe button (right button, by default) to find out the boundary zone labels. The zone labels will be displayed in the console.

6. Mirror the display about the symmetry plane.

*Graphics and Animations ➔ Views...*
a. Select **axis-2** from the **Mirror Planes** selection list.

b. Click **Apply** and close the **Views** dialog box.

*The full geometry is displayed, as shown in Figure 17.4: 2D BERL Combustor Mesh Display Including the Symmetry Plane (p. 730)*
17.4.3. Specifying Solver and Analysis Type

1. Retain the default settings of pressure-based steady-state solver in the Solver group box.

   - General

   The non-premixed combustion model is available only with the pressure-based solver.

2. Change the spatial definition to axisymmetric swirl by selecting Axisymmetric Swirl in the 2D Space list.
17.4.4. Specifying the Models

1. Enable the Energy Equation.

   ![Energy Equation]

   a. Enable Energy Equation.
   b. Click OK to close the Energy dialog box.

   Since heat transfer occurs in the system considered here, you will have to solve the energy equation.

2. Select the standard k-epsilon turbulence model.

   ![Viscous Turbulence]

   Models → Viscous → Edit...
a. Select **k-epsilon (2eqn)** in the **Model** list.

   *For axisymmetric swirling flow, the RNG k-epsilon model can also be used, but for this case you will retain the default Standard, k-epsilon model.*

b. Retain the default **Standard Wall Treatment** in the **Near-Wall Treatment** group box.

c. Click **OK** to accept all other default settings and close the **Viscous Model** dialog box.

3. Select the **Discrete Ordinates (DO)** radiation model.

   *The DO radiation model provides a high degree of accuracy, but it can be CPU intensive. In cases where the computational expense of the DO model is deemed too great, the P1 model may provide an acceptable solution more quickly.*

   For details on the different radiation models available in ANSYS Fluent, see **Modeling Heat Transfer** in the **User's Guide**.

   ![Viscous Model dialog box]

   a. Select **Discrete Ordinates (DO)** in the **Model** list.

   The dialog box will expand to show related inputs.
b. Enter 1 for **Energy Iterations per Radiation Iteration**.

c. Click **OK** to accept all other default settings and close the **Radiation Model** dialog box.

*The ANSYS Fluent console will list the properties that are required for the model you have enabled. An **Information** dialog box will open, reminding you to confirm the property values.*

d. Click **OK** to close the **Information** dialog box.

4. Select the **Non-Premixed Combustion** model.

[Models → Species → Edit...](#)
a. Select **Non-Premixed Combustion** in the **Model** list.

   The dialog box will expand to show the related inputs. You will use this dialog box to create the PDF table.

When you use the non-premixed combustion model, you need to create a PDF table. This table contains information on the thermo-chemistry and its interaction with turbulence. ANSYS Fluent interpolates the PDF during the solution of the non-premixed combustion model.

b. Enable **Inlet Diffusion** in the **PDF Options** group box.

   The **Inlet Diffusion** option enables the mixture fraction to diffuse out of the domain through inlets and outlets.

c. Define chemistry models.

   i. Retain the default selection of the **Chemical Equilibrium** state relation and the **Non-Adiabatic** energy treatment.

      In most non-premixed combustion simulations, the **Chemical Equilibrium** model is recommended. The **Steady Diffusion Flamelet** option can model local chemical non-equilibrium due to turbulent strain.

   ii. Retain the default value for **Operating Pressure**.

   iii. Enter **0.064** for **Fuel Stream Rich Flammability Limit**.

      The **Fuel Stream Rich Flammability Limit** allows you to perform a “partial equilibrium” calculation, suspending equilibrium calculations when the mixture fraction exceeds the specified rich limit. This increases the efficiency of the PDF calculation, allowing you to bypass the complex
equilibrium calculations in the fuel-rich region. This is also more physically realistic than the assumption of full equilibrium.

For combustion cases, a value 10% – 50% larger than the stoichiometric mixture fraction can be used for the rich flammability limit of the fuel stream. In this case, the stoichiometric fraction is 0.058, therefore a value that is 10% greater is 0.064.

d. Click the **Boundary** tab to add and define the boundary species.

![Species Model](image1.png)

i. Enter `c2h6` in the **Boundary Species** text-entry field and click **Add**.

The `c2h6` species will appear at the bottom of the table.

ii. Similarly, add `c3h8`, `c4h10`, and `co2`.

*All the added species will appear in the table.*

iii. Select **Mole Fraction** in the **Specify Species in** list.

iv. Retain the default values for `n2` and `o2` for **Oxid**.

*The oxidizer (air) consists of 21% O₂ and 79% N₂ by volume.*

v. Specify the fuel composition by entering the following values for **Fuel**:

*The fuel composition is entered in mole fractions of the species, c2h6, c3h8, c4h10, and co2.*

<table>
<thead>
<tr>
<th>Species</th>
<th>Mole Fraction</th>
</tr>
</thead>
<tbody>
<tr>
<td>ch4</td>
<td>0.965</td>
</tr>
</tbody>
</table>
### Using the Non-Premixed Combustion Model

<table>
<thead>
<tr>
<th>Species</th>
<th>Mole Fraction</th>
</tr>
</thead>
<tbody>
<tr>
<td>n2</td>
<td>0.013</td>
</tr>
<tr>
<td>c2h6</td>
<td>0.017</td>
</tr>
<tr>
<td>c3h8</td>
<td>0.001</td>
</tr>
<tr>
<td>c4h10</td>
<td>0.001</td>
</tr>
<tr>
<td>co2</td>
<td>0.003</td>
</tr>
</tbody>
</table>

**Tip**

Scroll down to see all the species.

**Note**

All boundary species with a mass or mole fraction of zero will be ignored.

vi. Enter 315 K for **Fuel** and **Oxid** in the **Temperature** group box.

e. Click the **Control** tab and retain default species to be excluded from the equilibrium calculation.

f. Click the **Table** tab to specify the table parameters and calculate the PDF table.

![Species Model](image)

i. Ensure that **Automated Grid Refinement** is enabled.

ii. Retain the default values for all the parameters in the **Table Parameters** group box.
The maximum number of species determines the number of most preponderant species to consider after the equilibrium calculation is performed.

iii. Click **Calculate PDF Table** to compute the non-adiabatic PDF table.

iv. Click the **Display PDF Table...** button to open the **PDF Table** dialog box.

A. Retain the default parameters and click **Display** (Figure 17.5: Non-Adiabatic Temperature Look-Up Table on the Adiabatic Enthalpy Slice (p. 738)).

B. Close the **PDF Table** dialog box.
**Figure 17.5: Non-Adiabatic Temperature Look-Up Table on the Adiabatic Enthalpy Slice**

The 3D look-up tables are reviewed on a slice-by-slice basis. By default, the slice selected corresponds to the adiabatic enthalpy values. You can also select other slices of constant enthalpy for display.

The maximum and minimum values for mean temperature and the corresponding mean mixture fraction will also be reported in the console. The maximum mean temperature is reported as 2246 K at a mean mixture fraction of 0.058.

g. Save the PDF output file (berl.pdf).

   File → Write → PDF...

   i. Retain berl.pdf for PDF File name.

   ii. Click OK to write the file.

   *By default, the file will be saved as formatted (ASCII, or text). To save a binary (unformatted) file, enable the Write Binary Files option in the Select File dialog box.*

   h. Click OK to close the Species Model dialog box.

**17.4.5. Defining Materials and Properties**

1. Specify the continuous phase (pdf-mixture) material.

   - Materials → pdf-mixture → Create/Edit...
All thermodynamic data for the continuous phase, including density, specific heat, and formation enthalpies are extracted from the chemical database when the non-premixed combustion model is used. These properties are transferred to the pdf-mixture material, for which only transport properties, such as viscosity and thermal conductivity need to be defined.

a. Select wsggm-domain-based from the Absorption Coefficient drop-down list.

Tip

Scroll down to view the Absorption Coefficient option.

This specifies a composition-dependent absorption coefficient, using the weighted-sum-of-gray-gases model. WSGGM-domain-based is a variable coefficient that uses a length scale, based on the geometry of the model.

For more details, see Radiation in Combusting Flows of the Theory Guide.

b. Click Change/Create and close the Create/Edit Materials dialog box.

You can click the View... button next to Mixture Species to view the species included in the pdf-mixture material. These are the species included during the system chemistry setup. The Density and Cp (Specific Heat) laws cannot be altered: these properties are stored in the non-premixed combustion look-up tables.

ANSYS Fluent uses the gas law to compute the mixture density and a mass-weighted mixing law to compute the mixture $C_p$. When the non-premixed combustion model is used, do not alter the properties of the individual species. This will create an inconsistency with the PDF look-up table.
17.4.6. Specifying Boundary Conditions

1. Read the boundary conditions profile file.
   
   File → Read → Profile...
   
   a. Select berl.prof from the Select File dialog box.
   
   b. Click OK.

   The CFD solution for reacting flows can be sensitive to the boundary conditions, in particular the incoming velocity field and the heat transfer through the walls. Here, you will use profiles to specify the velocity at air-inlet-4, and the wall temperature for wall-9. The latter approach of fixing the wall temperature to measurements is common in furnace simulations, to avoid modeling the wall convective and radiative heat transfer. The data used for the boundary conditions was obtained from experimental data [1].

2. Set the boundary conditions for the pressure outlet (poutlet-3).

   Boundary Conditions → poutlet-3 → Edit...

   a. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the Turbulence group box.
   
   b. Retain 5% for Backflow Turbulent Intensity.
   
   c. Enter 600 mm for Backflow Hydraulic Diameter.
   
   d. Click the Thermal tab and enter 1300 K for Backflow Total Temperature.
   
   e. Click OK to close the Pressure Outlet dialog box.
The exit gauge pressure of zero defines the system pressure at the exit to be the operating pressure. The backflow conditions for scalars (temperature, mixture fraction, turbulence parameters) will be used only if flow is entrained into the domain through the exit. It is a good idea to use reasonable values in case flow reversal occurs at the exit at some point during the solution process.

3. Set the boundary conditions for the velocity inlet (air-inlet-4).

- **Boundary Conditions** → **air-inlet-4 → Edit...**

  ![Velocity inlet](image)

  a. Select **Components** from the **Velocity Specification Method** drop-down list.
  
  b. Select **vel-prof u** from the **Axial-Velocity** drop-down list.
  
  c. Select **vel-prof w** from the **Swirl-Velocity** drop-down list.
  
  d. Select **Intensity and Hydraulic Diameter** from the **Specification Method** drop-down list in the **Turbulence** group box.
  
  e. Enter **17%** for **Turbulent Intensity**.
  
  f. Enter **29** mm for **Hydraulic Diameter**.

  *Turbulence parameters are defined based on intensity and length scale. The relatively large turbulence intensity of 17% may be typical for combustion air flows.*
g. Click the **Thermal** tab and enter 312 K for **Temperature**.

h. Click the **Species** tab. For the non-premixed combustion calculation, you have to define the inlet **Mean Mixture Fraction** and **Mixture Fraction Variance**. In this case, the gas phase air inlet has a zero mixture fraction. Therefore, you can retain the zero default settings.

i. Click **OK** to close the **Velocity Inlet** dialog box.

4. Set the boundary conditions for the velocity inlet (**fuel-inlet-5**).

   ![Boundary Conditions](image)

   a. Select **Components** from the **Velocity Specification Method** drop-down list.

   b. Enter 157.25 m/s for **Radial-Velocity**.

   c. Select **Intensity and Hydraulic Diameter** from the **Specification Method** drop-down list in the **Turbulence** group box.

   d. Retain 5% for **Turbulent Intensity**.

   e. Enter 1.8 mm for **Hydraulic Diameter**.

   *The hydraulic diameter has been set to twice the height of the 2D inlet stream.*
5. Set the boundary conditions for wall-6.

![Wall Conditions](image)

a. Click the Thermal tab.
   
i. Select Temperature in the Thermal Conditions list.
   
   ii. Enter 1370 K for Temperature.
   
   iii. Enter 0.5 for Internal Emissivity.

b. Click OK to close the Wall dialog box.

6. Similarly, set the boundary conditions for wall-7 through wall-13 using the following values:

<table>
<thead>
<tr>
<th>Zone Name</th>
<th>Temperature</th>
<th>Internal Emissivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>wall-7</td>
<td>312</td>
<td>0.5</td>
</tr>
<tr>
<td>wall-8</td>
<td>1305</td>
<td>0.5</td>
</tr>
<tr>
<td>wall-9</td>
<td>temp-prof t (from the drop-down list)</td>
<td>0.5</td>
</tr>
<tr>
<td>wall-10</td>
<td>1100</td>
<td>0.5</td>
</tr>
</tbody>
</table>
Using the Non-Premixed Combustion Model

<table>
<thead>
<tr>
<th>Zone Name</th>
<th>Temperature</th>
<th>Internal Emissivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>wall-11</td>
<td>1273</td>
<td>0.5</td>
</tr>
<tr>
<td>wall-12</td>
<td>1173</td>
<td>0.5</td>
</tr>
<tr>
<td>wall-13</td>
<td>1173</td>
<td>0.5</td>
</tr>
</tbody>
</table>

7. Plot the profile of temperature for the wall furnace (wall-9).

![Plot](https://example.com/plot.png)

- Select `temp-prof` from the Profile selection list.
- Retain the selection of `t` and `x` from the Y Axis Function and X Axis Function selection lists respectively.
- Click Plot (Figure 17.6: Profile Plot of Temperature for wall-9 (p. 745)).
Figure 17.6: Profile Plot of Temperature for wall-9

8. Plot the profiles of velocity for the swirling air inlet (air-inlet-4).
   a. Plot the profile of axial-velocity for the swirling air inlet.

   ![Plot Profile Data](image)

   - **Steps**
     i. Select **vel-prof** from the **Profile** selection list.
     ii. Retain the selection of **u** from the **Y Axis Function** selection list.
     iii. Select **y** from the **X Axis Function** selection list.
iv. Click **Plot** (Figure 17.7: Profile Plot of Axial-Velocity for the Swirling Air Inlet (air-inlet-4)(p. 746)).

**Figure 17.7: Profile Plot of Axial-Velocity for the Swirling Air Inlet (air-inlet-4)**

![Profile Plot](image)

b. Plot the profile of swirl-velocity for swirling air inlet.

1. **Plots** → **Profile Data** → **Set Up...**

i. Retain the selection of **vel-prof** from the **Profile** selection list.

ii. Select **w** from the **Y Axis Function** selection list.

iii. Retain the selection of **y** from the **X Axis Function** selection list.
iv. Click **Plot** (Figure 17.8: Profile Plot of Swirl-Velocity for the Swirling Air Inlet (air-inlet-4) (p. 747)) and close the **Plot Profile Data** dialog box.

**Figure 17.8: Profile Plot of Swirl-Velocity for the Swirling Air Inlet (air-inlet-4)**

![Profile Plot](image)

---

17.4.7. Specifying Operating Conditions

1. Retain the default operating conditions.

   ![Operating Conditions](image)
The **Operating Pressure** was already set in the PDF table generation in *Specifying the Models* (p. 731).

### 17.4.8. Obtaining Solution

1. Set the solution parameters.

   **Solution Methods**

   ![Solution Methods](image)

   a. Select **Coupled** from the **Scheme** drop-down list in the **Pressure-Velocity Coupling** group box.

   b. Select **PRESTO!** from the **Pressure** drop-down list in the **Spatial Discretization** group box.

   c. Retain the other default selections and settings.

2. Set the solution controls.

   **Solution Controls**

   ![Solution Controls](image)
a. Enter 70 for **Flow Courant Number**.

b. Set the following parameters in the **Under-Relaxation Factors** group box:

<table>
<thead>
<tr>
<th>Under-Relaxation Factor</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Density</td>
<td>0.2</td>
</tr>
<tr>
<td>Body Forces</td>
<td>0.8</td>
</tr>
</tbody>
</table>

*The default under-relaxation factors are considered to be too aggressive for reacting flow cases with high swirl velocity.*

3. Enable the display of residuals during the solution process.

ças Residuals → Edit...
Using the Non-Premixed Combustion Model

a. Ensure that the **Plot** is enabled in the **Options** group box.

b. Click **OK** to close the **Residual Monitors** dialog box.

4. Initialize the flow field.

   ![Solution Initialization](image)

   a. Retain the default selection of **Hybrid Initialization** from the **Initialization Methods** group box.

   b. Click **Initialize**.

5. Save the case file (**berl-1.cas.gz**).

   ![File → Write → Case...](image)

6. Start the calculation by requesting 1500 iterations.
**Run Calculation**

The solution will converge in approximately 830 iterations.

7. Save the converged solution (ber1-1.dat.gz).

   **File → Write → Data...**

**17.4.9. Postprocessing**

1. Display the predicted temperature field (Figure 17.9: Temperature Contours (p. 753)).

   **Graphics and Animations → Contours → Set Up...**
Using the Non-Premixed Combustion Model

a. Enable **Filled** in the **Options** group box.

b. Select **Temperature...** and **Static Temperature** from the **Contours of** drop-down lists.

c. Click **Display**.

*The peak temperature in the system is 1979 K.*
2. Display contours of velocity (Figure 17.10: Velocity Contours (p. 754)).

- **Graphics and Animations → Contours → Set Up...**
  - a. Select **Velocity...** and **Velocity Magnitude** from the **Contours of** drop-down lists.
  - b. Click **Display**.
3. Display the contours of mass fraction of O2 (Figure 17.11: Contours of Mass Fraction of O2 (p. 755)).

- **Graphics and Animations** → **Contours** → **Set Up**...
  
  a. Select **Species**... and **Mass fraction of O2** from the **Contours of** drop-down lists.
  
  b. Click **Display** and close the **Contours** dialog box.
17.4.10. Energy Balances Reporting

*ANSYS Fluent* can report the overall energy balance and details of the heat and mass transfer.

1. Compute the gas phase mass fluxes through the domain boundaries.

   ![Reports → Fluxes → Set Up...](image)
a. Retain the default selection of **Mass Flow Rate** in the **Options** group box.

b. Select **air-inlet-4**, **fuel-inlet-5**, and **poutlet-3** from the **Boundaries** selection list.

c. Click **Compute**.

*The net mass imbalance should be a small fraction of the total flux through the system. If a significant imbalance occurs, you should decrease your residual tolerances by at least an order of magnitude and continue iterating.*

2. Compute the fluxes of heat through the domain boundaries.

   ![Flux Reports](image)

   a. Select **Total Heat Transfer Rate** in the **Options** group box.

   b. Select all the zones from the **Boundaries** selection list.

   c. Click **Compute**, examine the resulting values, and close the **Flux Reports** dialog box.

   *The value will be displayed in the console. Positive flux reports indicate heat addition to the domain. Negative values indicate heat leaving the domain. Again, the net heat imbalance should be a small fraction (for example, 0.5% or less) of the total energy flux through the system. The reported value may change for different runs.*

3. Compute the mass weighted average of the temperature at the pressure outlet.

   ![Reports](image)

   ![Surface Integrals](image)
a. Select **Mass-Weighted Average** from the **Report Type** drop-down list.

b. Select **Temperature...** and **Static Temperature** from the **Field Variable** drop-down lists.

c. Select **poutlet-3** from the **Surfaces** selection list.

d. Click **Compute**.

   *A value of approximately 1467 K will be displayed in the console.*

e. Close the **Surface Integrals** dialog box.

**17.5. Summary**

In this tutorial you learned how to use the non-premixed combustion model to represent the gas phase combustion chemistry. In this approach the fuel composition was defined and assumed to react according to the equilibrium system data. This equilibrium chemistry model can be applied to other turbulent, diffusion-reaction systems. You can also model gas combustion using the finite-rate chemistry model.

You also learned how to set up and solve a gas phase combustion problem using the Discrete Ordinates radiation model, and applying the appropriate absorption coefficient.

**17.6. References**

17.7. Further Improvements

This tutorial guides you through the steps to first generate an initial solution, and then to reach a more accurate second-order solution. You may be able to increase the accuracy of the solution even further by using an appropriate higher-order discretization scheme and by adapting the mesh. Mesh adaption can also ensure that your solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 18: Modeling Surface Chemistry

This tutorial is divided into the following sections:

18.1. Introduction
18.2. Prerequisites
18.3. Problem Description
18.4. Setup and Solution
18.5. Summary
18.6. Further Improvements

18.1. Introduction

In chemically reacting laminar flows, such as those encountered in chemical vapor deposition (CVD) applications, accurate modeling of time-dependent hydrodynamics, heat and mass transfer, and chemical reactions (including wall surface reactions) is important.

In this tutorial, surface reactions are considered. Modeling the reactions taking place at gas-solid interfaces is complex and involves several elementary physico-chemical processes like adsorption of gas-phase species on the surface, chemical reactions occurring on the surface, and desorption of gases from the surface back to the gas phase.

This tutorial demonstrates how to do the following:

• Create new materials and set the mixture properties.
• Model surface reactions involving site species.
• Enable physical models and define boundary conditions for a chemically reacting laminar flow involving wall surface reactions.
• Calculate the deposition solution using the pressure-based solver.
• Examine the flow results using graphics.

18.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.
Before beginning with this tutorial, see Modeling Species Transport and Finite-Rate Chemistry in the User's Guide for more information about species transport, chemically reacting flows, wall surface reaction modeling, and chemical vapor deposition. In particular, you should be familiar with the Arrhenius rate equation, as this equation is used for the surface reactions modeled in this tutorial.

### 18.3. Problem Description

A rotating disk CVD reactor for the growth of Gallium Arsenide (GaAs) shown in Figure 18.1: Schematic of the Reactor Configuration (p. 760) will be modeled.

#### Figure 18.1: Schematic of the Reactor Configuration

The process gases, Trimethyl Gallium (\( \text{Ga(CH}_3\text{)}_3 \)) and Arsine (\( \text{AsH}_3 \)) enter the reactor at 293 K through the inlet at the top. These gases flow over the hot, spinning disk depositing thin layers of gallium and arsenide on it in a uniform, repeatable manner. The disk rotation generates a radially pumping effect, which forces the gases to flow in a laminar manner down to the growth surface, outward across the disk, and finally to be discharged from the reactor.

The semiconductor materials Ga(s) and As(s) are deposited on the heated surface governed by the following surface reactions.

1. \( \text{AsH}_3 + \text{Ga}_s \rightarrow \text{Ga}_s + \text{As}_s + 1.5 \text{H}_2 \)  \hspace{1cm} (18.1)
2. \( \text{Ga(CH}_3\text{)}_3 + \text{As}_s \rightarrow \text{As}_s + \text{Ga}_s + 3 \text{CH}_3 \)  \hspace{1cm} (18.2)

The inlet gas is a mixture of Trimethyl Gallium, which has a mass fraction of 0.15, and Arsine, which has a mass fraction of 0.4. The mixture velocity at the inlet is 0.02189 m/s. The disk rotates at 80 rad/sec. The top wall (wall-1) is heated to 473 K and the sidewalls (wall-2) of the reactor are maintained at 343 K. The susceptor (wall-4) is heated to a uniform temperature of 1023 K and the bottom wall (wall-6) is at 303 K. These CVD reactors are typically known as cold-wall reactors, where only the wafer surface is heated to higher temperatures, while the remaining reactor walls are maintained at low temperatures.
In this tutorial, simultaneous deposition of Ga and As is simulated and examined. The mixture properties and the mass diffusivity are determined based on kinetic theory. Detailed surface reactions with multiple sites and site species, and full multi-component/thermal diffusion effects are also included in the simulation.

The purpose of this tutorial is to demonstrate surface reaction capabilities in ANSYS Fluent. Convective heat transfer is considered to be the dominant mechanism compared to radiative heat transfer, thus radiation effects are ignored.

18.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
- 18.4.1. Preparation
- 18.4.2. Reading and Checking the Mesh
- 18.4.3. Specifying Solver and Analysis Type
- 18.4.4. Specifying the Models
- 18.4.5. Defining Materials and Properties
- 18.4.6. Specifying Boundary Conditions
- 18.4.7. Setting the Operating Conditions
- 18.4.8. Simulating Non-Reacting Flow
- 18.4.9. Simulating Reacting Flow
- 18.4.10. Postprocessing the Solution Results

18.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.


   **Note**

   If you do not have a login, you can request one by clicking Customer Registration on the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   a. Click ANSYS Fluent under Product.
   b. Click 15.0 under Version.

5. Select this tutorial from the list.

6. Click Files to download the input and solution files.

7. Unzip the surface_chem_R150.zip file you have downloaded to your working folder.

   *The file surface.msh can be found in the surface_chem folder created after unzipping the file.*
8. Use Fluent Launcher to start the 3D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in the User’s Guide.

9. Ensure that the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color Scheme options are enabled.

10. Ensure that the Serial processing option is selected.

11. Enable Double Precision.

### 18.4.2. Reading and Checking the Mesh

1. Read in the mesh file surface.msh.

   File \(\rightarrow\) Read \(\rightarrow\) Mesh...

2. Check the mesh.

   General \(\rightarrow\) Check

   ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure that the reported minimum volume is a positive number.

3. Scale the mesh.

   General \(\rightarrow\) Scale...

   Scale the mesh to meters as it was created in centimeters.

   ![Scale Mesh dialog box](image)

   a. Select cm (centimeters) from the Mesh Was Created In drop-down list in the Scaling group box.
b. Click Scale and verify that the domain extents are as shown in the Scale Mesh dialog box.

_The default SI units will be used in this tutorial, hence there is no need to change any units._

c. Close the Scale Mesh dialog box.

4. Check the mesh.

Dé General ➔ Check

---

**Note**

It is a good practice to check the mesh after manipulating it (scale, convert to polyhedra, merge, separate, fuse, add zones, or smooth and swap). This will ensure that the quality of the mesh has not been compromised.

---

5. Examine the mesh (Figure 18.2: Mesh Display (p. 764)).
**Figure 18.2: Mesh Display**

You can use the left mouse button to rotate the image and view it from different angles. Use the right mouse button to check which zone number corresponds to each boundary. If you click the right mouse button on one of the boundaries in the graphics window, its name and type will be printed in the ANSYS Fluent console. This feature is especially useful when you have several zones of the same type and you want to distinguish between them quickly. Use the middle mouse button to zoom the image.

---

**Extra**

---

**18.4.3. Specifying Solver and Analysis Type**

1. Retain the default solver settings of pressure-based steady-state solver in the **Solver** group box.
18.4.4. Specifying the Models

In this problem, the energy equation and the species conservation equations will be solved, along with the momentum and continuity equations.

1. Enable heat transfer by enabling the energy equation.

a. Enable Energy Equation.

b. Click OK to close the Energy dialog box.

2. Enable chemical species transport and reaction.

Although you enable reactions, you still run a non-reacting flow to produce an initial solution. You will run a reacting flow in Simulating Reacting Flow (p. 786).
a. Select **Species Transport** in the **Model** list.

   The **Species Model** dialog box will expand to show relevant input options.

b. Enable **Volumetric** and **Wall Surface** in the **Reactions** group box.

c. Retain the selection of **mixture-template** from the **Mixture Material** drop-down list.

   You will modify the mixture material later in this tutorial.

---

**Extra**

The **Mixture Material** drop-down list includes all of the chemical mixtures that are currently defined in the ANSYS Fluent database. To check the constituents and the properties of the predefined mixture material, select it from the drop-down list and click the **View**... button next to **Mixture Material** to view a complete description of the reacting system.

d. Disable **Heat of Surface Reactions** in the **Wall Surface Reaction Options** group box.

e. Enable **Mass Deposition Source** in the **Wall Surface Reaction Options** group box.
**Mass Deposition Source** is enabled because there is a certain loss of mass due to the surface deposition reaction, that is, As(s) and Ga(s) are being deposited out. If you were to do an overall mass balance without taking this fact into account, you would end up with a slight imbalance.

f. Retain the default setting for Diffusion Energy Source.

This includes the effect of enthalpy transport due to species diffusion in the energy equation, which contributes to the energy balance, especially for the case of Lewis numbers far from unity.

g. Enable **Full Multicomponent Diffusion** and **Thermal Diffusion**.

The **Full Multicomponent Diffusion** activates Stefan-Maxwell’s equations and computes the diffusive fluxes of all species in the mixture to all concentration gradients. The **Thermal Diffusion** effects cause heavy molecules to diffuse less rapidly, and light molecules to diffuse more rapidly, toward heated surfaces.

h. Click **OK** to close the **Species Model** dialog box.

The ANSYS Fluent console will display a list of the properties that are required for the models that you have enabled.

An **Information** dialog box will open reminding you to confirm the property values that have been extracted from the database.

i. Click **OK** in the **Information** dialog box.

### 18.4.5. Defining Materials and Properties

In this step, you will first copy the gas-phase species (AsH$_3$, Ga(CH$_3$)$_3$, CH$_3$, and H$_2$) from the ANSYS Fluent database and modify their properties. Then you will create the site species (Ga$_s$ and As$_s$) and the solid species (Ga and As).

1. Copy arsenic-trihydride, hydrogen, methyl-radical, and trimethyl-gallium from the ANSYS Fluent material database to the list of fluid materials and modify their properties.

   - **Materials → air → Create/Edit...**

   a. Click **Fluent Database...** in the **Create/Edit Materials** dialog box to open the **Fluent Database Materials** dialog box.

   b. In the **Fluent Database Materials** dialog box, select **fluid** from the **Material Type** drop-down list.

   c. From the **Fluent Fluid Materials** selection list, select **arsenic-trihydride (ash3)**, **hydrogen (h2)**, **methyl-radical (ch3)**, and **trimethyl-gallium (game3)** by clicking each species once.
Scroll down the **Fluent Fluid Materials** list to locate each species.

![Fluent Database Materials dialog box]

- **d.** Click **Copy** to copy the selected species to your model.
- **e.** Click **Close** to close the **Fluent Database Materials** dialog box.

The **Create/Edit Materials** dialog box is updated to show the new materials, **arsenic-trihydride (ash3)**, **hydrogen (h2)**, **methyl-radical (ch3)**, and **trimethyl-gallium (game3)**, in the Fluent Fluid Materials drop-down list. The species are also listed under **Fluid** in the **Materials** task page.

- **f.** In the **Create/Edit Materials** dialog box, select **arsenic-trihydride (ash3)** from the **Fluent Fluid Materials** drop-down list.
g. In the Properties group box, modify the arsenic-trihydride properties as shown in Table 18.1: Properties of Species (p. 769).

**Tip**

Scroll down in the Properties group box to see all the parameters.

**Table 18.1: Properties of Species**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>AsH_3</th>
<th>Ga(CH_3)_3</th>
<th>CH_3</th>
<th>H_2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>arsenic-trihydride</td>
<td>trimethylgallium</td>
<td>methyl-radical</td>
<td>hydrogen</td>
</tr>
<tr>
<td>Chemical Formula</td>
<td>ash3</td>
<td>game3</td>
<td>ch3</td>
<td>h2</td>
</tr>
<tr>
<td>Cp (Specific Heat)</td>
<td>piecewise-polynomial</td>
<td>piecewise-polynomial</td>
<td>piecewise-polynomial</td>
<td>piecewise-polynomial</td>
</tr>
<tr>
<td>Thermal Conductivity</td>
<td>kinetic-theory</td>
<td>kinetic-theory</td>
<td>kinetic-theory</td>
<td>kinetic-theory</td>
</tr>
<tr>
<td>Viscosity</td>
<td>kinetic-theory</td>
<td>kinetic-theory</td>
<td>kinetic-theory</td>
<td>kinetic-theory</td>
</tr>
<tr>
<td>Molecular Weight</td>
<td>77.95</td>
<td>114.83</td>
<td>15</td>
<td>2.02</td>
</tr>
<tr>
<td>Standard State Enthalpy</td>
<td>0</td>
<td>0</td>
<td>2.044e+07</td>
<td>0</td>
</tr>
<tr>
<td>Standard State Entropy</td>
<td>130579.1</td>
<td>130579.1</td>
<td>257367.6</td>
<td>130579.1</td>
</tr>
<tr>
<td>Parameter</td>
<td>AsH₃</td>
<td>Ga(CH₃)₃</td>
<td>CH₃</td>
<td>H₂</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------</td>
<td>----------</td>
<td>-----</td>
<td>----</td>
</tr>
<tr>
<td>Reference Temperature</td>
<td>298.15</td>
<td>298.15</td>
<td>298.15</td>
<td>298.15</td>
</tr>
<tr>
<td>L-J Characteristic Length</td>
<td>4.145</td>
<td>5.68</td>
<td>3.758</td>
<td>2.827</td>
</tr>
<tr>
<td>L-J Energy Parameter</td>
<td>259.8</td>
<td>398</td>
<td>148.6</td>
<td>59.7</td>
</tr>
</tbody>
</table>

**Note**

Ignore the **Density** property for now as the density will be set to **incompressible-ideal-gas** for mixture.

h. When finished, click **Change/Create** to update your local copy of the species material.

**Note**

When you modify the properties of the material local copy, the original copy in Fluent material database stays intact.

i. In a similar way, modify the properties of **hydrogen (h₂)**, **methyl-radical (ch₃)**, and **trimethyl-gallium (game3)**.

**Note**

Make sure to click **Change/Create** each time you modify the properties for the material to apply the changes to the local copy.

2. Create the site species (Ga_s and As_s) and the solid species (Ga and As).

a. Select **air** from the **Fluent Fluid Materials** drop-down list.

b. Enter **ga_s** for the **Name** text entry field.

c. Enter **ga_s** for the **Chemical Formula** text entry field.

d. Enter the parameter values for the **ga_s** species as shown in **Table 18.2: Properties of Species (p. 770)**

**Table 18.2: Properties of Species**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Ga_s</th>
<th>As_s</th>
<th>Ga</th>
<th>As</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>ga_s</td>
<td>as_s</td>
<td>ga</td>
<td>as</td>
</tr>
<tr>
<td>Chemical Formula</td>
<td>ga_s</td>
<td>as_s</td>
<td>ga</td>
<td>as</td>
</tr>
<tr>
<td>Cp (Specific Heat)</td>
<td>520.64</td>
<td>520.64</td>
<td>1006.43</td>
<td>1006.43</td>
</tr>
<tr>
<td>Thermal Conductivity</td>
<td>0.0158</td>
<td>0.0158</td>
<td>kinetic-theory</td>
<td>kinetic-theory</td>
</tr>
<tr>
<td>Parameter</td>
<td>Ga_s</td>
<td>As_s</td>
<td>Ga</td>
<td>As</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------</td>
<td>-------</td>
<td>------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Viscosity</td>
<td>2.125e-05</td>
<td>2.125e-05</td>
<td>kinetic-theory</td>
<td>kinetic-theory</td>
</tr>
<tr>
<td>Molecular Weight</td>
<td>69.72</td>
<td>74.92</td>
<td>69.72</td>
<td>74.92</td>
</tr>
<tr>
<td>Standard State Enthalpy</td>
<td>-3117.71</td>
<td>-3117.71</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Standard State Entropy</td>
<td>154719.3</td>
<td>154719.3</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Reference Temperature</td>
<td>298.15</td>
<td>298.15</td>
<td>298.15</td>
<td>298.15</td>
</tr>
<tr>
<td>L-J Characteristic Length</td>
<td>-</td>
<td>-</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>L-J Energy Parameter</td>
<td>-</td>
<td>-</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

- Click **Change/Create** to create the new material.
- Click **No** in the **Question** dialog box when asked if you want to overwrite air.

The new material **ga-s** is added to your model and listed under **Fluid** in the **Materials** task page.

- Create other species following the same procedure as for Ga_s and close the **Create/Edit Materials** dialog box.

---

**Extra**

To enter complex formulae such as Ga(CH\(_3\))\(_3\) in the text entry box, use ‘<’ and ‘>’ instead of ‘(‘ and ‘)’, respectively.

---

3. Set the mixture species.

   ➤ **Materials** → **mixture-template** → **Create/Edit...**

a. Enter **gaas_deposition** for **Name**.

b. Click **Change/Create**.

c. Click **Yes** in the **Question** dialog box to overwrite the mixture-template.

d. Set the **Selected Species**, **Selected Site Species**, and **Selected Solid Species**.

i. In **Properties** group box, click the **Edit...** button to the right of the **names** drop-down list for **Mixture Species** to open the **Species** dialog box.
ii. Set the **Selected Species**, **Selected Site Species**, and **Selected Solid Species** from the **Available Materials** selection list as shown in Table 18.3: **Selected Species** (p. 772)

### Table 18.3: Selected Species

<table>
<thead>
<tr>
<th>Selected Species</th>
<th>Selected Site Species</th>
<th>Selected Solid Species</th>
</tr>
</thead>
<tbody>
<tr>
<td>ash3</td>
<td>ga_s</td>
<td>ga</td>
</tr>
<tr>
<td>game3</td>
<td>as_s</td>
<td>as</td>
</tr>
<tr>
<td>ch3</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>h2</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

**Warning**

Ensure that h2 is at the bottom in the **Selected Species** selection list as shown in Table 18.3: **Selected Species** (p. 772). ANSYS Fluent will interpret the last species in the list as the bulk species.

To add/remove the species:

- To add a particular species to the list, select the required species from the **Available Materials** selection list and click **Add** in the corresponding species selection list (**Selected Species**, **Selected Site Species**, or **Selected Solid Species**). The species will be added to the end of the relevant list and removed from the **Available Materials** list.

- To remove an unwanted species from the selection list, select the species from the selection list (**Selected Species**, **Selected Site Species**, or **Selected Solid Species**) and click **Remove** in the corresponding selection list. The species will be removed from the list and added to the **Available Materials** list.
iii. Click **OK** to close the **Species** dialog box after all the species are set under the respective categories.

e. Set the mixture reactions.

i. Click the **Edit...** button to the right of the **Reaction** drop-down list to open the **Reactions** dialog box.

![Reactions dialog box](image)

ii. Increase the **Total Number of Reactions** to 2, and define the following reactions using the parameters in **Table 18.4: Reaction Parameters (p. 773)**:

\[
AsH_3 + Ga_s \rightarrow Ga + As_s + 1.5H_2 \quad (18.3)
\]

\[
Ga(CH_3)_3 + As_s \rightarrow As + Ga_s + 3CH_3 \quad (18.4)
\]

**Table 18.4: Reaction Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>For Equation 18.3 (p. 773)</th>
<th>For Equation 18.4 (p. 773)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reaction Name</td>
<td>gallium-dep</td>
<td>arsenic-dep</td>
</tr>
<tr>
<td>Reaction ID</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Reaction Type</td>
<td>Wall Surface</td>
<td>Wall Surface</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Parameter</th>
<th>For Equation 18.3 (p. 773)</th>
<th>For Equation 18.4 (p. 773)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Reactants</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Species</td>
<td>ash3, ga_s</td>
<td>game3, as_s</td>
</tr>
<tr>
<td>Stoich. Coefficient</td>
<td>ash3 = 1, ga_s = 1</td>
<td>game3 = 1, as_s = 1</td>
</tr>
<tr>
<td>Rate Exponent</td>
<td>ash3 = 1, ga_s = 1</td>
<td>game3 = 1, as_s = 1</td>
</tr>
<tr>
<td>Arrhenius Rate</td>
<td>PEF = 1e+12, AE = 0, TE = 0.5</td>
<td>PEF = 1e+12, AE = 0, TE = 0.5</td>
</tr>
<tr>
<td>Number of Products</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Species</td>
<td>ga, as_s, h2</td>
<td>as, ga_s, ch3</td>
</tr>
<tr>
<td>Stoich. Coefficient</td>
<td>ga = 1, as_s = 1, h2 = 1.5</td>
<td>as = 1, ga_s = 1, ch3 = 3</td>
</tr>
<tr>
<td>Rate Exponent</td>
<td>as_s = 0, h2 = 0</td>
<td>ga_s = 0, ch3 = 0</td>
</tr>
</tbody>
</table>

Here, PEF = Pre-Exponential Factor, AE = Activation Energy, and TE = Temperature Exponent.

*Set the ID to 2 in order to set the parameters for the second reaction.*

iii. Click OK to save the data and close the Reactions dialog box.

f. Set the reaction mechanisms for the mixture.

i. Click the Edit... button to the right of the Mechanism drop-down list to open the Reaction Mechanisms dialog box.

ii. Retain Number of Mechanisms as 1.

iii. Enter gaas-ald for Name.

iv. Select Wall Surface in the Reaction Type group box.
v. Select gallium-dep and arsenic-dep from the Reactions selection list.

vi. Set Number of Sites to 1.

vii. Enter \(1e^{-08}\) kgmol/m\(^2\) for Site Density for site-1.

viii. Click the Define... button to the right of site-1 to open the Site Parameters dialog box.

A. Set Total Number of Site Species to 2.

B. Select ga_s as the first site species and enter 0.7 for Initial Site Coverage.

C. Select as_s as the second site species and enter 0.3 for Initial Site Coverage.

D. Click Apply and close the Site Parameters dialog box.

ix. Click OK to close the Reaction Mechanisms dialog box.

g. Retain the default selection of incompressible-ideal-gas from the Density drop-down list.

h. Retain the default selection of mixing-law from the Cp (Specific Heat) drop-down list.

i. Select mass-weighted-mixing-law from the Thermal Conductivity drop-down list.

j. Select mass-weighted-mixing-law from the Viscosity drop-down list.

k. Retain the default selection of kinetic-theory from the Mass Diffusivity drop-down list.

l. Retain the default selection of kinetic-theory from the Thermal Diffusion Coefficient drop-down list.

m. Click Change/Create and close the Create/Edit Materials dialog box.
18.4.6. Specifying Boundary Conditions

1. Set the conditions for **velocity-inlet**.

   ![Boundary Conditions](image)

   ![Boundary Conditions](image)
a. Retain the default selection of **Magnitude, Normal to Boundary** from the **Velocity Specification Method** drop-down list.

b. Retain the default selection of **Absolute** from the **Reference Frame** drop-down list.

c. Enter **0.02189 m/s** for **Velocity Magnitude**.

d. Click the **Thermal** tab and enter **293 K** for **Temperature**.

e. Under the **Species** tab, set the **Species Mass Fractions** for **ash3** to **0.4**, **game3** to **0.15**, and **ch3** to **0**.
f. Click OK to close the Velocity Inlet dialog box.

2. Set the boundary conditions for outlet.

   ![Boundary Conditions ➔ outlet ➔ Edit...]

   a. Retain the default settings under the Momentum tab.

   b. Under the Thermal tab, enter 400 K for Temperature.

   c. Under the Species tab, set the Species Mass Fractions for ash3 to 0.32, game3 to 0.018, and ch3 to 0.06.

   Since a certain amount of backflow is expected in the flow regions around the rotating shaft, you should set the realistic backflow species mass fractions to minimize convergence difficulties.
d. Click **OK** to accept the remaining default settings.

3. Set the boundary conditions for **wall-1**.

   ![Boundary Conditions](image1)

   a. Click the **Thermal** tab.
i. Select **Temperature** in the **Thermal Conditions** group box.

ii. Enter 473 K for **Temperature**.

b. Click **OK** to close the **Wall** dialog box.

4. Set the boundary conditions for **wall-2**.

   ![Boundary Conditions](image)

   a. Click the **Thermal** tab.

   i. Select **Temperature** in the **Thermal Conditions** group box.

   ii. Enter 343 K for **Temperature**.

   b. Click **OK** to close the **Wall** dialog box.

5. Set the boundary conditions for **wall-4**.

   ![Boundary Conditions](image)

   a. Select **Moving Wall** in the **Wall Motion** group box.
The **Wall** dialog box will expand to wall motion inputs and options.

b. Select **Absolute** and **Rotational** in the **Motion** group box.

c. Enter 80 rad/s for **Speed**.

d. Retain the other default settings.

e. Click the **Thermal** tab.

   i. Select **Temperature** in the **Thermal Conditions** group box.

   ii. Enter 1023 K for **Temperature**.

f. Click the **Species** tab.

   i. Enable **Reaction**.

   ii. Retain the selection of **gaas-ald** from the **Reaction Mechanisms** drop-down list.

g. Click **OK** to close the **Wall** dialog box.

6. Set the boundary conditions for **wall-5**.

   ![Boundary Conditions]
   ![wall-5]
   ![Edit...]
a. Select **Moving Wall** in the **Wall Motion** group box.

b. Select **Absolute** and **Rotational** in the **Motion** group box.

c. Enter 80 rad/s for **Speed**.

d. Click the **Thermal** tab.

   i. Select **Temperature** in the **Thermal Conditions** group box.

   ii. Enter 720 K for **Temperature**.

e. Click **OK** to close the **Wall** dialog box.

7. Set the boundary conditions for **wall-6**.

   ![Boundary Conditions](image)

   a. Click the **Thermal** tab.

   i. Select **Temperature** in the **Thermal Conditions** group box.

   ii. Enter 303 K for **Temperature**.

b. Click **OK** to close the **Wall** dialog box.

**18.4.7. Setting the Operating Conditions**

1. Specify the operating conditions.

   ![Operating Conditions](image)
a. Enter 10000 Pa for Operating Pressure.

b. Enable Gravity.
   
The dialog box will expand to show related gravitational inputs.

c. Enter 9.81 m/s^2 for Gravitational Acceleration in the Z direction.

d. Enter 303 K for Operating Temperature.

e. Click OK to close the Operating Conditions dialog box.

The Operating Conditions dialog box can be accessed from the Cell Zone Conditions task page as well as the Boundary Conditions task page.

### 18.4.8. Simulating Non-Reacting Flow

1. Disable Volumetric for solving non-reacting flow.

   ✷ Models → ✮ Species → Edit...

   a. Disable Volumetric in the Reactions group box.

   b. Click OK to close the Species Model dialog box.

   You will first run a non-reacting solution to establish the flow.

2. Select the Coupled solver method.

   ✷ Solution Methods
a. Select **Coupled** from the **Scheme** drop-down list in the **Pressure-Velocity Coupling** group box.

b. Retain the default selections in the **Spatial Discretization** group box.

3. Examine **Solution Controls** and retain the default settings.
4. Enable residual plotting during the calculation.

- Monitors \rightarrow \textbf{Residuals} \rightarrow \textbf{Edit}...

  a. Retain the default settings and close the \textbf{Residual Monitors} dialog box.

5. Initialize the flow field.

- Solution Initialization
a. Retain the default selection of **Hybrid Initialization** from the **Initialization Methods** group box.

b. Click **Initialize**.

6. Save the case file (*surface-non-react.cas.gz*).

   **File** → **Write** → **Case...**

7. Start the calculation by requesting 200 iterations.

   **Run Calculation**

   a. Enter **200** for **Number of Iterations** and click **Calculate**.

   The solution will converge in approximately 40 iterations.

### 18.4.9. Simulating Reacting Flow

1. Enable **Volumetric** for the reacting flow solution.

   **Models** → **Species** → **Edit...**
a. Enable **Volumetric** and **Wall Surface** in the **Reactions** group box.

b. Enable **Mass Deposition Source** in the **Wall Surface Reaction Options** group box.

c. Click **OK** to close the **Species Model** dialog box.

2. Retain the default convergence criteria for calculation.

   ![Monitors → Residuals → Edit...](image-url)
3. Request 200 more iterations.

- **Run Calculation**

  The solution will converge in approximately 60 additional iterations.

4. Compute the mass fluxes.

- **Reports → Fluxes → Set Up...**
a. Retain the default selection of **Mass Flow Rate** in the **Options** group box.

b. Select **outlet, velocity-inlet, and wall-4** from the **Boundaries** selection list.

   *In order to properly assess the mass balance, you must account for the mass deposition on the spinning disk. Hence you select wall-4 in addition to the inlet and outlet boundaries.*

c. Click **Compute**, examine the values displayed in the **Results** and **Net Results** boxes, and close the **Flux Reports** dialog box.

   The net mass imbalance should be a small fraction (for example, 0.5% or less) of the total flux through the system. If a significant imbalance occurs, you should decrease your residual tolerances by at least an order of magnitude and continue iterating.

5. Display contours of surface deposition rate of **ga** *(Figure 18.3: Contours of Surface Deposition Rate of Ga (p. 790)).*

   ![Graphics and Animations → Contours → Set Up...](image)

   a. Enable **Filled** in the **Options** group box.

   b. Select **Species...** and **Surface Deposition Rate of ga** from the **Contours of** drop-down lists.

   c. Select **wall-4** from the **Surfaces** selection list.

   d. Click **Display** and close the **Contours** dialog box.

   *Rotate the display with the mouse to obtain the view as shown in (Figure 18.3: Contours of Surface Deposition Rate of Ga (p. 790)).*
6. Reduce the convergence criteria.

\[\text{Monitors} \rightarrow \text{Residuals} \rightarrow \text{Edit...}\]
a. Enter $5 \times 10^{-6}$ for **Absolute Criteria** for **continuity**.

b. Click **OK** to close the **Residual Monitors** dialog box.

7. Request 200 more iterations.

-run calculation

*The solution will converge in approximately 150 additional iterations.*
8. Check the mass fluxes.

![Reports → Fluxes → Set Up...](image-url)
a. Retain the default selection of **Mass Flow Rate** in the **Options** group box.

b. Retain the selection of **outlet** and **velocity-inlet** and, **wall-4** from the **Boundaries** selection list.

c. Click **Compute**, examine the values displayed in the **Results** and **Net Results** boxes, and close the **Flux Reports** dialog box.

   Again, the net mass imbalance should be a small fraction (for example, 0.5% or less) of the total flux through the system.

9. Save the case and data files (**surface-react1.cas.gz** and **surface-react1.dat.gz**).

   File → Write → Case & Data...

**18.4.10. Postprocessing the Solution Results**

1. Create an iso-surface near **wall-4**.

   Surface → Iso-Surface...
a. Select **Mesh...** and **Z-Coordinate** from the **Surface of Constant** drop-down lists.

b. Click **Compute**.

   The **Min** and **Max** fields display the z-extent of the domain.

c. Enter 0.075438 m for **Iso-Values**.

d. Enter **z=0.07** for **New Surface Name**.

   **Note**

   If you want to delete or otherwise manipulate any surfaces, click **Manage...** to open the **Surfaces** dialog box.

e. Click **Create** and close the **Iso-Surface** dialog box.

   The new surface **z=0.07** is added to the surfaces selection list.

2. Display contours of temperature on the plane surface created. (**Figure 18.5: Temperature Contours Near wall-4 (p. 796)**).

   ![Graphics and Animations → Contours → Set Up...](image)
a. Ensure that **Filled** is enabled in the **Options** group box.

b. Select **Temperature...** and **Static Temperature** from the **Contours of** drop-down lists.

c. Deselect **wall-4** from the **Surfaces** selection list.

d. Select **z=0.07** from the **Surfaces** selection list.

e. Click **Display**.
Figure 18.5: Temperature Contours Near wall-4

![Temperature Contours Near wall-4]

**Figure 18.5: Temperature Contours Near wall-4 (p. 796)** shows the temperature distribution across a plane just above the rotating disk. You can see that the disk has a temperature of 1023 K.

3. Display contours of surface deposition rates of ga (Figure 18.6: Contours of Surface Deposition Rate of ga (p. 797)).

   ◆ Graphics and Animations → Contours → Set Up...

   a. Select Species... and Surface Deposition Rate of ga from the Contours of drop-down lists.

   b. Select wall-4 from the Surfaces selection list.

   c. Deselect z=0.07 from the Surfaces selection list.

   d. Click Display.

   You may need to use the left mouse button to rotate the image so that you can see the contours on the top side of wall-4 where the deposition takes place.

   **Figure 18.6: Contours of Surface Deposition Rate of ga (p. 797)** shows the gradient of surface deposition rate of ga. The maximum deposition is seen at the center of the disk.
4. Display contours of surface coverage of \textbf{ga\_s} (Figure 18.7: Contours of Surface Coverage of ga\_s (p. 798)).

\textbullet Graphics and Animations $\rightarrow$ Contours $\rightarrow$ Set Up...

a. Select \textit{Species...} and \textit{Surface Coverage of ga\_s} from the \textit{Contours of} drop-down lists.

b. Retain the selection of \textit{wall-4} in the \textit{Surfaces} selection list.

c. Click \textit{Display} and close the \textit{Contours} dialog box.
Figure 18.7: Contours of Surface Coverage of ga_s

Contours of Surface Coverage of ga_s

Figure 18.7: Contours of Surface Coverage of ga_s (p. 798) shows the rate of surface coverage of the site species ga_s.

5. Create a line surface from the center of wall-4 to the edge.

Surface → Line/Rake...
a. Enter the values for $x_0$, $x_1$, $y_0$, $y_1$, $z_0$, and $z_1$ as shown in the Line/Rake Surface dialog box.

You can also select the points by clicking Select Points with Mouse. Then, in the graphic display, click at the center of wall-4 and at the edge using the right mouse button.

b. Accept the default name of line-9 for the New Surface Name and click Create.

Note

If you want to delete or otherwise manipulate any surfaces, click Manage... to open the Surfaces dialog box.

c. Close the Line/Rake Surface dialog box.

6. Plot the surface deposition rate of Ga versus radial distance (Figure 18.8: Plot of Surface Deposition Rate of Ga (p. 801)).

Plots → XY Plot → Set Up...
a. Disable **Node Values** in the **Options** group box.

b. Select **Species...** and **Surface Deposition Rate of ga** from the **Y Axis Function** drop-down lists.

   The source/sink terms due to the surface reaction are deposited in the cell adjacent to the wall cells, so it is necessary to plot the cell values and not the node values.

c. Select **line-9** you just created from the **Surfaces** selection list.

d. Click **Plot** and close the **Solution XY Plot** dialog box.

   The peak surface deposition rate occurs at the center of **wall-4** (where the concentration of the mixture is highest).
Figure 18.8: Plot of Surface Deposition Rate of Ga

You can also perform all the postprocessing steps to analyze the deposition of As.

7. Save the case and data files (surface-react2.cas.gz and surface-react2.dat.gz).

File → Write → Case & Data...

18.5. Summary

The main focus of this tutorial is the accurate modeling of macroscopic gas flow, heat and mass transfer, species diffusion, and chemical reactions (including surface reactions) in a rotating disk CVD reactor. In this tutorial, you learned how to use the two-step surface reactions involving site species, and computed simultaneous deposition of gallium and arsenide from a mixture of precursor gases on a rotating susceptor. Note that the same approach is valid if you are simulating multi-step reactions with multiple sites/site species.

18.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 19: Modeling Evaporating Liquid Spray

This tutorial is divided into the following sections:
19.1. Introduction
19.2. Prerequisites
19.3. Problem Description
19.4. Setup and Solution
19.5. Summary
19.6. Further Improvements

19.1. Introduction

In this tutorial, the air-blast atomizer model in ANSYS Fluent is used to predict the behavior of an evaporating methanol spray. Initially, the air flow is modeled without droplets. To predict the behavior of the spray, the discrete phase model is used, including a secondary model for breakup.

This tutorial demonstrates how to do the following:

• Define a spray injection for an air-blast atomizer.

• Calculate a solution using the discrete phase model in ANSYS Fluent.

19.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.

19.3. Problem Description

The geometry to be considered in this tutorial is shown in Figure 19.1: Problem Specification (p. 804). Methanol is cooled to $-10^\circ$C before being introduced into an air-blast atomizer. The atomizer contains an inner air stream surrounded by a swirling annular stream. To make use of the periodicity of the problem, only a $30^\circ$ section of the atomizer will be modeled.
19.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

19.4.1. Preparation
19.4.2. Reading the Mesh
19.4.3. General Settings
19.4.4. Specifying the Models
19.4.5. Materials
19.4.6. Boundary Conditions
19.4.7. Initial Solution Without Droplets
19.4.8. Create a Spray Injection
19.4.9. Solution
19.4.10. Postprocessing

19.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

   **Note**

   If you do not have a login, you can request one by clicking *Customer Registration* on the login page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   a. Click *ANSYS Fluent* under *Product*.
   b. Click *15.0* under *Version*.

5. Select this tutorial from the list.

6. Click *Files* to download the input and solution files.

7. Unzip `evaporate_liquid_R150.zip` to your working folder.

   *The mesh file sector.msh can be found in the evaporate_liquid directory created after unzipping the file.*

8. Use the ANSYS Fluent Launcher to start the 3D version of ANSYS Fluent.

   Fluent Launcher displays your Display Options preferences from the previous session.

   For more information about the ANSYS Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in the User’s Guide.

9. Ensure that the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color Scheme options are enabled.

10. Ensure that the **Serial** processing option is selected.

11. Ensure that **Double Precision** is disabled.

**19.4.2. Reading the Mesh**

1. Read in the mesh file *sector.msh*.

   *File ➔ Read ➔ Mesh...*

2. Change the periodic type of **periodic-a** to rotational.

   ✤ Boundary Conditions ➔ ➔ periodic-a ➔ Edit...
a. Select **Rotational** in the **Periodic Type** group box.

b. Click **OK** to close the **Periodic** dialog box.

3. In a similar manner, change the periodic type of **periodic-b** to rotational.

**19.4.3. General Settings**

1. Check the mesh.

   ![General → Check](image)

   ANSYS Fluent will perform various checks on the mesh and report the progress in the console. Ensure that the reported minimum volume is a positive number.

2. Display the mesh.

   ![General → Display...](image)

   a. Enable **Faces** in the **Options** group box.
b. Select only `atomizer-wall`, `central_air`, and `swirling_air` from the `Surfaces` selection list.

**Tip**

To deselect all surfaces click the far-right unshaded button ( Staples) at the top of the `Surfaces` selection list, and then select the desired surfaces from the `Surfaces` selection list.

c. Click the `Colors...` button to open the `Mesh Colors` dialog box.

![Mesh Colors dialog box]

   i. Select `wall` from the `Types` selection list.

   ii. Select `pink` from the `Colors` selection list.

   iii. Close the `Mesh Colors` dialog box.

d. Click `Display` and close the `Mesh Display` dialog box.

*The graphics display will be updated to show the mesh. Zoom in with the mouse to obtain the view shown in Figure 19.2: Air-Blast Atomizer Mesh Display (p. 808).*
3. Reorder the mesh using the Mesh menu that is found at the top of the ANSYS Fluent window.

   **Mesh → Reorder → Domain**

   *To speed up the solution procedure, the mesh should be reordered, which will substantially reduce the bandwidth.*

   **ANSYS Fluent will report the progress in the console:**

   Reordering domain using Reverse Cuthill-McKee method:
   
   zones, cells, faces, done.

   Bandwidth reduction = 30882/741 = 41.68

   Done.

4. Retain the default solver settings of pressure-based steady-state solver in the Solver group box.
19.4.4. Specifying the Models

1. Enable heat transfer by enabling the energy equation.

   ![Models → Energy → Edit...](image)

2. Enable the Realizable $k$-$\varepsilon$ turbulence model.

   ![Models → Viscous → Edit...](image)
a. Select **k-epsilon (2 eqn)** in the **Model** list.

b. Select **Realizable** in the **k-epsilon Model** list.

*The Realizable $k-\varepsilon$ model gives a more accurate prediction of the spreading rate of both planar and round jets than the standard $k-\varepsilon$ model.*

c. Retain the default selection of **Standard Wall Functions** in the **Near-Wall Treatment** list.

d. Click **OK** to close the **Viscous Model** dialog box.

3. Enable chemical species transport and reaction.

- **Models** → **Species** → **Edit...**
a. Select **Species Transport** in the **Model** list.

b. Select **methyl-alcohol-air** from the **Mixture Material** drop-down list.

The **Mixture Material** list contains the set of chemical mixtures that exist in the ANSYS Fluent database. When selecting an appropriate mixture for your case, you can review the constituent species and the reactions of the predefined mixture by clicking **View...** next to the **Mixture Material** drop-down list. The chemical species and their physical and thermodynamic properties are defined by the selection of the mixture material. After enabling the **Species Transport** model, you can alter the mixture material selection or modify the mixture material properties using the **Create/Edit Materials** dialog box. You will modify your local copy of the mixture material later in this tutorial.

c. Click **OK** to close the **Species Model** dialog box.

In the console window, ANSYS Fluent lists the properties that are required for the models you have enabled. An **Information** dialog box opens, reminding you to confirm the property values that have been extracted from the database.

d. Click **OK** in the **Information** dialog box to continue.
19.4.5. Materials

1. Remove water vapor and carbon dioxide from the **Mixture Species** list.

   ![Materials](image)

   ![Materials](image) **Mixture** → ![Mixture](image) **Create/Edit...**
a. Click the **Edit** button next to the **Mixture Species** drop-down list to open the **Species** dialog box.

i. Select carbon dioxide (**co2**) from the **Selected Species** selection list.

ii. Click **Remove** to remove carbon dioxide from the **Selected Species** list.
iii. In a similar manner, remove water vapor (\textit{h2o}) from the \textbf{Selected Species} list.

iv. Click \textbf{OK} to close the \textbf{Species} dialog box.

b. Click \textbf{Change/Create} and close the \textbf{Create/Edit Materials} dialog box.

---

\textbf{Note}

It is good practice to click the \textbf{Change/Create} button whenever changes are made to material properties even though it is not necessary in this case.

---

\textbf{19.4.6. Boundary Conditions}

---

1. Set the boundary conditions for the inner air stream (\textit{central_air}).

\quad \textbf{Boundary Conditions} \rightarrow \textit{central_air} \rightarrow \textit{Edit...}
a. Enter 9.167e-5 kg/s for **Mass Flow Rate**.
b. Enter 0 for **X-Component of Flow Direction**.
c. Retain the default value of 0 for **Y-Component of Flow Direction**.
d. Enter 1 for **Z-Component of Flow Direction**.
e. Select **Intensity and Hydraulic Diameter** from the **Specification Method** drop-down list.
f. Enter 10 for **Turbulent Intensity**.
g. Enter 0.0037 m for **Hydraulic Diameter**.
h. Click the **Thermal** tab and enter 293 K for **Total Temperature**.
i. Click the **Species** tab and enter 0.23 for **o2** in the **Species Mass Fractions** group box.
j. Click **OK** to close the **Mass-Flow Inlet** dialog box.

2. Set the boundary conditions for the air stream surrounding the atomizer (**co-flow-air**).
a. Enter 1 m/s for **Velocity Magnitude**.

b. Select **Intensity and Hydraulic Diameter** from the **Specification Method** drop-down list.

c. Retain the default value of 5 for **Turbulent Intensity**.

d. Enter 0.0726 m for **Hydraulic Diameter**.

e. Click the **Thermal** tab and enter 293 K for **Temperature**.

f. Click the **Species** tab and enter 0.23 for **o2** in the **Species Mass Fractions** group box.

g. Click **OK** to close the **Velocity Inlet** dialog box.

3. Set the boundary conditions for the exit boundary (**outlet**).

   1. **Boundary Conditions → outlet → Edit...**
a. Select From Neighboring Cell from the Backflow Direction Specification Method drop-down list.

b. Retain Intensity and Viscosity Ratio from the Specification Method drop-down list.

c. Retain the default value of 5 for Backflow Turbulent Intensity (%).

d. Enter 5 for Backflow Turbulent Viscosity Ratio.

e. Click the Thermal tab and enter 293 K for Backflow Total Temperature.

f. Click the Species tab and enter 0.23 for o2 in the Species Mass Fractions group box.

g. Click OK to close the Pressure Outlet dialog box.

4. Set the boundary conditions for the swirling annular stream (swirling_air).

Boundary Conditions → swirling_air → Edit...
a. Select **Magnitude and Direction** from the **Velocity Specification Method** drop-down list.

b. Enter 19 m/s for **Velocity Magnitude**.

c. Select **Cylindrical (Radial, Tangential, Axial)** from the **Coordinate System** drop-down list.

d. Enter 0 for **Radial-Component of Flow Direction**.

e. Enter 0.7071 for **Tangential-Component of Flow Direction**.

f. Enter 0.7071 for **Axial-Component of Flow Direction**.

g. Select **Intensity and Hydraulic Diameter** from the **Specification Method** drop-down list.

h. Retain the default value of 5 for **Turbulent Intensity**.

i. Enter 0.0043 m for **Hydraulic Diameter**.

j. Click the **Thermal** tab and enter 293 K for **Temperature**.

k. Click the **Species** tab and enter 0.23 for **o2** in the **Species Mass Fractions** group box.

l. Click **OK** to close the **Velocity Inlet** dialog box.
5. Set the boundary conditions for the outer wall of the atomizer (outer-wall).

- **Boundary Conditions → outer-wall → Edit...**

```
5. Set the boundary conditions for the outer wall of the atomizer (outer-wall).

- **Boundary Conditions → outer-wall → Edit...**

  a. Select **Specified Shear** in the **Shear Condition** list.
  b. Retain the default values for the remaining parameters.
  c. Click **OK** to close the **Wall** dialog box.

19.4.7. Initial Solution Without Droplets

*The airflow will first be solved and analyzed without droplets.*

1. Set the solution method.

  - **Solution Methods**
a. Select **Coupled** from the **Scheme** drop-down list in the **Pressure-Velocity Coupling** group box.

b. Retain the default **Second Order Upwind** for **Momentum**.

c. Enable **Pseudo Transient**.

The message appears in the console informing you of changing AMG cycle type for Volume Fraction, Turbulent Kinetic Energy, and Turbulent Dissipation Rate to F-cycle.

2. Retain the default under-relaxation factors.

> **Solution Controls**
3. Enable residual plotting during the calculation.

Monitors → Residuals → Edit...

a. Ensure that Plot is enabled in the Options group box.
b. Click **OK** to close the **Residual Monitors** dialog box.

4. Initialize the flow field.

   ![Solution Initialization](image)

   **Solution Initialization**

   a. Retain the default **Hybrid Initialization** from the **Initialization Methods** group box.

   b. Click **Initialize** to initialize the variables.

   **Note**

   For flows in complex topologies, hybrid initialization will provide better initial velocity and pressure fields than standard initialization. This will help to improve the convergence behavior of the solver.

5. Save the case file (**spray1.cas.gz**).

   **File → Write → Case...**

6. Start the calculation by requesting 150 iterations.

   ![Run Calculation](image)

   **Run Calculation**

   a. Select **User Specified** from the **Time Step Method** group box.

   b. Retain 1 s for **Pseudo Time Step**.

   c. Enter 150 for **Number of Iterations**.

   d. Click **Calculate**.

   *The solution will converge in approximately 110 iterations.*
7. Save the case and data files (spray1.cas.gz and spray1.dat.gz).

**File → Write → Case & Data...**

**Note**

ANSYS Fluent will ask you to confirm that the previous case file is to be overwritten.

8. Create a clip plane to examine the flow field at the midpoint of the atomizer section.

**Surface → Iso-Surface...**
a. Select **Mesh...** and **Angular Coordinate** from the **Surface of Constant** drop-down lists.

b. Click **Compute** to obtain the minimum and maximum values of the angular coordinate.

c. Enter 15 for **Iso-Values**.

d. Enter **angle=15** for **New Surface Name**.

e. Click **Create** to create the isosurface.

f. Close the **Iso-Surface** dialog box.

9. Review the current state of the solution by examining contours of velocity magnitude (Figure 19.4: Velocity Magnitude at Mid-Point of Atomizer Section (p. 826)).

   ![Graphics and Animations ➔ Contours ➔ Set Up...](Image)
a. Enable **Filled** in the **Options** group box

b. Select **Velocity...** and **Velocity Magnitude** from the **Contours of** drop-down lists.

c. Enable **Draw Mesh**.

   *The Mesh Display dialog box will open.*

   i. Retain the current mesh display settings.

   ii. Close the **Mesh Display** dialog box.

d. Select **angle=15** from the **Surfaces** selection list.

e. Click **Display** and close the **Contours** dialog box.

f. Use the mouse to obtain the view shown in **Figure 19.4: Velocity Magnitude at Mid-Point of Atomizer Section** (p. 826).
10. Modify the view to include the entire atomizer.

*Graphics and Animations ➔ Views...*
a. Click the **Define...** button to open the **Graphics Periodicity** dialog box.

![Graphics Periodicity dialog box]

i. Select **fluid** from the **Cell Zones** selection list.

ii. Retain the selection of **Rotational** in the **Periodic Type** list.

iii. Retain the value of 12 for **Number of Reppeats**.

iv. Click **Set** and close the **Graphics Periodicity** dialog box.

*The graphics display will be updated to show the entire atomizer.*

b. Click **Apply** and close the **Views** dialog box.

11. Display pathlines of the air in the swirling annular stream (**Figure 19.5: Pathlines of Air in the Swirling Annular Stream** (p. 829)).
Graphics and Animations → Pathlines → Set Up...

a. Increase the Path Skip value to 5.

b. Select swirling_air from the Release from Surfaces selection list.

   *You will need to scroll down the list to access this item.*

c. Enable Draw Mesh in the Options group box.

   *The Mesh Display dialog box will open.*

   i. Retain the current mesh display settings.

   ii. Close the Mesh Display dialog box.

d. Click Display and close the Pathlines dialog box.

e. Use the mouse to obtain the view shown in Figure 19.5: Pathlines of Air in the Swirling Annular Stream (p. 829).
19.4.8. Create a Spray Injection

1. Define the discrete phase modeling parameters.

![Models → Discrete Phase → Edit...](image)
a. Select **Interaction with Continuous Phase** in the **Interaction** group box.

*This will include the effects of the discrete phase trajectories on the continuous phase.*

b. Retain the value of 10 for **Number of Continuous Phase Iterations per DPM Iteration**.

c. Select **Mean Values** in the **Contour Plots for DPM Variables** group box.

*This will make the cell-averaged variables available for postprocessing activities.*

d. Select the **Unsteady Particle Tracking** option in the **Particle Treatment** group box.

e. Enter 0.0001 for **Particle Time Step Size**.
f. Enter 10 for **Number of Time Steps**.

g. Under the **Tracking** tab, retain the default value of 5 for the **Step Length Factor** tracking option.

h. Under the **Physical Models** tab, select the **Temperature Dependent Latent Heat**.

i. Select the **Breakup** option in the **Options** group box.

j. Under the **Numerics** tab, select **Linearize Source Terms**.

   Enabling this option will allow you to run the simulation with more aggressive setting for the **Discrete Phase Sources** under-relaxation factor to speed up the solution convergence.
k. Click **Injections...** to open the **Injections** dialog box.

In this step, you will define the characteristics of the atomizer.

![Injections Dialog](image)

l. Click the **Create** button to create the spray injection.

![Set Injection Properties](image)

i. In the **Set Injection Properties** dialog box, select **air-blast-atomizer** from the **Injection Type** drop-down list.
ii. Enter 600 for **Number of Particle Streams**.

   *This option controls the number of droplet parcels that are introduced into the domain at every time step.*

iii. Select **Droplet** in the **Particle Type** group box.

iv. Select **methyl-alcohol-liquid** from the **Material** drop-down list.

v. In the **Point Properties** tab, retain the default values of 0 and 0 for **X-Position** and **Y-Position**.

vi. Enter 0.0015 for **Z-Position**.

   *Scroll down the list to see the remaining point properties.*

vii. Retain the default values of 0, 0, and 1 for **X-Axis**, **Y-Axis**, and **Z-Axis**, respectively.

viii. Enter 263 K for **Temperature**.

ix. Enter 8.5e-5 kg/s for **Flow Rate**.

   *This is the methanol flow rate for a 30-degree section of the atomizer. The actual atomizer flow rate is 12 times this value.*

x. Retain the default **Start Time** of 0 s and enter 100 s for the **Stop Time**.

   *For this problem, the injection should begin at \( t = 0 \) and not stop until long after the time period of interest. A large value for the stop time (for example, 100 s) will ensure that the injection will essentially never stop.*

xi. Enter 0.0035 m for the **Injector Inner Diameter** and 0.0045 m for the **Injector Outer Diameter**.

xii. Enter −45 degrees for **Spray Half Angle**.

   *The spray angle is the angle between the liquid sheet trajectory and the injector centerline. In this case, the value is negative because the sheet is initially converging toward the centerline.*

xiii. Enter 82.6 m/s for the **Relative Velocity**.

   *The relative velocity is the expected relative velocity between the atomizing air and the liquid sheet.*

xiv. Retain the default **Azimuthal Start Angle** of 0 degrees and enter 30 degrees for the **Azimuthal Stop Angle**.

   *This will restrict the injection to the 30-degree section of the atomizer that is being modeled.*

xv. Click the **Physical Models** tab to specify the breakup model and drag parameters.
xvi. Ensure that Enable Breakup and TAB are enabled in the Breakup group box.

xvii. Retain the default values of 0 for y0 and 2 for Breakup Parcels in the Breakup Constants group box.

xviii. Select dynamic-drag from the Drag Law drop-down list in the Drag Parameters group box.

   The dynamic-drag law is available only when the Breakup model is used.

xix. Click the Turbulent Dispersion tab to define the turbulent dispersion.
xx. Enable **Discrete Random Walk Model** and **Random Eddy Lifetime** in the **Stochastic Tracking** group box.

*These models will account for the turbulent dispersion of the droplets.*

xxi. Click **OK** to close the **Set Injection Properties** dialog box.

An **Information** dialog box appears reminding you to confirm the property values before continuing. Click **OK** in the **Information** dialog box to continue.

---

**Note**

To modify the existing injection, select its name in the **Injections** list and click **Set...**, or simply double-click the injection of interest.

xxii. Close the **Injections** dialog box.

---

**Note**

In the case that the spray injection would be striking a wall, you should specify the wall boundary conditions for the droplets. Though this tutorial does have wall zones, they are a part of the atomizer apparatus. You need not change the wall boundary conditions any further because these walls are not in the path of the spray droplets.
m. Click OK to close the Discrete Phase Model dialog box.

2. Specify the droplet material properties.

- Materials → methyl-alcohol-liquid → Create/Edit...

When secondary atomization models (such as Breakup) are used, several droplet properties need to be specified.

![Materials dialog box]

- Ensure droplet-particle is selected in the Material Type drop-down list.
- Enter 0.0056 kg/m-s for Viscosity in the Properties group box.
- Ensure that piecewise-linear is selected from the Saturation Vapor Pressure drop-down list.
  
  Scroll down to find the Saturation Vapor Pressure drop-down list.
- Click the Edit... button next to Saturation Vapor Pressure to open the Piecewise-Linear Profile dialog box.
  
  i. Review the default values and click OK to close the Piecewise-Linear Profile dialog box.
- Select convection/diffusion-controlled from the Vaporisation Model drop-down list.
- Click Change/Create to accept the change in properties for the methanol droplet material and close the Create/Edit Materials dialog box.
19.4.9. Solution

1. Increase the under-relaxation factor for Discrete Phase Sources.

\[ \text{Solution Controls} \]

![Solution Controls]

In the Pseudo Transient Explicit Relaxation Factors group box, change the under-relaxation factor for Discrete Phase Sources to 0.9.

2. Remove the convergence criteria.

\[ \text{Monitors} \rightarrow \text{Residuals} \rightarrow \text{Edit...} \]
a. Select **none** from the **Convergence Criterion** drop-down list.

b. Click **OK** to close the **Residual Monitors** dialog box.

3. Enable the plotting of mass fraction of **ch3oh**.

   ![Monitors (Surface Monitors) → Create...](image)
a. Retain surf-mon-1 for Name.

b. Enable Plot.

c. Select Mass-Weighted Average from the Report Type drop-down list.

d. Select Species... and Mass fraction of ch3oh from the Field Variable drop-down lists.

e. Select outlet from the Surfaces selection list.

f. Click OK to close the Surface Monitor dialog box.

4. Enable the plotting of the sum of the DPM Mass Source.

 Elves: Monitors (Volume Monitors) → Create...

![Volume Monitor dialog box]

a. Retain vol-mon-1 for Name.

b. Enable Plot.

c. Click the Axes... button to open the Axes - volume Monitor Plot dialog box.
i. Select Y in the Axis list.

ii. Select exponential from the Type drop-down list.

iii. Set Precision to 2.

iv. Click Apply and close the Axes - volume Monitor Plot dialog box.

d. Select Sum from the Report Type drop-down list.

e. Select Discrete Phase Sources... and DPM Mass Source from the Field Variable drop-down lists.

f. Select fluid from the Cell Zones selection list.

g. Click OK to close the Volume Monitor dialog box.

5. Request 200 more iterations (Figure 19.6: Convergence History of Mass Fraction of ch3oh on Fluid (p. 841) and Figure 19.7: Convergence History of DPM Mass Source on Fluid (p. 841)).

Run Calculation

It can be concluded that the solution is converged because the number of particle tracks are constant and the monitors are flat.
Figure 19.6: Convergence History of Mass Fraction of ch3oh on Fluid

Convergence history of Mass fraction of ch3oh on outlet

ANSYS Fluent (3d, pbns, spa, rke)

Figure 19.7: Convergence History of DPM Mass Source on Fluid

Convergence history of DPM Mass Source on fluid

ANSYS Fluent (3d, pbns, spa, rke)

6. Save the case and data files (spray2.cas.gz and spray2.dat.gz).
19.4.10. Postprocessing

1. Display the trajectories of the droplets in the spray injection (Figure 19.8: Particle Tracks for the Spray Injection (p. 843)).

   This will allow you to review the location of the droplets.

   ![Particle Tracks](image)

   a. Enable **Draw Mesh** in the **Options** group box.

      The **Mesh Display** dialog box will open.

      i. Retain the current display settings.

      ii. Close the **Mesh Display** dialog box.

   b. Retain the default selection of **point** from the **Track Style** drop-down list.

   c. Select **Particle Variables...** and **Particle Diameter** from the **Color by** drop-down lists.

      This will display the location of the droplets colored by their diameters.

   d. Select **injection-0** from the **Release from Injections** selection list.

   e. Click **Display**. As an optional exercise, you can increase the particle size by clicking the **Attributes...** button in the **Particle Tracks** dialog box and adjusting the **Marker Size** value in the **Track Style Attributes** dialog box.
f. Close the **Particle Tracks** dialog box.

g. Restore the 30-degree section to obtain the view as shown in **Figure 19.8: Particle Tracks for the Spray Injection (p. 843)**.

**Graphics and Animations → Views...**

i. Click the **Define** button to open **Graphics Periodicity** dialog box.

ii. Click **Reset** and close the **Graphics Periodicity** dialog box.

iii. Close the **Views** dialog box.

h. Use the mouse to obtain the view shown in **Figure 19.8: Particle Tracks for the Spray Injection (p. 843)**.

**Figure 19.8: Particle Tracks for the Spray Injection**

---

*The air-blast atomizer model assumes that a cylindrical liquid sheet exits the atomizer, which then disintegrates into ligaments and droplets. Appropriately, the model determines that the droplets should be*
input into the domain in a ring. The radius of this disk is determined from the inner and outer radii of the injector.

**Note**

The maximum diameter of the droplets is about $10^{-4}$ m or 0.1 mm. This is slightly smaller than the film height. The inner diameter and outer diameter of the injector are 3.5 mm and 4.5 mm, respectively. Hence the film height is 0.5 mm. The range in the droplet sizes is due to the fact that the air-blast atomizer automatically uses a distribution of droplet sizes.

Also note that the droplets are placed a slight distance away from the injector. Once the droplets are injected into the domain, their behavior will be determined by secondary models. For instance, they may collide/coalesce with other droplets depending on the secondary models employed. However, once a droplet has been introduced into the domain, the air-blast atomizer model no longer affects the droplet.

---

2. Display the mean particle temperature field (Figure 19.9: Contours of DPM Temperature (p. 845)).

- **Graphics and Animations → Contours → Set Up...**

  ![Contour Settings](image)

  a. Ensure that **Filled** is enabled in the **Options** group box

  b. Disable **Draw Mesh**.

  c. Select **Discrete Phase Variables...** and **DPM Temperature** from the **Contours of** drop-down lists.
d. Disable **Auto Range**.

*The Clip to Range option will automatically be enabled.*

e. Click **Compute** to update the **Min** and **Max** fields.

f. Enter 2.60 for **Min**.

g. Select **angle=15** from the **Surfaces** selection list.

h. Click **Display** and close the **Contours** dialog box.

i. Use the mouse to obtain the view shown in Figure 19.9: Contours of DPM Temperature (p. 845).

**Figure 19.9: Contours of DPM Temperature**

3. Display the mean Sauter diameter (**Figure 19.10: Contours of DPM Sauter Diameter** (p. 846)).

![Contours of DPM Temperature](image_url)
Modeling Evaporating Liquid Spray

a. Enable **Filled** in the **Options** group box.

b. Select **Discrete Phase Variables...** and **DPM Mean Sauter Diam** from the **Contours of** drop-down lists.

c. Select **angle=15** from the **Surfaces** selection list.

d. Click **Display** and close the **Contours** dialog box.

**Figure 19.10: Contours of DPM Sauter Diameter**

4. Display vectors of DPM mean velocity colored by DPM velocity magnitude (Figure 19.11: *Vectors of DPM Mean Velocity Colored by DPM Velocity Magnitude* (p. 848)).

[Diagram showing contours of DPM Mean Sauter Diameter]
a. Select **dpm-mean-velocity** from the **Vectors of** drop-down lists.

b. Select **Discrete Phase Variables**... and **DPM Velocity Magnitude** from the **Color by** drop-down lists.

c. Enter 7 for **Scale**.

d. Select **angle=15** from the **Surfaces** selection list.

e. Click **Display** and close the **Contours** dialog box.
5. Create an isosurface of the methanol mass fraction.

\[ \text{Surface} \rightarrow \text{Iso-Surface} \ldots \]
a. Select **Species...** and **Mass fraction of ch3oh** from the **Surface of Constant** drop-down lists.

b. Click **Compute** to update the minimum and maximum values.

c. Enter 0.002 for **Iso-Values**.

d. Enter methanol-mf=0.002 for the **New Surface Name**.

e. Click **Create** and then close the **Iso-Surface** dialog box.

6. Display the isosurface you just created (methanol-mf=0.002).

**General → Display...**
a. Deselect **atomizer-wall** and select **methanol-mf=0.002** in the **Surfaces** selection list.

b. Click the **Colors...** button to open the **Mesh Colors** dialog box.

![Mesh Colors dialog box]

i. Select **surface** in the **Types** list and **green** in the **Colors** list.

> Scroll down the **Types** list to locate **surface**. The isosurface will now be displayed in green, which contrasts better with the rest of the mesh.

ii. Close the **Mesh Colors** dialog box.

c. Click **Display** in the **Mesh Display** dialog box.

> The graphics display will be updated to show the isosurface.

7. Modify the view to include the entire atomizer.

Graphics and Animations → Views...

a. Click **Define...** to open the **Graphics Periodicity** dialog box.
i. Select **fluid** from the **Cell Zones** list.

ii. Ensure that **Rotational** is selected from the **Periodic Type** list and the **Number of Repeats** is set to 12.

iii. Click **Set** and close the **Graphics Periodicity** dialog box.

b. Click **Apply** and close the **Views** dialog box.

c. Click **Display** and close the **Mesh Display** dialog box.

d. Use the mouse to obtain the view shown in **Figure 19.12: Full Atomizer Display with Surface of Constant Methanol Mass Fraction** (p. 852).
**Figure 19.12: Full Atomizer Display with Surface of Constant Methanol Mass Fraction**

Mesh

ANSYS Fluent (3d, pbns, spe, rke)

e. This view can be improved to resemble **Figure 19.13: Atomizer Display with Surface of Constant Methanol Mass Fraction Enhanced (p. 853)** by changing some of the following variables:

- Disable **Edges** in the **Mesh Display** dialog box
- Select only `atomizer-wall` and `methanol-mf=0.002` in the **Surfaces** list of the **Mesh Display** dialog box
- Change the **Number of Repeats** to 6 in the **Graphics Periodicity** dialog box
- Change **Lighting Method** to **Flat** in the **Lights** dialog box
- Check the **Headlight On** check box in the **Lights** dialog box
8. Save the case and data files (`spray3.cas.gz` and `spray3.dat.gz`).

   File → Write → Case & Data...

**19.5. Summary**

In this tutorial, a spray injection was defined for an air-blast atomizer and the solution was calculated using the discrete phase model in ANSYS Fluent. The location of methanol droplet particles after exiting the atomizer and an isosurface of the methanol mass fraction were examined.

**19.6. Further Improvements**

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh.
Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 20: Using the VOF Model

This tutorial is divided into the following sections:

20.1. Introduction
20.2. Prerequisites
20.3. Problem Description
20.4. Setup and Solution
20.5. Summary
20.6. Further Improvements

20.1. Introduction

This tutorial examines the flow of ink as it is ejected from the nozzle of a printhead in an inkjet printer. Using ANSYS Fluent's volume of fluid (VOF) multiphase modeling capability, you will be able to predict the shape and motion of the resulting droplets in an air chamber.

This tutorial demonstrates how to do the following:

• Set up and solve a transient problem using the pressure-based solver and VOF model.

• Copy material from the property database.

• Define time-dependent boundary conditions with a user-defined function (UDF).

• Patch initial conditions in a subset of the domain.

• Automatically save data files at defined points during the solution.

• Examine the flow and interface of the two fluids using volume fraction contours.

20.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.
20.3. Problem Description

The problem considers the transient tracking of a liquid-gas interface in the geometry shown in Figure 20.1: Schematic of the Problem (p. 856). The axial symmetry of the problem enables a 2D geometry to be used. The computation mesh consists of 24,600 cells. The domain consists of two regions: an ink chamber and an air chamber. The dimensions are summarized in Table 20.1: Ink Chamber Dimensions (p. 856).

Figure 20.1: Schematic of the Problem

![Schematic of the Problem](image)

Table 20.1: Ink Chamber Dimensions

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink Chamber, Cylindrical Region: Radius (mm)</td>
<td>0.015</td>
</tr>
<tr>
<td>Ink Chamber, Cylindrical Region: Length (mm)</td>
<td>0.050</td>
</tr>
<tr>
<td>Ink Chamber, Tapered Region: Final Radius (mm)</td>
<td>0.009</td>
</tr>
</tbody>
</table>

properties of ink
- density = 998.2 kg/m³
- viscosity = 0.001003 kg/m·s

properties of air
- density = 1.225 kg/m³
- viscosity = 1.7894e-5 kg/m·s
The following is the chronology of events modeled in this simulation:

- At time zero, the nozzle is filled with ink, while the rest of the domain is filled with air. Both fluids are assumed to be at rest. To initiate the ejection, the ink velocity at the inlet boundary (which is modeled in this simulation by a user-defined function) suddenly increases from 0 to 3.58 m/s and then decreases according to a cosine law.

- After 10 microseconds, the velocity returns to zero.

The calculation is run for 30 microseconds overall, that is, three times longer than the duration of the initial impulse.

Because the dimensions are small, the double-precision version of ANSYS Fluent will be used. Air will be designated as the primary phase, and ink (which will be modeled with the properties of liquid water) will be designated as the secondary phase. Patching will be required to fill the ink chamber with the secondary phase. Gravity will not be included in the simulation. To capture the capillary effect of the ejected ink, the surface tension and prescription of the wetting angle will be specified. The surface inside the nozzle will be modeled as neutrally wettable, while the surface surrounding the nozzle orifice will be non-wettable.

### 20.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

- **20.4.1. Preparation**
- **20.4.2. Reading and Manipulating the Mesh**
- **20.4.3. General Settings**
- **20.4.4. Models**
- **20.4.5. Materials**
- **20.4.6. Phases**
- **20.4.7. Operating Conditions**
- **20.4.8. User-Defined Function (UDF)**
- **20.4.9. Boundary Conditions**
- **20.4.10. Solution**
- **20.4.11. Postprocessing**

### 20.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.
2. Go to the ANSYS Customer Portal, [https://support.ansys.com/training](https://support.ansys.com/training).

---

**Note**

If you do not have a login, you can request one by clicking **Customer Registration** on the log in page.
Using the VOF Model

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   a. Click **ANSYS Fluent** under **Product**.
   b. Click **15.0** under **Version**.

5. Select this tutorial from the list.

6. Click **Files** to download the input and solution files.

7. Unzip **vof_R150.zip** file you downloaded to your working folder.
   
   The files **inkjet.msh** and **inlet1.c** can be found in the **vof** directory created on unzipping the file.

8. Use Fluent Launcher to start the **2D** version of ANSYS Fluent.

    Fluent Launcher displays your **Display Options** preferences from the previous session.

9. Ensure that the **Display Mesh After Reading**, **Embed Graphics Windows**, and **Workbench Color Scheme** options are enabled.

10. Enable **Double-Precision**.

    For more information about Fluent Launcher, see **Starting ANSYS Fluent Using Fluent Launcher in the Fluent Getting Started Guide**.

    **Note**

    The double precision solver is recommended for modeling multiphase flows simulation.

11. Ensure that the **Serial** processing option is selected.

20.4.2. Reading and Manipulating the Mesh

1. Read the mesh file **inkjet.msh**.

    **File → Read → Mesh..**

    A warning message will be displayed twice in the console. You need not take any action at this point, as the issue will be resolved when you define the solver settings in **General Settings (p. 863)**.

2. Examine the mesh (Figure 20.2: Default Display of the Nozzle Mesh (p. 859)).
Figure 20.2: Default Display of the Nozzle Mesh

Extra

By zooming in with the middle mouse button, you can see that the interior of the model is composed of a fine mesh of quadrilateral cells (see Figure 20.3: The Quadrilateral Mesh (p. 860)).
3. Set graphics display options

anchor Graphics and Animations ➔ Options...
a. Select **All** from the **Animation Option** drop-down list.

*Selecting All will allow you to see the movement of the entire mesh as you manipulate the Camera view in the next step.*

4. Click **Apply** and close the **Display Options** dialog box.

5. Manipulate the mesh display to show the full chamber upright.

✿ **Graphics and Animations → Views...**
Using the VOF Model

a. Select **front** from the **Views** selection list.

b. Select **axis** from the **Mirror Planes** selection list.

c. Click **Apply**.

   *The mesh display is updated to show both sides of the chamber.*

d. Click the **Camera...** button to open the **Camera Parameters** dialog box.

![Camera Parameters Dialog Box]

**Note**

You may notice that the scale of the dimensions in the Camera Parameters dialog box appear very large given the problem dimensions. This is because you have not yet scaled the mesh to the correct units. You will do this in a later step.

i. Drag the indicator of the dial with the left mouse button in the clockwise direction until the upright view is displayed (*Figure 20.4: Mesh Display of the Nozzle Mirrored and Upright (p. 863)*).
ii. Close the Camera Parameters dialog box.

e. Close the Views dialog box.

### 20.4.3. General Settings

1. Check the mesh.

   **General → Check**

   *ANSYS Fluent will perform various checks on the mesh and report the progress in the console. Make sure that the reported minimum volume is a positive number.*

2. Scale the mesh.

   **General → Scale...**
a. Select **Specify Scaling Factors** from the **Scaling** group box.

b. Enter $1e^{-6}$ for X and Y in the **Scaling Factors** group box.

c. Click **Scale** and close the **Scale Mesh** dialog box.

3. Check the mesh.

   ![Scale Mesh dialog box](image)

   **General ➔ Check**

   **Note**

   It is a good idea to check the mesh after you manipulate it (that is, scale, convert to polyhedra, merge, separate, fuse, add zones, or smooth and swap.) This will ensure that the quality of the mesh has not been compromised.

4. Define the units for the mesh.

   ![Units dialog box](image)

   **General ➔ Units...**
a. Select **length** from the **Quantities** list.

b. Select **mm** from the **Units** list.

c. Select **surface-tension** from the **Quantities** list.

d. Select **dyn/cm** from the **Units** list.

e. Close the **Set Units** dialog box.

5. Retain the default setting of **Pressure-Based** in the **Solver** group box.

   ![Set Units dialog box](image)

   6. Select **Transient** from the **Time** list.
7. Select **Axisymmetric** from the **2D Space** list.

### 20.4.4. Models

1. Enable the **Volume of Fluid** multiphase model.

   **Models → Multiphase → Edit...**

   ![Multiphase Model dialog box](image)

   a. Select **Volume of Fluid** from the **Model** list.

      *The Multiphase Model dialog box expands to show related inputs.*

   b. Retain the default settings and click **OK** to close the **Multiphase Model** dialog box.

### 20.4.5. Materials

*The default properties of air and water defined in ANSYS Fluent are suitable for this problem. In this step, you will make sure that both materials are available for selection in later steps.*

1. Add water to the list of fluid materials by copying it from the ANSYS Fluent materials database.

   **Materials → air → Create/Edit...**
a. Click **Fluent Database**... in the **Create/Edit Materials** dialog box to open the **Fluent Database Materials** dialog box.
i. Select **water-liquid (h2o < l >)** from the **Fluent Fluid Materials** selection list.

   *Scroll down the **Fluent Fluid Materials** list to locate **water-liquid (h2o < l >)**.*

ii. Click **Copy** to copy the information for water to your list of fluid materials.

iii. Close the **Fluent Database Materials** dialog box.

b. Click **Change/Create** and close the **Create/Edit Materials** dialog box.

### 20.4.6. Phases

In the following steps, you will define water as the secondary phase. When you define the initial solution, you will patch water in the nozzle region. In general, you can specify the primary and secondary phases whichever way you prefer. It is a good idea to consider how your choice will affect the ease of problem setup, especially with more complicated problems.
1. Specify air (air) as the primary phase.

   Phases → phase-1 - Primary Phase → Edit...

   a. Enter air for Name.

   b. Retain the default selection of air in the Phase Material drop-down list.

   c. Click OK to close the Primary Phase dialog box.

2. Specify water (water-liquid) as the secondary phase.

   Phases → phase-2 - Secondary Phase → Edit...
Using the VOF Model

1. Set the operating reference pressure location.

20.4.7 Operating Conditions
Boundary Conditions → Operating Conditions...

You will set the Reference Pressure Location to be a point where the fluid will always be 100% air.

a. Enter 0.10 mm for X.

b. Enter 0.03 mm for Y.

c. Click OK to close the Operating Conditions dialog box.

20.4.8. User-Defined Function (UDF)

1. Interpret the UDF source file for the ink velocity distribution (inlet1.c).

   Define → User-Defined → Functions → Interpreted...

   a. Enter inlet1.c for Source File Name.

   If the UDF source file is not in your working directory, then you must enter the entire directory path for Source File Name instead of just entering the file name. Alternatively, click the Browse... button and select inlet1.c in the vof directory that was created after you unzipped the original file.
b. Click **Interpret**.

The UDF defined in inlet1.c is now visible and available for selection as **udf membrane_speed** in the drop-down lists of relevant graphical user interface dialog boxes.

c. Close the **Interpreted UDFs** dialog box.

### 20.4.9. Boundary Conditions

1. Set the boundary conditions at the inlet (**inlet**) for the mixture by selecting **mixture** from the **Phase** drop-down list in the **Boundary Conditions** task page.

   ![Boundary Conditions](image)

   a. Select **udf membrane_speed** from the **Velocity Magnitude** drop-down list.

   b. Click **OK** to close the **Velocity Inlet** dialog box.

2. Set the boundary conditions at the inlet (**inlet**) for the secondary phase by selecting **water-liquid** from the **Phase** drop-down list in the **Boundary Conditions** task page.

   ![Boundary Conditions](image)
Setup and Solution

a. Click the **Multiphase** tab and enter 1 for the **Volume Fraction**.

b. Click **OK** to close the **Velocity Inlet** dialog box.

3. Set the boundary conditions at the outlet (**outlet**) for the secondary phase by selecting **water-liquid** from the **Phase** drop-down list in the **Boundary Conditions** task page.

    🎯 Boundary Conditions → outlet → Edit...

    ![Boundary Conditions dialog box](image)

    a. Click the **Multiphase** tab and retain the default setting of 0 for the **Backflow Volume Fraction**.

    b. Click **OK** to close the **Pressure Outlet** dialog box.

4. Set the conditions at the top wall of the air chamber (**wall_no_wet**) for the mixture by selecting **mixture** from the **Phase** drop-down list in the **Boundary Conditions** task page.

    🎯 Boundary Conditions → wall_no_wet → Edit...
a. Enter 175 degrees for **Contact Angles**.

b. Click **OK** to close the **Wall** dialog box.

---

**Note**

This angle affects the dynamics of droplet formation. You can repeat this simulation to find out how the result changes when the wall is hydrophilic (that is, using a small contact angle, say 10 degrees).

---

5. Set the conditions at the side wall of the ink chamber (**wall_wet**) for the mixture.

   ![Boundary Conditions → wall_wet → Edit...](image_url)
a. Retain the default setting of 90 degrees for Contact Angles.

b. Click OK to close the Wall dialog box.

20.4.10. Solution

1. Set the solution methods.

Solution Methods
a. Enable Non-Iterative Time Advancement.

The non-iterative time advancement (NITA) scheme is often advantageous compared to the iterative schemes as it is less CPU intensive. Although smaller time steps must be used with NITA compared to the iterative schemes, the total CPU expense is often smaller. If the NITA scheme leads to convergence difficulties, then the iterative schemes (for example, PISO, SIMPLE) should be used instead.

b. Select Fractional Step from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

c. Retain the default selection of Least Squares Cell Based from the Gradient drop-down list in the Spatial Discretization group box.

d. Retain the default selection of PRESTO! from the Pressure drop-down list.

e. Select QUICK from the Momentum drop-down list.

f. Select Compressive from the Volume-Fraction drop-down list.

2. Enable the plotting of residuals during the calculation.

Monitors → Residuals → Edit...
a. Ensure **Plot** is selected in the **Options** group box.

b. Click **OK** to close the **Residual Monitors** dialog box.

3. Initialize the solution using the default initial values.

**Solution Initialization**
a. Retain the default settings for all the parameters and click **Initialize**.

4. Define a register for the ink chamber region.

   **Adapt → Region...**
a. Retain the default setting of 0 mm for X Min and Y Min in the Input Coordinates group box.

b. Enter 0.10 mm for X Max.

c. Enter 0.03 mm for Y Max.

d. Click Mark.

    ANSYS Fluent will report in the console that 1500 cells were marked for refinement while zero cells were marked for coarsening.

    **Extra**

    You can display and manipulate adaption registers, which are generated using the Mark command, using the Manage Adaption Registers dialog box. Click the Manage... button in the Region Adaption dialog box to open the Manage Adaption Registers dialog box. For details, see Adapting the Mesh (p. 175).

e. Close the Region Adaption dialog box.

5. Patch the initial distribution of the secondary phase (water-liquid).

    Solution Initialization → Patch...
a. Select **water-liquid** from the **Phase** drop-down list.

b. Select **Volume Fraction** from the **Variable** list.

c. Enter 1 for **Value**.

d. Select **hexahedron-r0** from the **Registers to Patch** selection list.

e. Click **Patch** and close the **Patch** dialog box.

6. Request the saving of data files every 200 steps.

   ![Calculation Activities (Autosave Every (Time Steps))] → Edit....
a. Enter 200 for **Save Data File Every (Time Steps)**.

b. Ensure that **time-step** is selected from the **Append File Name with** drop-down list.

c. Enter **inkjet** for the **File Name**.

   ANSYS Fluent will append the time step value to the file name prefix (**inkjet**). The standard **.dat** extension will also be appended. This will yield file names of the form **inkjet-1-00200.dat**, where 200 is the time step number.

   Optionally, you can add the extension **.gz** to the end of the file name (for example, **inkjet.gz**), which instructs ANSYS Fluent to save the data files in a compressed format, yielding file names of the form **inkjet-1-00200.dat.gz**.

d. Click **OK** to close the **Autosave** dialog box.

7. Save the initial case file (**inkjet.cas.gz**).

   **File → Write → Case...**

8. Run the calculation.

   ✎ **Run Calculation**
a. Enter \(1.0 \times 10^{-8}\) seconds for the **Time Step Size (s)**.

**Note**

Small time steps are required to capture the oscillation of the droplet interface and the associated high velocities. Failure to use sufficiently small time steps may cause differences in the results between platforms.

b. Enter 3000 for the **Number of Time Steps**.

c. Retain the default selection of **Fixed** in the **Time Stepping Method** drop-down list.

d. Click **Calculate**.

*The solution will run for 3000 iterations.*

### 20.4.11. Postprocessing

1. Read the data file for the solution after 6 microseconds (**inkjet-1-00600.dat.gz**).

   File → Read → Data...
2. Display filled contours of water volume fraction after 6 microseconds (Figure 20.5: Contours of Water Volume Fraction After 6 µs (p. 884)).

Graphics and Animations → Contours → Set Up...

- Enable Filled in the Options group box.
- Select Phases... and Volume fraction from the Contours of drop-down lists.
- Select water-liquid from the Phase drop-down list.
- Click Display.

Tip

In order to display the contour plot in the graphics window, you may need to click the Fit to Window button.

3. Similarly, display contours of water volume fraction after 12, 18, 24, and 30 microseconds (Figure 20.6: Contours of Water Volume Fraction After 12 µs (p. 885) — Figure 20.9: Contours of Water Volume Fraction After 30 µs (p. 888)).
Figure 20.5: Contours of Water Volume Fraction After 6 µs

Contours of Volume fraction (water-liquid) (Time=6.0000e-06)
ANSYS Fluent (axi, dp, pbns, vof, lam, transient)
Figure 20.6: Contours of Water Volume Fraction After 12 µs

Contours of Volume fraction (water-liquid) (Time=1.2000e-05)
ANSYS Fluent (axi, dp, pbns, vof, lam, transient)
Using the VOF Model

Figure 20.7: Contours of Water Volume Fraction After 18 µs

Contours of Volume fraction (water-liquid) (Time=1.8000e-05)
ANSYS Fluent (axi, dp, pbns, vof, lam, transient)
Figure 20.8: Contours of Water Volume Fraction After 24 µs

Contours of Volume fraction (water-liquid) (Time=2.4000e-05)
ANSYS Fluent (axi, dp, pbns, vof, lam, transient)
20.5. Summary

This tutorial demonstrated the application of the volume of fluid method with surface tension effects. The problem involved the 2D axisymmetric modeling of a transient liquid-gas interface, and postprocessing showed how the position and shape of the surface between the two immiscible fluids changed over time.

For additional details about VOF multiphase flow modeling, see Volume of Fluid (VOF) Model Theory of the Theory Guide.

20.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh.
Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in *Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow* (p. 123).
Chapter 21: Modeling Cavitation

This tutorial is divided into the following sections:

21.1. Introduction
21.2. Prerequisites
21.3. Problem Description
21.4. Setup and Solution
21.5. Summary
21.6. Further Improvements

21.1. Introduction

This tutorial examines the pressure-driven cavitating flow of water through a sharp-edged orifice. This is a typical configuration in fuel injectors, and brings a challenge to the physics and numerics of cavitation models because of the high pressure differentials involved and the high ratio of liquid to vapor density. Using the multiphase modeling capability of ANSYS Fluent, you will be able to predict the strong cavitation near the orifice after flow separation at a sharp edge.

This tutorial demonstrates how to do the following:

• Set boundary conditions for internal flow.
• Use the mixture model with cavitation effects.
• Calculate a solution using the pressure-based coupled solver.

21.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.

21.3. Problem Description

The problem considers the cavitation caused by the flow separation after a sharp-edged orifice. The flow is pressure driven, with an inlet pressure of $5 \times 10^5$ Pa and an outlet pressure of $9.5 \times 10^4$ Pa. The orifice diameter is $4 \times 10^{-3}$ m, and the geometrical parameters of the orifice are $D/d = 2.88$ and $L/d =$
4, where \( D \), \( d \), and \( L \) are the inlet diameter, orifice diameter, and orifice length respectively. The geometry of the orifice is shown in Figure 21.1: Problem Schematic (p. 892).

**Figure 21.1: Problem Schematic**

![Problem Schematic](image)

21.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
- 21.4.1. Preparation
- 21.4.2. Reading and Checking the Mesh
- 21.4.3. General Settings
- 21.4.4. Models
- 21.4.5. Materials
- 21.4.6. Phases
- 21.4.7. Boundary Conditions
- 21.4.8. Operating Conditions
- 21.4.9. Solution
- 21.4.10. Postprocessing

### 21.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.
2. Go to the ANSYS Customer Portal, [https://support.ansys.com/training](https://support.ansys.com/training).

   **Note**

   If you do not have a login, you can request one by clicking **Customer Registration** on the log in page.

3. Enter the name of this tutorial into the search bar.
4. Narrow the results by using the filter on the left side of the page.
   a. Click **ANSYS Fluent** under **Product**.
   b. Click **15.0** under **Version**.
5. Select this tutorial from the list.
6. Click **Files** to download the input and solution files.

7. Unzip the **cavitation_R150.zip** file you downloaded to your working folder.
   
   *The mesh file **cav.msh** can be found in the **cavitation** directory created after unzipping the file.*

8. Use the Fluent Launcher to start the **2D** version of ANSYS Fluent.

   Fluent Launcher displays your **Display Options** preferences from the previous session.

   For more information about Fluent Launcher, see [Starting ANSYS Fluent Using Fluent Launcher](#) in the User’s Guide.

9. Ensure that the **Display Mesh After Reading, Embed Graphics Windows**, and **Workbench Color Scheme** options are enabled.

10. Ensure that the **Serial** processing option is selected.

11. Enable **Double Precision**.

    **Note**

    The double precision solver is recommended for modeling multiphase flows simulation.

### 21.4.2. Reading and Checking the Mesh

1. Read the mesh file **cav.msh**.

   **File → Read → Mesh...**

   *As ANSYS Fluent reads the mesh file, it will report the progress in the console. You can disregard the warnings about the use of axis boundary conditions, as you will make the appropriate change to the solver settings in the next step.*

2. Check the mesh.

   **General → Check**

   *ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure that the reported minimum volume is a positive number.*

3. Check the mesh scale.

   **General → Scale...**
a. Retain the default settings.

b. Close the Scale Mesh dialog box.

4. Examine the mesh (Figure 21.2: The Mesh in the Orifice (p. 895)).
As seen in Figure 21.2: The Mesh in the Orifice (p. 895), half of the problem geometry is modeled, with an axis boundary (consisting of two separate lines) at the centerline. The quadrilateral mesh is slightly graded in the plenum to be finer toward the orifice. In the orifice, the mesh is uniform with aspect ratios close to 1, as the flow is expected to exhibit two-dimensional gradients.

When you display data graphically in a later step, you will mirror the view across the centerline to obtain a more realistic view of the model.

Since the bubbles are small and the flow is high speed, gravity effects can be neglected and the problem can be reduced to axisymmetrical. If gravity could not be neglected and the direction of gravity were not coincident with the geometrical axis of symmetry, you would have to solve a 3D problem.

**21.4.3. General Settings**

1. Specify an axisymmetric model.
General

- Retain the default selection of **Pressure-Based** in the **Type** list.

  *The pressure-based solver must be used for multiphase calculations.*

- Select **Axisymmetric** in the **2D Space** list.

**Note**

A computationally intensive, transient calculation is necessary to accurately simulate the irregular cyclic process of bubble formation, growth, filling by water jet re-entry, and break-off. In this tutorial, you will perform a steady-state calculation to simulate the presence of vapor in the separation region in the time-averaged flow.

### 21.4.4. Models

1. Enable the multiphase mixture model.

   *Models → Multiphase → Edit...*
a. Select **Mixture** in the **Model** list.

   *The Multiphase Model dialog box will expand.*

b. Clear **Slip Velocity** in the **Mixture Parameters** group box.

   *In this flow, the high level of turbulence does not allow large bubble growth, so gravity is not important. Therefore, there is no need to solve for the slip velocity.*

c. Click **OK** to close the **Multiphase Model** dialog box.

2. Enable the realizable $k$-$\varepsilon$ turbulence model with standard wall functions.

   *Models → Viscous → Edit...*
21.4.5. Materials

1. Create a new material to be used for the primary phase.

   Materials → Fluid → Create/Edit...
a. Enter water for Name.

b. Enter 1000 kg/m³ for Density.

c. Enter 0.001 kg/m–s for Viscosity.

d. Click Change/Create.

A Question dialog box will open, asking if you want to overwrite air. Click Yes.

2. Copy water vapor from the materials database and modify the properties of your local copy.

a. In the Create/Edit Materials dialog box, click the Fluent Database... button to open the Fluent Database Materials dialog box.
i. Select **water-vapor (h2o)** from the **Fluent Fluid Materials** selection list.

   *Scroll down the list to find **water-vapor (h2o)**.*

ii. Click **Copy** to include water vapor in your model.

   **water-vapor** appears under **Fluid** in the **Materials** task page

iii. Close the **Fluent Database Materials** dialog box.
b. Enter $0.02558 \text{ kg/m}^3$ for **Density**.

c. Enter $1.26e-06 \text{ kg/m} - \text{s}$ for **Viscosity**.

d. Click **Change/Create** and close the **Create/Edit Materials** dialog box.

### 21.4.6. Phases
1. Specify liquid water as the primary phase.

   Phases → phase-1 → Edit...

   a. Enter liquid for Name.
   b. Retain the default selection of water from the Phase Material drop-down list.
   c. Click OK to close the Primary Phase dialog box.

2. Specify water vapor as the secondary phase.

   Phases → phase-2 → Edit...
a. Enter *vapor* for **Name**.

b. Select *water-vapor* from the **Phase Material** drop-down list.

c. Click **OK** to close the **Secondary Phase** dialog box.

3. Enable the cavitation model.

   ☀ **Phases → Interaction...**

   a. Click the **Mass** tab.

      The dialog box expands to show relevant modeling parameters.

      i. Set **Number of Mass Transfer Mechanisms** to 1.

         *Click OK in the dialog box that appears to inform you that Linearized-Mass-Transfer UDF is on.*

      ii. Ensure that **liquid** is selected from the **From Phase** drop-down list in the **Mass Transfer** group box.

      iii. Select **vapor** from the **To Phase** drop-down list.

      iv. Select **cavitation** from the **Mechanism** drop-down list.

         *The Cavitation Model dialog box will open to show the cavitation inputs.*
A. Retain the default settings.

B. Retain the value of 3540 Pa for **Vaporization Pressure**.
   
   The vaporization pressure is a property of the working liquid, which depends mainly on the liquid temperature. The default value is the vaporization pressure of water at a temperature of 300 K.

C. Click **OK** to close the Cavitation Model dialog box.

b. Click **OK** to close the Phase Interaction dialog box.

### 21.4.7. Boundary Conditions

For the multiphase mixture model, you will specify conditions for the mixture (that is, conditions that apply to all phases) and the conditions that are specific to the primary and secondary phases. In this tutorial, boundary conditions are required only for the mixture and secondary phase of two boundaries: the pressure inlet (consisting of two boundary zones) and the pressure outlet. The pressure outlet is the downstream boundary, opposite the pressure inlets.
1. Set the boundary conditions at **inlet_1** for the mixture. Ensure that **mixture** is selected from the **Phase** drop-down list in the **Boundary Conditions** task page.

   ![Boundary Conditions](image)

   ![Boundary Conditions](image)
a. Select vapor from the Phase drop-down list.

b. Enter 500000 Pa for Gauge Total Pressure.

c. Enter 449000 Pa.

If you choose to initialize the solution based on the pressure-inlet conditions, the Supersonic/Initial Gauge Pressure will be used in conjunction with the specified stagnation pressure (the Gauge Total Pressure) to compute initial values according to the isentropic relations (for compressible flow) or Bernoulli’s equation (for incompressible flow). Otherwise, in an incompressible flow calculation, ANSYS Fluent will ignore the Supersonic/Initial Gauge Pressure input.

d. Retain the default selection of Normal to Boundary from the Direction Specification Method drop-down list.

e. Select K and Epsilon from the Specification Method drop-down list in the Turbulence group box.

f. Enter 0.02 m²/s² for Turbulent Kinetic Energy.

g. Retain the value of 1 m²/s³ for Turbulent Dissipation Rate.

h. Click OK to close the Pressure Inlet dialog box.

2. Set the boundary conditions at inlet-1 for the secondary phase.

   ![Boundary Conditions](inlet_1)

   a. Select vapor from the Phase drop-down list.

   b. Click Edit... to open the Pressure Inlet dialog box.
i. Click the **Multiphase** tab and retain the default value of 0 for **Volume Fraction**.

ii. Click **OK** to close the **Pressure Inlet** dialog box.

3. Copy the boundary conditions defined for the first pressure inlet zone (inlet_1) to the second pressure inlet zone (inlet_2).

   ![Boundary Conditions](inlet_1)

   a. Select **mixture** from the **Phase** drop-down list.

   b. Click **Copy...** to open the **Copy Conditions** dialog box.

   ![Copy Conditions](inlet_1)

   i. Select **inlet_1** from the **From Boundary Zone** selection list.

   ii. Select **inlet_2** from the **To Boundary Zones** selection list.

   iii. Click **Copy**.

     A **Question** dialog box will open, asking if you want to copy **inlet_1** boundary conditions to **inlet_2**. Click **OK**.
iv. Close the Copy Conditions dialog box.

4. Set the boundary conditions at outlet for the mixture.

   ![Boundary Conditions](image)

   a. Enter 95000 Pa for Gauge Pressure.
   b. Select K and Epsilon from the Specification Method drop-down list in the Turbulence group box.
   c. Enter 0.02 m²/s² for Backflow Turbulent Kinetic Energy.
   d. Retain the value of 1 m²/s³ for Backflow Turbulent Dissipation Rate.
   e. Click OK to close the Pressure Outlet dialog box.

5. Set the boundary conditions at outlet for the secondary phase.

   ![Boundary Conditions](image)

   a. Select vapor from the Phase drop-down list.
   b. Click Edit... to open the Pressure Outlet dialog box.
i. Click the **Multiphase** tab and retain the default value of 0 for **Volume Fraction**.

ii. Click **OK** to close the **Pressure Outlet** dialog box.

### 21.4.8. Operating Conditions

1. Set the operating pressure.

   ✷ **Boundary Conditions** → **Operating Conditions**...

   ![Operating Conditions dialog box]

   a. Enter 0 Pa for **Operating Pressure**.
   
   b. Click **OK** to close the **Operating Conditions** dialog box.

### 21.4.9. Solution

1. Set the solution parameters.

   ✷ **Solution Methods**
### Solution Methods

#### Pressure-Velocity Coupling

<table>
<thead>
<tr>
<th>Scheme</th>
<th>Coupled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coupled with Volume Fractions</td>
<td></td>
</tr>
</tbody>
</table>

#### Spatial Discretization

<table>
<thead>
<tr>
<th>Pressure</th>
<th>PRESTO!</th>
</tr>
</thead>
<tbody>
<tr>
<td>Momentum</td>
<td>QUICK</td>
</tr>
<tr>
<td>Volume Fraction</td>
<td>QUICK</td>
</tr>
<tr>
<td>Turbulent Kinetic Energy</td>
<td>First Order Upwind</td>
</tr>
<tr>
<td>Turbulent Dissipation Rate</td>
<td>First Order Upwind</td>
</tr>
</tbody>
</table>

#### Transient Formulation

- Non-Iterative Time Advancement
- Frozen Flux Formulation
- Pseudo Transient
- High Order Term Relaxation

| Options... | Default |

---

a. Select **Coupled** from the **Scheme** drop-down list in the **Pressure-Velocity Coupling** group box.

b. Retain the selection of **PRESTO!** from the **Pressure** drop-down list in the **Spatial Discretization** group box.

c. Select **QUICK** for **Momentum** and **Volume Fraction**.

d. Retain **First Order Upwind** for **Turbulent Kinetic Energy** and **Turbulent Dissipation Rate**.

e. Enable **Pseudo Transient**.

f. Enable **High Order Term Relaxation**.

> *The message appears in the console informing you of changing AMG cycle type for Volume Fraction, Turbulent Kinetic Energy, and Turbulent Dissipation Rate to F-cycle.*

> *The relaxation of high order terms will help to improve the solution behavior of flow simulations when higher order spatial discretizations are used (higher than first).*

---

2. Set the solution controls.

---

## Solution Controls
a. Retain the default values in the **Pseudo Transient Explicit Relaxation Factors** group box.

3. Enable the plotting of residuals during the calculation.

   ![Residual Monitors](image)

   a. Ensure that **Plot** is enabled in the **Options** group box.
b. Enter $3 \times 10^{-7}$ for the **Absolute Criteria** of **continuity**.

c. Enter $1 \times 10^{-5}$ for the **Absolute Criteria** of **x-velocity**, **y-velocity**, **k**, and **epsilon**.

*Decreasing the criteria for these residuals will improve the accuracy of the solution.*

d. Click **OK** to close the **Residual Monitors** dialog box.

4. Initialize the solution.

**Solution Initialization**

![Solution Initialization Dialog Box]

a. Select **Hybrid Initialization** from the **Initialization Methods** group box.

b. Click **More Settings...** to open the **Hybrid Initialization** dialog box.

![Hybrid Initialization Dialog Box]
c. Enable **Use Specified Initial Pressure on Inlets** in the **Initialization Options** group box. The velocity will now be initialized to the **Initial Gauge Pressure** value that you set in the **Pressure Inlet Boundary Condition** dialog box. For more information on initialization options, see **Steps in Using Hybrid Initialization in the Fluent User’s Guide**.

d. Click **OK** to close the **Hybrid Initialization** dialog box.

e. Click **Initialize** to initialize the solution.

---

**Note**

For flows in complex topologies, hybrid initialization will provide better initial velocity and pressure fields than standard initialization. This will help to improve the convergence behavior of the solver.

---

5. Save the case file (**cav.cas.gz**).

   **File → Write → Case...**

6. Start the calculation by requesting 400 iterations.

---

**Run Calculation**

- Enter **400** for **Number of Iterations**.
b. Click **Calculate**.

The solution will converge in approximately 300 iterations.

7. Save the data file (cav.dat.gz).

   File → Write → Data...

### 21.4.10. Postprocessing

1. Plot the pressure in the orifice ([Figure 21.3: Contours of Static Pressure (p. 915)]).

   ![Contour Plot](image)

   **Graphics and Animations** → **Contours** → **Set Up**...

   a. Enable **Filled** in the **Options** group box.
   
   b. Retain the default selection of **Pressure**... and **Static Pressure** from the **Contours of** drop-down lists.
   
   c. Click **Display** and close the **Contours** dialog box.
Note the dramatic pressure drop at the flow restriction in Figure 21.3: Contours of Static Pressure (p. 915). Low static pressure is the major factor causing cavitation. Additionally, turbulence contributes to cavitation due to the effect of pressure fluctuation (Figure 21.4: Mirrored View of Contours of Static Pressure (p. 917)) and turbulent diffusion (Figure 21.5: Contours of Turbulent Kinetic Energy (p. 918)).

2. Mirror the display across the centerline (Figure 21.4: Mirrored View of Contours of Static Pressure (p. 917)).

Mirroring the display across the centerline gives a more realistic view.
a. Select `symm_2` and `symm_1` from the **Mirror Planes** selection list.

b. Click **Apply** and close the **Views** dialog box.
3. Plot the turbulent kinetic energy (Figure 21.5: Contours of Turbulent Kinetic Energy (p. 918)).

- Graphics and Animations → Contours → Set Up...
  - Select Turbulence... and Turbulent Kinetic Energy(k) from the Contours of drop-down lists.
  - Click Display.
In this example, the mesh used is fairly coarse. However, in cavitating flows the pressure distribution is the dominant factor, and is not very sensitive to mesh size.

4. Plot the volume fraction of water vapor (Figure 21.6: Contours of Vapor Volume Fraction (p. 919)).

折叠 Graphics and Animations → Contours → Set Up...

a. Select Phases... and Volume fraction from the Contours of drop-down lists.

b. Select vapor from the Phase drop-down list.

c. Click Display and close the Contours dialog box.
The high turbulent kinetic energy region near the neck of the orifice in Figure 21.5: Contours of Turbulent Kinetic Energy (p. 918) coincides with the highest volume fraction of vapor in Figure 21.6: Contours of Vapor Volume Fraction (p. 919). This indicates the correct prediction of a localized high phase change rate. The vapor then gets convected downstream by the main flow.

### 21.5. Summary

This tutorial demonstrated how to set up and resolve a strongly cavitating pressure-driven flow through an orifice, using multiphase mixture model of ANSYS Fluent with cavitation effects. You learned how to set the boundary conditions for an internal flow. A steady-state solution was calculated to simulate the formation of vapor in the neck of the flow after the section restriction at the orifice. A more computationally intensive transient calculation is necessary to accurately simulate the irregular cyclic process of bubble formation, growth, filling by water jet re-entry, and break-off.
21.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 22: Using the Mixture and Eulerian Multiphase Models

This tutorial is divided into the following sections:

22.1. Introduction
22.2. Prerequisites
22.3. Problem Description
22.4. Setup and Solution
22.5. Summary
22.6. Further Improvements

22.1. Introduction

This tutorial examines the flow of water and air in a tee junction. Initially you will solve the problem using the less computationally intensive mixture model. You will then switch to the more accurate Eulerian model and compare the results of these two approaches.

This tutorial demonstrates how to do the following:

• Use the mixture model with slip velocities.
• Set boundary conditions for internal flow.
• Calculate a solution using the pressure-based coupled solver with the mixture model.
• Use the Eulerian model.
• Calculate a solution using the multiphase coupled solver with the Eulerian model.
• Display the results obtained using the two approaches for comparison.

22.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.
22.3. Problem Description

This problem considers an air-water mixture flowing upwards in a duct and then splitting in a tee junction. The ducts are 25 mm in width, the inlet section of the duct is 125 mm long, and the top and the side ducts are 250 mm long. The schematic of the problem is shown in Figure 22.1: Problem Specification (p. 922).

22.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
- 22.4.1. Preparation
- 22.4.2. Mesh
- 22.4.3. General Settings
- 22.4.4. Models
- 22.4.5. Materials
- 22.4.6. Phases
- 22.4.7. Boundary Conditions
- 22.4.8. Operating Conditions
- 22.4.9. Solution Using the Mixture Model
- 22.4.10. Postprocessing for the Mixture Solution
- 22.4.11. Higher Order Solution using the Mixture Model
22.4.12. Setup and Solution for the Eulerian Model
22.4.13. Postprocessing for the Eulerian Model

22.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.
   
   **Note**
   
   If you do not have a login, you can request one by clicking Customer Registration on the login page.

3. Enter the name of this tutorial into the search bar.
4. Narrow the results by using the filter on the left side of the page.
   a. Click ANSYS Fluent under Product.
   b. Click 15.0 under Version.
5. Select this tutorial from the list.
6. Click Files to download the input and solution files.
7. Unzip mix_eulerian_multiphase_R150.zip to your working folder.

   *The file tee.msh can be found in the mix_eulerian_multiphase folder created after unzipping the file.*
8. Use Fluent Launcher to enable Double Precision and start the 2D version of ANSYS Fluent.
   Fluent Launcher displays your Display Options preferences from the previous session.
   For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in the User’s Guide.
9. Ensure that the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color Scheme options are enabled.
10. Run in Serial under Processing Options.
   
   **Note**
   
   The double precision solver is recommended for modeling multiphase flow simulations.

22.4.2. Mesh

1. Read the mesh file tee.msh.
As ANSYS Fluent reads the mesh file, it will report the progress in the console.

### 22.4.3. General Settings

1. Check the mesh.

   **General → Check**

   ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure that the reported minimum volume is a positive number.

2. Examine the mesh (Figure 22.2: Mesh Display (p. 925)).

   **Extra**

   You can use the right mouse button to probe for mesh information in the graphics window. If you click the right mouse button on any node in the mesh, information will be displayed in the ANSYS Fluent console about the associated zone, including the name of the zone. This feature is especially useful when you have several zones of the same type and you want to distinguish between them quickly.
3. Retain the default settings for the pressure-based solver.
22.4.4. Models

1. Select the mixture multiphase model with slip velocities.

   - Models → Multiphase → Edit...

   a. Select Mixture in the Model list.

   The Multiphase Model dialog box will expand to show the inputs for the mixture model.

   b. Ensure that Slip Velocity is enabled in the Mixture Parameters group box.
You need to solve the slip velocity equation because there will be significant difference in velocities for the different phases.


   This treatment improves solution convergence by accounting for the partial equilibrium of the pressure gradient and body forces in the momentum equations. It is used in VOF and mixture problems, where body forces are large in comparison to viscous and convective forces.

d. Click OK to close the Multiphase Model dialog box.

2. Select the realizable $k$-$\varepsilon$ turbulence model with standard wall functions.

   ![Models → Viscous → Edit...](image)

   a. Select k-epsilon in the Model list.

   b. Select Realizable under in the k-epsilon Model list.

   The realizable $k$-$\varepsilon$ model is recommended in cases where flow separation around sharp corners or over bluff bodies can be expected.

   c. Retain Standard Wall Functions in the Near-Wall Treatment list.
This problem does not require a particularly fine mesh, and standard wall functions will be used.

d. Click **OK** to close the **Viscous Model** dialog box.

### 22.4.5. Materials

1. Copy the properties for liquid water from the materials database so that it can be used for the primary phase.

   ![Materials → Fluid → Create/Edit...]

   a. Click the **Fluent Database...** button to open the **Fluent Database Materials** dialog box.

   i. Select **water-liquid (h2o < l >)** from the **Fluent Fluid Materials** selection list.

      *Scroll down the list to find **water-liquid (h2o < l >)**.*

   ii. Click **Copy** to copy the properties for liquid water to your model.

   iii. Close the **Fluent Database Materials** dialog box.

b. Close the **Create/Edit Materials** dialog box.
22.4.6. Phases

In the following steps you will define the liquid water and air phases that flow in the tee junction.

1. Specify liquid water as the primary phase.

   Phases → phase-1 → Edit...

   a. Enter water for Name.

   b. Select water-liquid from the Phase Material drop-down list.

   c. Click OK to close the Primary Phase dialog box.

2. Specify air as the secondary phase.

   Phases → phase-2 → Edit...
a. Enter **air** for **Name**.

b. Retain the default selection of **air** from the **Phase Material** drop-down list.

c. Enter **0.001 m** for **Diameter**.

d. Click **OK** to close the **Secondary Phase** dialog box.

3. Check that the drag coefficient is set to be calculated using the Schiller-Naumann drag law.

   ◾ **Phases → Interaction...**
a. Retain the default selection of **schiller-naumann** from the **Drag Coefficient** drop-down list.

The Schiller-Naumann drag law describes the drag between the spherical particle and the surrounding liquid for a wide range of conditions provided the bubbles remain approximately spherical. In this case, the bubbles have a diameter of 1 mm which is within the spherical regime.

b. Click **OK** to close the **Phase Interaction** dialog box.

**22.4.7. Boundary Conditions**
For this problem, you need to set the boundary conditions for three boundaries: the velocity inlet and the two outflows. Since this is a mixture multiphase model, you will set the conditions at the velocity inlet that are specific for the mixture (conditions that apply to all phases) and also conditions that are specific to the primary and secondary phases.

1. Set the boundary conditions at the velocity inlet (velocity-inlet-4) for the mixture.

   ![Boundary Conditions → velocity-inlet-4 → Edit...]

   - Select **Intensity and Length Scale** from the **Specification Method** drop-down list.
   - Retain the default of 5% for **Turbulent Intensity**.
   - Enter 0.025 m for **Turbulent Length Scale**.
   - Click **OK** to close the **Velocity Inlet** dialog box.

2. Set the boundary conditions at the velocity inlet (velocity-inlet-4) for the primary phase (water).

   ![Boundary Conditions → velocity-inlet-4]

   - Select `water` from the **Phase** drop-down list.
   - Click **Edit...** to open the **Velocity Inlet** dialog box.
i. Retain the default selection of **Magnitude, Normal to Boundary** from the **Velocity Specification Method** drop-down list.

ii. Retain the default selection of **Absolute** from the **Reference Frame** drop-down list.

iii. Enter 1.53 m/s for **Velocity Magnitude**.

iv. Click **OK** to close the **Velocity Inlet** dialog box.

3. Set the boundary conditions at the velocity inlet (velocity-inlet-4) for the secondary phase (air).

   ![Boundary Conditions](velocity-inlet-4)

   a. Select **air** from the **Phase** drop-down list.

   b. Click **Edit...** to open the **Velocity Inlet** dialog box.

   i. Retain the default selection of **Magnitude, Normal to Boundary** from the **Velocity Specification Method** drop-down list.

   ii. Retain the default selection of **Absolute** from the **Reference Frame** drop-down list.

   iii. Enter 1.53 m/s for **Velocity Magnitude**.

   In multiphase flows, the volume rate of each phase is usually known. Volume rate divided by the inlet area gives the superficial velocity, which is the product of the inlet physical velocity and the volume fraction. When you have two phases, you must enter two physical velocities and the volume fraction of the secondary phase. Here it is assumed that bubbles at the inlet are moving at the same physical speed as the water.

   iv. Click the **Multiphase** tab and enter 0.02 for **Volume Fraction**.
v. Click OK to close the Velocity Inlet dialog box.

4. Set the boundary conditions at outflow-5 for the mixture.

- Boundary Conditions → outflow-5
  a. Select mixture from the Phase drop-down list.
  b. Click Edit... to open the Outflow dialog box.
     i. Enter 0.62 for Flow Rate Weighting.
     ii. Click OK to close the Outflow dialog box.

5. Set the boundary conditions at outflow-3 for the mixture.

- Boundary Conditions → outflow-3 → Edit...
  a. Enter 0.38 for Flow Rate Weighting.
  b. Click OK to close the Outflow dialog box.

22.4.8. Operating Conditions

1. Set the gravitational acceleration.

- Boundary Conditions → Operating Conditions...
a. Enable Gravity.

The Operating Conditions dialog box will expand to show additional inputs.

b. Enter \(-9.81\) m/s\(^2\) for \(Y\) in the Gravitational Acceleration group box.

c. Enable Specified Operating Density.

d. Enter \(0\) kg/m\(^3\) for Operating Density.

ANSYS Fluent redefines the fluid pressure by removing the hydrostatic component based on an average density in the domain or a user-specified operating density. By setting the operating density to \(0\) you force the hydrostatic pressure to appear explicitly in the postprocessed results. For more information, refer to Operating Density in the Fluent User's Guide.

e. Click OK to close the Operating Conditions dialog box.

22.4.9. Solution Using the Mixture Model

You will begin by calculating a preliminary solution using first-order discretization for momentum, volume fraction and turbulence quantities. You will then change to higher-order methods to refine the solution.

1. Set the solution parameters.

  Solution Methods
a. Select **Coupled** from the **Scheme** drop-down list.

b. Confirm that **PRESTO!** is selected from the **Pressure** drop-down list.

   *The PRESTO! method for pressure is a good choice when buoyancy and inertial forces are present.*

2. Set the solution controls.

   **Solution Controls**

   a. Enter 40 for **Flow Courant Number**.

   b. Enter 0.5 for both **Momentum** and **Pressure** in the **Explicit Relaxation Factors** group box.
c. Enter 0.4 for **Volume Fraction** in the **Under-Relaxation Factors** group box.

3. Enable the plotting of residuals during the calculation.

   ![Monitors] Residuals → Edit...
Using the Mixture and Eulerian Multiphase Models

4. Initialize the solution.

Solution Initialization

Solution Initialization

Initialization Methods

- Hybrid Initialization
- Standard Initialization

a. Select Hybrid Initialization from the Initialization Methods group box.

b. Click Initialize.

Note

For flows in complex topologies, hybrid initialization will provide better initial velocity and pressure fields than standard initialization. In general, this will help in improving the convergence behavior of the solver.
5. Save the case file (tee_1a.cas.gz).
   File → Write → Case...

6. Start the calculation by requesting 1400 iterations.
   ✤ Run Calculation

7. Save the case and data files (tee_1a.cas.gz and tee_1a.dat.gz).
   File → Write → Case & Data...

8. Check the total mass flow rate for each phase.
   ✤ Reports → ♻ Fluxes → Set Up...

   ![Flux Reports dialog box]

   a. Retain the default selection of **Mass Flow Rate** in the **Options** list.
   b. Select **water** from the **Phase** drop-down list.
   c. Select **outflow-3**, **outflow-5**, and **velocity-inlet-4** from the **Boundaries** selection list.
   d. Click **Compute**.

   *Note that the net mass flow rate of water is a small fraction of the inlet and outlet flow rates (<0.1%), indicating that mass is conserved.*

   e. Select **air** from the **Phase** drop-down list and click **Compute** again.

   *Again, note that the net mass flow rate of air is small compared to the inlet and outlet flow rates.*

   f. Close the **Flux Reports** dialog box.
22.4.10. Postprocessing for the Mixture Solution

1. Display the static pressure field in the tee (Figure 22.3: Contours of Static Pressure (p. 941)).

   Graphics and Animations → Contours → Set Up...

   ![Contours dialog box]

   a. Enable Filled in the Options group box.

   b. Retain the default selection of Pressure... and Static Pressure from the Contours of drop-down lists.

   c. Click Display.
In Figure 22.3: Contours of Static Pressure (p. 941) the hydrostatic pressure gradient is readily apparent in the vertical arm — a result of setting the Operating Density to 0.

2. Display contours of velocity magnitude (Figure 22.4: Contours of Velocity Magnitude (p. 942)).

- Select Velocity... and Velocity Magnitude from the Contours of drop-down lists.
- Select water from the Phase drop-down list.
- Click Display.
3. Display the volume fraction of air (Figure 22.5: Contours of Air Volume Fraction (p. 943)).

Graphics and Animations → Contours → Set Up...

a. Select Phases... and Volume fraction from the Contours of drop-down lists.

b. Select air from the Phase drop-down list.

c. Click Display and close the Contours dialog box.
When gravity acts downwards, it induces stratification in the side arm of the tee junction. In Figure 22.5: Contours of Air Volume Fraction (p. 943), you can see that the gas (air) tends to concentrate on the upper part of the side arm. In this case, gravity acts against inertia that tends to concentrate gas on the low pressure side, thereby creating gas pockets. In the vertical arm, both the gas and the water have velocities in the same direction, and therefore there is no separation. The outflow split modifies the relation between inertia forces and gravity to a large extent, and has an important role in flow distribution and on the gas concentration.

22.4.11. Higher Order Solution using the Mixture Model

In this step you will change to higher order discretization schemes and continue the calculation to refine the solution.

1. Revisit the Solution Methods task page and make the following selections
Using the Mixture and Eulerian Multiphase Models

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spatial Discretization</td>
<td></td>
</tr>
<tr>
<td>Pressure</td>
<td>PRESTO!</td>
</tr>
<tr>
<td>Momentum</td>
<td>Third-Order MUSCL</td>
</tr>
<tr>
<td>Volume Fraction</td>
<td>QUICK</td>
</tr>
<tr>
<td>Turbulent Kinetic Energy</td>
<td>Third-Order MUSCL</td>
</tr>
<tr>
<td>Turbulent Dissipation Rate</td>
<td>Third-Order MUSCL</td>
</tr>
</tbody>
</table>

2. Run the calculation for an additional 1400 iterations.

3. Save the case and data files as `tee_1b.cas.gz` and `tee_1b.dat.gz`

4. Plot the contours of air volume fraction using the higher order method on the same scale as in Figure 22.5: Contours of Air Volume Fraction (p. 943).

   Graphics and Animations → Contours → Set Up...

   a. Select Phases... and Volume fraction from the Contours of drop-down lists.

   b. Select air from the Phase drop-down list.

   c. Disable Auto Range and Clip to Range.

   d. Enter 0 and 3.90e−1 for Min and Max, respectively.

   e. Click Display and close the Contours dialog box.
22.4.12. Setup and Solution for the Eulerian Model

The mixture model is a simplification of the Eulerian model and is valid only when bubble inertia can be neglected. This assumption can be violated in the recirculation pattern. The Eulerian model also offers models for various non-drag forces that are not available when using the mixture model. As a result, the Eulerian model is expected to make a more realistic prediction in this case. You will use the solution obtained using the mixture model as an initial condition for the calculation using the Eulerian model. Because you have already computed a reasonable initial solution, you will continue with the higher order discretization methods.

1. Select the Eulerian multiphase model.

[Image of a diagram showing contours of air volume fraction]
1. Select **Eulerian** in the **Model** list.

2. Click **OK** to close the **Multiphase Model** dialog box.

2. Specify the drag and lift laws to be used for computing the interphase momentum transfer.

   - **Phases → Interaction...**

   a. Retain the default selection of **schiller-naumann** from the **Drag Coefficient** drop-down list.

   b. In the **Lift** tab, select **legendre-magnaudet** from the **Lift Coefficient** drop-down list.

   *Lift forces can arise when the gradient of the primary phase velocity field has a component normal to the bubble flow.*
c. Click **OK** to close the **Phase Interaction** dialog box.

---

**Note**

For this problem, there are no parameters to be set for the individual phases other than those that you specified when you set up the phases for the mixture model calculation. If you use the Eulerian model for a flow involving a granular secondary phase, you will need to set additional parameters. There are also other options in the **Phase Interaction** dialog box that may be relevant for other applications.

For details on setting up an Eulerian multiphase calculation, see *Steps for Using a Multiphase Model* in the User’s Guide.

3. Modify the boundary conditions at the velocity inlet (**velocity-inlet-4**) for the mixture.

   - **Boundary Conditions** → **velocity-inlet-4**
   
   a. Select **mixture** from the **Phase** drop-down list.
   
   b. Click **Edit...** to open the **Velocity Inlet** dialog box.
   
   c. Enter **10 %** for **Turbulent Intensity** and click **OK** to close the **Velocity Inlet** dialog box.

4. Select the multiphase turbulence model.

   - **Models** → **Viscous** → **Edit...**
a. Retain the default selection of Mixture in the Turbulence Multiphase Model list. 

   *In this case the dispersed phase volume concentration is relatively small so the mixture turbulence model is sufficient to capture the important features of the turbulent flow.*

b. Click OK to close the Viscous Model dialog box.

5. Confirm that the solution parameters are set to use the higher-order discretization schemes.

Revisit the Solution Methods task page and verify that the settings are as follows:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pressure-Velocity Coupling</td>
<td>Coupled</td>
</tr>
<tr>
<td>Spatial Discretization</td>
<td></td>
</tr>
<tr>
<td>Pressure-Velocity Coupling</td>
<td></td>
</tr>
<tr>
<td>Momentum</td>
<td>Third-Order MUSCL</td>
</tr>
<tr>
<td>Volume Fraction</td>
<td>QUICK</td>
</tr>
<tr>
<td>Turbulent Kinetic Energy</td>
<td>Third-Order MUSCL</td>
</tr>
<tr>
<td>Turbulent Dissipation Rate</td>
<td>Third-Order MUSCL</td>
</tr>
</tbody>
</table>

6. Set the solution controls
Solution Controls

a. Enter 40 for Flow Courant Number.

b. Enter 0.5 for Momentum and for Pressure in the Explicit Relaxation Factors group box.

c. Confirm that Volume Fraction is set to 0.4 in the Under-Relaxation Factors group box.

7. Continue the solution by requesting 1400 additional iterations.

Run Calculation

8. Check that the mass imbalance is small (less than about 0.2 %) using the Flux Reports dialog box as for the Mixture model solution.

Reports → Fluxes → Set Up...

9. Save the case and data files (tee_2.cas.gz and tee_2.dat.gz).

File → Write → Case & Data...
22.4.13. Postprocessing for the Eulerian Model

1. Display the static pressure field in the tee for the mixture (Figure 22.7: Contours of Static Pressure — Eulerian Model (p. 951)).

Split Screen → Animation → Contours → Set Up...

- Select **Pressure...** from the **Contours of** drop-down list.
  
  *By default, Dynamic Pressure will be displayed in the lower Contours of drop-down list. This will automatically change to Static Pressure after you select the appropriate phase in the next step.*

- Select **mixture** from the **Phase** drop-down list.
  
  *The lower Contours of drop-down list will now display Static Pressure.*

- As before, disable **Auto Range** (**Clip to Range** will be enabled) and set the **Min** and **Max** values to match those in Figure 22.3: Contours of Static Pressure (p. 941).

- Click **Display**.
2. Display contours of velocity magnitude for water (Figure 22.8: Contours of Water Velocity Magnitude — Eulerian Model (p. 952)).

Graphics and Animations ➔ Contours ➔ Set Up...

a. Select Velocity... and Velocity Magnitude from the Contours of drop-down lists.

b. Retain the selection of water from the Phase drop-down list.

Since the Eulerian model solves individual momentum equations for each phase, you can choose the phase for which solution data is plotted.

c. Set the scale to match that in Figure 22.4: Contours of Velocity Magnitude (p. 942).

d. Click Display.
3. Display the volume fraction of air (Figure 22.9: Contours of Air Volume Fraction — Eulerian model (p. 953)).

 Architects and Animations → Contours → Set Up...

a. Select Phases... and Volume fraction from the Contours of drop-down lists.

b. Select air from the Phase drop-down list.

c. Set the scale to match that in Figure 22.5: Contours of Air Volume Fraction (p. 943).

d. Click Display and close the Contours dialog box.
Compare the volume fraction plot in Figure 22.9: Contours of Air Volume Fraction — Eulerian model (p. 953) with the volume fraction plot using the mixture model in Figure 22.6: Contours of Air Volume Fraction — Higher Order Solution (p. 945). Notice that the path of the concentrated air stream in the side arm extends farther into the side arm before drifting to the top surface. As is apparent from the velocity plots, there is a substantial velocity gradient across the side arm as a result of the recirculation near the lower corner of the tee junction. As the dispersed phase bubbles travel along the side arm with the flow, this velocity gradient induces a lift force which tends to oppose the buoyancy force thereby delaying the accumulation of the air concentration along the top surface of the side arm.

22.5. Summary

This tutorial demonstrated how to set up and solve a multiphase problem using the mixture model and the Eulerian model. You learned how to set boundary conditions for the mixture and both phases. The solution obtained with the mixture model was used as a starting point for the calculation with the Eulerian model. After completing calculations for each model, you displayed the results to allow for a
comparison of the two approaches. For more information about the mixture and Eulerian models, see *Modeling Multiphase Flows* in the User’s Guide.

### 22.6. Further Improvements

This tutorial guides you through the steps to reach an initial set of solutions. You may be able to obtain a more accurate solution by adapting the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in *Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow* (p. 123).
Chapter 23: Using the Eulerian Multiphase Model for Granular Flow

This tutorial is divided into the following sections:
23.1. Introduction
23.2. Prerequisites
23.3. Problem Description
23.4. Setup and Solution
23.5. Summary
23.6. Further Improvements

23.1. Introduction

Mixing tanks are used to maintain solid particles or droplets of heavy fluids in suspension. Mixing may be required to enhance reaction during chemical processing or to prevent sedimentation. In this tutorial, you will use the Eulerian multiphase model to solve the particle suspension problem. The Eulerian multiphase model solves momentum equations for each of the phases, which are allowed to mix in any proportion.

This tutorial demonstrates how to do the following:

• Use the granular Eulerian multiphase model.
• Specify fixed velocities with a user-defined function (UDF) to simulate an impeller.
• Set boundary conditions for internal flow.
• Calculate a solution using the pressure-based solver.
• Solve a time-accurate transient problem.

23.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.
23.3. Problem Description

The problem involves the transient startup of an impeller-driven mixing tank. The primary phase is water, while the secondary phase consists of sand particles with a 111 micron diameter. The sand is initially settled at the bottom of the tank, to a level just above the impeller. A schematic of the mixing tank and the initial sand position is shown in Figure 23.1: Problem Specification (p. 956). The domain is modeled as 2D axisymmetric.

![Figure 23.1: Problem Specification](image)

The fixed-values option will be used to simulate the impeller. Experimental data are used to represent the time-averaged velocity and turbulence values at the impeller location. This approach avoids the need to model the impeller itself. These experimental data are provided in a user-defined function.

23.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

- 23.4.1. Preparation
- 23.4.2. Mesh
- 23.4.3. General Settings
- 23.4.4. Models
- 23.4.5. Materials
- 23.4.6. Phases
- 23.4.7. User-Defined Function (UDF)
- 23.4.8. Cell Zone Conditions
- 23.4.9. Solution
- 23.4.10. Postprocessing

23.4.1. Preparation

To prepare for running this tutorial:
1. Set up a working folder on the computer you will be using.


   **Note**
   If you do not have a login, you can request one by clicking **Customer Registration** on the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   a. Click **ANSYS Fluent** under **Product**.
   b. Click **15.0** under **Version**.

5. Select this tutorial from the list.

6. Click **Files** to download the input and solution files.

7. Unzip **eulerian_multiphase_granular_R150.zip** to your working folder.

   The files, **mixtank.msh** and **fix.c** can be found in the **eulerian_multiphase_granular** folder created after unzipping the file.

8. Use Fluent Launcher to start the **2D** version of ANSYS Fluent.

   Fluent Launcher displays your **Display Options** preferences from the previous session.

   For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in the User’s Guide.

9. Ensure that the **Display Mesh After Reading**, **Embed Graphics Windows**, and **Workbench Color Scheme** options are enabled.

10. Enable **Double-Precision**.

11. Ensure **Serial** is selected under **Processing Options**.

   **Note**
   The double precision solver is recommended for modeling multiphase flow simulations.

   **23.4.2. Mesh**

1. Read the mesh file **mixtank.msh**.

   **File → Read → Mesh...**

   *A warning message will be displayed twice in the console. You need not take any action at this point, as the issue will be rectified when you define the solver settings in General Settings (p. 958).*
23.4.3. General Settings

1. Check the mesh.

   ![General → Check]

   *ANSYS Fluent will perform various checks on the mesh and report the progress in the console. Ensure that the reported minimum volume is a positive number.*

2. Examine the mesh (Figure 23.2: Mesh Display (p. 958)).

   **Figure 23.2: Mesh Display**

| Mesh | ANSYS Fluent (2d, dp, pbns, lam) |

**Extra**

You can use the right mouse button to check which zone number corresponds to each boundary. If you click the right mouse button on one of the boundaries in the graphics...
window, its zone number, name, and type will be printed in the console. This feature is especially useful when you have several zones of the same type and you want to distinguish between them quickly.

3. Modify the mesh colors.

General → Display...

a. Click the Colors... button to open the Mesh Colors dialog box.

You can control the colors used to draw meshes by using the options available in the Mesh Colors dialog box.

b. Click Display and close the Mesh Display dialog box.

The graphics display will be updated to show the mesh.
4. Modify the view of the mesh display to show the full tank upright.

- Graphics and Animations → Views...
a. Select **axis** from the **Mirror Planes** selection list and click **Apply**.

*The mesh display will be updated to show both sides of the tank.*

b. Click **Auto Scale**.

*This option is used to scale and center the current display without changing its orientation (Figure 23.4: Mesh Display of the Tank, Mirrored and Scaled (p. 962)).*
c. Click the Options... button to open the Display Options dialog box and select All from the Animation Option drop-down list. Click Apply and close the Display Options dialog box.

This will ensure that the 2D geometry remains visible while you manipulate the camera view in the next step.

d. Click the Camera... button to open the Camera Parameters dialog box.
i. Drag the indicator of the dial with the left mouse button in the counter-clockwise direction until the upright view is displayed (Figure 23.5: Mesh Display of the Upright Tank (p. 964)).

ii. Click Apply and close the Camera Parameters dialog box.

e. Close the Views dialog box.

**Note**

While modifying the view, you may accidentally lose the view of the geometry in the display. You can easily revert to the default (front) view by clicking the Default button in the Views dialog box.
5. Specify a transient, axisymmetric model.

General
a. Retain the default **Pressure-Based** solver.

*The pressure-based solver must be used for multiphase calculations.*

b. Select **Transient** in the **Time** list.

c. Select **Axisymmetric** in the **2D Space** list.

6. Set the gravitational acceleration.

   a. Enable **Gravity**.

   b. Enter $-9.81 \, \text{m/s}^2$ for the **Gravitational Acceleration** in the **X** direction.

### 23.4.4. Models

1. Enable the Eulerian multiphase model.

   ✷ **Models → Multiphase → Edit...**
Using the Eulerian Multiphase Model for Granular Flow

a. Select **Eulerian** in the **Model** list.

b. Retain the default setting of 2 for **Number of Eulerian Phases**.

c. Click **OK** to close the **Multiphase Model** dialog box.

2. Enable the $k$-$\varepsilon$ turbulence model with standard wall functions.

   - **Models** → **Viscous** → **Edit...**
a. Select k-epsilon (2eqn) in the Model list.

b. Retain Standard Wall Functions in the Near-Wall Treatment list.

   This problem does not require a particularly fine mesh hence, standard wall functions can be used.

c. Select Dispersed in the Turbulence Multiphase Model list.

   The dispersed turbulence model is applicable in this case because there is clearly one primary continuous phase and the material density ratio of the phases is approximately 2.5. Furthermore, the Stokes number is much less than 1. Therefore, the kinetic energy of the particle will not differ significantly from that of the liquid. For more information, see Model Comparisons in the Theory Guide.

d. Click OK to close the Viscous Model dialog box.

23.4.5. Materials

In this step, you will add liquid water to the list of fluid materials by copying it from the ANSYS Fluent materials database and create a new material called sand.

1. Copy liquid water from the Fluent materials database so that it can be used for the primary phase.

   Materials → Fluid → Create/Edit...
a. Click the **Fluent Database...** button to open the **Fluent Database Materials** dialog box.

![Fluent Database Materials dialog box](image)

b. Select **water-liquid (h2o<l>)** from the **Fluent Fluid Materials** selection list.

   *Scroll down the **Fluent Fluid Materials** list to locate **water-liquid (h2o<l>)**.*

c. Click **Copy** to copy the information for liquid water to your model.

d. Close the **Fluent Database Materials** dialog box.

2. Create a new material called **sand**.
a. Enter sand for Name and delete the entry in the Chemical Formula field.

b. Enter 2500 kg/m³ for Density in the Properties group box.

c. Click Change/Create.

   A Question dialog box will open, asking if you want to overwrite water-liquid.

d. Click No in the Question dialog box to retain water-liquid and add the new material (sand) to the list.

   The Create/Edit Materials dialog box will be updated to show the new material, sand, in the Fluent Fluid Materials drop-down list.


23.4.6. Phases

Phases
1. Specify water (water-liquid) as the primary phase.

   ![Phases screen]

   - **Phases → phase-1 → Edit...**

   a. Enter water for **Name**.

   b. Select water-liquid from the **Phase Material** drop-down list.

   c. Click **OK** to close the **Primary Phase** dialog box.

2. Specify sand (sand) as the secondary phase.

   ![Phases screen]

   - **Phases → phase-2 → Edit...**
a. Enter sand for Name.

b. Select sand from the Phase Material drop-down list.

c. Enable Granular.

d. Retain the selection of Phase Property in the Granular Temperature Model list.

e. Enter 0.000111 m for Diameter.

f. Select syamlal-obrien from the Granular Viscosity drop-down list.

g. Select lun-et-al from the Granular Bulk Viscosity drop-down list.

h. Enter 0.6 for Packing Limit.

   Scroll down in the Properties group box to locate Packing Limit.

i. Click OK to close the Secondary Phase dialog box.

3. Specify the interaction terms between the phases.

   Phases → Interaction...
a. In the Drag tab, select gidaspow from the Drag Coefficient drop-down list.

b. In the Turbulence Interaction tab, select simonin-et-al from the Turbulence Interaction drop-down list.

   The Simonin-et-al Model dialog box will appear. Click OK to retain the default model settings.

c. Click OK to close the Phase Interaction dialog box.

23.4.7. User-Defined Function (UDF)

A UDF is used to specify the fixed velocities that simulate the impeller. The values of the time-averaged impeller velocity components and turbulence quantities are based on experimental measurement. The variation of these values may be expressed as a function of radius, and imposed as polynomials according to:

\[ \text{variable} = A_1r + A_2r^2 + A_3r^3 + \ldots \]

The order of polynomial to be used depends on the behavior of the function being fitted. For this tutorial, the polynomial coefficients shown in Table 23.1: Impeller Profile Specifications (p. 972)

<table>
<thead>
<tr>
<th>Variable</th>
<th>A1</th>
<th>A2</th>
<th>A3</th>
<th>A4</th>
<th>A5</th>
<th>A6</th>
</tr>
</thead>
<tbody>
<tr>
<td>u velocity</td>
<td>-7.1357e-2</td>
<td>54.304</td>
<td>-3.1345e+3</td>
<td>4.5578e+4</td>
<td>-1.966e+5</td>
<td>-</td>
</tr>
<tr>
<td>v velocity</td>
<td>3.1131e-2</td>
<td>-10.313</td>
<td>9.5558e+2</td>
<td>-2.0051e+4</td>
<td>1.186e+5</td>
<td>-</td>
</tr>
<tr>
<td>kinetic energy</td>
<td>2.2723e-2</td>
<td>6.7989</td>
<td>-424.18</td>
<td>9.4615e+3</td>
<td>-7.725e+4</td>
<td>1.8410e+5</td>
</tr>
<tr>
<td>dissipation</td>
<td>-6.5819e-2</td>
<td>88.845</td>
<td>-5.3731e+3</td>
<td>1.1643e+5</td>
<td>-9.120e+5</td>
<td>1.9567e+6</td>
</tr>
</tbody>
</table>

For more information about setting up a UDF using the DEFINE_PROFILE macro, refer to the separate UDF Manual. Though this macro is usually used to specify a profile condition on a boundary face zone, it is used in fix.c to specify the condition in a fluid cell zone. Hence, the arguments of the macro have been changed accordingly.

1. Interpret the UDF source file fix.c.

   Define → User-Defined → Functions → Interpreted...
a. Enter `fix.c` for **Source File Name**.

   *If the UDF source file is not in your working folder, you must enter the entire folder path for **Source File Name** instead of just entering the file name. Alternatively, click **Browse...** and select `fix.c` in the `eulerian_multiphase_granular` folder that was created after you unzipped the original file.*

b. Enable **Display Assembly Listing**.

   *The **Display Assembly Listing** option displays the assembly language code in the console as the function compiles.*

c. Click **Interpret** to interpret the UDF.

d. Close the **Interpreted UDFs** dialog box.

---

**Note**

The name and contents of the UDF are stored in the case file when you save the case file.

---

### 23.4.8. Cell Zone Conditions

**Cell Zone Conditions**
For this problem, you do not have to specify any conditions for outer boundaries. Within the domain, there are three fluid zones, representing the impeller region, the region where the sand is initially located, and the rest of the tank. There are no conditions to be specified in the latter two zones, so you need to set conditions only in the zone representing the impeller.

1. Set the boundary conditions for the fluid zone representing the impeller (**fix-zone**) for the primary phase.

   ![Cell Zone Conditions](image)

   You will specify the conditions for water and sand separately using the UDF. The default conditions for the mixture (that is, the conditions that apply to all phases) are acceptable.

   a. Select **water** from the **Phase** drop-down list.

   b. Click the **Edit...** button to open the **Fluid** dialog box.
i. Enable **Fixed Values**.

*The Fluid dialog box will expand to show the related inputs.*

ii. Click the **Fixed Values** tab and set the following fixed values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axial Velocity</td>
<td>udf fixed_u</td>
</tr>
<tr>
<td>Radial Velocity</td>
<td>udf fixed_v</td>
</tr>
<tr>
<td>Turbulent Kinetic Energy</td>
<td>udf fixed_ke</td>
</tr>
<tr>
<td>Turbulent Dissipation Rate</td>
<td>udf fixed_diss</td>
</tr>
</tbody>
</table>


c. Click **OK** to close the **Fluid** dialog box.

2. Set the boundary conditions for the fluid zone representing the impeller (**fix-zone**) for the secondary phase.

   ◆ **Cell Zone Conditions → fix-zone**

   a. Select **sand** from the **Phase** drop-down list.

   b. Click the **Edit...** button to open the **Fluid** dialog box.
i. Enable **Fixed Values**.

   *The Fluid dialog box will expand to show the related inputs.*

ii. Click the **Fixed Values** tab and set the following fixed values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axial Velocity</td>
<td>udf fixed_u</td>
</tr>
<tr>
<td>Radial Velocity</td>
<td>udf fixed_v</td>
</tr>
</tbody>
</table>

   c. Click **OK** to close the **Fluid** dialog box.

### 23.4.9. Solution

1. Set the under-relaxation factors.

   ![Solution Controls](image)

   a. Enter **0.5** for **Pressure**, **0.2** for **Momentum**, and **0.8** for **Turbulent Viscosity**.
**Tip**

Scroll down in the **Under-Relaxation Factors** group box to locate **Turbulent Viscosity**.

2. Enable the plotting of residuals during the calculation.

   ![Monitors](Monitors) → ![Residuals](Residuals) → Edit...
a. Ensure that the **Plot** is enabled in the **Options** group box.

b. Click **OK** to close the **Residual Monitors** dialog box.

3. Initialize the solution using the default initial values.

   **Solution Initialization**
a. Retain the default initial values and click **Initialize**.

4. Patch the initial sand bed configuration.

   ![Solution Initialization](patch.png)
a. Select **sand** from the **Phase** drop-down list.

b. Select **Volume Fraction** from the **Variable** selection list.

c. Enter **0.3** for **Value**.

d. Select **initial-sand** from the **Zones to Patch** selection list.

e. Click **Patch** and close the **Patch** dialog box.

5. Save the initial case and data files (**mixtank.cas.gz** and **mixtank.dat.gz**).

   File → Write → Case & Data...

   The problem statement is now complete. As a precaution, you should review the impeller velocity fixes and sand bed patch after running the calculation for a single time step. Since you are using a UDF for the velocity profiles, perform one time step in order for the profiles to be calculated and available for viewing.

6. Set the time stepping parameters and run the calculation for 0.005 seconds.

   Run Calculation

   a. Enter **0.005** for **Time Step Size**.

   b. Enter 1 for **Number of Time Steps**.
c. Enter 40 for **Max Iterations/Time Step**.

d. Click **Calculate**.

7. Examine the initial velocities and sand volume fraction.

   *In order to display the initial fixed velocities in the fluid zone (**fix-zone**), you need to create a surface for this zone.*

   a. Create a surface for **fix-zone**.

      **Surface → Zone...**
i. Select **fix-zone** from the **Zone** selection list and click **Create**.  

*The default name is the same as the zone name. ANSYS Fluent automatically assign the default name to the new surface when it is created. The new surface is added to the **Surfaces** selection list in the **Zone Surface** dialog box.*

ii. Close the **Zone Surface** dialog box.

b. Display the initial impeller velocities for water (Figure 23.6: Initial Impeller Velocities for Water (p. 984)).

ências and Animations → Vectors → Set Up...
i. Retain the selection of **Velocity** from the **Vectors of** drop-down list.

ii. Retain the selection of **water** from the **Phase** drop-down list below the **Vectors of** drop-down list.

iii. Retain the selection of **Velocity...** and **Velocity Magnitude** from the **Color by** drop-down lists.

iv. Retain the selection of **water** from the **Phase** drop-down list below the **Color by** drop-down lists.

v. Select **fix-zone** from the **Surfaces** selection list and click **Display**.

*ANSYS Fluent will display the water velocity vectors fixes at the impeller location, as shown in Figure 23.6: Initial Impeller Velocities for Water (p. 984).*
c. Display the initial impeller velocities for sand (Figure 23.7: Initial Impeller Velocities for Sand (p. 985)).

Graphics and Animations → Vectors → Set Up...

i. Select sand from the Phase drop-down lists (below the Vectors of drop-down list and Color by drop-down lists).

ii. Click Display (Figure 23.7: Initial Impeller Velocities for Sand (p. 985)) and close the Vectors dialog box.
**Figure 23.7: Initial Impeller Velocities for Sand**

Display contours of sand volume fraction (Figure 23.8: Initial Settled Sand Bed (p. 987)).
i. Enable Filled in the Options group box.

ii. Select sand from the Phase drop-down list.

iii. Select Phases... and Volume fraction from the Contours of drop-down lists.

iv. Click Display and close the Contours dialog box.

ANSYS Fluent will display the initial location of the settled sand bed, as shown in Figure 23.8: Initial Settled Sand Bed (p. 987).
8. Run the calculation for 1 second.

Run Calculation

a. Enter 199 for Number of Time Steps.
b. Click Calculate.

After a total of 200 time steps have been computed (1 second of operation), you will review the results before continuing.

9. Save the case and data files (mixtank1.cas.gz and mixtank1.dat.gz).

File → Write → Case & Data...

10. Examine the results of the calculation after 1 second.

a. Display the velocity vectors for water in the whole tank (Figure 23.9: Water Velocity Vectors after 1 s (p. 988)).

Graphics and Animations → Vectors → Set Up...

i. Select water from the Phase drop-down lists (below the Vectors of drop-down list and Color by drop-down lists).

ii. Deselect fix-zone from the Surfaces selection list.
iii. Click Display.

*Figure 23.9: Water Velocity Vectors after 1 s (p. 988)* shows the water velocity vectors after 1 second of operation. The circulation is confined to the region near the impeller, and has not yet had time to develop in the upper portions of the tank.

![Water Velocity Vectors after 1 s](image.png)

**Figure 23.9: Water Velocity Vectors after 1 s**

b. Display the velocity vectors for the sand (*Figure 23.10: Sand Velocity Vectors after 1 s (p. 989)*).

*Graphics and Animations → Vectors → Set Up...*

i. Select sand from the Phase drop-down lists (below the Vectors of drop-down list and Color by drop-down lists).

ii. Click Display and close the Vectors dialog box.
Figure 23.10: Sand Velocity Vectors after 1 s

Figure 23.10: Sand Velocity Vectors after 1 s (p. 989) shows the sand velocity vectors after 1 second of operation. The circulation of sand around the impeller is significant, but note that no sand vectors are plotted in the upper part of the tank, where the sand is not yet present.

c. Display contours of sand volume fraction (Figure 23.11: Contours of Sand Volume Fraction after 1 s (p. 990)).

† Graphics and Animations → Contours → Set Up...

i. Retain the selection of Phases... and Volume fraction from the Contours of drop-down lists.

ii. Retain the selection of sand from the Phase drop-down list.

iii. Click Display and close the Contours dialog box.

Notice that the action of the impeller draws clear fluid from above the originally settled bed and mixes it into the sand. To compensate, the sand bed is lifted up slightly. The maximum sand volume fraction has decreased as a result of the mixing of water and sand.
11. Continue the calculation for another 99 seconds.

Run Calculation

a. Set the Time Step Size to 0.05.

The initial calculation was performed with a very small time step size to stabilize the solution. After the initial calculation, you can increase the time step to speed up the calculation.

b. Enter 1980 for Number of Time Steps.

c. Click Calculate.

The transient calculation will continue up to 100 seconds.

12. Save the case and data files (mixtank100.cas.gz and mixtank100.dat.gz).

File → Write → Case & Data...

23.4.10. Postprocessing

You will now examine the progress of the sand and water in the mixing tank after a total of 100 seconds. The mixing tank has nearly, but not quite, reached a steady flow solution.

1. Display the velocity vectors for water (Figure 23.12: Water Velocity Vectors after 100 s (p. 991)).
Figure 23.12: Water Velocity Vectors after 100 s (p. 991) shows the water velocity vectors after 100 seconds of operation. The circulation of water is now very strong in the lower portion of the tank, though modest near the top.

Figure 23.12: Water Velocity Vectors after 100 s

2. Display the velocity vectors for sand (Figure 23.13: Sand Velocity Vectors after 100 s (p. 992)).

Figure 23.13: Sand Velocity Vectors after 100 s (p. 992) shows the sand velocity vectors after 100 seconds of operation. The sand has now been suspended much higher within the mixing tank, but does not reach the upper region of the tank. The water velocity in that region is not sufficient to overcome the gravity force on the sand particles.
Figure 23.13: Sand Velocity Vectors after 100 s

3. Display contours of sand volume fraction (Figure 23.14: Contours of Sand Volume Fraction after 100 s (p. 993)).

Graphics and Animations → Contours → Set Up...
4. Display filled contours of static pressure for the mixture (Figure 23.15: Contours of Pressure after 100 s (p. 994)).

**Graphics and Animations → Contours → Set Up...**

a. Select mixture from the Phase drop-down list.

b. Select Pressure... and Static Pressure from the Contours of drop-down lists.

c. Click Display and close the Contours dialog box.

*Figure 23.15: Contours of Pressure after 100 s (p. 994) shows the pressure distribution after 100 seconds of operation. The pressure field represents the hydrostatic pressure except for some slight deviations due to the flow of the impeller near the bottom of the tank.*
23.5. Summary

This tutorial demonstrated how to set up and solve a granular multiphase problem using the Eulerian multiphase model. The problem involved the 2D modeling of particle suspension in a mixing tank and postprocessing showed the near-steady-state behavior of the sand in the mixing tank, under the assumptions made.

23.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by adapting the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 24: Modeling Solidification

This tutorial is divided into the following sections:
24.1. Introduction
24.2. Prerequisites
24.3. Problem Description
24.4. Setup and Solution
24.5. Summary
24.6. Further Improvements

24.1. Introduction

This tutorial illustrates how to set up and solve a problem involving solidification and will demonstrate how to do the following:

- Define a solidification problem.
- Define pull velocities for simulation of continuous casting.
- Define a surface tension gradient for Marangoni convection.
- Solve a solidification problem.

24.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

- Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
- Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
- Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.

24.3. Problem Description

This tutorial demonstrates the setup and solution procedure for a fluid flow and heat transfer problem involving solidification, namely the Czochralski growth process. The geometry considered is a 2D axisymmetric bowl (shown in Figure 24.1: Solidification in Czochralski Model (p. 996)), containing liquid metal. The bottom and sides of the bowl are heated above the liquidus temperature, as is the free surface of the liquid. The liquid is solidified by heat loss from the crystal and the solid is pulled out of the domain at a rate of 0.001 m/s and a temperature of 500 K. There is a steady injection of liquid at
the bottom of the bowl with a velocity of \(1.01 \times 10^{-3} \text{ m/s}\) and a temperature of 1300 \(K\). Material properties are listed in Figure 24.1: Solidification in Czochralski Model (p. 996).

Starting with an existing 2D mesh, the details regarding the setup and solution procedure for the solidification problem are presented. The steady conduction solution for this problem is computed as an initial condition. Then, the fluid flow is enabled to investigate the effect of natural and Marangoni convection in a transient fashion.

**Figure 24.1: Solidification in Czochralski Model**

\(A_{\text{mush}}\) is the mushy zone constant. For details refer to section Momentum Equations for modeling the solidification/melting process, in the Theory Guide.

### 24.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

24.4.1. Preparation

24.4.2. Reading and Checking the Mesh

24.4.3. Specifying Solver and Analysis Type
24.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.


   **Note**

   If you do not have a login, you can request one by clicking Customer Registration on the login page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   a. Click ANSYS Fluent under Product.
   b. Click 15.0 under Version.

5. Select this tutorial from the list.

6. Click Files to download the input and solution files.

7. Unzip the solidification_R150.zip file you downloaded to your working folder.

   *The file solid.msh can be found in the solidification directory created after unzipping the file.*

8. Use Fluent Launcher to start the 2D version of ANSYS Fluent.

   Fluent Launcher displays your Display Options preferences from the previous session.

   *For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in the Getting Started Guide.*

9. Ensure that the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color Scheme options are enabled.

10. Ensure that the Serial processing option is selected.

11. Ensure that the Double Precision option is disabled.
24.4.2. Reading and Checking the Mesh

1. Read the mesh file `solid.msh`.

   **File → Read → Mesh...**

   As the mesh is read by ANSYS Fluent, messages will appear in the console reporting the progress of the reading.

   A warning about the use of axis boundary conditions will be displayed in the console. You are asked to consider making changes to the zone type or change the problem definition to axisymmetric. You will change the problem to axisymmetric swirl later in this tutorial.

2. Check the mesh.

   **General → Check**

   ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Make sure that the minimum volume is a positive number.

3. Examine the mesh (Figure 24.2: Mesh Display (p. 999)).
24.4.3. Specifying Solver and Analysis Type

1. Select **Axisymmetric Swirl** from the **2D Space** list.
The geometry comprises an axisymmetric bowl. Furthermore, swirling flows are considered in this problem, so the selection of **Axisymmetric Swirl** best defines this geometry.

Also, note that the rotation axis is the x-axis. Hence, the x-direction is the axial direction and the y-direction is the radial direction. When modeling axisymmetric swirl, the swirl direction is the tangential direction.

2. Add the effect of gravity on the model.

    ![General](General) → ![Gravity](Gravity)
24.4.4. Specifying the Models

1. Define the solidification model.

   ![Models dialog box]

   a. Enable the **Solidification/Melting** option in the **Solidification and Melting** dialog box.

   ![Solidification and Melting dialog box]

   b. Enter \(-9.81\ m/s^2\) for \(X\) in the **Gravitational Acceleration** group box.

   a. Enable **Gravity**.

   b. Enter \(-9.81\ m/s^2\) for \(X\) in the **Gravitational Acceleration** group box.
The **Solidification and Melting** dialog box will expand to show the related parameters.

b. Retain the default value of 100000 for the **Mushy Zone Constant**.  
   *This default value is acceptable for most cases.*

c. Enable the **Include Pull Velocities** option.

   *By including the pull velocities, you will account for the movement of the solidified material as it is continuously withdrawn from the domain in the continuous casting process.*

   *When you enable this option, the **Solidification and Melting** dialog box will expand to show the **Compute Pull Velocities** option. If you were to enable this additional option, ANSYS Fluent would compute the pull velocities during the calculation. This approach is computationally expensive and is recommended only if the pull velocities are strongly dependent on the location of the liquid-solid interface. In this tutorial, you will patch values for the pull velocities instead of having ANSYS Fluent compute them.*

   For more information about computing the pull velocities, see Setup Procedure in the User’s Guide.

d. Click OK to close the **Solidification and Melting** dialog box.

   *An Information dialog box will open, telling you that available material properties have changed for the solidification model. You will set the material properties later, so you can simply click OK in the dialog box to acknowledge this information.*

---

**Note**

ANSYS Fluent will automatically enable the energy calculation when you enable the solidification model, so you need not visit the **Energy** dialog box.

---

### 24.4.5. Defining Materials

In this step, you will create a new material and specify its properties, including the melting heat, solidus temperature, and liquids temperature.

1. Define a new material.

   ![Materials Fluid Create/Edit...](image-url)
a. Enter liquid-metal for Name.

b. Select polynomial from the Density drop-down list to open the Polynomial Profile dialog box.

Scroll down the list to find polynomial.

i. Set Coefficients to 2.

ii. Enter 8000 for 1 and -0.1 for 2 in the Coefficients group box.

As shown in Figure 24.1: Solidification in Czochralski Model (p. 996), the density of the material is defined by a polynomial function: \( \rho = 8000 - 0.1T \).

iii. Click OK to close the Polynomial Profile dialog box.
A Question dialog box will open, asking you if air should be overwritten. Click No to retain air and add the new material (liquid-metal) to the Fluent Fluid Materials drop-down list.

c. Select liquid-metal from the Fluent Fluid Materials drop-down list to set the other material properties.

d. Enter \( 680 \text{ J/kg} - \text{k} \) for \( \text{Cp (Specific Heat)} \).

e. Enter \( 30 \text{ w/m} - \text{k} \) for Thermal Conductivity.

f. Enter \( 0.00553 \text{ kg/m} - \text{s} \) for Viscosity.

g. Enter \( 100000 \text{ J/kg} \) for Pure Solvent Melting Heat.

Scroll down the group box to find Pure Solvent Melting Heat and the properties that follow.

h. Enter \( 1150 \text{ K} \) for Solidus Temperature.

i. Enter \( 1150 \text{ K} \) for Liquidus Temperature.

j. Click Change/Create and close the Create/Edit Materials dialog box.

24.4.6. Setting the Cell Zone Conditions

1. Set the cell zone conditions for the fluid (fluid).

   ![Cell Zone Conditions](image) – fluid – Edit...
a. Select **liquid-metal** from the **Material Name** drop-down list.

b. Click **OK** to close the **Fluid** dialog box.

### 24.4.7. Setting the Boundary Conditions

1. Set the boundary conditions for the inlet (**inlet**).
Boundary Conditions

<table>
<thead>
<tr>
<th>Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>axis</td>
</tr>
<tr>
<td>bottom-wall</td>
</tr>
<tr>
<td>default-interior</td>
</tr>
<tr>
<td>free-surface</td>
</tr>
<tr>
<td>inlet</td>
</tr>
<tr>
<td>outlet</td>
</tr>
<tr>
<td>side-wall</td>
</tr>
<tr>
<td>solid-wall</td>
</tr>
</tbody>
</table>

### Phase

<table>
<thead>
<tr>
<th>Phase</th>
<th>Type</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>mixture</td>
<td>velocity-inlet</td>
<td>2</td>
</tr>
</tbody>
</table>

- **Velocity inlet**
  - **Zone Name**: inlet
  - **Momentum**
    - **Velocity Specification Method**: Magnitude, Normal to Boundary
    - **Reference Frame**: Absolute
    - **Velocity Magnitude (m/s)**: 0.00101
    - **Supersonic/Initial Gauge Pressure (pascal)**: 0

- **Thermal**
  - **Temperature**: 1300 K

---

**Instructions**

- Enter 0.00101 m/s for **Velocity Magnitude**.
- Click the **Thermal** tab and enter 1300 K for **Temperature**.
c. Click OK to close the **Velocity Inlet** dialog box.

2. Set the boundary conditions for the outlet (outlet).

   ![Boundary Conditions](image)

   Here, the solid is pulled out with a specified velocity, so a velocity inlet boundary condition is used with a positive axial velocity component.

   ![Velocity Inlet](image)

   a. Select **Components** from the **Velocity Specification Method** drop-down list.

   The **Velocity Inlet** dialog box will change to show related inputs.
b. Enter 0.001 m/s for **Axial-Velocity**.

c. Enter 1 rad/s for **Swirl Angular Velocity**.

d. Click the **Thermal** tab and enter 500 K for **Temperature**.

![Velocity Inlet dialog box](image)

e. Click **OK** to close the **Velocity Inlet** dialog box.

3. Set the boundary conditions for the bottom wall (**bottom-wall**).

   ![Boundary Conditions](image)

   a. Click the **Thermal** tab.
i. Select **Temperature** from the **Thermal Conditions** group box.

ii. Enter **1300 K** for **Temperature**.

b. Click **OK** to close the **Wall** dialog box.

4. Set the boundary conditions for the free surface (free-surface).

   ![Boundary Conditions](image)

   The specified shear and Marangoni stress boundary conditions are useful in modeling situations in which the shear stress (rather than the motion of the fluid) is known. A free surface condition is an example of such a situation. In this case, the convection is driven by the Marangoni stress and the shear stress is dependent on the surface tension, which is a function of temperature.
a. Select Marangoni Stress from the Shear Condition group box.

   *The Marangoni Stress condition allows you to specify the gradient of the surface tension with respect to temperature at a wall boundary.*

b. Enter $-0.00036 \, \text{n/m} - k$ for Surface Tension Gradient.

c. Click the Thermal tab to specify the thermal conditions.
i. Select **Convection** from the **Thermal Conditions** group box.

ii. Enter 100 \(\text{W/m}^2\text{K}\) for **Heat Transfer Coefficient**.

iii. Enter 1500 \(\text{K}\) for **Free Stream Temperature**.

d. Click **OK** to close the **Wall** dialog box.

5. Set the boundary conditions for the side wall (**side-wall**).

![Boundary Conditions](boundary_conditions_icon.png)

*a. Click the **Thermal** tab.*
i. Select **Temperature** from the **Thermal Conditions** group box.

ii. Enter \(1400\) \(\text{K}\) for the **Temperature**.

b. Click **OK** to close the **Wall** dialog box.

6. Set the boundary conditions for the solid wall (**solid-wall**).

   ![Boundary Conditions → solid-wall → Edit...](image)
a. Select **Moving Wall** from the **Wall Motion** group box.

   *The Wall dialog box will expand to show additional parameters.*

b. Select **Rotational** in the lower box of the **Motion** group box.

   *The Wall dialog box will change to show the rotational speed.*

c. Enter **1.0 rad/s** for **Speed**.

d. Click the **Thermal** tab to specify the thermal conditions.
i. Select **Temperature** from the **Thermal Conditions** selection list.

ii. Enter 500 $K$ for **Temperature**.

e. Click **OK** to close the **Wall** dialog box.

## 24.4.8. Solution: Steady Conduction

In this step, you will specify the discretization schemes to be used and temporarily disable the calculation of the flow and swirl velocity equations, so that only conduction is calculated. This steady-state solution will be used as the initial condition for the time-dependent fluid flow and heat transfer calculation.

1. Set the solution parameters.

   - **Solution Methods**
a. Select **Coupled** from the Scheme drop-down list in the **Pressure-Velocity Coupling** group box.

b. Select **PRESTO!** from the Pressure drop-down list in the **Spatial Discretization** group box.

   *The PRESTO! scheme is well suited for rotating flows with steep pressure gradients.*

c. Retain the default selection of **Second Order Upwind** from the Momentum, Swirl Velocity, and Energy drop-down lists.

d. Enable **Pseudo Transient**.

   *The Pseudo Transient option enables the pseudo transient algorithm in the coupled pressure-based solver. This algorithm effectively adds an unsteady term to the solution equations in order to improve stability and convergence behavior. Use of this option is recommended for general fluid flow problems.*

2. Enable the calculation for energy.

   *Solution Controls ➔ Equations...*
a. Deselect Flow and Swirl Velocity from the Equations selection list to disable the calculation of flow and swirl velocity equations.

b. Click OK to close the Equations dialog box.

3. Confirm the Relaxation Factors.

Solution Controls

Retain the default values.

4. Enable the plotting of residuals during the calculation.
Monitors → Residuals → Edit...

![Residual Monitors dialog box]

- Ensure **Plot** is enabled in the **Options** group box.
- Click **OK** to accept the remaining default settings and close the **Residual Monitors** dialog box.

5. Initialize the solution.

Solution Initialization

- Retain the default of **Hybrid Initialization** from the **Initialization Methods** group box.

  *For flows in complex topologies, hybrid initialization will provide better initial velocity and pressure field than standard initialization. This in general will help in improving the convergence behavior of the solver.*

- Click **Initialize**.

6. Define a custom field function for the swirl pull velocity.

Define → Custom Field Functions...
In this step, you will define a field function to be used to patch a variable value for the swirl pull velocity in the next step. The swirl pull velocity is equal to $\Omega \cdot r$, where $\Omega$ is the angular velocity and $r$ is the radial coordinate. Since $\Omega = 1$ rad/s, you can simplify the equation to simply $r$. In this example, the value of $\Omega$ is included for demonstration purposes.

![Custom Field Function Calculator](image)

a. Select **Mesh...** and **Radial Coordinate** from the **Field Functions** drop-down lists.

b. Click the **Select** button to add **radial-coordinate** in the **Definition** field.

   *If you make a mistake, click the **DEL** button on the calculator pad to delete the last item you added to the function definition.*

c. Click the $\times$ button on the calculator pad.

d. Click the **1** button.

e. Enter $omega_r$ for **New Function Name**.

f. Click **Define**.

---

**Note**

To check the function definition or delete the custom field function, click **Manage...** to open the **Field Function Definitions** dialog box. Then select $omega_r$ from the **Field Functions** selection list to view the function definition.

---

g. Close the **Custom Field Function Calculator** dialog box.

7. Patch the pull velocities.

**Solution Initialization → Patch...**

As noted earlier, you will patch values for the pull velocities, rather than having ANSYS Fluent compute them. Since the radial pull velocity is zero, you will patch just the axial and swirl pull velocities.
a. Select **Axial Pull Velocity** from the **Variable** selection list.

b. Enter **0.001 m/s** for **Value**.

c. Select **fluid** from the **Zones to Patch** selection list.

d. Click **Patch**.

*You have just patched the axial pull velocity. Next you will patch the swirl pull velocity.*

e. Select **Swirl Pull Velocity** from the **Variable** selection list.

   *Scroll down the list to find **Swirl Pull Velocity**.*

f. Enable the **Use Field Function** option.

g. Select **omegar** from the **Field Function** selection list.
h. Ensure that **fluid** is selected from the **Zones to Patch** selection list.

i. Click **Patch** and close the **Patch** dialog box.

8. Save the initial case and data files (*solid0.cas.gz* and *solid0.dat.gz*).

   **File** → **Write** → **Case & Data...**

9. Start the calculation by requesting 20 iterations.

   ![Run Calculation](image)

   a. Select **User Specified** for the **Time Step Method** in both the **Fluid Time Scale** and the **Solid Time Scale** group boxes.

   b. Retain the default values of 1 and 1000 for the **Pseudo Time Step (s)** in the **Fluid Time Scale** and the **Solid Time Scale** group boxes, respectively.

   c. Enter 20 for **Number of Iterations**.

   d. Click **Calculate**.

   *The solution will converge in approximately 12 iterations.*
10. Display filled contours of temperature (Figure 24.3: Contours of Temperature for the Steady Conduction Solution (p. 1022)).

Graphics and Animations → Contours → Set Up...

- Enable the **Filled** option.
- Select **Temperature...** and **Static Temperature** from the **Contours of** drop-down lists.
- Click **Display** (Figure 24.3: Contours of Temperature for the Steady Conduction Solution (p. 1022)).
11. Display filled contours of temperature to determine the thickness of mushy zone.

Graphics and Animations → Contours → Set Up...
a. Disable **Auto Range** in the **Options** group box.

*The Clip to Range option will automatically be enabled.*

b. Enter **1100** for **Min** and **1200** for **Max**.

c. Click **Display** (See Figure 24.4: Contours of Temperature (Mushy Zone) for the Steady Conduction Solution (p. 1024)) and close the **Contours** dialog box.
12. Save the case and data files for the steady conduction solution (solid.cas.gz and solid.dat.gz).

File → Write → Case & Data...

**24.4.9. Solution: Transient Flow and Heat Transfer**

*In this step, you will turn on time dependence and include the flow and swirl velocity equations in the calculation. You will then solve the transient problem using the steady conduction solution as the initial condition.*

1. Enable a time-dependent solution.
a. Select Transient from the Time list.

2. Set the solution parameters.

Solution Methods
### Solution Methods

#### Pressure-Velocity Coupling
- **Scheme**: Coupled

#### Spatial Discretization
- **Gradient**: Least Squares Cell Based
- **Pressure**: PRESTO!
- **Momentum**: Second Order Upwind
- **Swirl Velocity**: Second Order Upwind
- **Energy**: Second Order Upwind

#### Transient Formulation
- **First Order Implicit**
- **Non-Iterative Time Advancement**
- **Frozen Flux Formulation**
- **High Order Term Relaxation**: Options...

### Instructions

a. Retain the default selection of **First Order Implicit** from the **Transient Formulation** drop-down list.

b. Ensure that **PRESTO!** is selected from the **Pressure** drop-down list in the **Spatial Discretization** group box.

3. Enable calculations for flow and swirl velocity.

### Solution Controls → Equations...

- **Flow**
- **Swirl Velocity**
- **Energy**
a. Select **Flow** and **Swirl Velocity** and ensure that **Energy** is selected from the **Equations** selection list.

*Now all three items in the Equations selection list will be selected.*

b. Click **OK** to close the **Equations** dialog box.

4. Set the **Under-Relaxation Factors**.

#### Solution Controls

<table>
<thead>
<tr>
<th>Flow Courant Number:</th>
<th>200</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Explicit Relaxation Factors</strong></td>
<td></td>
</tr>
<tr>
<td>Momentum</td>
<td>0.75</td>
</tr>
<tr>
<td>Pressure</td>
<td>0.75</td>
</tr>
</tbody>
</table>

#### Under-Relaxation Factors

| Density | 1 |
| Body Forces | 1 |
| Swirl Velocity | 0.9 |
| Liquid Fraction Update | 0.1 |
| Energy | 1 |

5. Save the initial case and data files (solid01.cas.gz and solid01.dat.gz).

**File → Write → Case & Data...**

6. Run the calculation for 2 time steps.

**Run Calculation**
a. Enter 0.1 s for **Time Step Size**.

b. Set the **Number of Time Steps** to 2.

c. Retain the default value of 20 for **Max Iterations/Time Step**.

d. Click **Calculate**.

7. Display filled contours of the temperature after 0.2 seconds.

   ![Graphics and Animations → Contours → Set Up...](image)

   a. Ensure that **Temperature...** and **Static Temperature** are selected from the **Contours of** drop-down lists.

   b. Click **Display** (See Figure 24.5: Contours of Temperature at t=0.2 s (p. 1029)).
Figure 24.5: Contours of Temperature at t=0.2 s

Contours of Static Temperature (k) (Time=2.0000e-01)

8. Display contours of stream function (Figure 24.6: Contours of Stream Function at t=0.2 s (p. 1030)).

Graphics and Animations → Contours → Set Up...

a. Disable Filled in the Options group box.

b. Select Velocity... and Stream Function from the Contours of drop-down lists.

c. Click Display.
As shown in Figure 24.6: Contours of Stream Function at t=0.2 s (p. 1030), the liquid is beginning to circulate in a large eddy, driven by natural convection and Marangoni convection on the free surface.

9. Display contours of liquid fraction (Figure 24.7: Contours of Liquid Fraction at t=0.2 s (p. 1031)).

Graphics and Animations → Contours → Set Up...

a. Enable Filled in the Options group box.

b. Select Solidification/Melting... and Liquid Fraction from the Contours of drop-down lists.

c. Click Display and close the Contours dialog box.
Figure 24.7: Contours of Liquid Fraction at t=0.2 s

The liquid fraction contours show the current position of the melt front. Note that in Figure 24.7: Contours of Liquid Fraction at t=0.2 s (p. 1031), the mushy zone divides the liquid and solid regions roughly in half.

10. Continue the calculation for 48 additional time steps.

Run Calculation

a. Enter 48 for Number of Time Steps.

b. Click Calculate.

After a total of 50 time steps have been completed, the elapsed time will be 5 seconds.

11. Display filled contours of the temperature after 5 seconds (Figure 24.8: Contours of Temperature at t=5 s (p. 1032)).
Graphics and Animations \rightarrow Contours \rightarrow Set Up...

a. Ensure that Filled is enabled in the Options group box.

b. Select Temperature... and Static Temperature from the Contours of drop-down lists.

c. Click Display.

Figure 24.8: Contours of Temperature at t=5 s

As shown in Figure 24.8: Contours of Temperature at t=5 s (p. 1032), the temperature contours are fairly uniform through the melt front and solid material. The distortion of the temperature field due to the recirculating liquid is also clearly evident.

In a continuous casting process, it is important to pull out the solidified material at the proper time. If the material is pulled out too soon, it will not have solidified (i.e., it will still be in a mushy state). If it is pulled out too late, it solidifies in the casting pool and cannot be pulled out in the required shape. The optimal rate of pull can be determined from the contours of liquidus temperature and solidus temperature.
12. Display contours of stream function (Figure 24.9: Contours of Stream Function at t=5 s (p. 1033)).

Graphics and Animations $\rightarrow$ Contours $\rightarrow$ Set Up...

a. Disable Filled in the Options group box.

b. Select Velocity... and Stream Function from the Contours of drop-down lists.

c. Click Display.

As shown in Figure 24.9: Contours of Stream Function at t=5 s (p. 1033), the flow has developed more fully by 5 seconds, as compared with Figure 24.6: Contours of Stream Function at t=0.2 s (p. 1030) after 0.2 seconds. The main eddy, driven by natural convection and Marangoni stress, dominates the flow.

To examine the position of the melt front and the extent of the mushy zone, you will plot the contours of liquid fraction.

Figure 24.9: Contours of Stream Function at t=5 s
13. Display filled contours of liquid fraction (Figure 24.10: Contours of Liquid Fraction at t=5 s (p. 1034)).

- **Graphics and Animations → Contours → Set Up...**
  a. Enable **Filled** in the **Options** group box.
  b. Select **Solidification/Melting...** and **Liquid Fraction** from the **Contours of** drop-down lists.
  c. Click **Display** and close the **Contours** dialog box.

The introduction of liquid material at the left of the domain is balanced by the pulling of the solidified material from the right. After 5 seconds, the equilibrium position of the melt front is beginning to be established (Figure 24.10: Contours of Liquid Fraction at t=5 s (p. 1034)).

**Figure 24.10: Contours of Liquid Fraction at t=5 s**

14. Save the case and data files for the solution at 5 seconds (solid5.cas.gz and solid5.dat.gz).
24.5. Summary

In this tutorial, you studied the setup and solution for a fluid flow problem involving solidification for the Czochralski growth process.

The solidification model in ANSYS Fluent can be used to model the continuous casting process where a solid material is continuously pulled out from the casting domain. In this tutorial, you patched a constant value and a custom field function for the pull velocities instead of computing them. This approach is used for cases where the pull velocity is not changing over the domain, as it is computationally less expensive than having ANSYS Fluent compute the pull velocities during the calculation.

For more information about the solidification/melting model, see Modeling Solidification and Melting in the User’s Guide.

24.6. Further Improvements

This tutorial guides you through the steps to reach an initial set of solutions. You may be able to obtain a more accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
Chapter 25: Using the Eulerian Granular Multiphase Model with Heat Transfer

This tutorial is divided into the following sections:

25.1. Introduction
25.2. Prerequisites
25.3. Problem Description
25.4. Setup and Solution
25.5. Summary
25.6. Further Improvements
25.7. References

25.1. Introduction

This tutorial examines the flow of air and a granular solid phase consisting of glass beads in a hot gas fluidized bed, under uniform minimum fluidization conditions. The results obtained for the local wall-to-bed heat transfer coefficient in ANSYS Fluent can be compared with analytical results [1].

This tutorial demonstrates how to do the following:

• Use the Eulerian granular model.
• Set boundary conditions for internal flow.
• Compile a User-Defined Function (UDF) for the gas and solid phase thermal conductivities.
• Calculate a solution using the pressure-based solver.

25.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.

In order to complete the steps to compile the UDF, you will need to have a working C compiler installed on your machine.
25.3. Problem Description

This problem considers a hot gas fluidized bed in which air flows upwards through the bottom of the domain and through an additional small orifice next to a heated wall. A uniformly fluidized bed is examined, which you can then compare with analytical results [1]. The geometry and data for the problem are shown in Figure 25.1: Problem Schematic (p. 1038).

Figure 25.1: Problem Schematic

25.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

25.4.1. Preparation
25.4.2. Mesh
25.4.3. General Settings
25.4.4. Models
25.4.5. UDF
25.4.6. Materials
25.4.7. Phases
25.4.8. Boundary Conditions
25.4.9. Solution
25.4.10. Postprocessing

25.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.


   **Note**
   
   If you do not have a login, you can request one by clicking Customer Registration on the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   
   a. Click ANSYS Fluent under Product.
   
   b. Click 15.0 under Version.

5. Select this tutorial from the list.

6. Click Files to download the input and solution files.

7. Unzip eulerian_granular_heat_R150.zip to your working folder.

   The files, fluid-bed.msh and conduct.c, can be found in the eulerian_granular_heat folder created after unzipping the file.

8. Use Fluent Launcher to enable Double Precision and start the 2D version of ANSYS Fluent.

   Fluent Launcher displays your Display Options preferences from the previous session.

   For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in the User’s Guide.

9. Ensure that the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color Scheme options are enabled.

10. Run in Serial by selecting Serial under Processing Options.

11. Ensure that Setup Compilation Environment for UDF is enabled in the Environment tab of the Fluent Launcher window. This will allow you to compile the UDF.

   **Note**
   
   The double precision solver is recommended for modeling multiphase flow simulations.
25.4.2. Mesh

1. Read the mesh file \texttt{fluid-bed.msh}.

   File $\rightarrow$ Read $\rightarrow$ Mesh...

   As ANSYS Fluent reads the mesh file, it will report the progress in the console.

25.4.3. General Settings

1. Check the mesh.

   General $\rightarrow$ Check

   ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Make sure that the reported minimum volume is a positive number.

2. Examine the mesh (Figure 25.2: Mesh Display of the Fluidized Bed (p. 1041)).

Extra

You can use the right mouse button to check which zone number corresponds to each boundary. If you click the right mouse button on one of the boundaries in the graphics window, its zone number, name, and type will be printed in the ANSYS Fluent console. This feature is especially useful when you have several zones of the same type and you want to distinguish between them quickly.
Setup and Solution

3. Enable the pressure-based transient solver.

  - **General**
    
    a. Retain the default selection of **Pressure-Based** from the **Type** list.

    The pressure-based solver must be used for multiphase calculations.

    b. Select **Transient** from the **Time** list.

4. Set the gravitational acceleration.

  - **General → Gravity**

Figure 25.2: Mesh Display of the Fluidized Bed
Using the Eulerian Granular Multiphase Model with Heat Transfer

a. Enter $-9.81 \text{ m/s}^2$ for the **Gravitational Acceleration** in the Y direction.

### 25.4.4. Models

1. Enable the Eulerian multiphase model for two phases.

   ![Models](Models.png) → ![Multiphase](Multiphase.png) → ![Edit](Edit.png)
a. Select **Eulerian** from the **Model** list.

b. Click **OK** to close the **Multiphase Model** dialog box.

2. Enable heat transfer by enabling the energy equation.

   ![Models → Energy → Edit...]

   a. Enable **Energy Equation**.

   b. Click **OK** to close the **Energy** dialog box.

   *An Information dialog box will open. Click **OK** to close the Information dialog box.*

3. Retain the default laminar viscous model.

   ![Models → Viscous → Edit...]
Experiments have shown negligible three-dimensional effects in the flow field for the case modeled, suggesting very weak turbulent behavior.

25.4.5. UDF

1. Compile the user-defined function, conduct.c, that will be used to define the thermal conductivity for the gas and solid phase.

   Define → User-Defined → Functions → Compiled...

   a. Click the Add... button below the Source Files option to open the Select File dialog box.

      i. Select the file conduct.c and click OK in the Select File dialog box.

   b. Click Build.

      ANSYS Fluent will create a libudf folder and compile the UDF. Also, a Warning dialog box will open asking you to make sure that UDF source file and case/data files are in the same folder.

   c. Click OK to close the Warning dialog box.
d. Click Load to load the UDF.

Extra

If you decide to read in the case file that is provided for this tutorial on the Customer Portal, you will need to compile the UDF associated with this tutorial in your working folder. This is necessary because ANSYS Fluent will expect to find the correct UDF libraries in your working folder when reading the case file.

25.4.6. Materials

1. Modify the properties for air, which will be used for the primary phase.

   Materials → air → Create/Edit...

   The properties used for air are modified to match data used by Kuipers et al. [1]

   ![Create/Edit Materials dialog box](image)

   a. Enter 1.2 kg/m³ for Density.

   b. Enter 994 J/kg-K for Cp.

   c. Select user-defined from the Thermal Conductivity drop-down list to open the User Defined Functions dialog box.

      i. Select conduct_gas::libudf from the available list.
Using the Eulerian Granular Multiphase Model with Heat Transfer

ii. Click **OK** to close the **User Defined Functions** dialog box.

d. Click **Change/Create**.

2. Define a new fluid material for the granular phase (the glass beads).

   ![Materials](image)

   **Materials** → ![air icon] → **Create/Edit**...

   ![Create/Edit Materials dialog box](image)

   a. Enter **solids** for Name.

   b. Enter **2660 kg/m³** for **Density**.

   c. Enter **737 J/kg-K** for **Cp**.

   d. Retain the selection of **user-defined** from the **Thermal Conductivity** drop-down list.

   e. Click the **Edit...** button to open the **User Defined Functions** dialog box.

      i. Select **conduct_solid::libudf** in the **User Defined Functions** dialog box and click **OK**.

         *A Question dialog box will open asking if you want to overwrite air.*

      ii. Click **No** in the **Question** dialog box.

   f. Select **solids** from the **Fluent Fluid Materials** drop-down list.

   g. Click **Change/Create** and close the **Materials** dialog box.
25.4.7. Phases

1. Define air as the primary phase.

   ✪ Phases → phase-1 - Primary Phase → Edit...

   a. Enter air for Name.

   b. Ensure that air is selected from the Phase Material drop-down list.

   c. Click OK to close the Primary Phase dialog box.

2. Define solids (glass beads) as the secondary phase.

   ✪ Phases → phase-2 - Secondary Phase → Edit...
a. Enter **solids** for **Name**.

b. Select **solids** from the **Phase Material** drop-down list.

c. Enable **Granular**.

d. Retain the default selection of **Phase Property** in the **Granular Temperature Model** group box.

e. Enter **0.0005 m** for **Diameter**.

f. Select **syamlal-obrien** from the **Granular Viscosity** drop-down list.

g. Select **lun-et-al** from the **Granular Bulk Viscosity** drop-down list.

h. Select **constant** from the **Granular Temperature** drop-down list and enter \(1e^{-0.5}\).

i. Enter **0.6** for the **Packing Limit**.

j. Click **OK** to close the **Secondary Phase** dialog box.

3. Define the interphase interactions formulations to be used.

   ![Phases → Interaction...](image)
a. Select syamlal-obrien from the Drag Coefficient drop-down list.

b. Click the Heat tab, and select gunn from the Heat Transfer Coefficient drop-down list.

c. Click OK to close the Phase Interaction dialog box.

25.4.8. Boundary Conditions

For this problem, you need to set the boundary conditions for all boundaries.

ensity
1. Set the boundary conditions for the lower velocity inlet (v_uniform) for the primary phase.

![Boundary Conditions](image)

- **Boundary Conditions → v_uniform**

*For the Eulerian multiphase model, you will specify conditions at a velocity inlet that are specific to the primary and secondary phases.*

a. Select **air** from the **Phase** drop-down list.

b. Click the **Edit...** button to open the **Velocity Inlet** dialog box.
i. Retain the default selection of **Magnitude, Normal to Boundary** from the **Velocity Specification Method** drop-down list.

ii. Enter 0.25 m/s for the **Velocity Magnitude**.

iii. Click the **Thermal** tab and enter 293 K for **Temperature**.

iv. Click **OK** to close the **Velocity Inlet** dialog box.

2. Set the boundary conditions for the lower velocity inlet (**v_uniform**) for the secondary phase.

   ![Boundary Conditions ➔ v_uniform](image)

   **Boundary Conditions ➔ v_uniform**

   a. Select **solids** from the **Phase** drop-down list.

   b. Click the **Edit...** button to open the **Velocity Inlet** dialog box.

   i. Retain the default **Velocity Specification Method** and **Reference Frame**.

   ii. Retain the default value of 0 m/s for the **Velocity Magnitude**.

   iii. Click the **Thermal** tab and enter 293 K for **Temperature**.

   iv. Click the **Multiphase** tab and retain the default value of 0 for **Volume Fraction**.

   v. Click **OK** to close the **Velocity Inlet** dialog box.

3. Set the boundary conditions for the orifice velocity inlet (**v_jet**) for the primary phase.

   ![Boundary Conditions ➔ v_jet](image)

   **Boundary Conditions ➔ v_jet**

   a. Select **air** from the **Phase** drop-down list.

   b. Click the **Edit...** button to open the **Velocity Inlet** dialog box.
i. Retain the default **Velocity Specification Method** and **Reference Frame**.

ii. Enter 0.25 m/s for the **Velocity Magnitude**.

In order for a comparison with analytical results [1] to be meaningful, in this simulation you will use a uniform value for the air velocity equal to the minimum fluidization velocity at both inlets on the bottom of the bed.

iii. Click the **Thermal** tab and enter 293 K for **Temperature**.

iv. Click **OK** to close the **Velocity Inlet** dialog box.

4. Set the boundary conditions for the orifice velocity inlet (**v_jet**) for the secondary phase.

**Boundary Conditions → v_jet**

a. Select **solids** from the **Phase** drop-down list.

b. Click the **Edit...** button to open the **Velocity Inlet** dialog box.

i. Retain the default **Velocity Specification Method** and **Reference Frame**.

ii. Retain the default value of 0 m/s for the **Velocity Magnitude**.
iii. Click the **Thermal** tab and enter 293 K for **Temperature**.

iv. Click the **Multiphase** tab and retain the default value of 0 for the **Volume Fraction**.

v. Click **OK** to close the **Velocity Inlet** dialog box.

5. Set the boundary conditions for the pressure outlet (p_{\text{outlet}}) for the mixture phase.

![Boundary Conditions](p_{\text{outlet}})

*For the Eulerian granular model, you will specify conditions at a pressure outlet for the mixture and for both phases.*

The thermal conditions at the pressure outlet will be used only if flow enters the domain through this boundary. You can set them equal to the inlet values, as no flow reversal is expected at the pressure outlet. In general, however, it is important to set reasonable values for these downstream scalar values, in case flow reversal occurs at some point during the calculation.

a. Select **mixture** from the **Phase** drop-down list.

b. Click the **Edit...** button to open the **Pressure Outlet** dialog box.

   i. Retain the default value of 0 Pascal for **Gauge Pressure**.

   ii. Click **OK** to close the **Pressure Outlet** dialog box.

6. Set the boundary conditions for the pressure outlet (p_{\text{outlet}}) for the primary phase.

![Boundary Conditions](p_{\text{outlet}})

a. Select **air** from the **Phase** drop-down list.

b. Click the **Edit...** button to open the **Pressure Outlet** dialog box.

   i. Click the **Thermal** tab and enter 293 K for **Backflow Total Temperature**.

   ii. Click **OK** to close the **Pressure Outlet** dialog box.

7. Set the boundary conditions for the pressure outlet (p_{\text{outlet}}) for the secondary phase.

![Boundary Conditions](p_{\text{outlet}})
a. Select **solids** from the **Phase** drop-down list.

b. Click the **Edit...** button to open the **Pressure Outlet** dialog box.

![Pressure Outlet Dialog Box]

i. Click the **Thermal** tab and enter **293 K** for the **Backflow Total Temperature**.

ii. Click the **Multiphase** tab and retain default settings.

iii. Click **OK** to close the **Pressure Outlet** dialog box.

8. Set the boundary conditions for the heated wall (**wall_hot**) for the mixture.

![Boundary Conditions Dialog Box]

For the heated wall, you will set thermal conditions for the mixture, and momentum conditions (zero shear) for both phases.

a. Select **mixture** from the **Phase** drop-down list.

b. Click the **Edit...** button to open the **Wall** dialog box.
i. Click the **Thermal** tab.

   A. Select **Temperature** from the **Thermal Conditions** list.
   
   B. Enter 373 K for **Temperature**.

   ii. Click **OK** to close the **Wall** dialog box.

9. Set the boundary conditions for the heated wall (**wall_hot**) for the primary phase.

   ![Wall dialog box](image)

   **Boundary Conditions → wall_hot**

   a. Select **air** from the **Phase** drop-down list.
   
   b. Click the **Edit...** button to open the **Wall** dialog box.
   
   c. Retain the default **No Slip** condition and click **OK** to close the **Wall** dialog box.

10. Set the boundary conditions for the heated wall (**wall_hot**) for the secondary phase same as that of the primary phase.

   **Boundary Conditions → wall_hot**

   *For the secondary phase, you will retain the default no slip condition as for the primary phase.*

11. Set the boundary conditions for the adiabatic wall (**wall_ins**) for the primary phase.

   **Boundary Conditions → wall_ins**

   *For the adiabatic wall, you will retain the default thermal conditions for the mixture (zero heat flux), and the default momentum conditions (no slip) for both phases.*

   a. Select **air** from the **Phase** drop-down list.
   
   b. Click the **Edit...** button to open the **Wall** dialog box.
c. Retain the default No Slip condition and click OK to close the Wall dialog box.

12. Set the boundary conditions for the adiabatic wall (wall_ins) for the secondary phase same as that of the primary phase.

\[ \text{Boundary Conditions} \rightarrow \text{wall_ins} \]

For the secondary phase, you will retain the default no slip condition as for the primary phase.

25.4.9. Solution

1. Select the second order implicit transient formulation.

\[ \text{Solution Methods} \]
### Solution Methods

#### Pressure- Velocity Coupling

<table>
<thead>
<tr>
<th>Scheme</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase Coupled SIMPLE</td>
</tr>
</tbody>
</table>

#### Spatial Discretization

<table>
<thead>
<tr>
<th>Gradient</th>
<th>Momentum</th>
<th>Volume Fraction</th>
<th>Energy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Least Squares Cell Based</td>
<td><strong>Second Order Upwind</strong></td>
<td>QUICK</td>
<td>QUICK</td>
</tr>
</tbody>
</table>

#### Transient Formulation

- **Second Order Implicit**
- Non-Iterative Time Advancement
- Frozen Flux Formulation
- High Order Term Relaxation

**Default**

| Help |

---

a. **Select Second Order Implicit** from the **Transient Formulation** drop-down list.

b. Modify the discretization methods in the **Spatial Discretization** group box.
   
   i. **Select Second Order Upwind** for **Momentum**.
   
   ii. **Select Quick** for **Volume Fraction** and **Energy**.

2. Set the solution parameters.

### Solution Controls
Using the Eulerian Granular Multiphase Model with Heat Transfer

**Solution Controls**

**Under-Relaxation Factors**

- **Pressure**: 0.5
- **Density**: 1
- **Body Forces**: 1
- **Momentum**: 0.2
- **Volume Fraction**: 0.5

**Actions**

- **Default**
- **Equations...**
- **Limits...**
- **Advanced...**

**Help**

---

a. Enter 0.5 for **Pressure**.

b. Enter 0.2 for **Momentum**.

3. Ensure that the plotting of residuals is enabled during the calculation.

   ![Monitors → Residuals → Edit...](image)

4. Define a custom field function for the heat transfer coefficient.

   ![Define → Custom Field Functions...](image)

   *Initially, you will define functions for the mixture temperature, and thermal conductivity, then you will use these to define a function for the heat transfer coefficient.*
a. Define the function \( t_{\text{mix}} \).

   i. Select **Temperature...** and **Static Temperature** from the Field Functions drop-down lists.

   ii. Ensure that **air** is selected from the Phase drop-down list and click **Select**.

   iii. Click the multiplication symbol in the calculator pad.

   iv. Select **Phases...** and **Volume fraction** from the Field Functions drop-down list.

   v. Ensure that **air** is selected from the Phase drop-down list and click **Select**.

   vi. Click the addition symbol in the calculator pad.

   vii. Similarly, add the term \( \text{solids}-\text{temperature} \times \text{solids-vof} \).

   viii. Enter \( t_{\text{mix}} \) for **New Function Name**.

   ix. Click **Define**.

b. Define the function \( k_{\text{mix}} \).
i. Select Properties... and Thermal Conductivity from the Field Functions drop-down lists.

ii. Select air from the Phase drop-down list and click Select.

iii. Click the multiplication symbol in the calculator pad.

iv. Select Phases... and Volume fraction from the Field Functions drop-down lists.

v. Ensure that air is selected from the Phase drop-down list and click Select.

vi. Click the addition symbol in the calculator pad.

vii. Similarly, add the term solids-thermal-conductivity-lam * solids-vof.

viii. Enter k_mix for New Function Name.

ix. Click Define.

c. Define the function ave_htc.
i. Click the subtraction symbol in the calculator pad.

ii. Select **Custom Field Functions...** and **k_mix** from the **Field Functions** drop-down lists.

iii. Use the calculator pad and the **Field Functions** lists to complete the definition of the function.

\[-k_{mix} \times (t_{mix} - 373) / \left(58.5 \times 10^{-6}\right) / 80\]

iv. Enter **ave_htc** for **New Function Name**.

v. Click **Define** and close the **Custom Field Function Calculator** dialog box.

5. Define the point surface in the cell next to the wall on the plane \(y=0.24\).

**Surface → Point...**

a. Enter \(0.28494\) m for **x0** and \(0.24\) m for **y0** in the **Coordinates** group box.
b. Enter \( y = 0.24 \) for **New Surface Name**.

c. Click **Create** and close the **Point Surface** dialog box.

6. Define a surface monitor for the heat transfer coefficient.

   ![Monitors (Surface Monitors) → Create...](image)

   a. Enable **Plot**, and **Write** for **surf-mon-1**.

   b. Enter **htc-024.out** for **File Name**.

   c. Select **Flow Time** from the **X Axis** drop-down list.

   d. Select **Time Step** from the **Get Data Every** drop-down list.

   e. Select **Facet Average** from the **Report Type** drop-down list.

   f. Select **Custom Field Functions...** and **ave_htc** from the **Field Variable** drop-down lists.

   g. Select **y=0.24** from the **Surfaces** selection list.

   h. Click **OK** to close the **Surface Monitor** dialog box.

7. Initialize the solution.

   ![Solution Initialization](image)
a. Select all-zones from the Compute from drop-down list.

b. Retain the default values and click Initialize.

8. Define an adaption register for the lower half of the fluidized bed.

   Adapt → Region...

   This register is used to patch the initial volume fraction of solids in the next step.
Using the Eulerian Granular Multiphase Model with Heat Transfer

a. Enter 0.3 m for Xmax and 0.5 m for Ymax in the Input Coordinates group box.

b. Click Mark.

c. Click the Manage... button to open the Manage Adaption Registers dialog box.
   
   i. Ensure that hexahedron-r0 is selected from the Registers selection list.

   ii. Click Display and close the Manage Adaption Registers dialog box.

   After you define a region for adaption, it is a good practice to display it to visually verify that it encompasses the intended area.
d. Close the **Region Adaption** dialog box.

9. Patch the initial volume fraction of solids in the lower half of the fluidized bed.

   ![Solution Initialization → Patch...](image_url)
a. Select **solids** from the **Phase** drop-down list.

b. Select **Volume Fraction** from the **Variable** selection list.

c. Enter 0.598 for **Value**.

d. Select **hexahedron-r0** from the **Registers to Patch** selection list.

e. Click **Patch** and close the **Patch** dialog box.

At this point, it is a good practice to display contours of the variable you just patched, to ensure that the desired field was obtained.

10. Display contours of **Volume Fraction** of solids (Figure 25.4: Initial Volume Fraction of Granular Phase (solids). (p. 1067)).

- **Graphics and Animations** → **Contours** → **Set Up**...
  
a. Enable **Filled** in the **Options** group box.

b. Select **Phases...** from the upper **Contours of** drop-down list.

c. Select **solids** from the **Phase** drop-down list.

d. Ensure that **Volume fraction** is selected from the lower **Contours of** drop-down list.

e. Click **Display** and close the **Contours** dialog box.
Figure 25.4: Initial Volume Fraction of Granular Phase (solids).

11. Save the case file (fluid-bed.cas.gz).

   File → Write → Case...

12. Start calculation.

    Run Calculation
a. Set 0.00015 for **Time Step Size(s)**.

b. Set 12000 for **Number of Time Steps**.

c. Enter 50 for **Max Iterations/Time Step**.

d. Click **Calculate**.

**Note**

If you do not want to wait for the solution to run the full 12000 time steps you can stop the calculation and read in the completed case/data files from the solution-files subdirectory in the eulerian_granular_heat.zip file.

*The plot of the value of the mixture-averaged heat transfer coefficient in the cell next to the heated wall versus time is in excellent agreement with results published for the same case [1].*
Figure 25.5: Plot of Mixture-Averaged Heat Transfer Coefficient in the Cell Next to the Heated Wall Versus Time

13. Save the case and data files (fluid-bed.cas.gz and fluid-bed.dat.gz).

File → Write → Case & Data...

25.4.10. Postprocessing

1. Display the pressure field in the fluidized bed (Figure 25.6: Contours of Static Pressure (p. 1071)).

Graphics and Animations → Contours → Set Up...
a. Select **mixture** from **Phase** drop-down list.

b. Select **Pressure...** and **Static Pressure** from the **Contours of** drop-down lists.

c. Click **Display**.
Figure 25.6: Contours of Static Pressure

Note the build-up of static pressure in the granular phase.

2. Display the volume fraction of solids (Figure 25.7: Contours of Volume Fraction of Solids (p. 1072)).
   a. Select solids from the Phase drop-down list.
   b. Select Phases... and Volume fraction from the Contours of drop-down lists.
   c. Click Display and close the Contours dialog box.
   d. Zoom in to show the contours close to the region where the change in volume fraction is the greatest.

   Note that the region occupied by the granular phase has expanded slightly, as a result of fluidization.
25.5. Summary

This tutorial demonstrated how to set up and solve a granular multiphase problem with heat transfer, using the Eulerian model. You learned how to set boundary conditions for the mixture and both phases. The solution obtained is in excellent agreement with analytical results from Kuipers et al. [1].

25.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh further. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123).
25.7. References

Chapter 26: Postprocessing

This tutorial is divided into the following sections:

26.1. Introduction
26.2. Prerequisites
26.3. Problem Description
26.4. Setup and Solution
26.5. Summary

26.1. Introduction

This tutorial demonstrates the postprocessing capabilities of ANSYS Fluent using a 3D model of a flat circuit board with a heat generating electronic chip mounted on it. The flow over the chip is laminar and involves conjugate heat transfer.

The heat transfer involves conduction in the chip and conduction and convection in the surrounding fluid. The physics of conjugate heat transfer such as this, is common in many engineering applications, including the design and cooling of electronic components.

In this tutorial, you will read the case and data files (without doing the calculation) and perform a number of postprocessing exercises.

This tutorial demonstrates how to do the following:

- Add lights to the display at multiple locations.
- Create surfaces for the display of 3D data.
- Display filled contours of temperature on several surfaces.
- Display velocity vectors.
- Mirror a display about a symmetry plane.
- Create animations.
- Display results on successive slices of the domain.
- Display pathlines.
- Plot quantitative results.
- Overlay and “explode” a display.
- Annotate the display.
26.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

- Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)
- Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
- Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.

26.3. Problem Description

The problem considered is shown schematically in Figure 26.1: Problem Specification (p. 1076). The configuration consists of a series of side-by-side electronic chips, or modules, mounted on a circuit board. Air flow, confined between the circuit board and an upper wall, cools the modules. To take advantage of the symmetry present in the problem, the model will extend from the middle of one module to the plane of symmetry between it and the next module.

As shown in the figure, each half-module is assumed to generate 2.0 Watts and to have a bulk conductivity of 1.0 W/m²-K. The circuit board conductivity is assumed to be one order of magnitude lower: 0.1 W/m²-K. The air flow enters the system at 298 K with a velocity of 1 m/s. The Reynolds number of the flow, based on the module height, is about 600. The flow is therefore treated as laminar.

26.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

- 26.4.1. Preparation
- 26.4.2. Reading the Mesh
- 26.4.3. Manipulating the Mesh in the Viewer
26.4.4. Adding Lights
26.4.5. Creating Isosurfaces
26.4.6. Generating Contours
26.4.7. Generating Velocity Vectors
26.4.8. Creating Animation
26.4.9. Displaying Pathlines
26.4.10. Overlaying Velocity Vectors on the Pathline Display
26.4.11. Creating Exploded Views
26.4.12. Animating the Display of Results in Successive Streamwise Planes
26.4.13. Generating XY Plots
26.4.14. Creating Annotation
26.4.15. Saving Hardcopy Files
26.4.16. Generating Volume Integral Reports

26.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.


   **Note**

   If you do not have a login, you can request one by clicking Customer Registration on the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   a. Click ANSYS Fluent under Product.
   b. Click 15.0 under Version.

5. Select this tutorial from the list.

6. Click Files to download the input and solution files.

7. Unzip the postprocess_R150.zip file you downloaded to your working folder.

   *The files chip.cas.gz and chip.dat.gz can be found in the postprocess folder created after unzipping the file.*

8. Use Fluent Launcher to start the 3D version of ANSYS Fluent.

   Fluent Launcher displays your Display Options preferences from the previous session.

   For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in the Fluent Getting Started Guide.
9. Ensure that the **Display Mesh After Reading**, **Embed Graphics Windows**, and **Workbench Color Scheme** options are enabled.

10. Ensure that the **Serial** processing option is selected.

11. Ensure that the **Double Precision** option is disabled.

### 26.4.2. Reading the Mesh

1. Read in the case and data files *chip.cas.gz* and *chip.dat.gz*.

   File → Read → Case & Data...

   *When you select the case file, ANSYS Fluent will read the data file automatically.*

### 26.4.3. Manipulating the Mesh in the Viewer

1. Display the mesh surfaces **board-top** and **chip**.

   ![Mesh Display](image)

   a. Retain the default selection of **Edges** in the **Options** group box.

   b. Deselect all surfaces and select **board-top** and **chip** from the **Surfaces** selection list.

   *To deselect all surfaces click the far-right unshaded button at the top of the **Surfaces** selection list, and then select the desired surfaces from the **Surfaces** selection list.*

   c. Click the **Colors...** button to open the **Mesh Colors** dialog box.

      i. Select **Color by ID** in the **Options** group box.

      ii. Click **Reset Colors** to reset the mesh colors to the default settings and close the **Mesh Colors** dialog box.
d. Click **Display**.

2. Rotate and zoom the view.

*Use the left mouse button to rotate the view. Use the middle mouse button to zoom the view until you obtain an enlarged display of the circuit board in the region of the chip, as shown in Figure 26.2: Mesh Display of the Chip and Board Surfaces (p. 1079).*

**Figure 26.2: Mesh Display of the Chip and Board Surfaces**

---

**Extra**

You can click the right mouse button on one of the mesh boundaries displayed in the graphics window and its zone number, name, and type will be printed in the console. This feature is especially useful when you have several zones of the same type and you want to distinguish between them.

3. Display the mesh faces.
General → Display...

a. Disable **Edges** and enable **Faces** in the **Options** group box.

b. Click **Display** and close the **Mesh Display** dialog box.

*The surfaces run together with no shading to separate the chip from the board.*

### 26.4.4. Adding Lights

1. Add lighting effects.

Graphics and Animations → Options...

*The default light settings add a white light at the position (1, 1, 1). The default light is defined in the **Lights** dialog box by the **Light ID** 0 with **Direction** vectors (X, Y, Z) as (1, 1, 1).*

- Disable **Double Buffering** in the **Rendering** group box.
- Enable **Lights On** in the **Lighting Attributes** group box.
- Select **Gouraud** from the **Lighting** drop-down list.
  
  *Flat* is the most basic lighting whereas **Gouraud** gives better color gradation.

- Click **Apply** and close the **Display Options** dialog box.
Shading will be added to the surface mesh display (Figure 26.3: Graphics Display with Default Lighting (p. 1081)).

Figure 26.3: Graphics Display with Default Lighting

2. Add lights in two directions, (-1, 1, 1) and (-1, 1, -1).

урс Graphics and Animations → Lights...
You can also open the **Lights** dialog box by clicking the **Lights...** button in the **Display Options** dialog box.

a. Set **Light ID** to 1.

b. Enable **Light On**.

c. Enter −1, 1, and 1 for X, Y, and Z respectively in the **Direction** group box.

d. Retain the selection of **Gouraud** in the **Lighting Method** drop-down list.

e. Enable **Headlight On**.

The **Headlight On** option provides constant lighting effect from a light source directly in front of the model, in the direction of the view. You can turn off the headlight by disabling the **Headlight On** option (*Figure 26.4: Display with Additional Lighting: - Headlight Off (p. 1083)*).
f. Click **Apply**.

g. Similarly, add a second light (**Light ID**= 2) at \((-1, 1, -1)\).

*The result will be more softly shaded display (Figure 26.5: Display with Additional Lighting (p. 1084)).*
26.4.5. Creating Isosurfaces

To display results in a 3D model, you will need surfaces on which the data can be displayed. ANSYS Fluent creates surfaces for all boundary zones automatically. Several surfaces have been renamed after reading the
case file. Examples are **board-sym** and **board-ends**, which correspond to the side and end faces of the circuit board.

You can define additional surfaces for viewing the results, for example, a plane in Cartesian space. In this exercise, you will create a horizontal plane cutting through the middle of the module with a \( y \) value of 0.25 inches. You can use this surface to display the temperature and velocity fields.

1. Create a surface of constant \( y \) coordinate.

   **Surface → Iso-Surface...**

   ![Iso-Surface dialog box]

   a. Select **Mesh...** and **Y-Coordinate** from the **Surface of Constant** drop-down lists.

   b. Click **Compute**.

      *The Min and Max fields display the \( y \) extents of the domain.*

   c. Enter 0.25 for **Iso-Values**.

   d. Enter \( y=0.25\text{in} \) for **New Surface Name**.

   e. Click **Create** and close the **Iso-Surface** dialog box.

2. Create a clipped surface for the X-coordinate of the fluid (**fluid-sym**).

   **Surface → Iso-Clip...**
a. Select **Mesh...** and **X-Coordinate** from the **Clip to Values of** drop-down lists.

b. Select **fluid-sym** from the **Clip Surface** selection list.

c. Click **Compute**.

   *The Min and Max fields display the x extents of the domain.*

d. Enter 1.9 and 3.9 for **Min** and **Max** respectively.

   *This will isolate the area around the chip.*

e. Enter **fluid-sym-x-clip** for **New Surface Name**.

f. Click **Clip**.

3. Create a clipped surface for the Y-coordinate of the fluid (**fluid-sym**).

   **Surface** → **Iso-Clip...**
a. Select **Mesh...** and **Y-Coordinate** from the **Clip to Values of** drop-down lists.

b. Retain the selection of **fluid-sym** from the **Clip Surface** selection list.

c. Click **Compute**.

   *The Min and Max fields display the y extents of the domain.*

d. Enter 0.1 and 0.5 for **Min** and **Max** respectively.

   **Note**

   This will isolate the area around the chip.

e. Enter **fluid-sym-y-clip** for **New Surface Name**.

f. Click **Clip** and close the **Iso-Clip** dialog box.

**26.4.6. Generating Contours**

1. Display filled contours of temperature on the symmetry plane (Figure 26.6: Filled Contours of Temperature on the Symmetry Surfaces (p. 1089)).

   - Graphics and Animations → Contours → Set Up...
a. Retain the default settings in the **Options** group box.

b. Select **Temperature...** and **Static Temperature** from the **Contours of** drop-down lists.

c. Select **board-sym**, **chip-sym**, and **fluid-sym** from the **Surfaces** selection list.

d. Click **Display**.

e. Rotate and zoom the display using the left and middle mouse buttons, respectively, to obtain the view as shown in **Figure 26.6: Filled Contours of Temperature on the Symmetry Surfaces** (p. 1089).

---

**Tip**

If the model disappears from the graphics window at any time, or if you are having difficulty manipulating it with the mouse, do one of the following:

- Click the **Fit to Window** button in the graphics toolbar.

- Open the **Views** dialog box by clicking the **Views...** button in **Graphics and Animations** task page and use the **Default** button to reset the view.

- Press the **Ctrl + L** to revert to a previous graphics display.

---

*The peak temperatures in the chip appear where the heat is generated, along with the higher temperatures in the wake where the flow is recirculating.*
2. Display filled contours of temperature for the clipped surface (Figure 26.7: Filled Contours of Temperature on the Clipped Surface (p. 1090)).

- **Graphics and Animations → Contours → Set Up...**

  a. Deselect all surfaces from the **Surfaces** selection list and then select **fluid-sym-x-clip** and **fluid-sym-y-clip**.

  b. Click **Display**.

    *A clipped surface appears, colored by temperature.*

  c. Orient the view to obtain the display as shown in Figure 26.7: Filled Contours of Temperature on the Clipped Surface (p. 1090).
3. Display filled contours of temperature on the plane, $y=0.25\text{in}$ (Figure 26.8: Temperature Contours on the Surface, $y = 0.25 \text{ in}$. (p. 1092)).

- Graphics and Animations → Contours → Set Up...
  
  a. Deselect all surfaces from the Surfaces selection list and then select $y=0.25\text{in}$.
  
  b. Click Display and close the Contours dialog box.

  The filled temperature contours will be displayed on the $y=0.25\text{in}$ plane.

4. Change the location of the colormap in the graphics display window.

- Graphics and Animations → Options...
a. Disable Axes in the Layout group box.

b. Select Bottom from the Colormap Alignment drop-down list.

c. Click Apply and close the Display Options dialog box.

5. Change the display of the colormap labels.

Graphics and Animations → Colormap...
a. Ensure that **Show All** is disabled.

b. Set **Skip** to 4.

*If the contour labels displayed next to the colormap are crowding the graphics window, you can use the skip-label function to control the number of labels displayed.*

c. Click **Apply** and close the **Colormap** dialog box.

d. Zoom the display using the middle mouse button to obtain the view as shown in **Figure 26.8: Temperature Contours on the Surface, y = 0.25 in. (p. 1092).**

**Figure 26.8: Temperature Contours on the Surface, y = 0.25 in.**

*In **Figure 26.8: Temperature Contours on the Surface, y = 0.25 in. (p. 1092),** the high temperatures in the wake of the module are clearly visible. You can also display other quantities such as velocity magnitude or pressure using the **Contours** dialog box.*
26.4.7. Generating Velocity Vectors

Velocity vectors provide an excellent visualization of the flow around the module, depicting details of the wake structure.

1. Display velocity vectors on the symmetry plane through the module centerline (Figure 26.9: Velocity Vectors in the Module Symmetry Plane (p. 1095)).

![Graphics and Animations → Vectors → Set Up...]

- Enter 1.9 for Scale.
- Deselect all surfaces from the Surfaces selection list and then select fluid-sym.
- Click Display and close the Vectors dialog box.

**Extra**

You can display velocity vectors for the clipped surfaces.

![Graphics and Animations → Vectors → Set Up...]

- Deselect all surfaces from the Surfaces selection list and then select fluid-sym-x-clip and fluid-sym-y-clip.
2. Change the colormap layout.

    - **Graphics and Animations → Options...**
      
      a. Enable **Axes** in the **Layout** group box.
      
      b. Select **Left** from the **Colormap Alignment** drop-down list.
      
      c. Click **Apply** and close the **Display Options** dialog box.
      
      d. Rotate and zoom the display to observe the vortex near the stagnation point and in the wake of the module (Figure 26.9: Velocity Vectors in the Module Symmetry Plane (p. 1095)).
Figure 26.9: Velocity Vectors in the Module Symmetry Plane

**Note**

The vectors in Figure 26.9: Velocity Vectors in the Module Symmetry Plane (p. 1095) are shown without arrowheads. You can modify the arrow style in the Vectors dialog box by selecting a different option from the Style drop-down list.

**Extra**

If you want to decrease the number of vectors displayed, then increase the Skip factor to a non-zero value.

3. Plot velocity vectors in the horizontal plane intersecting the module (Figure 26.10: Velocity Vectors Intersecting the Surface (p. 1097)).
Graphics and Animations → Vectors → Set Up...

After plotting the vectors, you will enhance the view by mirroring the model about the module centerline and displaying the module surfaces.

a. Enable Draw Mesh in the Options group box to open the Mesh Display dialog box.

i. Ensure that Faces is enabled in the Options group box.

ii. Retain the selection of board-top and chip from the Surfaces selection list.

iii. Click the Colors... button to open the MeshColors dialog box.

A. Select Color by Type in the Options group box.

B. Select wall from the Types selection list.
C. Select **light blue** from the **Colors** selection list and close the **Mesh Colors** dialog box.

iv. Click **Display** and close the **Mesh Display** dialog box.

b. Enter **3.8** for **Scale**.

c. Deselect all surfaces by clicking the unshaded icon to the right of the **Surfaces** selection list.

d. Select **y=0.25in** from the **Surfaces** selection list.

e. Click **Display** and close the **Vectors** dialog box.

f. Rotate the model with the mouse to obtain the view as shown in **Figure 26.10: Velocity Vectors Intersecting the Surface** (p. 1097).

**Figure 26.10: Velocity Vectors Intersecting the Surface**

4. Mirror the image about the chip symmetry plane (**Figure 26.11: Velocity Vectors After Mirroring** (p. 1099)).
Graphics and Animations → Views...

a. Select symmetry-18 from the Mirror Planes selection list.

---

Note

This zone is the centerline plane of the module and its selection will create a mirror of the entire display about the centerline plane.

---

b. Click Apply and close the Views dialog box.

*The display will be updated in the graphics window (Figure 26.11: Velocity Vectors After Mirroring (p. 1099)).*
26.4.8. Creating Animation

Using ANSYS Fluent, you can animate the solution and also a scene. For information on animating the solution, see Using Dynamic Meshes (p. 631), Step 10. In this tutorial, you will animate a scene between two static views of the graphics display.

You will display the surface temperature distribution on the module and the circuit board by selecting the corresponding boundaries. You will also create the key frames and view the transition between the key frames, dynamically, using the animation feature.

1. Display filled contours of surface temperature on the board-top and chip surfaces. (Figure 26.12: Filled Temperature Contours on the Chip and Board Top Surfaces (p. 1101)).
a. Ensure that **Filled** is enabled in the **Options** group box.

b. Retain the selection of **Temperature...** and **Static Temperature** from the **Contours of** drop-down lists.

c. Deselect all surfaces by clicking the unshaded icon to the right of **Surfaces**.

d. Select **board-top** and **chip** from the **Surfaces** selection list.

e. Click **Display** and close the **Contours** dialog box.

f. Zoom the display as needed to obtain the view shown in Figure 26.12: Filled Temperature Contours on the Chip and Board Top Surfaces (p. 1101).

> **Figure 26.12: Filled Temperature Contours on the Chip and Board Top Surfaces (p. 1101)** shows the high temperatures on the downstream portions of the module and relatively localized heating of the circuit board around the module.
Figure 26.12: Filled Temperature Contours on the Chip and Board Top Surfaces

Contours of Static Temperature (k)

ANSYS Fluent (3d, pbns, lam)

2. Create the key frames by changing the point of view.

Graphics and Animations → Scene Animation → Set Up...
You will use the current display (Figure 26.12: Filled Temperature Contours on the Chip and Board Top Surfaces (p. 1101)) as the starting view for the animation (Frame = 1).

a. Click Add in the Key Frames group box to create the first frame for your animation.
   
   *This will store the current display as Key-1.*

b. Zoom the view to focus on the module region.

c. Enter 100 for Frame in the Key Frames group box.

d. Click Add to create the tenth frame for your animation.
   
   *This will store the new display as Key-100.*

The zoomed view will be the one-hundredth key frame of the animation, with intermediate displays (2 through 99) to be filled in during the animation.
e. Rotate the view and zoom out the display so that the downstream side of the module is in the foreground (Figure 26.13: Filled Temperature Contours on the Chip and Board Top Surfaces (p. 1103)).

Figure 26.13: Filled Temperature Contours on the Chip and Board Top Surfaces

f. Enter 200 for Frame.

g. Click Add to create the two-hundredth frame for your animation.

This will store the new display as Key-200.

Note

You can check the display view of any of your saved key frames by selecting it in the Keys list.
3. View the scene animation by clicking on the “play” button (▶) in the Playback group box.

**Note**

If your computer is having difficulty displaying the animation with 200 frames, you can increase the increment to 10.

While effective animation is best conducted on “high-end” graphics workstations, you can view scene animations on any workstation. If the graphics display speed is slow, the animation playback will take some time and will appear choppy, with the redrawing very obvious. On fast graphics workstations, the animation will appear smooth and continuous and will provide an excellent visualization of the display from a variety of spatial orientations. On many machines, you can improve the smoothness of the animation by enabling the **Double Buffering** option in the **Display Options** dialog box.

To produce a slower animation, increase the number of frames between the key frames. The more sparsely you place your key frames, the more transition frames ANSYS Fluent creates between the key frames and thus stretching out your animation.

**Note**

You can also make use of animation tools of ANSYS Fluent for transient cases as demonstrated in Modeling Transient Compressible Flow (p. 257).

**Extra**

You can change the **Playback** mode if you want to “auto repeat” or “auto reverse” the animation. When you are in either of these **Playback** modes, you can click the “stop” button (■) to stop the continuous animation.

4. Close the **Animate** dialog box.

**26.4.9. Displaying Pathlines**

**Pathlines** are the lines traveled by neutrally buoyant particles in equilibrium with the fluid motion. Pathlines are an excellent tool for visualization of complex three-dimensional flows. In this example, you will use pathlines to examine the flow around and in the wake of the module.

1. Create a rake from which the pathlines will emanate.

   **Surface → Line/Rake...**
a. Select **Rake** from the **Type** drop-down list.

   A rake surface consists of a specified number of points equally spaced between two specified endpoints. A line surface (the other option in the **Type** drop-down list) is a line that includes the specified endpoints and extends through the domain; data points on a line surface will not be equally spaced.

b. Retain the default value of **10** for **Number of Points**.

   This will generate 10 pathlines.

c. Enter a starting coordinate of \((1.0, 0.105, 0.07)\) and an ending coordinate of \((1.0, 0.25, 0.07)\) in the **End Points** group box.

   This will define a vertical line in front of the module, about halfway between the centerline and edge.

d. Enter **pathline-rake** for **New Surface Name**.

   You will refer to the rake by this name when you plot the pathlines.

e. Click **Create** and close the **Line/Rake Surface** dialog box.

2. Draw the pathlines (Figure 26.14: Pathlines Display (p. 1107)).

   🔸 **Graphics and Animations** → ▶️ **Pathlines** → **Set Up**...
a. Enable **Draw Mesh** in the **Options** group box to open the **Mesh Display** dialog box.

   i. Ensure that **Faces** is enabled in the **Options** group box.

   ii. Retain the selection of **board-top** and **chip** from the **Surfaces** selection list.

      *These surfaces should already be selected from the earlier exercise where the mesh was displayed with velocity vectors, Step 6: Velocity Vectors.*

   iii. Close the **Mesh Display** dialog box.

b. Enter **0.001** inch for **Step Size**.

c. Enter **6000** for **Steps**.

---

**Note**

A simple rule of thumb to follow when you are setting these two parameters is that if you want the particles to advance through a domain of length $L$, the **Step Size** times the number of **Steps** should be approximately equal to $L$.

---

d. Set **Path Coarsen** to **5**.

*Coarsening the pathline simplifies the plot and reduces the plotting time. The coarsening factor specified for **Path Coarsen** indicates the interval at which the points are plotted for a given pathline in any cell.*

e. Select **pathline-rake** from the **Release from Surfaces** selection list.
f. Click **Display**.

*The pathlines will be drawn on the surface.*

g. Rotate the model so that the flow field is in front and the wake of the chip is visible as shown in Figure 26.14: Pathlines Display (p. 1107).

**Figure 26.14: Pathlines Display**

3. Write the pathlines to a file.

   a. Enable **Write to File** in the **Options** group box.

   *The **Display** button changes to a **Write...** button.*

   b. Select **Fieldview** from the **Type** drop-down list.

   c. Click the **Write...** button to open the **Select File** dialog box.
i. Enter chip-pathline for Fieldview File.

ii. Click OK to close the Select File dialog box.

*ANSYS Fluent will save the file in Fieldview format.fvp extension.*

4. Display pathlines as spheres.

- Graphics and Animations → Pathlines → Set Up...

![Pathlines settings dialog box](image)

- a. Disable **Write to File** in the **Options** group box.
- b. Select **sphere** from the **Style** drop-down list.
- c. Click the **Attributes...** button to open the **Path Style Attributes** dialog box.

![Path Style Attributes dialog box](image)

- i. Enter **0.0005** for **Diameter**.
ii. Click **OK** to close the **Path Style Attributes** dialog box.

d. Enter **1 inch** for **Step Size** and **1000** for **Steps** respectively.

e. Set **Path Skip** to 2 and **Path Coarsen** to 1.

f. Retain the selection of **pathline-rake** in the **Release from Surfaces** selection list.

g. Click **Display**.

*The spherical pathlines will be drawn along the surface.*

h. Rotate the model so that the flow field is in front and the wake of the chip is visible as shown in Figure 26.15: Sphere Pathlines Display (p. 1109).

**Figure 26.15: Sphere Pathlines Display**

i. Select **Surface ID** from the lower **Color by** drop-down list.
j. Click **Display** and close the **Pathlines** dialog box.

*This will color the pathlines by the surface they are released from (Figure 26.16: Sphere Pathlines Colored by Surface ID (p. 1110)).*

**Figure 26.16: Sphere Pathlines Colored by Surface ID**

---

**Note**

As an optional exercise, you can create solution animations for pathlines using **Animation Sequence** dialog box.

**Calculation Activities (Solution Animations) → Create/Edit...**
26.4.10. Overlaying Velocity Vectors on the Pathline Display

The overlay capability, provided in the Scene Description dialog box, allows you to display multiple results on a single plot. You can exercise this capability by adding a velocity vector display to the pathlines just plotted.

1. Enable the overlays feature.

![Scene Description Dialog Box]

a. Enable Overlays in the Scene Composition group box.

b. Click Apply and close the Scene Description dialog box.

2. Add a plot of vectors on the chip centerline plane.

![Graphics and Animations and Vectors]

a. Enable Overlays in the Scene Composition group box.

b. Click Apply and close the Scene Description dialog box.
a. Disable **Draw Mesh** in the **Options** group box.

b. Retain the value of 3.8 for **Scale**.

c. Deselect all surfaces by clicking the unshaded icon to the right of **Surfaces**.

d. Select **fluid-sym** from the **Surfaces** selection list.

   Because the mesh surfaces are already displayed and overlaying is active, there is no need to redisplay the mesh surfaces.

  
e. Click **Display** and close the **Vectors** dialog box.

  
f. Use the mouse to obtain the view that is shown in **Figure 26.17: Overlay of Velocity Vectors and Pathlines Display** (p. 1113).
Note

The final display (Figure 26.17: Overlay of Velocity Vectors and Pathlines Display (p. 1113)) does not require mirroring about the symmetry plane because the vectors obscure the mirrored image. You may disable the mirroring option in the Views dialog box at any stage during this exercise.

26.4.11. Creating Exploded Views

The Scene Description dialog box stores each display that you request and allows you to manipulate the displayed items individually. This capability can be used to generate “exploded” views, in which results are translated or rotated out of the physical domain for enhanced display. As shown in the Scene Description dialog box, you can experiment with this capability by displaying “side-by-side” velocity vectors and temperature contours on a streamwise plane in the module wake.

1. Delete the velocity vectors and pathlines from the current display.
Graphics and Animations → Scene...

a. Select the pathlines `path-8-surface-id` and the velocity vectors `vv-0-velocity-magnitude` from the Names selection list.

b. Click Delete Geometry.

c. Click Apply and close the Scene Description dialog box.

The Names selection list of the Scene Description dialog box should then contain only the two mesh surfaces (board-top and chip).

2. Create a plotting surface at \( x=3 \) inches (named \( x=3.0\text{in} \)), just downstream of the trailing edge of the module.

Surface → Iso-Surface...
Tip

For details on creating an isosurface, see Step 4: Creating Isosurfaces.

3. Add the display of filled temperature contours on the \textbf{x}=3.0\text{in} surface.

\textbf{Graphics and Animations} \rightarrow \textbf{Contours} \rightarrow \textbf{Set Up}...
a. Ensure that **Draw Mesh** is disabled in the **Options** group box.

b. Deselect all surfaces by clicking on the unshaded icon to the right of **Surfaces**.

c. Select **x=3.0in** from the **Surfaces** selection list.

d. Click **Display** and close the **Contours** dialog box.

*The filled temperature contours will be displayed on the **x=3.0in** surface.*

4. Add the velocity vectors on the **x=3.0in** plotting surface.

   ![ Graphics and Animations →  Vectors → Set Up...](image)

   a. Enable the **Draw Mesh** option in the **Options** group box to open the **Mesh Display** dialog box.
      
      i. Retain the default settings.
      
      ii. Close the **Mesh Display** dialog box.

   b. Enter **1.9** for **Scale**.

   c. Set **Skip** to **2**.

   d. Deselect all surfaces by clicking on the unshaded icon to the right of **Surfaces**.
e. Select \( x=3.0 \text{in} \) from the Surfaces selection list.

f. Click Display and close the Vectors dialog box.

*The display will show the vectors superimposed on the contours of temperature at \( x=3.0 \text{ in} \).*

5. Create the exploded view by translating the contour display, placing it above the vectors (Figure 26.18: Exploded Scene Display of Temperature and Velocity (p. 1118)).

\[\textbf{Graphics and Animations} \rightarrow \textbf{Scene...}\]

a. Select \textit{contour-9-temperature} from the Names selection list.

b. Click the Transform... button to open the Transformations dialog box.

i. Enter 1 inch for \( Y \) in the Translate group box.

ii. Click Apply and close the Transformations dialog box.

*The exploded view allows you to see the contours and vectors as distinct displays in the final scene (Figure 26.18: Exploded Scene Display of Temperature and Velocity (p. 1118)).*

c. Deselect Overlays.

d. Click Apply and close the Scene Description dialog box.
26.4.12. Animating the Display of Results in Successive Streamwise Planes

You may want to march through the flow domain, displaying a particular variable on successive slices of the domain. While this task could be accomplished manually, plotting each plane in turn, or using the Scene Description and Animate dialog boxes, here you will use the Sweep Surface dialog box to facilitate the process. To illustrate the display of results on successive slices of the domain, you will plot contours of velocity magnitude on planes along the \( X \) axis.

1. Delete the vectors and temperature contours from the display.

   Graphics and Animations → Scene...

   a. Select \texttt{contour-9-temperature} and \texttt{vv-9-velocity-magnitude} from the Names selection list.

   b. Click Delete Geometry.

   c. Click Apply and close the Scene Description dialog box.
The dialog box and display window will be updated to contain only the mesh surfaces.

2. Use the mouse to zoom out the view in the graphics window so that the entire board surface is visible.

3. Generate contours of velocity magnitude and sweep them through the domain along the \( X \) axis.

**Graphics and Animations → Sweep Surface → Set Up...**

![Sweep Surface dialog box](image)

a. Retain the default settings in the **Sweep Axis** group box.

b. Retain the default value of 0 m for **Initial Value** in the **Animation** group box.

c. Retain 0.1651 m for **Final Value**.

**Warning**

The units for the initial and final values are in meters, regardless of the length units being used in the model. Here, the initial and final values are set to the **Min Value** and **Max Value**, to generate an animation through the entire domain.

d. Enter 20 for **Frames**.

e. Select **Contours** in the **Display Type** list to open the **Contours** dialog box.
i. Select **Velocity...** and **Velocity Magnitude** from the **Contours of** drop-down lists.

ii. Click **OK** to close the **Contours** dialog box.

f. Click **Animate** and close the **Sweep Surface** dialog box.

**You will see the velocity contour plot displayed at 20 successive streamwise planes. ANSYS Fluent will automatically interpolate the contoured data on the streamwise planes between the specified end points. Especially on high-end graphics workstations, this can be an effective way to study how a flow variable changes throughout the domain.**

---

**Note**

You can also make use of animation tools of ANSYS Fluent for transient cases as demonstrated in **Modeling Transient Compressible Flow (p. 257).**

---

### 26.4.13. Generating XY Plots

**XY plotting can be used to display quantitative results of your CFD simulations. Here, you will complete the review of the module cooling simulation by plotting the temperature distribution along the top centerline of the module.**

1. Define the line along which to plot results.

   **Surface → Line/Rake...**
a. Select **Line** from the **Type** drop-down list.

b. Enter the coordinates of the line using a starting coordinate of \((2.0, 0.4, 0.01)\) and an ending coordinate of \((2.75, 0.4, 0.01)\) in the **End Points** group box.

   *These coordinates define the top centerline of the module.*

c. Enter **top-center-line** for **New Surface Name**.

d. Click **Create** and close the **Line/Rake Surface** dialog box.

2. Plot the temperature distribution along the top centerline of the module ([Figure 26.19: Temperature Along the Top Centerline of the Module](p. 1123)).

   ✷ **Plots** → ☐ **XY Plot** → **Set Up...**
a. Retain the default **Plot Direction** of X.

b. Select **Temperature...** and **Static Temperature** from the **Y Axis Function** drop-down lists.

c. Select **top-center-line** from the **Surfaces** selection list.

   *This will plot temperature vs the x coordinate along the selected line (top-center-line).*

d. Click the **Axes...** button to open the **Axes - Solution XY Plot** dialog box.

i. Retain the selection of **X** in the **Axis** list.

ii. Disable **Auto Range** in the **Options** group box.
iii. Enter 2.0 for **Minimum** and 2.75 for **Maximum** in the **Range** group box.

iv. Click **Apply** and close the **Axes - Solution XY Plot** dialog box.

e. Click **Plot** and close the **Solution XY Plot** dialog box.

*The temperature distribution (Figure 26.19: Temperature Along the Top Centerline of the Module (p. 1123)) shows the temperature increase across the module surface as the thermal boundary layer develops in the cooling air flow.*

**Figure 26.19: Temperature Along the Top Centerline of the Module**

26.4.14. Creating Annotation

▲ **Graphics and Animations → Annotate...**

*You can annotate the display with the text of your choice.*
1. Enter the text describing the plot (for example, Temperature Along the Top Centerline), in the **Annotation Text** field.

2. Select 20 from the **Size** drop-down list in the **Font Specification** group box.

3. Click **Add**.

   A *Working* dialog box will appear telling you to select the desired location of the text using the mouse-probe button.

4. Click the right mouse button in the graphics display window where you want the text to appear, and you will see the text displayed at the selected location (**Figure 26.20: Temperature Along the Top Centerline of the Module** (p. 1125)).

---

**Extra**

If you want to move the text to a new location on the screen, select the text in the **Names** selection list, click **Delete Text**, and click **Add** once again, defining a new position with the mouse.

---

**Note**

Depending on the size of the graphics window and the hardcopy file format you choose, the font size of the annotation text you see on the screen may be different from the font size in a hardcopy file of that graphics window. The annotation text font size is absolute, while the rest of the items in the graphics window are scaled to the proportions of the hardcopy.
26.4.15. Saving Hardcopy Files

File → Save Picture...

You can save hardcopy files of the graphics display in many different formats, including PostScript, encapsulated PostScript, TIFF, PNG, PPM, JPEG, VRML and window dumps. Here, the procedure for saving a color PostScript file is shown.

1. Select PostScript in the Format group box.
2. Select Color in the Coloring group box.
3. Select Vector in the File Type group box.
4. Click the **Save...** button to open the **Select File** dialog box.
   a. Enter a name for **Hardcopy File**.
   b. Click **OK** to close the **Select File** dialog box.
5. Close the **Save Picture** dialog box.

### 26.4.16. Generating Volume Integral Reports

**Reports → Volume Integrals → Set Up...**

Reports of Volume Integral can be used to determine the Volume of a particular fluid region (that is, fluid zone), the sum of quantities or the maximum and minimum values of particular variables. Here we will use the Volume Integral reports to determine the maximum and minimum temperature in the chip, board, and the airflow.

![Volume integrals dialog box](image)

1. Select **Maximum** in the **Report Type** group box.
2. Select **Temperature...** and **Static Temperature** from the **Field Variable** drop-down lists.
3. Select **solid-1** from the **Cell Zones** selection list.
4. Click **Compute** to calculate the maximum temperature.
   
   The maximum temperature in the solid-1 cell zone (the chip) is displayed.
5. Select **Minimum** in the **Report Type** group box and click **Compute**.
   
   The minimum temperature in the solid-1 cell zone (the chip) is displayed.
6. Repeat the operations to determine the maximum and minimum temperatures in the **solid-2** and **fluid-8** cell zones, corresponding to the board and fluid volume, respectively.

### 26.5. Summary

This tutorial demonstrated the use of many of the extensive postprocessing features available in ANSYS Fluent.
For more information on these and related features, see Reporting Alphanumeric Data or Displaying Graphics in User's Guide.
Chapter 27: Parallel Processing

This tutorial is divided into the following sections:

27.1. Introduction
27.2. Prerequisites
27.3. Problem Description
27.4. Setup and Solution
27.5. Summary

27.1. Introduction

This tutorial illustrates the setup and solution of a simple 3D problem using the parallel processing capabilities of ANSYS Fluent. In order to be run in parallel, the mesh must be divided into smaller, evenly sized partitions. Each ANSYS Fluent process, called a compute node, will solve on a single partition, and information will be passed back and forth across all partition interfaces. The solver of ANSYS Fluent enables parallel processing on a dedicated parallel machine, or a network of workstations running Windows or Linux.

The tutorial assumes that both ANSYS Fluent and network communication software have been correctly installed (see the separate installation instructions and related information for details). The case chosen is the mixing elbow problem you solved in Tutorial 3.

This tutorial demonstrates how to do the following:

• Start the parallel version of ANSYS Fluent using either Windows or Linux.

• Partition a mesh for parallel processing.

• Use a parallel network of workstations.

• Check the performance of the parallel solver.

27.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in the setup and solution procedure will not be shown explicitly.
27.3. Problem Description

The problem to be considered is shown schematically in Figure 27.1: Problem Specification (p. 1130). A cold fluid at $20^\circ C$ flows into the pipe through a large inlet, and mixes with a warmer fluid at $40^\circ C$ that enters through a smaller inlet located at the elbow. The pipe dimensions are in inches, and the fluid properties and boundary conditions are given in SI units. The Reynolds number for the flow at the larger inlet is 50,800, so a turbulent flow model will be required.

Figure 27.1: Problem Specification

Density: $p = 1000$ kg/m$^3$
Viscosity: $\mu = 8 \times 10^{-4}$ Pa-s
Conductivity: $k = 0.677$ W/m-K
Specific Heat: $C_p = 4216$ J/kg-K

27.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

27.4.1. Preparation
27.4.2. Starting the Parallel Version of ANSYS Fluent
27.4.3. Reading and Partitioning the Mesh
27.4.4. Solution
27.4.5. Checking Parallel Performance
27.4.6. Postprocessing

27.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

   **Note**

   If you do not have a login, you can request one by clicking Customer Registration on the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
   a. Click ANSYS Fluent under Product.
   b. Click 15.0 under Version.

5. Select this tutorial from the list.

6. Click Files to download the input and solution files.

7. Unzip parallel_process_R150.zip to your working folder.

   The case file elbow2.cas.gz can be found in the parallel_process directory created after unzipping the file.

   You can partition the mesh before or after you set up the problem (define models, boundary conditions, and so on.). It is best to partition after the problem is set up, since partitioning has some model dependencies (for example, sliding-mesh and shell-conduction encapsulation). Since you have already followed the procedure for setting up the mixing elbow in Tutorial 3, elbow2.cas.gz is provided to save you the effort of redefining the models and boundary conditions.

### 27.4.2. Starting the Parallel Version of ANSYS Fluent

Since the procedure for starting the parallel version of ANSYS Fluent is dependent upon the type of machine(s) you are using, two versions of this step are provided here.

#### 27.4.2.1. Multiprocessor Machine

Use ANSYS Fluent Launcher to start the 3D parallel version of ANSYS Fluent on a Windows or Linux machine using 2 processes.

1. Specify 3D for Dimension.

2. Select Parallel (Local Machine) under Processing Options.

3. Set Number of Processes to 2.

   To show details of the parallel settings, click **Show More Options**, then go to the **Parallel Settings** tab. Note that your Run Types will be Shared Memory on Local Machine.

4. Click OK.
To start ANSYS Fluent on a Linux machine, type at the command prompt

```
fluent 3d -t2
```

If you type `fluent` at the command prompt, then Fluent Launcher will appear.

For additional information about parallel command line options, see Parallel Processing in the User's Guide.

### 27.4.2.2. Network of Computers

You can start the 3D parallel version of ANSYS Fluent on a network of Windows or Linux machines using 2 processes and check the network connectivity by performing the following steps:
1. In Fluent Launcher, restore the default settings by clicking the **Default** button.

2. Specify **3D** for **Dimension**.

3. Select **Parallel (Local Machine)** under **Processing Options**.

4. Set the **Number of Processes** to 2.

5. Click the **Show More Options** button and select the **Parallel Settings** tab.

   - Retain the selection of **default** in the **Interconnects** and **MPI Types** drop-down lists.

   **Note**
   
   On Windows platforms, **default** is the only available selection for **Interconnects**.

   - Select **Distributed Memory on a Cluster**.

   - Ensure that **File Containing Machine Names** is selected to specify the file.

   - Type the name and location of the hosts text file in the text box below **File Containing Machine Names**, or browse and select it using the **Browsing Machine File** dialog box.

     *Alternatively, you can select **Machine Names** and type the names of the machines in the text box.*

6. Click **OK**.

   **Note**

   If you are using a Windows platform, you will need to enter your password for MPI the first time you run ANSYS Fluent using **Distributed Memory on a Cluster**.
You can also start parallel ANSYS Fluent by typing the following at the command prompt:

```
fluent 3d -t2 -cnf=fluent.hosts
```

where `--cnf` indicates the location of the hosts text file. The hosts file is a text file that contains a list of the computers on which you want to run the parallel job. If the hosts file is not located in the directory where you are typing the startup command, you will need to supply the full pathname to the file.

For example, the `fluent.hosts` file may look like the following:

```
my_computer
another_computer
```
7. Check the network connectivity information.

Although ANSYS Fluent displays a message confirming the connection to each new compute node and summarizing the host and node processes defined, you may find it useful to review the same information at some time during your session, especially if more compute nodes are spawned to several different machines.

Parallel ➔ Network ➔ Show Connectivity...

![Parallel Connectivity dialog box](image)

a. Set **Compute Node** to 0.

For information about all defined compute nodes, you will select node 0, since this is the node from which all other nodes are spawned.

b. Click **Print**.

```
ID    Comm.  Hostname         O.S.        PID    Mach ID  HW ID   Name
      ----------  -----------------  ---------  -------  -------  -------  ------------
host  net     my_computer      Windows-x64 10256  0       620     Fluent Host
n1    pcmipi  another_computer Windows-x64 2892   0       1       Fluent Node
n0*   pcmipi  my_computer      Windows-x64 9412   0       0       Fluent Node
```

Selected system interconnect: default

ID is the sequential denomination of each compute node (the host process is always host), Comm. is the communication library (that is, MPI type), Hostname is the name of the machine hosting the compute node (or the host process), O.S. is the architecture, PID is the process ID number, Mach ID is the compute node ID, and HW ID is an identifier specific to the communicator used.

c. Close the **Parallel Connectivity** dialog box.

27.4.3. Reading and Partitioning the Mesh

When you use the parallel solver, you need to subdivide (or partition) the mesh into groups of cells that can be solved on separate processors. If you read an unpartitioned mesh into the parallel solver, ANSYS Fluent will automatically partition it using the default partition settings. You can then check the partitions to see if you need to modify the settings and repartition the mesh.

1. Inspect the automatic partitioning settings.

Parallel ➔ Auto Partition...
If the **Case File** option is selected (the default setting), and there exists a valid partition section in the case file (that is, one where the number of partitions in the case file divides evenly into the number of compute nodes), then that partition information will be used rather than repartitioning the mesh. You need to disable the **Case File** option only if you want to change other parameters in the **Auto Partition Mesh** dialog box.

a. Retain the **Case File** option.

   *When the **Case File** option is selected, ANSYS Fluent will automatically select a partitioning method for you. This is the preferred initial approach for most problems. In the next step, you will inspect the partitions created and be able to change them, if required.*

b. Click **OK** to close the **Auto Partition Mesh** dialog box.

2. Read the case file *elbow2.cas.gz*.

   **File → Read → Case...**

3. Examine the front view of the **symmetry** mesh zone (*Figure 27.2: Mesh Along the Symmetry Plane for the Mixing Elbow (p. 1137)*).
4. Check the partition information.

   Parallel → Partitioning and Load Balancing...
a. Click **Print Active Partitions**.

*ANSYS Fluent will print the active partition statistics in the console.*

<table>
<thead>
<tr>
<th></th>
<th>Cells</th>
<th>I-Cells</th>
<th>Cell Ratio</th>
<th>Faces</th>
<th>I-Faces</th>
<th>Face Ratio</th>
<th>Neighbors</th>
<th>Load</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>11638</td>
<td>195</td>
<td>0.017</td>
<td>37996</td>
<td>263</td>
<td>0.007</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>11328</td>
<td>205</td>
<td>0.018</td>
<td>37565</td>
<td>263</td>
<td>0.007</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

---

**Collective Partition Statistics:**

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Maximum</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell count</td>
<td>11328</td>
<td>11638</td>
<td>22966</td>
</tr>
<tr>
<td>Mean cell count deviation</td>
<td>-1.3%</td>
<td>1.3%</td>
<td></td>
</tr>
<tr>
<td>Partition boundary cell count</td>
<td>195</td>
<td>205</td>
<td>400</td>
</tr>
<tr>
<td>Partition boundary cell count ratio</td>
<td>1.7%</td>
<td>1.8%</td>
<td>1.7%</td>
</tr>
<tr>
<td>Face count</td>
<td>37565</td>
<td>37996</td>
<td>75298</td>
</tr>
<tr>
<td>Mean face count deviation</td>
<td>-0.6%</td>
<td>0.6%</td>
<td></td>
</tr>
<tr>
<td>Partition boundary face count</td>
<td>263</td>
<td>263</td>
<td>263</td>
</tr>
<tr>
<td>Partition boundary face count ratio</td>
<td>0.7%</td>
<td>0.7%</td>
<td>0.3%</td>
</tr>
<tr>
<td>Partition neighbor count</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

**Partition Method** Metis

**Stored Partition Count** 2

Done.

---

**Note**

ANSYS Fluent distinguishes between two cell partition schemes within a parallel problem—the active cell partition, and the stored cell partition. Here, both are set to the cell partition that was created upon reading the case file. If you repartition the mesh using the **Partition Mesh** dialog box, the new partition will be referred to as
the stored cell partition. To make it the active cell partition, you need to click the **Use Stored Partitions** button in the **Partition Mesh** dialog box. The active cell partition is used for the current calculation, while the stored cell partition (the last partition performed) is used when you save a case file. This distinction is made mainly to allow you to partition a case on one machine or network of machines and solve it on a different one.

For details, see **Parallel Processing** in the **User’s Guide**.

b. Review the partition statistics.

An optimal partition should produce an equal number of cells in each partition for load balancing, a minimum number of partition interfaces to reduce interpartition communication bandwidth, and a minimum number of partition neighbors to reduce the startup time for communication. Here, you will be looking for relatively small values of mean cell and face count deviation, and total partition boundary cell and face count ratio. Values less than 5% are considered reasonable in most cases. However, with very large core counts and/or especially complex cases, larger values may be unavoidable.

c. Close the **Partitioning and Load Balancing** dialog box.

5. Examine the partitions graphically.

a. Initialize the solution using the default values.

\[\text{Solution Initialization} \rightarrow \text{Initialize}\]

In order to use the **Contours** dialog box to inspect the partition you just created, you have to initialize the solution, even though you are not going to solve the problem at this point. The default values are sufficient for this initialization.

b. Display the cell partitions (Figure 27.3: Cell Partitions (p. 1141)).

\[\text{Graphics and Animations} \rightarrow \text{Contours} \rightarrow \text{Set Up...}\]
i. Ensure **Filled** is selected in the **Options** group box.

ii. Select **Cell Info...** and **Active Cell Partition** from the **Contours of** drop-down lists.

iii. Select **symmetry** from the **Surfaces** selection list.

iv. Set **Levels** to 2, which is the number of compute nodes.

v. Click **Display** and close the **Contours** dialog box.
As shown in Figure 27.3: Cell Partitions (p. 1141), the cell partitions are acceptable for this problem. The position of the interface reveals that the criteria mentioned earlier will be matched. If you are dissatisfied with the partitions, you can use the Partition Mesh dialog box to repartition the mesh. Recall that, if you want to use the modified partitions for a calculation, you will need to make the Stored Cell Partition the Active Cell Partition by either clicking the Use Stored Partitions button in the Partition Mesh dialog box, or saving the case file and reading it back into ANSYS Fluent.

For details about the procedure and options for manually partitioning a mesh, see Partitioning the Mesh Manually and Balancing the Load in the User’s Guide.

6. Save the case file with the partitioned mesh (elbow3.cas.gz).

File → Write → Case...
27.4.4. Solution

1. Initialize the flow field.

   Solution Initialization

   ![Solution Initialization Interface]

   a. Retain the default selection of **Hybrid Initialization** from the **Initialization Methods** group box.

   b. Click **Initialize**.

      A **Warning** dialog box will open, asking if you want to discard the data generated during the first initialization, which was used to inspect the cell partitions.

   c. Click **OK** in the **Warning** dialog box to discard the data.

2. Enable the plotting of residuals during the calculation.

   ![Monitors and Residuals Interface]

3. Start the calculation by requesting 90 iterations.

   Run Calculation

   *The solution will converge in approximately 36 iterations.*

4. Save the data file (`elbow3.dat.gz`).

   File → Write → Data...

27.4.5. Checking Parallel Performance

Generally, you will use the parallel solver for large, computationally intensive problems, and you will want to check the parallel performance to determine if any optimization is required. Although the example in this tutorial is a simple 3D case, you will check the parallel performance as an exercise.

For details, see **Parallel Processing** in the **User's Guide**.

Parallel → Timer → Usage
### Performance Timer for 36 iterations on 2 compute nodes

<table>
<thead>
<tr>
<th>Category</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average wall-clock time per iteration</td>
<td>0.107 sec</td>
</tr>
<tr>
<td>Global reductions per iteration</td>
<td>79 ops</td>
</tr>
<tr>
<td>Global reductions time per iteration</td>
<td>0.000 sec (0.0%)</td>
</tr>
<tr>
<td>Message count per iteration</td>
<td>1330 messages</td>
</tr>
<tr>
<td>Data transfer per iteration</td>
<td>0.470 MB</td>
</tr>
<tr>
<td>LE solves per iteration</td>
<td>4 solves</td>
</tr>
<tr>
<td>LE wall-clock time per iteration</td>
<td>0.058 sec (54.1%)</td>
</tr>
<tr>
<td>LE global solves per iteration</td>
<td>8 solves</td>
</tr>
<tr>
<td>LE global wall-clock time per iteration</td>
<td>0.000 sec (0.1%)</td>
</tr>
<tr>
<td>LE global matrix maximum size</td>
<td>17</td>
</tr>
<tr>
<td>AMG cycles per iteration</td>
<td>8.139 cycles</td>
</tr>
<tr>
<td>Relaxation sweeps per iteration</td>
<td>853 sweeps</td>
</tr>
<tr>
<td>Relaxation exchanges per iteration</td>
<td>861 exchanges</td>
</tr>
<tr>
<td>Total wall-clock time</td>
<td>3.836 sec</td>
</tr>
<tr>
<td>Total CPU time</td>
<td>7.691 sec</td>
</tr>
</tbody>
</table>

The most accurate way to evaluate parallel performance is by running the same parallel problem on 1 CPU and on \( n \) CPUs, and comparing the Total wall-clock time (elapsed time for the iterations) in both cases.

Ideally you would want to have the Total wall-clock time with \( n \) CPUs be \( 1/n \) times the Total wall-clock time with 1 CPU. In practice, this improvement will be reduced by the performance of the communication subsystem of your hardware, and the overhead of the parallel process itself. As a rough estimate of parallel performance, you can compare the Total wall-clock time with the Total CPU time. In this case, the CPU time was approximately twice the Total wall-clock time. For a parallel process run on two compute nodes, this reveals very good parallel performance, even though the advantage over a serial calculation is small, as expected for this simple 3D problem.

---

**Note**

The wall clock time, the CPU time, and the ratio of iterations to convergence time may differ depending on the type of computer you are running (for example, Windows 32, Linux 64, and so on).

---

### 27.4.6. Postprocessing

See Tutorial 3 for complete postprocessing exercises for this example. Here, two plots are generated so that you can confirm that the results obtained with the parallel solver are the same as those obtained with the serial solver.

1. Display an XY plot of temperature along the centerline of the outlet (Figure 27.4: Temperature Distribution at the Outlet (p. 1144)).

   ![Plots](Plots) → ![XY Plot](XY Plot) → Set Up...
a. Select **Temperature...** and **Static Temperature** from the **Y Axis Function** drop-down lists.

b. Select **z=0_outlet** from the **Surfaces** selection list.

c. Click **Plot** and close the **Solution XY Plot** dialog box.

**Figure 27.4: Temperature Distribution at the Outlet**
Compare the plot of Temperature at the Outlet with the serial solution shown in Figure 3.20: Outlet Temperature Profile for the Adapted Coupled Solver Solution (p. 187).

2. Display filled contours of the custom field function **dynamic-head** (Figure 27.5: Contours of the Custom Field Function, Dynamic Head (p. 1146)).

   ![Graphics and Animations → Contours → Set Up...](image)

   a. Select **Custom Field Functions...** from the **Contours of** drop-down list.

   The custom field function you created in Tutorial 3 (**dynamic-head**) will be selected in the lower drop-down list.

   b. Enter 80 for **Levels**.

   c. Select **symmetry** from the **Surfaces** selection list.

   d. Click **Display** and close the **Contours** dialog box.
27.5. Summary

This tutorial demonstrated how to solve a simple 3D problem using the parallel solver of ANSYS Fluent. Here, the automatic mesh partitioning performed by ANSYS Fluent when you read the mesh into the parallel version was found to be acceptable. You also learned how to check the performance of the parallel solver to determine if optimizations are required.

For additional details about using the parallel solver, see Checking and Improving Parallel Performance in the User’s Guide.